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KIRISH

Web-saytlarni yaratish va undan foydalanish ta'lim tizimida ham
muhim ahamiyat kasb etadi. Ta’limda web-saytlardan nafaqgat tijorat
yoki namoyish vositasi sifatida, balki bilim berish magsadlarida ham
foydalaniladi. Albatta banda ta’lim masofadan turib amalga oshiriladi.
Bunday ta'lim berish jarayoni o’gituvchi va o'quvchi to'gXidan-to”ri
muloqot qilmasdan olib boriladi. Buning uchun ta'lim beruvchi (oliy
o'quv yurti, maktab va boshqgalar) crqitiladigan predmetga tegishli
ma’lumotlarni web-sahifalarga har xil ko‘rinishlarda (matn, rasm,
jadval. animatsiya, tovushli ma’lumot va xatto video tasma ko’rinishida)
joylaslii kerak. O'quvchi esa dunyoning xohlagan joyidan turib
Internet orgali bu ma’lumotlardan bilim olishi mumkin. Ta'limning
bunday ko‘rinishi masofaviy ta'lim deb yuritiladi. Bugungi kunda
masofaviy ta'lim dunyoning ko‘plab rivojlangan davlatlarida go'llanilib
kelinmogda. Masofaviy ta'limdan foydalanish natijasida vaqt va pulni
tejash, ortigcha ovvoragarchiliklarsiz bilim olish imkoniyatlariga
ega bo’linadi. Bunday imkoniyatlarni bizga web-sahifalar yaratib
beradi. Ma'lum predmetga tegishli ma'lumotlarni (matn, rasm, jadval,
animatsiya va boshqalarni) sahifalarga jovlab, ularni doimiy ravishda
to‘ldirib, yangilab borish, o‘gquvchilarni bilim larini baholash uchun
nazorat test savollarini kiritish imkoniyatlari mavjud. Buning natijasida
o'quvchining oigan bilimini nazorat qilish, baholash imkoniyatlari
paydo bo'ladi. Bu esa web-texnologiyadan ta'limda foydalanishning eng
optimal variantlaridan biri hisoblanadi.

Ushbu go‘llanmada ana shunday W eb-saytlarni yaratishda qo‘llani-
ladigan Macromedia Dreamweaver, Macromedia Flash, Corel Draw,
Adobe PhotoShop dasturlari va HTML - gipermatnlarni belgilash
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tilidan foydalanish imkoniyatlari hagida raa'lumot berilgan. Professional
dasturlar gatoriga kiruvchi Dreamweaver dasturi o’zining barcha
imkoniyatlari bilan har ganday nrurakkablik va masshtabdagi Web-
sahifalarni yaratish va o‘zgartirishga qodir. U vizual loyihalash
(WYSIWYG) rejimini ta'minlab, dastlabki matnli WEB —hujjatlarning
juda aniq ishlashi bilan ajralib turadi va katta tarmogqli loyihalarni
go‘llab-quvvatiovchi ichki qurilgan vositalarga ega.

Dasturda matnlar hamda obyektlarning obrazlari wustida olib
boriladigan ishlar bevosita kodlashtirishdan ustun turadigan gipermatnli
hujjatlar yaratish usulini vizual deb atash gqabul qilingan. Dastur
nafagat vizual loyihalash vositalarining kuchli bazasiga ega, balki
web — sahifalarni deyarli maxsus ko'iib chigish dasturlari yordamida
aks ettirishga ham qodir: Microsoft Internet Explorer yoki Netscape
Navigator.

D astur web-dizayn sohasida gipermatnli hujjatlarni to‘g'ridan-to‘g‘ri
kodlashtirish yordamida yaratishni afzal ko'ruvchi mutaxassislarga
ham m a’qul keladi. Dreamweaver qobig'iga gipermatnlarni belgilovchi
diskreptorlar bilan ishlash uchun zarur barcha uskunalarga ega to'liq
funksional HTM L tahrirlagichi integratsiya gilingan.

Dreamweaver dasturi «odiiq arxitektura» prinsiplariga asoslangan.
Bu amaliy dasturni interfevsi (Application Programming Interface. API)
to'lig ochiqg ekanligini biliiradi. Uning yordamida tashqi dasturchilar
hamda dasturiy ta’minot bilan shug'ullanuvchi firmalar, dastur va uning
interfeysiga radikal funksional o'zgartirishlar Iciritishi: yangi uskuna
go‘shish, menyu palitrasi yoki bolimini yaratish. yangi obyekt yoki
multimedia roligini dasturlashtirish va hokazolar.

Dreamweaver ti/dmi tarkibiga multimedia roliklarini qo‘yishga
mo‘ljallangan qo'shimcha dastur Kkiradi, shuning uchun Flash -
texnolog iyaning interfaol imkoniyatlarini tahrirlagichdan chigmay turib
ko’rib chigish mumkin.

Ta’lim tizimida esa, axborot texnologiyalarini qo‘llab, ta’lim-
tarbiya berish va unga tegishli barcha jarayonlarni axborotlashtirish
bilan ta’lim samaradorligini oshirishga olib kelinadi. Bunda - axborot
texnologiyalaridan dars jarayonidagi ko‘rgazmalilik imkoniyatlari oshib
o‘quvchiiarning mazmunni tushunish darajasi ortadi. Oquvchi dars
vaqtida biror murakkab jaiayonni ko‘z oldiga keltirishi qgiyin bolib. uni
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tasavvur qila olmaydi. Ana shunday paytda kompyuterning maxsus
dasturlari yordamida shu murakkab jarayonni aynan o‘zidek qilib
tasvirlab berish mumkin. Bunda o‘quvchilarda ushbu murakkab jarayon
haqidagi tasavvurni hosil giladi. Bu kabi dasturlar ko‘pincha inson ko‘zi
bilan koTta olmaydigan (masalan, mashina dvigateli ichidagi harakatlar,
odam qon aylanish tizimi va boshqgalar) murakkab jarayonlarni tasvirlab
berish uchun xizmat qiladi. Bunday dasturlarga misol qilib Flash
M X, 3D MAX kabi dasturlarni aytishimiz mumkin. Ushbu dasturlar
yordamida nafagat murakkab jarayonlarning tasvirlarini, balki barcha
turdagi elektron darsliklarni yaratish imkoniyatlari ham mavjud.
Avynigsa arimatsiyali m a’lumotlarni keltirish va bezashda keng qo‘llash
mumkin.

Ushbu qo'llanmada shuningdek Flash M X dasturini o'rganishga
bag'ishlangan ma’lumotlar ham berilgan. Qo‘llanmada dastur imko-
niyatlari, uning interfeysi, flash-filmlar, flash-saytlar yaratish va
ulardan turli jarayonlarda foydalanish to‘g‘risidagi ma’lumotlar berilgan.
Bundan tashqari web dizaynning eng muhim ajralmas qismlaridan
biri bo'lgan kompyuter grafikasi hagida ham ma’lumot beriladi. Bizga
ma’lumki web muharrirlar savtning asosini yaratishda ishlatilsa,
uni rasmlar, grafiklar wva turli illustraisiyalar bilan boyitish uchun esa
grafk muliarrirlariga murojat qilamiz. Bunda Adobe PhotoShop, Corel
Draw kabi grafik muharrirlarning o‘rni tengsiz. Qo'llanmani yozishda
aynan bu dasturlarning tanlab olinishiga sabab, birinchidan ularning
professional dasturlar gqatoriga Kkirishi bo‘lsa, ikkinchidan Adobe
PhotoShop rastrli grafrka bilan, Corel Draw7esa vektorli graftka bilan
ishlashga moljallanganligi uchundir.



I-bob. WEB-DIZAYN
1.1. Web-dizayn. Web-dizayn qo‘llaniladigan dasturlash vositalar

Dizayn (ingliz tilidan design injener-konstruktor, lotiachadan
designare o ‘Ichab ko‘rmoq, o‘lchab bennoqg) - bu ijodiy faoliyat bo‘lib,
uning asosiy maqgsadi sanoat buyumlarini formal sifatini belgilaydi.
Bu sifat shuningdek buyumning tashqi qgirralarini o‘z ichiga olish bilan
birga, asosan shu tuzilmaviy va funksional alogadorlik xaridor hamda
ishlab chigaruvchi ko‘zi bilan qgaraganda buyumni yagona holatga
keltiradi. Dizayn sanoat ishlab chigarishi bilan bog'langan insonni o'rab
turgan atrof-muhitning barcha jabhalarini qurshab oladi [21]. [22], [23].

Dizaynning turiari - dizaynerlik faoliyati loyihalash predmetining
farglanishi, loyiha isliining magsadlari va xnetodlari hamda uning
yakuniy aatijasi bilan farglanadi. Dizaynning quyidagi turiari
mavjud:

- grafik dizayn,

- sanoat dizayn,

- web-dizayn.

Grafik dizayn

Grafik dizaynda - informatsion grafika, reklama va boshqgalar
bilan ishlanadi. Web-dizayn va grafik dizayn nomining o‘xshashligiga
garamasdan, dizaynning turli yo'nalislilari hisoblanadi. Web-dizayn
ma’lumotni saytda tasvirlash uchun ishlatiladi. Ammo grafik dizayn
bilan web-dizayn o'zaro bogiangan. Grafik dizaynda tayyorlangan
illyustratsiyalar saytlarni bezashdakeng ishlatiladi. Grafik dizayn aslida
foydalanuvchiga uzatiladigan ma’lumotni gabul qilinishini loyihalashi
kerak. Grafik dizaynning vo'nalishlari;

1 Firma stili,

2. Shriftlar,



Plakat.
Grafik reklama,
Kitobiy grafika,

o o p oW

Gazeta grafikasi,

7. Jurnal grafikasi.

Saroat dizayni — maishiy buy umlar va asbob-uskunalarni ishlab
chigishda. mashinasozlik obyektlarida, transport vositalarida va bosh-
galarda ishlatiladi.

Bulardan tashgari dizaynning bir gancha ko'rinishlari mavjud.
Bnlar: arxitektura dizayni, kiyim va aksessuarlar dizayni, art-
dizayn, reklama dizayni.

Web-dizayn (ingliz tilidan olingan bo‘lib, web-design — web-
sahifari loyihalash ma'nosini bildiradi) - bu web-sahifani jihoz-
lanishidir. Web dizayn sayt uchun huddi poligrafiya dizayni A/a qog;ozli
nashrlar dastgohlari singari muhim rol o‘ynaydi. Web-dizayn deganda
nafagat web sayt uchun grafikli elementlarni yaratish, balki uning
strukturasini loyihalash. unda harakatlanish vositalari, ya’ni butun
sajtni yaratish tushuniladi. Shu sababli ham biz ushbu go’llanmada
nafagat -web muharrirlarni, balki grafik muharrirlar, animator das-
turlarri ham gapirib o ‘tishni maqul ko'rdik.

Sayt gancha ajoyib bezatilgan bo‘lmasin, unda qulay va tu-
shunaili harakatlanish chizmasi mavjud boMmasa. hammabop ke-
rakli matnlar bo’lImasa. agar sayt yaxshi dasturchilar tomonidan
tayyorlangan samarali dasturiy vositalarga ega boimasa - bunday
sayt tezda o'z foydalanuvchilarini yo'gotadi va undagi noqulaylik
(hattoki u professional va munosib stilda tayyorlangan boisa ham)
muvofaqgiyatsizlikka mahkum boiadi. Yaxshi web-dizayn saytning
sahifalarini hamohanglik bilan birlashtiradi. Boshgacha aytganda, web-
dizayn saytning joylashish o'rnini belgilaydi.

Web-dizaynni o ‘rganishda quyidagi uchta tushuncha muhim
ahamiyat kasb etadi: Web-sahifa, Web-sayt va Web-server.

Web-sahifa - o ‘zining unikal adresiga ega boigan va maxsus
ko’rish dasturi yordamida (brauzer) ko'riluvchi hujjatdir. Unga matn,
grafika, ovoz, video voki animatsiya ma’lumotlar birlashmasi -
multimediyali xujjatlar, boshga hujjatlarga gipermurojaatlar Kirishi
mumkin.



Web-sayt - bir gancha web-sahifalarning mantigiy birlashmasi.
Inglizcha «site» (tarjimasi «jov») so’zining o'zbekcha talaffuzi. Umum-
jahon o‘rgimchak to‘ri ina’lum axborot topish mumkin boigan va
noyob URL bilan belgilangan virtual jov. Mazkur URL web-saytning
bosh sahifasi manzilini ko‘rsatadi. 0 ‘z navbatida, bosh sahifada web-
saytning boshqga sahifalari yoki boshqga saytlarga murojaatlar bo'ladi.
Web-sayt sahifalari HTML, ASP. PHP. JSP. grafik va boshqa fayllardan
tashkil topgan bo'lishi inumkin. Web-saytni ochish uchun brauzer
dasturidan foydalaniladi. Web-sayt shaxsiy, tijorat. axborot va boshqa
koTinishlarda bo‘lishi mumkin.

Web-server - tarmogga ulangan kompyuter va undagi dastur
hisoblanib. umumiy resurslarni inijozga taqdiin etish yoki ularni
boshqarish vazifalarini bajaradi. Web-serverlar rna’lumotlar bazalari
va multimediyali ma’lumotlarni bir biriga moslashtiradi. Web-
serverda Web-sahifa va Web-saytlar saglanadi. Web-server — Internet
yoki Internetga ulangan umumfoyialanishdagi axborot serveri. Unda
hujjatlar va fayllar - audio, video, grafik va matn fayllari - saqglanib,
ular fovdalanuvchilarga HTTP vositalar orqgali tagdim etiladi. Web-
server nomi u umumjahon tarmog'Mning qisini boTgani uchun kelib
chiggan. Maxsus dasturiy ta’minotga ega bo‘lgan, bir yoki bir aecha
web-sayt fayllarini saglash va ularga ishlov berish mumkin. Bir necha
web-sayt bitta kompyuterda ishlaganda. web-server deganda web-
sayt ishlovchi virtual makon (dasturiy taininot va kompyuterdagi joy)
tushuniladi. Shunga ko’ra ko'pchilik uchun «web-server» deganda
«web-sayt» tushuniladi. Ko’p axborotni saglovchi web-saytlar bir
paytning o‘zida bir necha kompyuterda saglanishi va ularga ishlov
berilishi mumkin. Web-seiver mijozlarning vveb-saytga so'roviga javob
beradi.

Bu tushunchalarga go‘shimcha web hujjat tushunchasini ham ko'rib
o ‘tamiz.

Odatda, maxsus HTML (Hypertext Markup Language) tilidagi
hujjat. Web-hujjat jahon o'rgimchak uyasining asosini tashkil qiladi.
Ular gipennatndan iborat bo'lib. foydalanuvchiga ajratib ko‘rsatilgan
so'z yoki jumlaga garatib, ma'lumotlarni o‘gish, hujjatning boshqga
qgistniga yoki ayni hujjat bilan giperhavola yordamida bogTangan
boshga web-hujjatga o'tish imkonini beradi. Web-hujjat, shuningdek,



matn, tasvir, tovush, videolarni mujassamlovchi gipermuhit maiumotni
ham o'z ichiga olishi mumkin. Web-hujjatni ochish, ularni o‘gish yoKki
aks ettirish Internet brauzerlari yordamida amalga oshiriladi. Web-
hujjat tushunchasi «web-sahifaLar» va «web-saytlar» tushunchalari
bilan chambarchas bogiig. Odatda «web-sahifa» atainasi web-hujjat
atamasining sinonimini bildiradi, «web-sayt» atamasi esa yagona mavzu
ostida birlashtirilgan yoki bitta tashkilot. muallif yoki foydalanuvchiga
tegishli boigan sahifalar majmuasiga tegishlidir.

Munosib web-dizaynni yaratishda qatnashuvchi quyidagi element-
larni sanab oiish mumkin:

Shrift - web sayt ichida imkoni boricha bitta shrift, yoki odatda
ikki-uchta bir-biriga o’xshash (oson gqorishadigan) shriftlarni qo‘shib
islilatish mumkin boigan xususiyatlar va tanlangan fonda o'gish
mumkin boigan ranglarga ega boiishi lozim.

Abzats - imkoni boricha web saytning barcha sahifalarida
matn va boshga vizual materiallarni tekislashning (sozlashning) bir
ko’rinishlarida boiishi magsadga muvoliq.

Web-saytning rangli sxemasi - sahifaning oddiy matnini, havola
va tashrif buyurilgan havolalarni tagdim qilishning uch xil ranglarini
belgilaydi. Rangli sxema. yoki turli mavzudagi saytning boiimlari
uchun bunday sxemalarning bir nechta koiinishi saytning barcha
sahifalarida takrorlanishi lozim.

Web-dizayn o'zida belgilangan rangli va mantigiy sxemani bir-
lashtirgan gandavdir grafikli jihozlashni nazarda tutadiki, shuniag
uchun ish boshida saytni jihozlashning umumiy konsepsiyasini o‘ylab
kcrish kerak boiadi. Barcha grafik elementlarni ikkita katta sinfga
ajratish mumkin: cliizilgan va biror real vogelik fotosuratlari. Saytni
bezash ishlarida bu ikki tipni aralashtirib yubonnaslik yoki ularni
web saytning tematik yoki mantigiy qismlariga to’g'ri taqsimlash
magsadga muvofig. Shuni alohida ta’kidlab oiish kerakki, saytda har
ganday tipdagi foto suratlarni illustratsiya sifatida ishlatishdan oldin,
ularni tegishli tarzda gayta ishlash (rang va tonda tuzatish, korreksiya)
zarur.

Web-dizaynning asosiv magsadi - saytni egasiga foyda (moddiy,
ma'naviy) keltiradigan koi'inishda taqdim gilishdan iborat. Foyda sayt
orgali mollarni to‘g‘ ridan-to‘g‘ri sotish orgali boiishi, shuningdek unga



go‘shimcha firmaiarni. mahsulotlarni reklama orqali yangi mijozlami
o‘ziga tortish yoii bilan ham kelishi mumkin. Ta’limda esa bularga
go‘'shimcha o‘quv resurslarini yetkazib berish, ta’'limni boshgarish
ishlarini amalga oshirish mumkin.

Bizga m a'lumki web-dizayner boshga kasblarga nisbatan yosh
(yangi) kasb hisoblanadi. Internetga boigan talabning ortishi bilan,
saytlarning dizayniga boigan talab va web-dizaynerlar soni ham ortib
bormoqda.

Endi web loyihalarning asosiy tiplari va ularni liar birini vizual
bezashga go'‘yiladigan talablar bilan tanishib chigamiz. Saytlar tarkibiga
koia quyidagi asosiy tiplarga boiinadi:

Uy sahifasi (fQomawHaa cTpaHuya) tushunchasining bir nechta
ko‘rinishi mavjud:

1 Alohida shaxsga tegishli web-sayt. Bu saytda shaxs haqidagi
bir necha mavzudagi ma’lumotlar, matnlar, foto jamlanmalar berilishi
mumkin. Odatda bunday saytlarga turli sohalarning (masalan, fan-
texnika, madaniyat, sport va boshga sohalarda) mashhur kishilari ega
boiadi.

2. Brauzerda birinchi yuklanadigan web-sahifa. Saytdan foydalanish
undan boshlanadi. Odatda, foydalanuvchi o:zining gayerda ekanligi va
saytning boshga sahifalarida nimalarni ko‘rishi mumkinligi haqgida uy
sahifasidan maiumot oladi. Brauzer tomonidan dastur yuklangandan
so'ng terminalda paydo bo‘ladigan web-sahifaning, portalning. maj-
muaning birinchi sahifasi, Odatda. prezentatsiya va navigatsiya bo'yicha
ham asosiy ish bajaradi.

Prezentatsion sayt - nomidan ko‘rinib turibdiki, sayt firnia /
xizmatlar / mahsulotlar haqgidagi ma’lumotlarni taqdim qgiladi. Maium
sondagi sahifalarni o'zida birlashtirib, kamdan-kam holatda yangilanadi.
Saytning asosiy vazifasi - tagqdim gilinayotgan xizmatlar va uning
afzalliklarini tashrif buyuruvchilargacha vizual jihozlash yordamida
maksimal tezlik va samara bilan yetkazib bera olishdan iborat. Bunday
loyihalar tartib goidalar bo'yicha aniq, noyob dizayn, grafikli jihozlanish
matnli ma’lumotlar oldida ustunlik giladi.

Misol sifatida http://www.loyalstudios.com va http://www.de-
signchapel.coin saytlarida keltirilgan sahifalarni aytish mumkin.

Korporativ saytlar - tashkilotning (firmalar, korporatsiyalar) inter-
net tarmog‘idagi vakolatxonasi hisoblanadi va binobarin, bunday
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loyihalarda eng asosiy talab ma’lumotni ya’ni grafika yoki matnning
jihozlanishiga garatiladi.

Informatsion resurslar - bu elektron kutubxonalar va gazetalar.
Bunday tipdagi saytlarda maiumotlar bir sutkada bir necha marta
yangilanadi. Ma’lumotlarning hajmijuda ham katta, va bunday saytlarni
ishlab chigishda shuni ta'kidlash kerakki, tashrif buyuruvchi saytni
tomosha qilish uchun eraas —ular mazmuni uchun kelishadi. Yangiliklar
nashri (misol uchun — http://www.cnews.ru") yoki http://sight.mn.i.ru
singari rasinlar galereyasida, loyihaning bosh magsadi —yuqori tezlikda
ma’lumotni tashrif buyuruvchiga tagdim qilish yoki bu ma'lumotni
gidirish imkoniyatidan iborat. FLar ganday grafikli bezaklar sahifaning
hajmini oshirib yuboradi —ya'ni sahifaning yuklanish vaqtini oshirib
yuboradi. Shuning uchun mum kin gadar bunday loyihalarda dizayn
matnli koTinishda ishlab chiqiladi. Kartinkalar, fotografiyalar. grafiklar,
sxenialar illustratsiyalar hisoblanadi.

Elektron tijorat — axborot texnologiyalariga asoslangan biznes
hisoblanadi. Elektron tijorat (ingliz tilidan e-commerce) - internetda
o'ziniiig sayti va virtual magazini, shuningdek o‘zining (firma yoki
kompaniyaning) boshqgaruv tizimi mavjudligi bilan asoslanadi. Elektron
tijoratga quyidagilar kiradi:

- elektron ma'lumot almashish (Electronic Data Interchange, EDI),

- elektron jamg'arma ko*chirish (Electronic Funds Transfer, EFS),

- elektron savdo (e-trade),

- elektron karmon (e-cash),

- elektron marketing (e-marketing),

- elektron banking (e-banking),

- elektron sug‘urta xizmatlari (e-insurance).

Web-dizaynda qoilaniladigan dasturiy vositalar

Bugungi kunning talablaridan kelib chiqib to‘lagonli web-saytlar
yaratishda bir gancha turdagi dasturiy vositalardan fovdalaniladi. Ularni
toTtta katta guruhga a jratish mumkin (1.1-rasm) [11], [12], [13].

Undan tashqgari web muharrirlar ning ham turlari juda ko‘p. Ular
o'zining imkoniyati, tezkorligi, interfeysi va boshga xususiyatlari

bilan farglanadi. 1l-jadvalda shunday dasturlardan asosiylari kel-
tirilgan.


http://www.cnews.ru
http://sight.mn.i.ru
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AutoCAD

Adobe Front Page
Ilustrator

l.I-rasm. Web saytlar yaratishdaqo'llaniladigan disturb vositalar guruhlari.

dastur nomi

Bloknot (Notepad)

HomeSite 4.5

U ltra Edit-32

Web Page Maker

DTM Lome 1.2

11-jadval

Web-muharrirlar ro‘yxati

izoh
Windows operatsion tizimi standart vositala-

ridan bolib. undan HTML tilini yaxshi bilgan
o'rganuvchilar foydalanadi.

HTML-muharrir. Teglarni ranglar bilan ajratish,
bir vaqtning o‘zida bir nechta faylda qidirish.
almashtirish va boshgalar.

Dasttirehilar uchun keng imkoniyatli matn
muharriri. Bir vaqtning o‘zida bir nechta faylni
talirirlash imkoniyati mavjud.

Dastnr Software Ine mahsuloti hisoblanadi.
Qisga vaqt ichida web-sahifa yaratish va
yulclash jmkoniyatini beradi. Unda HTML tilini
bilish shart ernas.

Ish  boshlovchilar va professionallar uchun
oddiy, tezkor va qulay HTML-muharrir.
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19.

Artisteer.2.3.0.10943

Codelobster
PHP Edition 3.3

Amaya

NeonHTML

Serif WebPlus X2

PHP Designer 2008
Professional 6.2.5.2

Dreamweaver CS4

Wap Editor 0.6d

BestAddress
HTML Editor 2008
Professional 12.12.0

DzSoft PHP Editor
421

SaveChm 1.2

MenuEditor
10.3.231

Quick Page 2008
(3.0.3.254)

AAA Web Album

Dastlabki web-dizaynni avtomatlashtirgan das-
tur. Photoshop, CSS, HTMLIarni bilish talab
gilinmaydi.

Juda qulay PHP. HTML, CSS muharriri

web-brauzer va HTML-muharrir
Wide Web Consortium (W3C) -
ishlab chigilgan.

The World
tomonidan

0 ‘zida vizual uskunalarni
va CSS mubharrir.

birlashtirgan HTM L

Professional darajadagi web-saytlar yaratishga
moTjallangan web-dizayn dasturi

PHP tilida ish boshlayotgan va professional
foydalanuvchilar uchun dastur PHPdan tash-
gari, dasturda HTML, MySQL, XML, CSS,
JavaScript, VBScript, JAVA, C, Python va
Rubylarni ham ishlatish mumkin.

Muralckab strukturali web-saytlarni loyihalash,
yaratish va boshgarishga moTjallangan profes-
sional dastur.

Qulay va ko'p funksiyali web-sahifalar yara-
tishga moTjallangan dastur.

Ko'p funksiyali HTML-muharrir. Dasturda
DHTML kodlari yordamida menyu yaratish
imlconiyatlari mavjud.

PHP - skriptlar yozishga va HTML-sahifalar
yaratishga mo'ljallangan dastur.

Rasmli web-sahifalarni tezkorlik bilan CHM
(Windows-help) formatida saqglovchi dastur.

Web-saytlarda harakatlanish uchun qulay men-
yularni yaratishga moTjallangan dastur

Web-saytlar yaratishga mo‘ljallangan
sional dasturiy vosita.

profes-

Bu dasturiy vosita web-sahifalar uchun
albomlar yaratish uchun mo'ljallangan.

foto
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21.
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24.
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28.

29.

30.

3L

M ultiple File Search
and Replace 2.0

Incomedia Website
Evolution X5 7.0.9

Arachnophilia
5.3.2177

Web Page Maker
v2.5Rus

Incomedia WebSite
X5 Evolution 7.0

AceHTML Pro
v6.03.0

Sothink
DHTML Menu 8.3
build 71210

HtmIReader 2.5

PHP Designer 2008
Professional vo.0.0

Atani 4.3.4 Rus

Sothink
DHTMLMenu

TIGER CMS vl.O
Lite

daronii

Bir vaqtning o‘zida web-saytning bir neclita
fayllari bilan ishlashga mo-‘ljailangan dasturiy
vosita

Foydalanish uchun qulay bo‘lgan, tushunarli
interfeys va gadainba-gadam yordamchidan
foydalanib bir necha minntda web-sayt yaratish
mumkin

Java asosida qurilgan HTML-muharrir Sun Mi-
crosystems malisuloti hisoblanadi

Dasturning arxivida bir gancha tayyor sayt
shablonlari mavjud boiib, bir necha dagiqgada
HTML sahifalar yaratish imkonini beradi

Shaxsiy web-saytlar yaratishga moijallangan

dastur

Web-saytlar yaratish va ularga xizmat ko'r-
satuvchi dasturlar paketi

Web-ustalar udiun moijallangan dasturlar pa-
keti

html-sahifalarni yaratish, tuzatish va ko'rishga
moijallangan dastur.

PHP, HTML, XHTML. CSS, Perl, C*, jav-
Script, VB, java va SQL muharriri.
Web-sahifalar uchun bannerlar yaratishga mo'l-
jallangan dastur

DHTML menyular yaratishga moijallangan
dastur. Dasturdan foydalanishda DHTML yoki
JavaScript bilish talab gilinmaydi

Shaxsiy web-sahifalar yaratishga mo'ljallangan
dastur

Web-ciizay nda goilaniladigan bir gancha dasturiy vositalar vayana

ko‘plab uskunaviy dasturlar, turli dasturlash tillari mavjud. Eng ko‘p
goilaniladigan tillarga misol gilib, HTML-gipermatnlarni belgilash tili.
PHP, ASP, Java., JavaScript. DHTML va boshqa tillarni aytish mumkin.
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~avaScript ]
4  Nlijoz tomonidan  ~I— [AdobeFlash (ActionScript)']
HSilverLight |

1.2-rasm. Web-dasturlash tillarining guruhlarga bolinishi.

W eb-dasturlash tillari ikki guruhga bolinadi: mijoz va sei'ver tillari.
Biz yuqorida web-serverga ta'rif berdik. Unga ko‘ra server sizning
saytingiz saqglanadigan. brauzerning so‘rovlari qayta ishlanadigan
gaysidir sahifadagi dasturlar saqglanadi. Undan tashqgari serverga
quyidagicha ta'rif berish mumkin: Server - tarmoq ishini ta'minlovchi
maxsus kompyuter. Server disklarida kompyuterlarni birgalikda ishlash
imkonini beruvchi dasturlar, ma'lumotlar omborlari va boshqgalar
saga.lanadi. Bundan tashqgari serverlar modemli va faksli alogalarni,
m afumotlarni bosmaga chigarish ishlarini amalga oshiradi. Serverda
joylashgan dasturlardan foydalanish doirasi umumiy masalaning
go'yilishiga ko'ra cheklangan boiishi mumkin.

Mij oz tomonidagi senariylar
JavaScript nima?

Mijoz tillaridan eng ko‘p targalgani JavaScript tili boiib. Netscape
(Netscape Navigator. v>\vw.netscape.com) SunMicrosystems (wWww.sun.
corn) kompaniyalari hamkorligida ishlab chigilgan. JavaScript faol
HTIML-sahifalar uchun senariylar yozishga mo'ljallangan. JavaScript
avtonom ravishda ishlaN'digan ilovalarni yaratishga moijallanmagan.
JavaScriptdagi dasturlar bevosita HTML-hujjat kodi icliiga quriladi va
brauzerda sahifani yuklanishi vaqtida faollashadi. Sodda qilib aytganda
HTMLning cheklangan, sodda imkoniyatlarini kengaytirish va toiaqonli
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sahifalar yaratishga moijallangan. JavaScript yordamida odatda
maiumotli va mulogot oynalarini chiqgarish, aniinatsiyalarni ko'rsatish
kabi wvazifalarni bajarish mumkin. Bundan tashqari, JavaScript-
senariyda bazan o;zi ishlab turgan brauzer va platforma tipini aniqglash
mumkin. JavaScript-senariylar foydalariuvchi tomonidan Kkiritilayotgan
ma’lumotlarni to'g’riligini tekshirishda ham qulay hisoblanadi.

ActionScript nima ?

ActionScript - obyektga yo'naltirilgan dasturlash tili boiib, Flash-
ilovalar tarkibida interfaollik, madumotlarni gayta ishlash va boshga
ko'plab  imkoniyatlarni beradigan ECMAScript dialektlaridan biri
hisoblanadi.

Silverlight nima?

M icrosoft Silverlight - bu dasturiy platforma bo’lib. RIA (Rich
Internet application)ga xos bo‘lgan animatsivalar vektorli grafika va
audio-video roliklardan tarkib topgan ilovalarni yuklash imkonini
beradigan brauzer wuchun plaginlarni o‘z ichiga oladi. Bu esa
Silverliglit barcha brauzerlarda WMV. WMA va MP3 kabi formatlarni
Windows Media Player singari qo'shimcha komponentlarsiz ijro qilish
imkoniyatini beradi. Dasturning 2.0 versiyasi 2008 vil oktyabrda ishlab
chigilgan bo'lib, unga .NET tillari bilan ishlash imkoniyati qo'shilgan.
Bundan tashqgari Microsoft kompaniyasi 2009-yil ivulda IDE bilan
integratsiyalashgan Silverlight 3 va Microsoft Expression Studio 3
dasturlarini ishlab chiqdi.

Silverlight platformasi Windows 2000, Windows XP, Windows
Server 2003. Windows Vista, Windows 7, Mac OS X 10.4, Mac OS
X 105, Mac OS X 10.6 operatsion tizimlariga va Internet Explorer
6.0/7.0/8.0. Mozilla Firefox 1.5/2.0/3. Safari 3.1. Google Chrome 3.0,
Opera 9.50 brauzerlariga mo'ijallangan.

VBScriptnima?

VBScript tili Microsoft korporatsiyasi tomonidan yaratilgan bo'lib.
Visual Basic tilining bir qgismi hisoblanadi. VBScript tili Internet
Explorer va Microsoft Internet Information Server (l1IS)lar bilan
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ishlashga ino’ljallangan tildir. VBScript tilining JavaScript tili bilan
urnumiy qismlari bir nechta. Jumladan, u aynan Microsoft Internet
Explorer bilan ishlash va uning qo‘llanish sohasini cheklay olish
imkoniyatiga ega. VBScript interpretatorli (sharhlovchi, izohlovchi,
tushuntirib beruvch i) til hisoblanib, Microsoftning Web-texnologiyalari
(masalan ASP (Active Server Page)) bilan hamkorlikda ishlay
oladi. Shunga qgaramay VBScript klient tomonida ishlovchi senariy
hisoblanadi, ASP esa server tomonida ishiaydi.

Server tomonidagi senariylar

Dasturning ishlashi toMiq sayt joylashtirilgan sei~verga bog'lig.
Server tillarini ishlashining muhim jihatlaridan biri bu serverda
tartiblangan holda saglanuvchi va xohlagan paytda chagirilishi mumkin
bo'lgan rra’lumotlarni bevosita ma:lumotlar bazalarini boshgarish
tizimlari bilan ozaro bog'langan holda faoliyat yuritadi. Eng ko'p
islilatiladigan ma’lumotlar bazasini boshqarish tizimlari quyidagilar:
Firebird. IBM DB2, IBM DB2 Express-C, Microsoft SQL Server,
Microsoft SQL Server Express, mSQL, MySQL, Oracle, PostgreSQL
SQLite, Sybase Adaptive Server Enterprise.

Server tomonida bajarilishi kerak bo'lgan senariylar odatda sayt
papkasining ichidagi maxsus papkaga joylashtiriladi. Foydalanuvchi
so'roviga asosan server bu senariyni bajaradi. Bajarilgan senariy natijasi
web-serverga uzatiladi va undan so'ng mijoz (klient)ga uzatiladi. Server
tomonidagi senariylarni tashkil etish uchun odatda Perl. ASP, PHP, JSP,
SSI kabi tillar va texnologiyalardan foydalaniladi.

Perl nima?

Perl —bu protsedurali dasturlash tili bo‘lib, juda keng gamrovli
topshiriglarni  yechish uchun mo'ljallangan universal uskunadir.
Perl boshga to'lagonli tillar singari platformalarga, operatsion tizim
va boshga vositalarga bog‘lig bo'lmagan funksivalar va qoidalar
to'plamiga ega yadrodan tashkil topgan. Perl tili Web-ilovalar
yaratishda eng ommabop tillardan biri hisoblanadi. Matnlarni gidirish
va tahrirlash. favllar bilan qulay ishlay olish qgoidalari uchun Perl tili
Internetning asosiy® tillaridan biri bo'lib goldi. Perl - interpretatorli til
hisoblanadi, shu bois unda \ aratilgan senariylar ishlashi uchun server
2—reaagogik Mlev-aizayn 1 0Shkent Axbomt Texnologiyalari Universitetl i7
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kompyuterda Perl-interpretator o'rnatilgan boiishi kerak. Bevosita
Perl-kodning interpretatsiya gilinish jarayoni uaing samaradorligini
pasaytiradi. Bugungi kunda Perlning asosiy yutuglaridan, lining barcha
platformalar uchun ishlay olishi va unitig barcha resurslari bepul
targatilayotganligidir. Ko'pgina web-serverlar UNIXda ishlaydi, Perl
interpretator esa bu operatsion tizimning bir gismi hisoblanadi.

ASP nima?

ASP (Active Server Pages) - ma’lumotlar bazalari tashkil etish
va ular bilan ishlash vazifalarini bajarishda juda moslasliuvchan.
qulay vositadir. ASP vositalari server tomonida ishlaydi va HTML-
kod va senariylar kabi fayllarni qayta islilaydi. ASP texnologiyasi
VBScript, Java va JavaScript tillarini goilab quvvatlaydi. ASP-
kod joylashtirilgan Web-sahifalar favllari kengaytmasi .asp boiadi.
ASP texnologiya Windows NT va Microsoft [IS web-serveriga
moijallangan boiib, imkoniyatlari va samaradorligi yuqori boiganligi
bois ko‘pgina kompaaiyalar 0'z vositalariga ASPni qo'llab-quvvatlash
im koniyatlarini kiritmoqgdalar. Ko'pgina HTML-inuharrirlar. masalan.
Adobe GoLive ham ASPni qoilab-quvv&tlaydi. ASP texnologiyasi
bir nechta qulayliklarni o‘zida jamlagan: HTML-hujjatni dinamik
generatsiyalaydi, formalarni go'llab-quvvatlaydi, maiumotlar bazasiga
ruxsatni tashkil etadi va u bilan ishlay oladi. ASP - dasturlash tili
ham, ilova ham emas, u interfaol web-sahifa hosil gilish texnologiyasi
hisoblanadi.

PHP nima?

PHP - bu serverda gayta ishlanuvchi senariylar tilidir. ASP kabi
PHP kodlar ham bevosita HTML-hujjatni tarkibiga go'shiladi. Ushbu
tilning nomi Personal Home Page Tools so‘zlarining gisgartmasidan
olingan. PHPda C va Perl tillarida uchragan bir gator muammolar hal
etilgan. Bund an tashgari. PHP ma’lumotlar bazasi bilan ishlash uchun
juda qulay vositadir. Umuman olganda Perl, PHP —ochiq tizimli tillar
hisoblanadi va ularni dasturchilar moiernizatsiyalashtira oladi.

Ko'pgina boshqa dasturlash. tillaridan fargli ravishda. PHP gandavdir
tashkilot yoki kuchli dasturchi toinonidan yaratilgan emas. Uni oddiy
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foydalanuvchi Rasmus Lerdorf 1994-yili o‘zining bosh sahifasini
interfaol uslubda ko‘rsatish uchun yaratgan. Unga Personal Home Page
(PHP - shaxsiy bosh sahifa) deb nom bergan.

1995-yili Rasmus PHPni o’zining HTML formalari bilan ishlaydigan
boshga dastur bilan umumlashtirib PHP/FI Version 2 («Form
Interpretator») hosil qildi. 1997-yilga borib PHPdan foydalanuvchi
saytlar 50 mingdan oshdi. Shundan so'ng web texnologiya ustalari
PHP g'oyasi asosida mukammal til yaratishga Ziva Suraski va Endi
Gutmans asoschiligida kirishildi. PHPni samarali deb hisoblanmagani
uchun deyarli noldan boshlab. mavjud C va Perl tillaridan ibrat olib
PHP3 talginini yaratildi. 1999-yilga kelib PHP asosida qurilgan saytlar
milliondan oshib ketdi. 2000-yilda esa Zend Technologies shirkati yangi
ko'pgina funksiyalarni qo'shgan holda PHP 4 sharhlovchisini yaratdi.

PHP —web texnologiya tili. PHPni oiganish uchun avval HTML
va dasturlash tilidan habardor boMish talab gilinadi. HTML/CSS va
JavaScript tillarini mukammal biladiganlar uchun PHPni o'rganish
murakkablik tug’dirmavdi. PHPning vazifasi HTML faylini yaratib
berish. JavaScript yordamida bajariladigan ko’pgina operatsiyalarni
PHP orgali ham amalga oshirish mumkin.

JavaScript —mijoz tomonda bajariladi, PHP esa serverda bajariladi.
PHPda yozilgan kod serverning o'zida bajarilib. klientga HTML
shaklida etib boradi. Bu havfsizl ik jihatdan ancha magsadga muvofig.

JavaScript yordamida kod yozish, ma’lumot uzatish va gabul gilishni
biroz tezlashtirsa-da, kodni mijoz ko‘rish imkoniyatiga ega boiadi.

«PHPda har ganday dasturni bajarsa bo'ladi» - degan edi uning
yaratuvchisi. Birinchi navbatda PHP tili server tomonidan bajariladigan
skriptlar yaratish uchun foydalaniladi va aynan shuning uchun u
yaratilgan. PHP tili ixtiyoriy CGlI-skriptlari masalalarini yechishga va
bundan tashgari html formali ma'lumotlarni gayta ishlashga hamda
dinamik ravishda html sahifalarni ishlab chigishga godir. Biroq PHP tili
foydalaniladigan boshga sohalar ham mavjud. Bu sohalarni biz uchta
asosiy gismga boTamiz:

Birinchi soha - biz yuqorida aytib o‘tganimizdek, server tomonidan
bajariladigan ilovalar (skriptlar) yaratish. PHP tili bunday turdagi
skriptlarni yaratish uchun juda keng qoilaniladi. Bunday ish ko'rsatish
uchun PHP-skriptlarni gayta ishlovchi va skriptlarni gayta ishlovchi
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web-server, skriptlarni natijasiai ko'rish uchun brauzer va albatta php-
kodini yozish uchun ganday boisa ham matn muharriri kerak boiadi.
PHP- skriptlarni gayta ishlovchi CGl-dasturlar koiinishida yoki server
rnodullari ko'rinishida targalgan.

IKkinehi soha —buyruglar satrida bajariladigan skriptlarni yara-
tish. Yaiii PHP tili yordamida biror-bir kompyuterda brauzer va
web-serverlardan imistagii ravishda o'zi bajariladigan skriptlarni
ham yaratish mumkin. Bu ishlarni bajarish uchun hech boimaganda
PHP-skriptlarni gayta ishlovchi (bu holatda biz uni buyruglar satri
interpretatori (CLI. command line interpreter) deb ataymiz) talab
etiladi. Bunday ishlash uslubi turli masalalarni rejalashtirish yordamida
bajari lishi uchun kerak boigan skriptlar yoki oddiy matnni gayta
ishlash uchun kerak boigan masalaga o‘xshash islilaydi.

Uchinchi soha - bu mijoz tomonidan bajariladigan GUlI-ilovalarni
Cgraftk interfeys) yaratish. Bu soha PHP tilini endigina o‘rganayotgan
foydaJanuvchilar uchun uncha muhim boimagan sohadir.

PJHP tilini qo'llanilish sohalari keng va turlichadir. Yuqoridagi
masalalarni yecha oladigan boshga turlicha dasturlash tillari ham
mavjud. Unda nixna uchun PHP tilini o‘rganishimiz kerak? U til bizga
nima beradi? Birinchidan, PHP tili o'rganish uchun juda qulay. PHP
tilini sintaksisi asosiy qoidalari va ishlash prinsipi bilan yetarlicha
tanishib chigib o’zingizni shaxsiy dasturingizni tuzib ko'rib, so‘ngra
uni boshqa dasturlash tillarida tuzilgan variantlari bilan solishtirsangiz
bunga guvoh boiasiz. Ikkinchidan, PHP tili barcha bizga maium
platformalarda, barcha operatsion tizimlarda hamda turlicha serverlarda
erkin ishlay oladi.

PHP dasturlash tilini turli dasturlash tillari oitasidagi o‘zarc
alogasiga diggatni garatsak. bunga Java dasturlash tilini aytib o'tish
lozim, chunki Java dasturlash tili obyektlarini PHP tili oz obyektlari
sifatida garaydi. Obvektlarga murojaat sifatida CORBA kengaytmasidan
foydalaniladi.

JSP

JSP (JavaServerPage) texnologiyasi o'zining funksional imkoniyat-
lariga ko‘ra ASPga o‘xshashdir. Asosiy fargi shundaki, bunda VVBScript
va JavaScript bilan birga Java tili liain go‘llanila oladi. Shunga garamay
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JSP Javadaii oldinroq qoilanilgan va ushbu texnologiya mukammal
Web-ilovalar yaratish uchun yetarli imkoniyatga ega.

SSI

SSI (Server Side Include) HTML-faylni dastlab serverda gayta
ishlaydi va lindan so'ng uni mijozga uzatadi. Dastlabki gayta ishlash
vaqgtida hujjatga dinamik generatsiya gilingan ma'lumotlar go‘shiladi.
Masalan joriy vaqt haqgidagi ma'lumot. Umuman olganda SSI
texnologiyasi HTML-faylning tarkibiga qo‘shimchalar qo'shishga
moijallangan HTMLning qismi hisoblanadi.

DHTML nima?

DHTML (dinamik HTML) - bu serverga ortigcha bogianishlarsiz
interfaol Web-sahifalar yaratish imkonini beradigan vositalar to'p-
lamidir.

DHTML tili HTML va JavaScriptlardan fargli ravishda bir gancha
go’shimcha internet texno logiyalariga ega. Dinamik HTML - Netscape
va Microsoft tomonidan o'ylab topilgan tijorat termini bolib, unda
Web-brauzerlarning dinamik imkoniyatini kengaytirish magsadida
kiritilgan. Bu texnologiyalar HTML yordamida Web-sahifa yaratishdagi
inavjud imkoniyatning cheklanganligi va ana shu cheklovdan o’tib
ketish uchun yaratilgan yoki qo'shilgan hisoblanadi. Chunki bizga
ma'lumki HTMLning fagatgina o'zidan foydalanib bugungi kunda
mukammal Web-sahifalar yaratib bolmaydi. Boshgacha aytganda
mavjud Internetda matnli ma'lumotlar va grafik ma'lumotlarga
moijallangan juda yaxshi texnologiyalar mavjud edi. Ammo multimedia
imkoniyatlariga ko'nikib golgan odamlar esa bunga ko'nika olmadi. Shu
sababli Internet imkoniyatlarini kengaytirish kerak edi.

DHTML asosida yaratilgan sahifa serverdagi qo'shimcha ma*
lumotlarga murojaat gilmasdan turib ham o‘zgarish imkoniyatiga ega.
DHTML o'zida turli xildagi standartlarga (CSS, DOM, JavaScript va
gipermatnlarni belgilashtillariga) asoslangan kombinatsiyalarni namoyon
giladi. Bu standartlarning kombinatsiyasi sizning web-sahifangizni
interfaolligini oshirish imkonini beradi. Boshgacha aytganda. sahifaga
tashrif buyurgan foydalanuvchi uning tashgi ko'ri nishi va mazmunini
serverga murojaatlarsiz o‘zgartira olish imkoniyatidi r.
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1.2. HTML tili hagida

Bizga ma’lumki, har ganday murakkablikdagi web-saytlar HTML
tiliga asoslangan bo‘lib, bu tilni bilrnasdan turib to‘lagonli web-saytlar
yaratib bo‘lmaydi. Endi HTMLtilining asoslari bilan tanishib chigamiz.

HTIML (Hyper Text Markup Language) - giper matnlarni belgilash
tili degan ina’noni anglatadi. HTML - web sahifada matn, tasvir va
boshga ma’lumotlarni ganday kcrrinishda joylashtirilishini belgilovchi
vosita. Bu til 1989-yilda Jenevada Tim Berners-Li (Tim Berners-Lee)
tomonidan yaratilgan. Keyinchalik Tim Berners-Li «Internet otasi»
nomiga sazovor bofigan. Til dasturlash tili emas, fagat Web-sahifa
yaratish uchun moijallangan. Web-sahifada biror ma’lumotlarni gayta
ishlash algoritmlarini o'rnatish uchun Java tilida tuzilgan dasturlardan
foydalamiladi.

Ushbu m a’lumotlardan foydalanib. kozda tutilgan asosiy magsad
-HTML hagida asosiy tushunchalami misollar yordamida tushuntirib
berish, HTMLning bir-oz giyin bo'lgan elementlari hisoblanmish jadval
tuzish. freymlardan foydalanish va sahifaga tasvirlarni joylashtirish,
sahifalarni bir-biriga faol havolalar orgali bogiash usullarini ko¥satib
berishdan iborat.

Teg tushunchasi

HT3ML sahifa - bu oddiy matn fayl bo'lib. HTML kengaytmasiga
ega. HTML sahifani yaratish uchun maxsas dastur shart emas. Har
ganday matn muharriri yordamida HTML sahifa yaratish mumkin.
Ana shnnday matn tahrirlovchi oddiy dasturlardan biri bolgan Notepad
(bnokHoT) standart holatda Windows mo‘hitida niavjud. HTML
sahifaning asosiy elementlaridan biri boigan teglar hagida dastlabki
tushunchalar bilan tanishib chigamiz.

HTML teg

HTIML teg bu HTML hujjatdagi turli elementlami (matn. tasvir
va boshgalar) web sahifada ganday ko'rinishda aks etishi lozimligini
brauzerda ko ‘rsatuvchi buyruglar hisoblanadi. Teglar rnaium oicham
va vazifani bajaruvch i buyruglardir.
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Teg quyidagi ko'rinishda boiadi: <TEG> hujjat elementi </TEG>

Ko'rib turganingizdek teglar < > uch burchaksimon qo'shtironoq
(burchak gavs) ichiga olifo yoziladi. Uch burchaksimon go‘shtironoq
ichiga teg nomi va uning atributlari yoziladi.

Quyida teg va uning atribut yozilishiga misol keltirilgan:

<B> <FONT COLOR= «red»> Helio World! </FONT> </B>

Misolda keltirilgan teglar HTML hujjatga kiritilgan Helio world!
jumla qizil rangda, ajratilib yoziladi. Teglar orasida kiritilgan matn, teg
atributida ganday -vazifalar berilgan boisa, shu vazifaga bo‘ysungan
holda ekranda hosil bo‘ladi. Bu misolda Helio World! jumlasiga
nishatan ikkita teg ishlatilgan. 1- teg <B> va 2 —teg <FONT> Helio
World! jumlasidan keyin y ana ikki teg </B> va </FONT> yozilgan.
Bularning fargi shundaki, birinchi ikkita teg ochuvchi va jumladan
song yozilgan ikkita teg esa jumla oldida yozilgan teglarni davomi
ya'ni yopuvchi tegdir. Yopuvchi teglarning vazifasi ochilgan teg ta’sir
maydoni tugaganligini belgilashdan iborat. HTML hujjatda deyarli
barcha teglarni yopish lozitn. /" belgisini qo‘yish orgali yopuvchi teg
yasaladi.

Eslatma: har doim eng oxirgi ochilgan tegni birinchi navbatda
yopishni unutmang. Teglarning ochilishi va yopilish tartibini almashtirib
yubormang. Aks holda xatoliklar kelib chigishi mumkin.

Endi e’tiborimizni <FONT COLOR=«red»> ga qaratamiz. FONT
(shrift) teg nomi, COLOR (rang) - esa tegning tarkibidagi go'shimcha
atribut, red (gizil) — rangning belgisi. Bu teg matnni gizil harflar bilan
yozilishini anglatad i. Ayni misolda ranglarni o‘zgartirish uchun red so'zi
o'rniga boshga rang nomini Kkiritish kifoya. Matn shu zahoti siz kiritgan
rang bilan ifodalanadi. Ushbu teg va uning qo‘shimcha atributlari
ganday yozilishini eslab goling. Ba sizga keyinchalik ham as gotadi.
Teglarning atributi bir nechta boTishi mumkin va ularni Kiritganda har
- biri orasida bo‘sh katakcha ya’ni probel goldirishni esdan chigarmang.

HTMLda teglarni ishlatish shartlari

Siz yuqorida teg tushunchasi haqida gisgacha tushunchaga ega
bo'lgansiz. HTML teglarni ishlatganda ularni to‘gri yozish muhim
ahamiyatga ega. Quyida teglarni to ‘gri yozish va ishlatish shartlari
hagida so‘z yuritamiz. Bu borada quyidagi goidalar mavjud:
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e Barcha teglar uch burchakli qgo‘shtirnoq ichida yoziladi
<TEG>".

Ochnvchi teg - uch burchakli qo‘shtirnog, teg nomi va uning
go‘shimcha atributlari (zarur boTgan taqdirda). Yopuvchi teg -
uchburchakli qcrshtirnog, /' slesh belgisi va teg nomi.

e Probel orqgali yoziluvchi teglar atril>utlari.

Teg nomidan so‘ng uning go'shimcha o'lchamlari boiishi mumkin.
Barcha atributlar probel orgali ajratib yoziladi. Bitta harf hajmidagi
bo‘shjoy goldirilish HTMLda probelni anglatadi.

<TEG 1 — atribut=yuklatilgan vazifa 2 - atribut=yuklatilgan va-
zifa...>

* Qo’'shtir*ioqg ichida yoziluvchi vuklatilgan vazifalar ma’nosi.

Ma’lum  vazifani bajaruvchi  buyruglar tenglik  belgisidan
so'ng go’shtirnoq «..» ichida yoziladi. Agar probel ishlatilmagan
tagdirda qo'shtirnogni tushirib qoldirish mumkin. <FONT SIZE=2
FACE= «Times Roman»> Flar hil hatolilclar kelib chigishini oldini olish
uchun go ’shtirnoqglarni ishlatish niagsadga muvofig.

e Aksariyat teglar yakunlash buyrug ini talab giladi.

Agar siz tegni yopmagan taqdiringizda aksariyat hollarda hatolik
kelib chigmaydi. Amino ochilgan teg atributlari butun hujjatga ta'sir
giladi. Jadval ichida vopilmagan taqdirda bu hatolikni keltirib chigarishi
mumkin. Bu haqda jadvallar tuzish bo'limida so'z yuritamiz.

e Teglarni yopish qoidasi

Har doim teglarni gat’iv tartibga rioya gilgan holda yoping. Birinchi
navbatda eng oxiri ochilgan teg yopiladi va shu tariga navbati boyicha
barchasi yopiladi. <TEG1> <TEG2> <TEG3> .. </TEG3> </TEG2>
</TEGI>

e Teg harflar yozish shartlari.

HTML hujjatda teglarni katta yoki kichik harflar bilan yozilishi
hech ganday ahamiyatga ega emas. Hamma teglarni katta yoki
kichik harflar bilan yozishingiz mumkin. Hattoki mana bunday
<teg></Teg> Sizga niaslahatimiz: barcha teglarni bir hil shaklda
vozgan ma’qul.

e Teg atributlarini yozish tartibi qanday bo‘lishi ahamiyatsiz.

Teg tarkibidagi atributlar ganday tartibda yozishingiz hech ganday
o‘zgarishlarga sabab boimaydi. Quyidagi ikki variant ham to'gii:

24



<TEG 1- atribui=yuklatilgan vazifa. 2 —atribut=yuklatilgan va-
zifa. 3 - atribut=yuklatilgan vazifa. >

<TEG 3 - atribui=yuklatilgan vazifa. | —atribui=y uklatilgan va-
zifa. 2 - atribut=yuklatilgan vazifa.>

HTML web-sahifa yaratish

Siz bilan birgalikda eng sodda HTML sahifa yaratishga harakat
gilib ko'ramiz. Buning uchun bizga Notepad (BnokHoOT) matn muharriri
kerak boiadi. Dasturni ishga tushirish uchun asosiy menyu Start
(Myck) > Programs (Mporpammbl) > Accessories (CTaHgapTHble) >
Notepad (BnokHoT) buyrug‘ini tanlang.

Quyida keltirilgan HTML teglarni Notepad (BnokHoT)ga ganday
bo‘lsa shundayligicha yozing:

<HTML>

<HEAD>

<TITLE> Eng sodda ko'rinishdagi HTML sahifal</TITLE>

</HEAD>

<BODY BGCOLOR=«white»>

<B><FONT COLOR=«red>»Salom!</FONT></B><BR>

Bu mening ilk HTML sahifam.

</BODY>

</HTML>

Navbatdagi amalga oshiradigan ishimiz, uni kompyuter xotirasiga
saglash. Buning uchun Notepad (BnokHoT) dasturi File (®aiin) menyusi
tarkibidagi Save As... (CoxpaHuTb Kak...) buyrug'ini tanlang va fayl
saqlanishi lozim bo'lgan papkani ianlang hamda faylni nomi.html
kengaytmasi bilan saglang.

Eslatina: har ganday HTML sahifa htm! voki htin kengavtmasiga
ega bo‘ladi. Faylrii kompyuter xotirasiga saqlagach, uni brauzer
dasturlari yordamida ochishingiz mumkin. Brauzer dasturlari internet
ishlashini ta'minlovchi maxsus dasturlar hisoblanib, gipennatnni
o'gish. web-resurslarda navigatsiyalash va koiib chigish dasturidir.
Web-brauzeri gipermatnlarni o’gishdan tashqari, tovushni va video
ma’lumotlarni gaytadan chigarish, ya’ni, gipermediani gayta chigarish,
tarmogning boshga kompyuterlari bilan ulanishni o'rnatish va ularda
ishlayotgan serverlarga web-hujjatlarga so‘rovlarni yuborish, tarmogning
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boshga foydalanuvchilari bilan mulogot tashkil gilish va uni quvvatlash
kabi qcfshimcha imkoniyatlarga ega boiishi mumkin. Eng ommaviy
targalgan web-brauzerlarga misol gilib Internet Explorer, Opera, Avant
Brauzer, Mozilla kabi dasturlarni aytishimiz mumkin. 1.2-jadval
brauzer dastuiiarning ro‘yxati va imkoniyatlari keltirilgan.

1.2-jadval
Brauzer dasturlari ro‘vxati
Ne Brauzer nomi: Imkoniyatlari
1 Opera 10.63 Opera Software kompaniyasi dasturidir. Bu dastur

43 tildagi foydalanuvchilar uchun moijallangan
bolib, Windows, Linux va Mac operatsion
tizimlarida ishkydi.

2. Mozilla Firefox Mozilla Firefox —tezkor, ko'p funksiyali brauzer
dasturi. Firefox dasturida bir oynada bir nechta
sahifani ochish mumkin.  Shuningdek, siz
giper havolalami shu sahifani (siz ayni paytda
kotib turgan sahifani) tark etmasdan turib
ochish imkoniyatiga ega bcrlasiz. Brauzer web
standartlarni juda yaxshi qoilab, unda juda qulay
interfeys mavjud va o'zida gidiruv paneli (Google
va boshgalar) joylashgan.

3. Google Chrome Google Chrome - bu brauzer, miirakkab tex-
nologiyalarni va sodda dizaynni birlashtirgan
va bu esa Internetda ishlashni tezlashtiradi va
xavfsizligini oshiradi.

4. Apple Safari Apple Inc. kompaniyasining brauzer dasturi
hisoblanadi. Dastlab dastur Mac OS operatsion
tizimi uchun ishlab chigilgan edi. Dasturda ko‘p
oynalik interfeys mavjud boiib, unda xavfsizlik
uskunalari bilan boyitilgan.

5 Maxthon Internet-brauzer dasturi. Maxthon web-sahifalarni
kop oynali rejimda ko'nsh imkonini beradi.
Dastuniing asosiy xususiyatlaridan biri ko'p sonli
bog'lanishiar imkoniyati mavjud.
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6. Avant Browser Bu brauzer ham ko'p oynali rejimda ishlaydi.
Ya’ni asosiy oyna ichida ko'plab oynalarni ochish
imkoniyati mavjud. Avant Browser dasturida
sichgoncha tugmasini bir bosish bilan grafiklar,
video, tovushlar va Flash animatsiyalarni yuk-
lashni tagiglash yoki aksincha ruxsat berish
imkoniyati mavjud.

7 Netscape Navigator Dastur 0o'zining oddiy va yengil sozlanadigan
foydalanuvchi interfeysi bilan va tezkorligi, ish-
lashga qulayligi hamda web-sahifalarni ko‘rishni
boshgarish imkoniyatlari kengaytirilgan.

Bizga ma'lumki yaratilgan web-sahifalarni ishlatib ko'rishda
ozimiz bilgan yoki bilmagan holda brauzer dasturiga murojaat gilamiz.
Ana shu paytda yaratilgan web sahifani ochish uchun uning fayli
ustida sichgonchaning chap tugmasini ikki marta ketma-ket bosish
yetarli. Blindan tashqari avval brauzer dasturini (Internet Explorer)
ishga tushirib olib. keyin esa File > Open buyrug‘ini berish orqali
ham faylni ishga tushirish mumkin. Hammamizga ma’lumki, web
sahifani yaratish vaqtida uning ganday dizaynda chigayotganini ko'rish
uchun biz brauzer dasturlariga gayta — qayta murojaat gilamiz. Ayriin
professional dasturlarda (Dreamweaver va boshqgalar) natijani koiish
uchun to'g'ridan-to‘g'ri maxsus tugma bosiladi. Bunda to‘g'ridan-
to‘g‘ri belgilangan brauzerda sahifa yuklanadi. Bu hagida Dreamweaver
dasturida batafsil tna'lumot beramiz.

HTML hujjatning asosiy strukturasi

Siz yaratgan ilk HTML sahifa asosida HTML hujjat asosiy
strukturasini tahlil gilamiz. Kompyuter xotirasiga sagqlangan HTML
hujjatni Notepad dasturi yordamida oching. Har ganday HTML hujjat
ichki gismi quyidagilardan tashkil topgan boiadi:

<HTML>

bu teg HTML hujjatni ochish (boshlash) uchun xizmat giladi va u
HTML hujjatning birinchi ochuvchi va oxirgi yopuvchi teg hisoblanadi.
Boshgacha aytganda web sahifaning boshlanish va tugash chegarasini
ifodalaydi. Uning yagona vazifasi, mazkur hujjatni ochavotgan dasturga
bu fayl HTML hujjatligi hagida axborot berishdan iborat.
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<HEAE»

HEAD tegidan so'ng HTML hujjatning tizimli axborotlari hagida
maiumot beradi. Bizning misolimizdagi yagona tizimli axborot -
TITLE tegi hisoblanadi.

<TITLE>

Bu teg ochuvchi teg <HEAD> va yopuvchi teg </HEAD> orasida
y~oziladi. Ochuvchi va yopuvchi TITLE orasida Kiritilgan axborot siz
yaratayotgan hujjat nomini anglatadi. Siz kiritgan nom brauzer dasturi
tomonidan va internetdagi gidiruv tizimlari tomonidan ishlatiladi. Biz
keltirilgan misolda «Eng sodda ko‘rinishdagi HTML sahifal» matni
brauzer dasturi vugori gismidaya'ni sarlavha satrida namoyish etiladi.

<BODY>-

BODY ochuvchi va yopuvchi teglari orasida yozilganlarning
barchasi sizning HTML hujjatingizning tanasi hisoblanadi. Agar siz
ushbu teg orasiga matn yozsangiz yoki tasvir kiritsangiz - bularning
barchasini brauzer ekranda namoyish etadi.

Har ganday HTML hujjat quyida keltirilgan tartibda yozilishi shart:

<HTML> HTML hujjat boshi <HEAD> Hujjat nomlanishining
boshlanishi <TITLE> .. </TITLE> HTML sahifa nomi (sarlavhasi)
<HEAD> Hujjat nomlanishining yakunlanishi <BODY BGCO-
LOR=«white»> Hujjat tanasining boshlanishi .. </BODY> Hujjat
tanasining yakunlanishi </HTML> HTML hujjat yakuni.

HTML sahifaga tasvir joylashtirish

Internet bilan ishlovchi dasturlar tasvirlarni (grafik elementlarni)
ochish imkoniga ega bo'lishi bilan internetda mavjud sahifalarning
deyarli barchasi tasvirli axborotlarni nashr eta boshladi. Siz yaratgan
web-sahifa gizigarli va cliiroyli dizayn asosiga qurilgan boisa uning
o‘quvchilari soni shubhasiz ortadi. Tasvirlar yordamida harakatlanuvchi
tugmalar va G if animatsiyalarni kiritish mumkin. Birog tasvirlar bilan
ishlashda ularni hajmi va formatiga etibor berish kerak. Hozirgi paytda
internetga joylashtirilayotgan deyarli barcha sahifalarda ishlatilayotgan
tasvirlar formati *JPEG yoki *.GIF ni tashkil etadi. Bunga asosiy
sabab, bu formatdagi tasvirlar hajmi juda kichik. Bu formatdagi
tasvirlar ishlatilganda web-sahifa hajmi ortib ketmaydi va sizning web
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sahifangizdan foydalanuvchi sahifani internetda ochilishini uzoq vaqt
kutmaydi.

Agar siz boshqa forinatdagi tasvirlardan web-sahifani bezashda
foydalansangiz uning hajini ortib ketadi va undan foydalanuvchilarga
sahifani ochishda muammolar keltirib chigaradi.  Web-sahifani
bezatishda uning dizayniga *.GIF formatdagi tasvirlardan foydalaning.
Boshga magsadlarda *.JPEG dan foydalanishingiz mumkin.

<img> tegini qoilash qoidalari

<IMG> tegi bilan bog'lig boigan, quyida Kkeltirilgan asosiy qoidalar
bilan tanishib chiging va o ‘z sahifangizni yaratishda ushbu goidalarga
doim rioya qilishga harakat giling.

e Tasvir nomi va joylashgan o‘rnini yozganda harflarning bir
hiida bo‘lishini ta’minlash katta ahamiyatga ega. Tasvir joylashgan
papka nomi va tasvirning nomini kiritganda harflarni bir hilda yozilishi
shart. Biror bir harfni tusliirib goldirish yoki hato yozilishi tasvirni
ocliishda hatoliklarni keltirib chigaradi.

» Tasvir yoki papka nomini kiritganda probel ishlatmang. Web-
sahifani yaratayotganingizda fayllar yoki papkalar nomini kiritganda
probel (bo’sh joy) ishlatmang. Agar siz kiritgan nom ikki yoki undan
ortig so‘zlardan iborat boisa. probel o‘rnida (pastgi chizigcha)
ishlatishingiz mumkin. Masalan: .../Chet_elga_sayohat/Ispaniya/Ma-
laga_OLjpeg

- Internetda ishlatiluvchi tasvir formatlari. Hozirgi paytda
internetda ikki hil formatdagi tasvirlar keng go'llanilib kelinmoqda. Bu
formatlar: GIF (bu formatdagi tasvirlar *.gif gisgartmasiga ega) hamda
JPEG (bu formatdagi tasvirlar esa * jpg yoki *.jpeg gisgartmasiga ega).
Siz ham ushbu formatdagi tasvirlardan foydalaning. Boshga formatdagi
tasvirlarni aksariyat brauzerlar ocha olmaydi.

e Har doim WIDTH va HEIGHT atributlarini Kkiritishga
harakat giling. Bu sizning web-sahifangizni ochilishini tezlashtiradi
va tasvirlarni asl oTchamda boiishini ta’minlaydi.

e Tasvir hajjmini sun’iy kichraytirish. WIDTH va HEIGHT orgali
tasvirning real atribut o'lchamlarini kichraytirish mumkin. Ammo
bu usuldan iloji boricha kamroq foydalanish kerak. Eng yaxshi usul
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tasvirni real oichamini grafik muharrirlar yordamida kichravtirishdir.
Bu usul tasvirning ochilish vagtini kamaytiradi.

e Tasvir hajmini sun’iy kattalashtirish. Tasvir o‘lchami kat-
talashtirilganda yoki Kkichraytirilganda uning sifatida cfzgarish
sodir boiadi. Agar siz oflchamlarni o'zgartirganda bo‘yi va enini
proportsionalligiga etibor bermasangiz, tasvir sifatini buzilishiga
olib keladi. WIDTH va HEIGHT atributlari orgali tasvir hajmini
kattalashtirganda, real oichamni 2 marta. 3 marta va shu tariga
oshishiga erishish kerak. Masalan, tasvirning real oichami WIDTH=
=«100». HEIGTH=«200» ga teng boTsa. uni ikki marta kattalashtir-
ganda WIDTH= «200», HEIGTH=«400» gateng boiishi shart. Bu usul
tasvir sifatidagi salbiy o‘zgarishlarni bir oz yumshatadi. Shuningdek,
ayni holatni tasvir oTchamini kichraytirishda ham gqoilash magsadga
muvofig.

e Har doim ALT atributini go‘llang.

Har doim ALTdan so‘ng tasvirga alogador go‘shimcha axborotni
kiritishga harakat giling. Buning asosiy sababi, siz jovlashtirgan tasvir
ochilmagan taqdirda, Internetdan foydalanuvchi siz kiritgan tasvir
izohini o'giydi va minimum axborotga ega boMadi.

Giperhavolalar - web-hujjatlarni bir-biriga bog‘lash

Web-sahifaga tasvir joylashtirishni o’zlashtirib oiganingizdan so‘ng,
endigi navbatda havolalar hagida tushuncha olishning ayni mavrudi.
Havolalar tufavli internet hozirgi mavqgeiga erishdi. Havolalar yordamida
ikki va undan ortiqg (cheksiz) web-sahifalarni bir-biriga bogMashingiz
mumkin. Havola rus tilida «ccbinka» deb ataladi. Havolaga bosish
orgali siz ikkinchi sahifani ochishingiz mumkin. Havolalar yordamida
web-sahifangiz uchun menyu tuzishingiz mumkin. Havolalar sizning
web-sahifangizdan foydalanuvchini sahifa bo’vlab tom nia’noda sayohat
gilishi imkonini beradi va unga to‘g'ri yoini ko'rsatib turadi.

Havolalar

Havola - bu HTML hujjatuing boshga HTML hujjat bilan bog'lovchi
gismi. Unga kursorni bosishiagiz bilan ikkinchi HTML hujjat ekranda
namoyon bo‘ladi. Shuningdek. havoladan (agar siz yaratgan bir sahifada
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juda ham ko'p matn kiritilgan boisa) bitta sahifa ichida boshqga HTML
hujjatni ochmasdan turib hain foydalanish mumkin. Sizga maslahatimiz,
agar bitta sahifaga joylashtirmoqchi boigan matn juda ham ko‘p boisa,
uni iloji boricha turli bo‘laklarga bo‘lgan holda. bir nechta HTML
faylgajoylashtiring. Shundav gilsangiz, web-sahifadan foydalanish oson
kechadi.

Navbatdagi sahifalar bilan tanishib chiggach siz havolalarni ishlatish
usullarini va havola tuzish uchun ganday HTML teglardan foydalanish
zarurligini bilib olasiz.

Havolalar tuzish usullari

Havolalarni ta’sir doirasi va ularni qaysi sahifa bilan bogiash
vazifasini <A> ochuvchi hamda </A> yopuvchi teglari orasida bel-
gilanadi. Ushbu teglar orasida uning atributlari va Kkalit so‘z
joylashtiriladi.

Ushbu teg orasida nimalarni joylashtirish mumkin? Deyarli
hamrna narsani. Bu matn, tasvir, jadval va hatto harakatlanuvchi
tasvir ham boiishi mumkin. Ulardan qaysi birini joylashtirish
0°zingizga havola.

Bu boiimda oldimizga go‘ygan maqsadimiz havolalar tuzish.
Magsadga erishislining eng oson usuli barchasini oddiy misollardan
boshlash. Shunga amal gilgan holda sizga havola tuzishning eng oddiy
misolini keltiramiz :

<A HREF=«pictures.titml">Bu sahifada mening hayotim bilan
bog' liq tasvirlar joy lashgan,</A>

INatija mana bunday ko‘rinishda bo'ladi:

Eu sahifada ntenine hayotim bilan boa‘iq tasvirlar ioylashean.
so‘zini bosishingiz bilan pictures.ntm| sahifasi ekranda namoyon
boiadi. <A> tegining qo‘shimcha atribui boigan HREF sizni pictures,
litm | sahifasiga olib boradi.

Tasvirlarni havola sifatida namoyon eifish uchun <A> va </A> ieglari
orasida <IMG> tegi yordamida tasvirda gaysi faylni nimani go‘yish va
u joylashgan papkaga yoini ko'rsaiing.

<A HREF = «picluressHTML»> <IMG SRC = «img/phoio.jpg»
WIDTH = «100« HEIGHT = «100» ALT=«Mening foio galereyam»>
</A>
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Havolalar - <A> tegining go‘shimcha atributlari tasnifi

Boshga HTML teglari kabi <A> tegining ham go‘shimcha atributi
mavjud. Quyida ushbu buvruglarning tasnifi keltirilgan.

HREF

Bu atribut yordamida havola gilinishi lozim boMgan HTML hujjat
nomi va uning joylashgan joyi belgilanadi. Bu atribut <IMG> tegining
SRC atributi kabi bir hil vazifani bajaradi. <IMG> tegining SRC
atributi yordamida tasvir nomi va u joylashgan papkaga yoi ko'rsatilsa.
HREF yordamida HTML hujjat nomi va u joylashgan papkaga yo‘l
tasvirlanadi.

TARGET

Bu atribut HTML hujjatni aynan o'sha oynada yoki alohida oynada
yoki qaysi freymda ochilishini belgilaydi. TARGET atributining
go‘shimcha o ‘Ichamlari: _blank - brauzerda siz ishlab turgan oynadan
tashgari yangi oynada koisatilgan hujjatni ochish.

_top - web sahifada freymlar ishlatilgan bolsa, havolada
ko'rsatilgan hujjatni faol oynada freymlar strukturasini buzgan holda
ochadi. Ochilgan oynada freym alomatlari mavjud boimaydi.

__parent — havolada ko‘rsatilgan hujjatni avval ochilgan oynada
ochiladi.

_self - havola qaysi freym yoki freymdan holi sahifada ishlatilgan
bo'lsa aynan o ;sha sahifada ochadi.

<A HREF =«pictures.html» TARGET=«_blank»>Bu sahifada</A>
mening hayotim bilan bog'liq tasvirlar joylashgan. <BR> Bu sahifada
siz <A HREF =«about.html» TARGET=« _top»> men hagimda </A>
gizigarli maiumotlarni o‘gishingiz mumkin.

NTatija mana bunday ko‘rinishda boiadi:

Bu sahifada mening hayotim bilan bogiig tasvirlar joylashgan.
Sahifada siz men hagimda gizigarli maiumotlarni o'gishingiz mumkin.
Ushbu havolalardan biriga bosib. siz havolada belgilangan HTML
hujjatdagi ma’lumotlarni o‘gishingiz mumkin.



E-MAIL havola

E-mail (Elektron pochta) manzillarni faollashtirish uchun havola
tuzish mumkin. E-mail manzil ko‘rsatilgan havolani bosish bilan
kompyuterga o‘rnatilgan elektron pochtalar bilan islilovchi dastur
faollashadi va unda havolada ko ‘rsatilgan elektron pochta manzili
koi'satilgan yangi oyna hosil bo‘ladi va siz koisatilgan manzilga xat
jo’natishingiz mumkin.

E-mail manzilni havola sifatida belgilash uchun HREF atributi
o'rnida mailto: elektron pochta manzili yoziladi. Misol uchun:

Mening <A HREF = «mailto: tsama.r@mail.ru»> elektron poch-
tamga</A> ushbu o'quv goilanma haqidagi fikr - mulohazalaringizni
yozing!

Natija mana bunday ko ‘rinishda boiadi:

Mening elektron poshtamga ushbu o ‘quv qoilanma haqidagi fikr-
mulohazalaringizni yozing!

Havolalar yozishning asosiy qoidalari

Quyida havola tuzishda bilishingiz lozim boigan oddiy qoidalar
yozilgan. Ularni diggat bilan o‘gib chiging va eslab qolishga harakat
giling. Havola tuzishda bu qoidalarga amal qilsangiz, siz tuzgan
havolalar hatoliklarsiz ishlaydi.

< Harflarning bir liilda yozish va fayl yoki papka nomini to‘g‘ri
ko‘rsating. Havola tuzil ganda eng katta e “tiborni siz murojaat gilmogchi
boigan faylga olib boruvchi yoi anig va to‘gii kotsatilishi lozim.
Bunda papka va fayl nomiga katta e’tibor garating. Ularning nomida
arzimagan hatolikka yoi qo‘ysangiz havola ishlamaydi. Aytaylik biror
bir harfni tushib qgolishi yoki bosh harfo'rniga kichik harf bilan yozilsa
hatolik yuz berishi muqgarrar. Shu bois, havola tuzishda aniglik katta
ahamiyatga ega.

e Fayl va papka nomini Iciritganda probe! ishlatmang. Web-
sahifa yaratish jarayonida fayl va papkalarni nomi ikki va undan ortiq
so‘zdan iborat boisa so'zlar orasida va oxirida probel ishlatmang.
Probel ishlatilgan fayl yoki papkaga havola murojat gilganda hatolik
sodir boiadi.

- Kalit so‘zlarga havola tuzish. Biror hujjat ichidagi kalit so‘zga
havola tuzganda, eng awalo kalit so'zni <A> teginingNAME buyrug" i
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yordamida belgilab olish lozim. So'ngra shu tegning HREF atributi
orgali u joylashgan fayl nomi (agar kalit so'z boshga faylda joylashgan
boisa) va kalit so'z manzilini koisating HREF=«fayl nhomi.HTML#
kalit so‘z ».

e FTP server va E-MAIL uchun maxsus bavola. FTP serverda
joylashgan faylga havola tuzgania 'FTP://' bilan boshlannvchi manzilni
yozing. E-MAIL havola tuzganda esa «mailto: e-mail manzil»ni
yozing.

Matnlarni tahrirlash

Matn tahrirlashni o'zlashtirib olishingizni osonlaslitirish uchun
uni ikkiga boiib tushuntirishni lozim topdik. Ularning har biri matn
tahrirlashda ishlatiladigan HTML teglarni batafsil tahlili misollar
yordamida aks ettirilgan.

» Matnning alohida boiaklarini tahrirlovchi teglar;

e Matnning yirik boiaklarini tahrirlovchi teglar.

Matnning alohida bo iaklarini tahrirlovchi teglar

Quyida tasnifi keltirilgan barcha matn tahrirlash uchun ishlatiluvchi
teglar ocliilgandan so’ng ularni yopish shart. Ochilgan tegning ta’sir
doirasi u yopilgunga gadar davom etadi. Agar siz tegni yopishni
unutsangiz, uning ta’sir doirasi hujjat oxirigacha davom etadi. Barcha
teglash quyidagi tartibda \oziladi: <TEG1><TEG2> Keiakli matn </
TEG2></TEG1>. Har doim eng oxiri ochilgan tegni birinchi boiib
yopishni unutmang.

<B> Kerakli matn </B>

Bu teg orasida yozilgan matn galin harflar bilan belgilanadi.

<1>Kerakli matn<l\>

Matn o ‘g tomonga egiltirib yoziladi.

<BIG=>Kerakli matn</BIG>

Matnni Kkattalashtirish. Yozilgan inatn boshgalariga nisbatan
kattalashtirilgan harflar bilan belgilanadi.

<SMA.LL>Kerakli matn</SMALL>

Matnni Kichraytirish. Yozilgan matn boshgalariga nisbatan ki-
chiklashtirilgan holda belgilanadi.
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FTP://'

<STRIKE>K.crakli matn</STRIKE>

Teg orasida j'ozilgan matn ustidan chiziq tortiladi.

<STRONG>Kerakli matn</STRONG>

Matn ichidagi ayrim so'zlarni kuchli ajratib ko’rsatish uchun
ishlatiladi.

Kerakli <SUB>4</SUB>

Koiinib turganidek bu teg orasida kiritilgan matn, matn chizig‘idan
pastda kichik harflar bilan yoziladi (indeks).

Kerakli <SUP>mgn</SUP>

Yuqorida keltirilgan tegning teskari shakldagisi boiib, u raatnni
yugorida kichik harflar bilan yozilishini ta’'minlaydi (daraja).

<U>Kerakli matn</U >

Yozilgan matn ostida chizig tortiladi. Bu teg yordamida ayrim
so‘zlarni belgilab ko‘rsatish mumkin.

<CENTER>Kerakli matn</CENTER>

Bu teg kiritilgan matnni sahifa o‘rtasida bo’lishini ta’minlaydi. Agar
bu teg jadval ichida qo‘llansa, u holda bu jadval katakchasi ichidagi
matnga ta'sir etadi. Bu tegni jadval ichida qoilash usullari hagida
iadvallar bilan ishlash boiimida tushuntirib o'tamiz.

<BR>

Bu teg matn qatorlarini surish uchun xizmat giladi. Ma’lum
jumladan so‘ng ikkinchi jumlani vangi qatordan boshlamoqchi
boisangiz, jumla so‘ngida ushbu tegni yozing.

Endi hech boimaganda bitta go'shimcha buyrugga ega bo‘lgan
teglar bilan tanishib chigamiz.

<FOTST>Kerakli matn</FONT>

Bu teg harfning qo'shimcha atributlarini belgilash uchun ishlatiladi.
Quyida ushbu tegning eng ko'p go‘llaniladigan go‘shimcha atribTitlari
bilan tanishib chigamiz:

SIZE

Harf oichamini belgilashda goilaniladi. Matndagi harflar oichamini
1 dan boshlab xohlagan son bilan belgilash mumkin.

Masalan: <FONT SIZE =«5»>Salom!</FONT> Bu mening web
sahifam. <FONT SIZE= «2»>(lzoh)</FONT>
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Bundan tashqgari siz SIZE o'lchamlarini plyus + va minus - bilan
ham belgilashingiz mumkin. Bu usul qoilanganda harf oichami
ishlatilayotgan harfga nisbatan katta yoki kichik belgilanadi. Misol
uchun siz 3 ga teng kattalikdagi harfdan foydalanayotgan boisangiz,
SIZE = «1-2» harf oichami SIZE=«5» ga. SIZE=«-1» oichami esa
SIZE =«2» ga teng boiadi.

COLOR

Bu atributdan so’ng rang nomi yoki rangni belgilovchi olti xonali
lotin harflari hamda ragamli kod Kkiritiladi va shu tariga harf rangi
belgilanadi. Turli brauzerlar turli raag nomlarini belgilay oladi. Rang
nomlari ingliz tilida kiritiladi. Rang noini va ko'rinishini yodlab
olishingi™ uchun ularning har birini notni o‘sha rangda belgilangan.
Bu ranglarni Netscape Navigator va Internet Explorer brauzerlari
muammosiz taniydi va o'giy oladi.

Rangni belgilovchi lotin alifbosi va ragamli kod simvol bilan
boshlanadi. Ragamlardan 1 dan 9 gacha yoki A dan F gacha bolgan
lotin harflarini ishlatish mumkin. Rang kodi ganday boiishidan gat’iy
nazar u RGB (RED - qizil, GREEN —yashil, BLUE - ko’k) ranglar
tizimida aks ettiriladi. Rangni belgilash uchun uchta rangni bir-
biriga qo ‘shish lozim. Har bir rang ulushini 0 dan 255 gacha bo'lgan
migdorda belgilanadi. Misol uchun toza qizil rangni belgilash
uchun qizil rang miqdorini 255 ga. yasliil va ko'k ranglar miqgdorini
esa 0 ga tenglashtirish lozim va bu mana bundav yoziladi <FONT
COLOR = #FOO0O0=>. Olti xonali alifboli —ragamli kodini gollash juda
ham qiyin. Shu bois ranglar kodini belgilab beruvchi jadvalimizdan
foydalanishingiz mumkin.

FACE

Matnni ganday shriftda yozilishini belgilash uchun shrift nomi
keltiriladi. SHrift nomi kompyuterda o'rnatilgan boiishi kerak yoki
umumiy ishlatiladigan shriftlardan foydalanish mumkin. Agar siz
goilagan shrift fovdalanuvchining kompyuterida topilmagan taqdirda
brauzer standart shriftni tanlaydi.

Masalan:

<FONTT FACE =«Arial»>Salom!</FON T>
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<FONT FACE=«Times New Roman, Arial, Courier New»>Bu
mening web sahifam.</FONT>

Siz har doim <FONT> tegining FACE atributini tanlaganingizda,
standart shrift turlaridan foydalaning. Misol uchun Windows mubhitida
isblovchi barcha kompyuterda o ‘rnatiladigan standart shriftlar quyida-
gilardan iborat:

Windows: Arial Arial Black, Arial Narrow, Courier, Courier New,
Garamond, Helvetica Times, Times New Roman.

Aytaylik siz Times va Times New Roman shriftining boshgacha
turini tanlagan boisangiz, u holda foydalanuvchi kompyuterida bu
shrift o'rnatilmagan bo‘ Isa, brauzer siz tanlagan shriftni standart Times
New Roman shriftiga almashtiradi.

Matnning yirik bo‘laklarini tahrirlovchi teglar

Endi siz bilan matndagi yirik bloklar va abzatslami tahrirlovchi
teglar va ularning go'shimcha buyruglarining ishlash tartibini o‘rganib
chigamiz.

<PLAINTEXT>

Ushbu tegdan so’ng Kkiritilgan barcha HTML teglarning ta’sirini
butunlay kesadi va ular huddi ekranda ko‘rsatilishi lozim bo’lgan
rriatn kabi aks etadi. Bu teg boshqga teglardan tubdan farg giladi va
uni yopish shart emas. Agar matnda avrim HTML teglarni ekranda
brauzer aks ettirishini xohlasangiz bu tegdan foydalanishingiz mumkin.
Birog yuqorida aytganimizdek bu tegdan so‘ng matnni HTML teglar
yordamida tahrirlash mumkin emas. Chunki ularni brauzer huddi
oddiy matn kabi tushunadi. Agar siz </PLAINTEXT> tegini Kiritgan
tagdiringizda ham bu <PLAMTEXT> ta’sir doirasini cheklay olmaydi.
Web sahifangizda HTML teglarni matn shaklida aks ettirmogchi
boMsangiz, u holda uch burchakli qo'shtirnog ‘<’ o'rnida &LT; simvolini
goilang.

<ADDRESS>

Kerakli matn

</ADDRESS>

Teg oz nomi bilan adres ya’ni manzillarni belgilash uchun
ishlatiladi. Bu teglar orasida yozilgan manzilni har gavsi brauzer o’z
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xohlagan tarzda namoyish etadi. Teg yopilganidan song Kiritilgan matn
yangi satrdan boshlanadi.

<BLOCKQUOTE>

Kerakli matn

</BLOCKQUOTE>

Bu teg matndagi paragraf\a satrlarni belgilash uchun go‘llanadi.

<H1> <H2>. <H3>, <H4>, <H5> va <H6>

vuqoridagi oltita teg sarlavhalarni belgilash uchun qoilaniladi.
Sarlavhalar galin harflarda yoziladi. Bu teglarning bir-biridan farqi
ulaming oichamlarida. 1 dan 6 gacha boigan sonlar sarlavha
oichamlarini katta-kichikligini quyida keltirilgan tartibda belgilaydi:

Sarlavha HI

Sarlavha H2

Sarlavha H6

<p>

Kerakli matn

</P>

Bu teg paragraflarni belgilaydi. Paragraf boshi va ohirida bo‘sh
gator qgoldiradi.

ALIGN

<P> tegining qo'shimcha atributi boiib u papagraf ichida yozilgan
matnni tekislash uchun ishlatiladi. Bu atributning qo‘shimcha
crichamlari ALIGN - LETT (matnni chap burchakdan tekislaydi).
RIGHT (o'ng tomonga tekislaydi), CENTER (sahifa markaziga
tekislaydi) va JUSTIFY (matnni sahifa eni bo‘ylab tekislaydi). JUSTIFY
ishlatilganda brauzer matnni chap va o'ng tomon bo'vlab bir xilda
tekislab chigishga harakat giladi. Bu jarayonda so'zlar orasi cho’zilib
ketishi ham mumkin.

<PRE>

Kerakli matn

</PRE>

Bu teg yordamida siz matnni ganday Kiritgan bo’lsangiz shunday
koiinishda boiishi ta'minlanadi. Quyida keltirilgan ikki misolda buni
yaggol ko’rish mumkin. <PRE> tegidan tashgarida yozilgan matnda



probel necha marta ishlatilishidan gat’iy nazar u bittaga hisoblanadi.
<PRE> tegi tarkibida Kiritilgan matn ganday boisa shundayligicha
ek randa ko’rinadi.

Hujjat asosiy gismini tahrirlash

Bu bo'limda hujjat tanasini belgilab beruvchi <BODY> tegi va
lining go‘shitncha buyruglari hagida so‘z boradi. <BODY> tegini
oldingi bo’limlarda gisgacha tanishtirib oigan edik. Bu teg bevosita
HTML hujjatni ekranda koiinishi lozim boigan matn. tasvir va boshqa
elementlami o‘z ichiga gamrab oladi. <BODY> ochuvchi hamda </
BODY> yopuvchi teglari orasida barcha muhim elementlar joylashadi.
Bu tegning ganday qo‘shimcha buyruglarini quyida birgalikda ko ‘rib
chigamiz.

BGCOLOR

Sahifaning orga foni rangini belgilash uchun ishlatiladi. Bunda
rangning ingliz tilidagi nomi yoki harf va sonlardan iborat kod
go'llaniladi.

BACKGROUND

Sahifaning orga foni wuchun qoilaniluvchi tasvir nomi va u
joylashgan papkaga yo* Ini ko‘rsatishda goilaniladi. Tasvir joylashgan
papkaga yoini ko'rsatish hagidagi ma'lumotlarni «<HTML safifagatasvir
joylashtirish» boiimida o”gishingiz niumkin.

TEXT

Hujjatda yozilgan matn harflarini ganday rangda boTishini rang
kodlarini kiritish orqgali belgilab beradi. Agar siz ushbu atribut
ishlatmagantagdiringizda matn rangi qora rangda boiadi.

LIXK

Bu atribut goilanilgan sahifadagi havola rangi teg oichamlarida
gaysi rang kodi yoki nomi berilgan boisa, o‘sha rangda ekranda
namoyon bo‘ladi.
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VLINK

Bu atribut yordamida ishlatilgan havolalarni belgilab ko'rsatish
uchun qo'llaniladi. Siz foydalanuvchilar adashib ketmasligi va havolada
kcrrsatilgan sahifaga gayta kirmasligi hamda hali qoilanihnagan
havolalarni qoilanilgan havolalardan ajratib ko‘rsatish uchun ish-
latishingiz mumkin.

ALINK

Bu atribut kursor yordamida tanlangan va sichqoncha chap tugmasi
bosilgan paytda havola rangini o’zgartirish uchun ishlatiladi.

Siz hozir o'gigan sahifada <BODY> tegining barcha qo'shimcha
atributlari quyidagi tartibda qoilaniladi.

<BODY BGCOLOR=#003399 TEXr=black LINK=blue ALINK=
=red VLINK=#006666>

Royxatlar tuzish

Sahifada matndagi ayrim elementlami ro‘yxatlaagan tartibda yozish
giyin emas va bundan tashgari o‘quvchi matn bilan tanishib chigishida
qulayliklar yaratib beradi. Sizhuddi Microsoft Word matn mubharririda
ro‘yxatlarni ganday tuzsangiz huddi shu ko’rinishda HTML hujjatda
ham maxsus teglar yordamida belgilash imkoniga egasiz.

Bu bo'limda ro'yxatlangan tartibda matnni Kiritish usullari bilan
tanishib chigamiz:

<RO' YXATNI OCHUVCHI TEG>

< Ro'yxat elementining tegi > Matn

</ RO YXATNI YOPUVCHI TEG >

Tartiblangan ro‘yxat: Tartiblanmagan ro‘yxat:
1 Ro'yxat elementi 1 * Ro'yxat elementi 1
2. Ro‘yxat elementi 2 * Ro‘yxat elementi 2
3. Ro'yxat elementi 3 » Ro'yxat elementi 3

Matn ro‘yxatini belgilovchi teglar tarkibida siz HTMLning boshga
matn tahrirlash uchun qoilaniluvchi teglarini ishlatishingiz mumkin.

Ro‘yxatlar tuzish - ro‘yxatni tartiblash

Matn boiaklarini tartiblashda sonlar yoki harflar bilan belgilash
mumkin. Shuningdek ayni jarayonda simvollardan ham foydalanish
imkoni mavjud.
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Matn bo'laklarini tartiblashda <OL> ochuvchi va </OL> yopuvchi
teglaridan foydalaniladi. Ushbu teglar icliida tartiblanuvchi matn oldiga
<LI> atributi yoziladi. <OL> tegining yagona go'shimcha olchami
TYPEDboiib. u tartiblovclii belgi koi inishini aniglab beradi.

Arab ragamlari bilan belgilash:

HTML kodi Natija
<OL TYPE=1> 1 Matn 1
<LI> Matn 1 2. Matn 2
<LI> Matn 2 ° Matn 3
<LI> Matn 3
</OL>

Rim ragamlari bilan belgilash:

HTML kodi Natija
<OL TYPE=I> . Matn 1
<LI>Matn 1 II. Matn 2
<LI> Matn 2 111 Matn 3
<LI> Matn 3
</OL>
Rim harflari bilan belgilash:
HTML kodi Natija
<0L TYPE=i> i. Matn 1
<LI> Matn 1 ii. Matn 2
<LI> Matn 2 iii. Matn 3
<LI> Matn 3
</OL>
Bosh harfalari bilan belgilash:
HTML kodi Natija
<OL TYPE=A> A. Matn 1
<LI> Matn 1 B. Matn 2
<LI> Matn 2 C. Matn 3
<LI> Matn 3

</OL>
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Kichik: harflar bilan belgilash:

HTML kodi
<OL TYPE=a> a. Mata 1
<LI> Matn 1 b. Matn 2
<LI> Matn 2 c. Matn 3
<LI> Matn 3
</OL>

Ro‘yxat tuzish - tartiblanmagan ro‘vxat
Tartiblanmagan ro'yxat tuzishda <UL> va </UL> yopuvchi

teglaridan foydalaniladi. Ro‘yxat ichidagi tartib <LI> atributi bilan
belgilanadi. <UL> tegi uctiun ham TYPE olchami ishlatiladi. TYPE
oTchami 3 xil turdagi ro‘yxat kirita oladi:

42

Doirasimon belgi yordamida tartiblash:

HTML Kkodi
<UL TYPE=circle> Matn 1
<LI> Matn 1 Matn 2
<LI> Matn 2 Matn 3
<LI> Matn 3
</UL>
Nuqtasimon belgi yordamida tartiblash:
HTML kodi Natija
<UL TYPE =disc> Matn L
<LI> Matn 1 Matn 2
<LI> Matn 2 Matn 3
<LI> Matn 3
</TJL>
Tcfg'ri to'rtburchaksimon belgi yordamida tartiblash:
HTML kodi Natija
<UL TYPE =square> Matn 1
<LI> Matn 1 Matn 2
<LI> Matn 2 Matn3
<LI> Matn 3
</UL>



Ro‘yxat tuzish - aniqlashtiruvchi ro ‘yxatlar

Aniglashtiruvchi ro'yxat va uning izohidan iborat matnni tartibli
tuzish uchun bir-necha teglar ishlatiladi.

Aniglashtiruvchi ro'yxatni <DL> ochuvchi va </DL> yopuvchi tegi
yordamida amalga osliiriladi. Aniglashtiruvchi ro’yxat nomi <DT>
tegidan so‘ng yoziladi va uni izohlovchi matn esa <DD> tegidan so'ng
kiritiladi. <DL> tegi qocshimcha oichamlarga ega emas.

A.niglashtiruvchi ro‘yxat:
<DL>
<DT> Aniqglashtiruvchi asosiy so’z yoki jumla
<DD> Izoh beruvch i matn
</DL>

Jadval tuzish

Jadval tuzish - HTML bo'yicha o’zlashtirish giyin boigan boiim-
lardan biri. Shu bois bu boiimni jadval tuzishni eng sodda usullaridan
boshlaymiz. Web-sahifani mukammal darajada yaratishni xohlasangiz,
unda jadval tuzishni chuqur o'rganib olishingiz kerak. Qisga qilib
aytganda jadvallar yordamida sahifani o0’zingiz xohlagan tarzda
boshgara olishingiz mumkin. Jadval ichiga nafagat matn. balki tasvir va
boshga elementlarni tartibli joylashtirish mumkin.

Jadval tuzish - umumiy qoidalar

Jadval tuzishda ishlatiladigan teglarni tasniflashdan avval. oddiv
jadval tuzish sxetnasi bilan tanishib chigsak. Har ganday jadval
quyidagi sxema bo ‘yichia tuziladi:

<JADVALNI OCHUVCHI TEG>

<JADVAL QATORINI OCHUVCHI TEG>

<JADVAL BO'LAGINI OCHUVCHI TEG>

Matn, tasvir yoki jadval

</JADVAL BO ‘LAGINI YOPUVCHI TEG>

</JADVAL QATORINI YOPUVCHI TEG>

</JADVALNI| YOPUVCHI TEG>

Har ganday jadvald a gatorlar va ustunlar mavjud boMadi. Jadvalning
bo'lakchalarida esa ax.borot Kkiritilishi mumkin. Yugorida Kkeltirilgan



misoldan ko'rin ib turibdiki, bitta ustun, bitta gator va bitta katakchadan
iborat jadvalni tuzish uchun jadval ocliiladi va yopiladi. Bitta ustundan
iborat va bir nechta gatorai o‘z ichiga oigan jadvalni tuzish uchun,
jadval gatorini ochuvchi va yopuvchi teglar orasiga bir nechta jadval
katakchalarini ochuvchi va yopuvchi teglarini kiritish lozim.

Oddiy jadvallar tuzish

Jadval tuzish usullarini tushunib olish uchun dastavval eng oddiy
jadvalni tuzishni o‘rganamiz. Biz tuzmoqchi boigan jadval uchta
ustundan iborat boiadi va har bir ustunda 3 dona katakchalar o’rin
oladi. Jadvalning birinchi ustunini «Mahsulot», ikkinchisini esa -
«Rangi», uchinchisini «Narhi» deb nomlaymiz. Biz tuzgan jadval mana
bunday ko finishda boiadi:

1.3-jadval
M ahsulot Rangi Narhi (so‘m)
Qalam Qora 100
Qalam ochgich Qora 500

Endi ushbu jadvalni tuzishda ganday HTML teglardan foyda-
lanilganligini koiib chigamiz:

<TABLE>

<TR>

<TD> Mahsu lot</TD>

<TD> Rangi</TD>

<TD>\Narhi(co‘tn.)</TD>

</TR>

<TR>

<TD> <3alam</TD>

<TD> <Qora</TD>

<TD>100</TD>

</TR>-

<TR>

<TD><5alam ochgichi</TD>

<TD><Qora</TD>
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<TD>500</TD>

</TR>

</TABLE>

Jadvalni ochuvchi teg

1 - gatorni ochuvchi teg

1 - Jadval bo'lagini ochuvchi va yopuvchi teg

2 - Jadval bo'lagini ochuvchi va yopuvchi teg

3 - Jadval bo'lagini ochuvchi va yopuvchi teg

1 - gatorni yopuvchite g

Jadvalni yopuvchi teg

Misolda ko‘rinib turibdiki, jadvalni <TABLE> va </TABLE> teg-
lari yordamida ochiladi va yopiladi. Qatorlar uchun <TR> va </TR>
teglari qoilaniladi, <TD> va </TD> teglari esa jadval ustunlarini
(katakchalarini) belgilash uchun ishlatiladi.

Jadval chizish - HTML teg oTchamlari

Murakkab jadvallar tuzishni boshlashdan avval <TABLE>, <TR>
va <TD> teglariga gisqacha tasnif berib o’tamiz. Mazkur uchta teg
bilan goilaniladigan bir xildagi oichamlar mavjud bo'lib, fagatgina
ularning fargli tomoni. ularning ta’sir doiralarining chegaralanishidadir.

BGCOLOR

Atribut yordamida jadvalning orga fonida ganday rang goilanilishi
belgilanadi.

BACKGROUND

Jadvaldagi boiakcha foni sifatida berilayotgan tasvirni joylashgan
joy va uning nomini belgilash uchun ishlatiladi. Agar siz bu atributni
<TABLE> tegidan so‘ng goilasangiz, u holda siz tanlagan tasvir
jadvaldagi har bir kataklar foni sifatida goilaniladi. <TR> tegidan so'ng
go'llanilganda, mazkur qatorda joylashgan hamma katakchalar uchun,

<TD> tegidan so'ng qo'llanilganda esa aniq biror katakchagacha fon
o‘rnatiladi.

WIDTH

Jadval eni (kengligi)ning oichami (umumiy jadval uchun xos).
Bu oicham bilan jadvaldagi maiutn bir ustuncha yoki boiakning
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kengligini piksel yohud foiz oichamida belgilash mumkin. Bu
oicham <TABLE> yoki <TR> tegi bilan goilanilgan taqdirda ham
bir xiJ koiinishdagi, ya’ni siz bergan oichamlarni hisobga oigan
holda jadval enining kengligini belgilaydi. Shuni doim yodda tutish
lozimki, siz bu oichamdan foydalangaa holdajadval enining kengligini
belgilaganingizda bir xildagi o‘lchov turidan foydalanishingiz magsadga
muvofiq. Agar siz jadval kengligini piksellarda belgilasangiz (misol
uchun AVIDTH =«100»), boshga oichovlar ham pikselda belgilanishi
lozim. Agar jadval kengligi foizlar hisobida berilsa (misol uchun
WIDTH=«50"?/0»), boshga oichovlar ham foiz hisobida berilishi lozim.
Ayni hollarda brauzer siz yaiatgan jadvalni ekranning teng yarmi, ya'ni
50% ga joylashtiradi.

HEIGHTr

Jadvalning, qator yoki katakchalarning balandligi oichovlarini
piksellar yoki foiz hisobida belgilash uchun go'llaniladi.

BORDER

Jadval ustuni va qatorlari kesishmalarini belgilovchi chiziglarni
galinligini piksellar hisobida belgilash uchun qoilaniladi. Agar jadval
chiziglarini nolga teng qilib belgilansa BORDER (BORDER =0) chiziq
(border) brauzerda koiinmaydigan boiib goladi.

ALIGN

Jadvalning ekranga nisbatan joylashish o'rnini belgilaydi. Agar
jadval ichida go‘shimcha jadval tuzilgan boisa, u holda ichki jadvalga
bu atribut kiritilganda. ichki jadval joylashishi o'rni tashqgi jadvalga
nisbatan belgilanadi. ALIGNning quyidagi go‘shimcha oichamlari
mavjud: ALIGN - center (Jadvalni markaz bo‘ylab jovlashtirish). left
(chap burchak bo'ylab joylashtirish) va right (o'ng burchak bo'ylab
joylashtirish).

CELLPADDING

Katakcha enining kengligini piksellar yordamida kengaytirish yoki
toraytirish.
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CELLSPACING

Jadvaldagi katakchalar chegara enining piksellar yordamida ken-
gaytirishi yoki toraytirishi.

Misol:

<TABLE BORDER=0 WIDTH= 100% CELLSPACING=5

CELLPADDING=5 BGCOLOR=blue>

<TR BGCOLOR=yellow>

<TD>Mahsulot</TD>

<TD>Narhi</TD>

</TR>

<TR BGCOLOR=white>

<TD>Qalam</TD>

<TD>100 so'm</TD>

</TR>

</TABLE>

AJLIGN

Jadvaldagi har bir katakchaning ichidagi elementlarni gorizontal
tarzda tartiblash uchun qoilaniladi. Uning mavjud oichamlari quyida-

gilardan iborat: — left (cliap tomonga tekislash), right (oiig tomonga
tekislash) va center (markaz bo'ylab tekislash).

VALIGN

Jadvaldagi har bir katakchaning ichidagi elementlarni vertikal tarzda
tartiblash uchun qoilaniladi. Uning mavjud o'lchamlari quyidagilardan
iborat: - top (katakning yuqori qismiga nisbatan), middle (yuqori va
guyigismiga nisbatan markazga tekislash).

Jadval tuzish qoidalari

Bu sahifada jadval tuzish jarayonida siz amal gilishingiz lozim
bolgan eng asosiv goida va maslahatlar keltirilgan.

. <TABLE>, <TR> va <TD> teglarini tartibiga rioya qiling

Har doim jadval tuzisb sxemasini buzmaslikka harakat giling. Avval
aytib ojtilgandek eng avvalo jadvalni oching so'ngra jadval gatorlari va
usUinlarinituzing va eng oxirida jadvalni yoping. Ushbu tartib buzilgan
tag<iirda turli hatoliklar kelib chigishi mumkin.
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* -<TABLE> tegini jadval so‘ngida yoping

Agar <TABLE> tegini yopmasangiz kutilmagan hatoliklar vujudga
keladi. Masalan, Netscape Navigator siz tuzgan jadvalni ekranda
umurrian ko‘rsatmaydi.

e Ustunda joylashgan gatorlar soni

Har bir gatorda kataklarning soni bir xilda bo‘lishiga etibor bering.
Bu tartibga, agar siz ayrim kataklarga hech ganday axborot kiritmagan
tagdiringizda ham ularni yaratish lozim. Bunday holatlarda bo'sh
katakchalarni mana bunday ko'rinishda vozish lozim: <TD>&nbsp;</TD>.
'&nbsp;' simvoli brauzerga mazkur katakda hech ganday axborot mavjud
emasligi hagida xabar beradi. Agar ushbu simvol yozilmagan taqdirda
brauzer bu katakni aks ettirmaydi va <TD> tegida BGCOLOR atribui
ishlatilgan iaqdirda fon rangi ifoda eiilmaydi va hatolik yuz beradi.

e Har bir jadval tegini yangi gatorda yozing

Jadval tuzishda adashib ketmaslik uchun har birjadval gatori, ustuni
va katakchalar belgilanganda ularni bir-biridan ajratib yozishga harakal
giling. Quyida ana shu holaiga misol keltirilgan.

<TABLE>
<TR>

<TD> .. </TD>
<TD> .. </TD>
<TD> .. </TD>
</TE>

<TR>

<TD> .. </TD>
<TD> .. </TD>
<TD> .. </TD>
</m>
</TABLE>

Ushbu qoidalarga rioya gilsangiz jadval tuzishda turli giyinchi-
liklarga duch kelmaysiz hamda siz tuzgan jadvallarda hatoliklar
b o ‘Imaydi.

Murakkab jadvallar tuzish

Odd iyjadval tuzish usuilarini o‘rganib oldingiz. <TD> tegining hali
siz bilmagan ba’zi gizig oichimlari mavjud bo‘lib ularni go‘shish orqali
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ajoyib natijalarga erishish mumkin. Aytaylik siz quyida keltirilgan
jadvalga o'xshash jadval tuzmoqchisiz (1.4-jadval).

1.4-jaclval
Ne Mahsulot nomi Narhi (so‘m)
1 Qalam 100
2 Ruchka 150
3 D aftar 400

Jami: 650 so'm

E’tibor bergan bcrlsangiz jadvalning so'ngidagi gator boshgalaridan
fargli oiaroq bitta katakchadan iborat. Biz avval aytib o‘tganimizdek
jadvaldagi barcha kataklar soni bir xil emas. Bu misolda oxirgi
gatordagi uchta kataklar bir-biri bilan birlashtirilgan xolos. Buni <TD>
tegining COLSPAN yordamida amalga oshirish mumkin.

COLSPAN

Jadvaldagi bir gator yoki ustundagi bir nechta kataklarni bir-
lashtiradi. Bu atribui oichamiga siz nechta katakchani birlashirmoqchi
bo'lsangiz, ulaming sonini Kkiritishingiz lozini. Quyida, yuqgoridagi
jadvalda bu usul ganday amalga oshirilganini ko‘rsatib beruvchi misol
keltiramiz. Bu misolda jadvalning aynan COLSPAN atributi goMlanilgan
gismigina yozilgan:

<TR>

<TD COLSPAN =3 BGCOLOR =red>

<FONT COLOR= white>Jami: 650 so;m</FONIT>

</TD>

</TR>

HTML kodlarga izoh

HTML kodlarni tahrirlashni oson kechishini ta'minlash uchun turli
izohlarni kiritish magsadga muvofig. lzohlar yordamida siz HTML
kodlarni gqayerda boshlanib, gayerda yakunlanganini muntazam kuzatib
borasiz va adashib ketmaysiz.
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Murakkab web-sahifaLar tuzganda ishlatiladigan HTML kodlar
soni cheksiz ko'payib ketishi mumkin. Buaday paytda HTML kodlarni
gayerdan boshlanib gayeria yakun topganini adashtirib yuborishingiz
anig. Shu sababli teg ochilganda va u yopilganda izoh bilan belgilab
borish lozim. Quyidagi misolda izohli HTML kodlar tizimi keltirilgan:

<BOD'Y BACKGROUMD-= img/back.gif>

<I—HTM L hujjat bosblanishi—>

<TABLE BORDER=0 CELLPADDING=0 CELLSPACING=0
WIDTH = 100% >
<!-Tashqi jadval boshlanishi—
<TR>
<TD WID TH =«1%» VALIGN= «top»>
<IMG SRC=«img/p.gif> WIDTH=«160» HEIGHT=«1» ALT=
»><BR>
<!—Sabifaning chap ustuni—
<FONT COLOR=whits>Sayt men.yusi:</[FONT>
<!—CHap ustun yakimi-->
</TD>
<TD WIDTH=«2%»></TD>
<TD WTDTH=«94%>» VALIGN=«top»>
<!—Saliifaning markaziy ustuni—
web sahifaning asosiy matni.
<BR><BR><BR><BR><BR><BR><BR><BR><BR><BR><BR>
<!—Markaziy ustun yakuni—
</TD>
<TD WIDTH=«2%»></TD>
<TD WIDTH=«1%» \ALIGN=«top»>
<IMG SRC =«img/p.gif» WIDTH =«100» HEIGHT =«1» ALT=
=« »><BR=>

<l—Sahifaning o‘ng ustuni—>

<TABLE BORDER=«0» CELLPADDING= «1» CELLSPACING =
=«0» WIDTH = «100» BGCOLOR=«#336699»>

<1—0 ‘ng ustundagi reklamali jadval—

<TR>

<l—Reklama sarlavhasi—

<TD><FONT COLOR=«#e0eOff»>Reklania:</FONT></TD>

<ITR>

=«

~
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<TR>

<TD>

<TABLE BORDER =«0» CELLPADDING =«0» CELLSPACING=
=«0» WIDTH=«100%» BGCOLOR=«#fOfOfO»>

<TR>

<TD BGCOLOR =«#cccc33»>

<!—Reklama matni—

<FONT SIZE= «2»>R.eklama matni va tasvimi shu yerga joylash-
tirishingiz mumkin

</FONT>

</TD>

</TR>

</TABLE>

</TD>

</TR>

</TABLE>

<!--0'ng ustun yakuni-->

</TD>

</TR>

</TABLE>

<l--Tashgi jadval yakuni—

</BODY>

<I—HTML hujjatyakuni—

Bu ifodalar sizga jadvalli sahifani oson tahlil qgilish imkonini
beradi hamda turli o‘zgarishlar kiritgan taqdiringizda, uni qaysi joyda
boiishini aniq belgilay olasiz.

Ba'zida o’zingiz ham mana shunday sxemalarni tuzishingiz mumkin
va sahifa tayyor boigach, kiritilgan izohlarni o;chirib tashlang. Bunda
kiritilgan izoh quy idagi tartibda yozi lishi lozim: <!—izoh —

Freymlar bilan ishlash imkoniyatlari

Freym - brauzer oynasidagi mustaqil to;g‘ri to ‘rtburchak shaklidagi
maydon boTib. u oz ichiga boshga alohida mustaqil HTML hujjatlarni
birlashtira oladi.

Endi siz har bir oynasida alohida mustagil HTML hujjatlarni ochish
imkonini beruvchi freymlarni tuzish usullari bilan tanishib chigasiz.
Freymlar brauzerdagi yangi oyna emas, balki bu alohida oyna yoki
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ramka boiib, u brauzerning ochilib turgan oynasi ichida aks ettiriladi.
Bu bo'limda, bir freymdan ikkinchi freymlarni bir-biriga havolalar
yordainida bogiash usullarini tahlil gilib chigamiz.

Freymlar tuzish

Siz internetdan foydalanish jarayonida freymlar ishlatilgan web
sahifani ko'rgansiz. Aytaylik bu sahifada uchia freymdan foydalanilgan.

Kolrib turganingizdek bu sahifa uchta freymdan iborat ustunlarga
boiingan. CHap ustunda joylashgan freymda navigatsion menyu,
yugoridan o'ngdagisida reklama va o'ngdan pastdagi freymda esa web
sahifa asosiy matni o’rin oladi. Chap ustunda joylashgan havolalarga
bosish bilan, havolalari hujjatning o‘ngdan pastida joylashgan freymda
ochiladi.

Ushbu freymlar qo'llanilgan sahifaning umumiy tuzilishini ko'rib
chigsak:

<FR.AMESET> — freymlar tuzilishini belgilovchi ochuvchi teg
(freymset)

<FR_AME> - birinchi freym

<FR.AME> - ikkinchi freym

</FRAMESET> - freymsetni yopuvchi teg

Sxemada ko'rinib turganidek, har gal <FRAMESET> tegi yor-
damida freymlar tuzilishini belgilash lozim, Shundan so'ng bevosita
freymlar <FRAME> tegiga navbat keladi. Oxirgi navbatda </
FRAMESET> freymset yopuvchi teg yoziladi.

Hozircha bu oddiy sxemani eslab qoling. Murakkab freymlar
goilanilgan sahifalar hagida ushbu bo‘limda keyinrog maiumot
beramiz.

Freymlar - oddiy misol

Xullas. freymlar bilan ko'rsatilgan oddiy misolni ko'rib chigamiz.
Ishni boshlashdan oldin. oddiy HTML formatida ikkita hujjat yarating.
Birinchi hujjatga «Freym-1 » ikkinchisiga esa «Freym-2» deb yozing va
ularni freml.LHTML va frem2.HTML deb nomlang. Bu ikkita favllar
bizning uiisolimizda ikki freymlar uchun asosiy manba bo'lib xizmat
giladi. Endi esa HTML formatida keyingi hujjatni yarating.
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<HTML>

<HEAHO>

<TTTLE>freymlar</TITLE>

</HEAD>

<FRANESET COLS =«200».*>

<FRAME NAM E= left SRC =«framel. HTML>»

<FRAME NAME =right SRC= «frame2. HTML»>

</FRAVIESET>

<NOFRAMES>

Sizning brauzeringiz freymlarni tushunmaydi.

</NOFRAMES>

</HTML>

Demak siz ham o‘zingizning birinchi sahifangizni freymlar
yordamida yaratdingiz. Endi shu yaratgan sahifangizni frameset.html
deb nomlal) oldin yaratilgan framel.html va frame2.html fayllar turgan
papkada saglang va frameset.html faylini 0‘z brauzeringizda oching.

Birinchi navbatda. e'tibor bergan boMsangiz HTML formatidagi
freymlardan iborat sahifada <BODY> tegi mavjud emas. Bu esajuda
muhimdir. Agar siz <BODY> tegini ishlatsangiz u holda, hamma
<FRAMESET> va <FRAME> teglari brauzeringiz tomonidan
o"chiriladi. Undan tashgari <NOFRAMES> tegi shunday holatga
mo'ijallangan-ki. bu holatda sizning brauzeringiz freymlarni qo'l lab-
quwatlamaydi.

Freymlar — oddiy freym

Bizning misolimizda <FRAMESET> va <FRAV1E> teglarini oddiy
o'lchamlarda ishlatgan edik. Endigi navbatda biz freymlar yordamida
0'z sahifamizda nimalarni o’zgartira olishimizni ko'rib chigaylik.
frameset.html sahifasini brauzerda y“oki HTML teglarni tahrirlovchi
dasturda oching. Foydalanuvchi sizning freymlaringizni oTchamlarini
o‘zgartira  olmaydigan qilishingiz mumkin. Siz hozir freym
chegaralariga sichgoncha ko'rsatkichini belgilab uning oTchamlarini
xoh lagan tarzda o'zgartirishingiz mumkin.

MORESIZE

<FRAME> tegining parametr ushbu freymni o;zgartirib bo‘l-
masligini anglatadi.
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Misol:

<FRAME NAME=left SRC= «framel.html» NORESIZE>

<FRAME NAME-=right SRC =«frame2.html» KORESIZE>

Keyingi holatlarda, agar siz freymlar orasidagi chegaralami
belgilash uchun siz <FRAMESET> teginiag quyidagi atributini ish-
latishingiz zarur.

BORDER

<FRAMESET> tegi freymlar chegaralari orasidagi masofani
piksellarda ifodalaydi. Freym orasidagi chegarani umuman bo'lmasligi
uchun shu o' Ichamni aolga tenglashtiramiz.

Misol:

<FRAMESET COLS= «200».* BORDER=«0»>

<FRAME> tegining yana. bir muhim atributi

SCROLLING

<FRAME> tegi mavjud freymda sahifalash chizig'ini mavjudligi
yoki mavjud emasligini belgilaydi. Bu parametrniag yes, no va auto
belgilari bu freymda sahifalash chizig‘ini borligini, yo'qligini va agar
kerak bo‘lsa ishlatilishini korsatadi.

Misol:

<FRAMLNAME=«left» SRC=«framel.html» NORESIZE SCROL-
LING =«auto»>

<FRAMENAME-= «right» SRC=«frame2.htmI»NORESIZE SCROL-
LING =«yes»>

<FRAMESET> tegining quyidagi atributlarini siz bilishingiz za-
rur:

COLS

<FRAMESET> tegining bu parametri gorizontal freymlarning
chapdan o'ngga tuzilishini ko:rsatadi. Freymlarning kengligi piksellarda
yoki foizlarda beriladi va bir-biridan tinish belgisi bilan ajratiladi.
* simvol shuni kofsatadiki. golgan ummniy maydon shu freyniga
ajratilishini anglatadi.

Misol:

<FRAMESET COLS = «200», *, 100>

Bu misolda uchta freym mavjud boiib. birinchisi-200 piksel.
oxirgisi —100 piksel. ikkinchisi (o'rtadagi freym) - golgan maydonning
hammasi sh\i freym uchun ajratilgart.
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<FRAMESET COLS =20%, 100, 50, *>

Bu misolda esa toftta freym bo‘lib, birinchisi maydonning 20%ni,
ikkinchisi - 100 pikselli, uchinchisi - 50 pikselli, to'rtinchisi esa golgan
mavdonni tashkil etadi.

ROWS

<FRAMESET> tegining bu parametri freymlarning vertikal
tepadan pastga bo'lgan tuzilishini ko‘rsatadi. O'lchami ragamlar bilan
beriladi. Bu freymlarning balandligi piksellarda yoki foizlarda beriladi
va bir- biridan tinish belgisi bilan ajratiladi. * simvol shuni ko‘rsatadik:i
u umurniy golgan maydonni shu freymga ajratilishini anglatadi.

Misol:

<FKAMESET ROWS =50%. 50%>

Balandligi ekranning 50% tashkil giluvchi ikkita freym. Anglash
giyin emaski. bu ifodani ROWS parametrida. simvol orgali quyidagicha
yozish mumkin 50%, *.

Freymlar - murakkab freymlar tuzish

Uslibu bo‘limning  boshida siz tanishib chiggan, freymlarga
bo’lingan sahifaga yana bir bor murojaat gilsak (1.3-rasm). Berilgan
sahifada uchta freym boiib. bu freymlar tarkibida gorizontal hamda
vertikal holatdagi freymlar mavjud. Bu sahifani yaratish uchun biz
nima gilishimiz kerak? Demak hammasini bir boshdan boshlaymiz.

Murakkab tarkibli freymlarni yaratishimiz uchun. biz jadvallarni
ganday yo‘l bilan yaratgan boisak shu yo‘l bilan yaratishimiz
qulayrogdir. Og gogo'zga freymlar tuzilishi
andozasini chizib oling va shu freymlarni
ragamlab chiging. Bizning misolimizda
freym lar tuzilishi quyidagicha bo’ladi:

Freymlarni quyidagicha ragamlaymiz:
chapdan o'ngga. tepadan pastga garab. Endigi
navbatni yangi sahifani yaratishga bersak.

Biznirg misolimizda yolg'iz <FRAMESET>

tegi orgali freymlar strukturasini  bel-

gilay olmaysiz, nega deganda birgina 13rasm Freymlarga
<FRAVIESET> tegida freymlarni birgalikda bo'lingan sahifa.



gorizontal (COLS) va vertikal (ROWS) jovlashtirishning iloji yo'q. Gap
shundaki bir nechta <FRAMESET> teglarni quyidagicha ishlatiladi

<HTML>

<HEAD>

<TITLE>freymlar</TTTLE>

</HEAD>

<FRAMESET COLS= 150,* BORDER= 0>

<FRAME SRC= left.ntml SCROLLING=yes NORESIZE>

<FRAJV1ESET ROWS=70,* BORDER =0>

<FRAME  SRC=top.html = SCROLLING=auto = NAME=top
NORESIZE>

<FRAME SRC-=content.htm| SCROLLING=yes MAME = content
NORESIZE>

</FRA,MESET>

</FRA.MESET>

<NOFRAMES>

Sizning brauzeringiz bu freyinlarni qoilab quvvatlainavdi.

</INOFRAMES>

</[HTML>

Birinchi <FRAMESET> tegi ekranni ikkita freytnga, ya’ni o’ng va
chap freymlarga ajratadi. Ikkinchi <FRAMESET> tegi esa o‘ng gism
(o'ng freym)ni yana ikkita tepa va past freymga ajratadi. Ketma-ketlik
tartibi HTML fomatida oldin ko‘rsatib o’tilganidek bao'lishi shart.
Birinchi navbatda birinchi <FRAMESET> tegi. Birinchi freym (o'ng
freym). Undan keyin ikkinchi freym kelishi kerak edi. Ammo biz
ikkinchi <FRAMESET> tegi yordamida uni yana ikkiga bo'ldik. ya'ni
biz ikkinchi freym (chap freym)ga yana ikkita freymni vertikal holda
(ROWS =70,*) joylashtirgan bo'lamiz. Kevin ikkita freym keladi va
ikkala <FRAMESET> teglari yopiladi. Mana endi natija quyidagicha
bo'ladi, ya'ni chap freymda left.html o'ng tomondagi freymning yuqori
gismida top.html va undan yugori gqismida content.html freymlar
vuklanadi.

Freymlar - liavolalar tuzish

Belgilangan mavsus freymda HTML hujjatni ochilishi uchun
havolani ganday tuziih lozim? Bu juda ham oson. Buning uchun. freym
ishlatiladigan sahifa yaratilganda. freym nomini berib o'tish lozim.
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NAME

<FRAME> tegining bu atributi mazkur freym nomini belgilaydi.
Freym nomlari ushbu freymga boshga freymdan havola tuzish uchun
go'llaniladi.

Bizning misoliinizda quyidagi kodlar go'llanilgan:

<IRAMESET COLS = 150* BORDER=0>

<FRAME SRC=left.html NAME =left SCROLLING =yes NORIE-
SIZE>

<FRAMESET ROWS =70* BORDER=0>

<FRAME SRC=top.html NAME =top SCROLLING =auto NORE-
SIZE>

<IRAME SRC= content.html NAME=content SCROLLING =yes>

</FRAMESET>

<yFRANESET>>

Natijada quyidagi nomlardagi freymlar vujudga keladi: left, top
va content. Endi chap frevmdagi liavoladan asosiy freymda hujjatni
ochilishi uchun <A> tegining TARGET parametrini content teng gilib
belgilash lozim, yani:

<A HREF=l.htm|l TARGET= content>1-Punkt </A>

Shakllaxhosil gilish (®opma)

Siz internetda ko ‘p marta shakllarga duch kelgan boTsangiz kerak.
Bu gogoz<lagi anketaning elektron varianti, o'zida matn Kiritish
maydonlarnii, savol larga javob variantlari va boshga shakl elementlarini
mujassam giladi. Shakllar sayt egasi va foydalanuvchilar orasida aloga
o‘rnatish uchun kerak.

Sliakllai vordamida saytingiz orgali, misol uchun, ovoz berish,
foydalanuvchilarnitig avrim savollar bo‘yicha fikrini bilish va shunga
o‘xshash masalalarni hal gilishingiz mumkin.

Shakllarning umumiy sxemasi

Qnyida har ganday shaklni yaratish umumiy sxemasi berilgan.

<FORM>

shakl inaydonid agi teglar

</FORN>

Ko‘rib turganingizdek, ochuvchi <FORM> va yopuvchi</FORM.>
teglaii orasiga shakl maydonlari teglarini go‘yish yetarlidir. Keyingi
sahifada tuili shakl maydonlari bilan tanishamiz.
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Turli shakl maydonlari

Shakl maydonlari ganday bo'ladi va ular nima ish bajaradi?

Matn gatori (TYPE=TEXT)

Bu gator ko'p boimagan simvollardaa iborat erkin ko‘rinishdagi
ma’lumotni (matnni) Kiritisli uchun foydalan iladi.

Misol:

<INPUT TYPE=TEXT NAME=Tekst SIZE=20 VALUE= «Siz-
ning matn»>

Shunday qilib matn gatori <INPUT> tegi va TYPE=TEXT para-
metrlari yordamida yaratiladi. Shu tegning boshga parametrlari nimani
bildiradi?

NAME

Serverga jo:natiladigan o‘zgaruvchining nomi. Foydalanuvchi Kki-
ritgan matn natijada shu nomli o‘zgaruvchiga beriladi. HTMLda
shakllar yaratish serverda dasturlash bilan uzluksiz boglig. Serverda
foydalanuvchilaringizdan malumotlarni shu dastur orgali gabul qi-
lishingiz mumkin.

SIZE

Matn gatorining simvol ko‘rinishdagi kengligi. Bizning misolda
bu parametrning ifodasi 20 ga teng. Buning ma’nosi Kiritilayotgan
matnning kengligi 20 simvoldan iborat. Foydalanuvchi undan ko'p
simvollardan iborat boMgari matnni Kiritishi mumkin, lekin 20 tadan
ortig simvol ko‘rinmaydi. Kiaviaturadagi yo‘naltiruvchi tugmachalar
yordamida matnni boshi yoki oxiriga o‘tish mumkin.

VALUE

Bu parametr ifodasi oldindan matn niaydoniga Kiritilgan bo'ladi.
Uni o‘zgartirish yoki o'chirish mumkin.

Javaob varianti (TYPE=RADIO)

Foydalanuvchi bir gancha javob variantlari orasidan fagat bitta
variantni tanlashi mumkin.

Misol:

Jinsi:

<INPUT TYPE=RADIO NAME =Jins VALUE = «Erkak»>Er.

<INPUT TYPE=RADIO NAME= lJins VALUE=«AyoI»>Ay.



Natija:

Jinsi: Er. Ay.

Ko'rib turganingizdek javob variantlari <INPUT> tegi TYPE=
=RADIO atributi orgali yaratiladi. Diqgqgat giling, javob variantlaridagi
NAME atribatining ifodalari bir x.il boiishi kerak, aks holda brauzer
bularni har xil savol deb gabul giladi.

VALUE

Bu ifoda o'zgaruvchining ifodasi ko'rinishida jowatiladi (bizning
misolda, agar Er. tanlansa Jins o‘zgaruvchming ifodasi 'Erkak' ga teng
bo'ladi).

Tasdiglash (TYPE=CHECKBOX)

Ayrim ifodalarni yoki javob variantlarini belgilash uchun ishlatiladi.

Misol:

Jinsi:

<INPUT TYPE=CHEICKBOX NAME=AddMe VALUE=«0Obuna
boiish»>

Ha, men sizning saytingizdan yangiliklar olishni istayman

Natija:

Ha. men sizning saytingizdan yangiliklar olishni istayman

Tasdiglash <INPUT> tegi TYPE =CHECKBOX atributi yordamida
yaratiladi. Bizning misolda, agar foydalanuvchi kvadratga belgi
go‘ysa (tasdiglasa) AddMe o'zgaruvchining ifodasi «Obuna boTish»ga
teng bo'ladi. Aks holda AddMe o‘zgaruvchisiga hech ganday ifoda
berilmaydi.

Harakatlanuvchi menyu (SELECT)

Bir gancha javob variantlaridan birini tanlash uchun harakatlanuvchi
menyu ko'rinishida ifodalanadi.

Misol:

Yoshi:

<SELECT NAME=Age>

OPTION VALUE= 10>10 dan kam

<OPTION VALUE= 11-2011-20

<OPTION>21 dan ko'p

</SELECT>

Natija:

Yoshi:
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Harakatlanuvchi menyu <SELECT> tegi. menyuning javob va-
riantlari esa <OPTION> tegi yordamida yaratiladi.

NAME

<SELECT> tegining atributi, o'zgaruvchining nomini ifodalaydi.
Bu o‘zgaruvchiga tanlangan javob variantining ifodasi beriladi. Bizning
holatda o'zgaruvchining nomi Age.

VALUE

<OPTION> tegining atributi. shu variant tanlanganda parametr
ifodasi ozgaruvchiga beriladi. Agar bu atribut belgilangan bo'l-
masa Cuchinchi <OPTION> tegiga o'xshab), o'zgaruvchining ifodasi
<OPTION> tegidan keyin kelgan matn bo'ladi. Agar bizning miso-
iimizda uchinchi variantni tanlasak Age o'zgaruvchining ifodasi 21 dan
ko'p, agar birinchi variantni tanlasak ifoda TO’ bo'ladi.

<OPTION>tegidan so'ng berilgan matn ekranda harakatlanuvchi
menyu varianti sifatida ko‘rinadi. Keyin <OPTTON> tegini yopish shart
emas.

Matn maydoni (TEXTAREA)

Matn maydoni foydalanuvchi tomonidan ko'p sonli simvollardan
iborat matnni kiritish uchun foydalaniladi.

Misol:

Sizning mulohazalaringiz:

<TEXTAREA NAME= Comments COLS=20 ROWS=5>

0 ‘z mulohazalaringizni Kiriting

</TEXTAREA>

Natya:

Sizning mulohazalaringiz:

Matn maydoni <TEXTAREA> tegi orqgali yaratiladi. Ochuvchi va
yopuvchi teglar orasidagi hamma matnlar shu matn maydoni ichiga
yoziladi.

COLS
Matn maydonining simvol ko'rinishidagi kengligi.
ROWS

Matn maydonining gator ko'rinishidagi balandligi.
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Shaklni tozalash va jo ‘natish tugmachasi

Foydalanuvchi toTdirilgan shakini jo‘natish uchun tasdiglovchi
tugmacha yaratish kerak. hainda shakl niaydonini tozalash tuginasini
yaratishi mumkin. Shu bo‘lim boshida jo’natish va tozalash tuginasini
gauday ko'rinishga ega ekanligini ko‘rdingiz.

Jo'natish tugmachasi (TYPE =SUBMIT)

Foydalanuvchining shaklda belgilangan ma'lumotlarini tasdiglab,
shu ma’lumotlarni serverga jo “natish uchun gollaniladi.

Misol:

<INPL'T TYPE= SUBMIT VALUE = «Shaklni jo ‘natish»>

Natija:

‘Shaklni jo'natish’ nomli tugmacha

Jc‘natish tugmachasi <INPUT> tegi yordamida TYPE=SUBMIT
atributini ishlatgan holda yaratiladi. Natijada VALUE parametrida
belgilangan yozuv bilan tugmacha yaratiladi. Tugmacha bosilganda
shakldagi ma’lumotlar serverga jo ‘natiladi.

Tozalash tugmachasi (TY PE = RESET)

Sliakl maydonidagi ma’luxnotlarni tozalash uchun goTlaniladi.

Misol:

<INPUT TYPE= RESET VALUE=«Shaklnitozalash)»

Natija:

*Shaklni tozalash’ nomli tugmacha

Shakl maydonini tozalash tugmachasi <INPUT> tegi yordamida
TYPE=RESET atributini ishlatgan holda belgilanadi. Natijada VALUE
atributida belgilangan yozuv bilan tugmacha yaratiladi. Tugmacha
bosilganda shakldagi ma’lumotlar toia o‘chiriladi.

Ko‘riramas shakl maydoni

Yana bir turdagi shakl maydoni bor - bu ko'rinmas shakl maydoni.
Bu maydon ma'lumotlar almashinuvi uchun ishlatiladi. KoTrinmas
maydonni foydalanuvchi ko'ra va o‘zgartira olmaydi.

Ko‘rinmas maydon (INPLJT TYPE =HIDDEN)

Shakl maydoni ekranda ko‘rinmaydi, uning ifodasi sahifa yara-
tilishida beriladi va foydalanuvchi shaklni toidirish jarayonida
0 ‘zgartirib boTmaydi.
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Misol:

<INPUT TYPE=HIDDEN NAME=Page VALUE=«1 sahifa»>

Ko'rinmas shakl maydom <INPUT> tegi yordamida va TYPE=
=HIDDEN atributini ishlatgan liolda yaratiladi. Berilgan misolda
shaklni jo‘natish vaqtida Page o‘zgaruvchisiga 1l sahifa’ ifodasi
beriladi. Buning natijasida, agar to'ldiriladigan sahifalaringiz ko'p
boTsa, gaysi sahifadagi shakldan ma’lumot jo'natilganini aniglashingiz
mumKkin.

FORM tegining atributlari va shaklni jo‘natish

Shu bo‘lim boshida eslatib o‘tganimizdek. shakl varatish dastur-
lash bilan uzluksiz bog‘lig. Boshgacha qilib aytganda shakldagi
maTumotlarni gayta ishlash dasturlashsiz iloji yo‘q. Ma’lumotlarni
gayta ishlash natijasi siz kcfrsatgan email manzili bo‘yicha jo‘na-
tiladi,

Keling, sizning saytingizdagi shakl maMumotlari dastur orgali gayta
ishlanishi uchun nima gilishni ko'rib chigaylik. Natija siz ko’rsatgan
email manzili bo‘yicha shu formatda jofhatiladi.

O'zgaruvchi: Kiritilgan ma’llumot

Buning uchun saytingizda xohlagan shaklni shu ko‘rinishda yara-
tishingiz zarur:

<FORM METHOD =POS7 ACTION=http://.....com/mail.php3>

<NPUT TYPE=HIDDEN NAME =recipient VALUE=EMAIL>

<INPUT TYPE=HIDDEN NAME =subject VALUE=MAVZU>
<INPUT TYPE=HIDDEN NAME =type VALUE=TUR>
<INPUT TYPE=HIDDEN NAME=return VALUE=MANZIL>
<INPUT TYPE=HIDDEN NAME=alpha VALUE =a>

Sizning shaklingiz

</FORM >

Endi shu HTML kodni 0'z sahifangizga ko'chiring va kevingi
so‘zlarni o‘zgartiring:

EMAIL —natijajo'natiladigan email manzil;

3MAVZU —Xat mavzasi (Subject);

TUR - Sizning pochtangiz turi, HTML deb yozing. agar aniq
bilmasangiz TEXT deb yozing;
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MANZIL - foydalanuvchi shaklIni to'ldirgandan keyin ko'rishi kerak
boigan sahifa manziii;

Keyin. ‘Sizning shaklingiz’ so ‘zini o‘rniga o'z shaklingizni go ‘ying.
Dastur gandav ishlashini ko‘rish uchun o‘zingizni email manzilingizni
kiritiog va ‘Tekshiruv’ tugmasini bosing.

HTMLda simvollar jadvali

Ayritn simvollarni to‘g‘ridan-to‘g‘ri yozib bo'lImaydi. Chunki ularni
brauzer aks ettirib bera olmaydi. Undan tashqgari ko’plab simvollar
klaviaturada mavjud emas. Bu ikki turdagi simvollarni brauzerda
aks ettirish uchun son va shriftlar kombinatsiyasidan foydalaniladi.
ASCII simvollar deb ataluvchi simvollarning son va shriftlardan iborat
konibinatsiyasi mavjud.

Savol va topshiriglar:

1 Web-dizayn niina?

2 Dizaynning ganday turlari bor?

3 Web-dizaynda gqanday dasturing vositalar ishlatiladi?

4. NTML nima? Uning asosiy strukturasi nimalardan iborat?
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I1-bob. DREAMWEAVER EASTURINING IMKONIYATLARI

Dreamweaverning MX versiyasi bu nafagat interfeysning tashqi
ko'rinishi yangilangani, balki radikal texnologik yangilangan, gi-
permatnli belgilash tili imkoniyatlari kengaygan. Unda Web-sahifa
maketlarini yaratish uchun yangi ashyolar paydo bo’ldi. Jumladan,
tizimga Flash obyektlarni qoyish buyruglari go'shilgan va WEB uzellar
bilan boshgarish va turli jamoaviy ishlarni loyihalashda rivojlanishga
imkon beradi. Endi Dreamweaver MX bilan batafsil tanishib chigamiz.

Belgili kodlar bilan ishlash vositalari sezilarli darajada rivojlandi.
IVIX-versiyasi bu ixtiyoriy murakkablikdagi dastlabki matn bilan ishlash
uchun kuchli bazaga ega bo'lgan gipermatnli dasturlashning to'lagonli
gobig'idir. Asosiy imkoniyatlarini sanab chigamiz:

1) Hujjatning oynasi endi har xil rejimlarda ishlashi murnkin.
Design View (Pexu>l nnaHupoBku) rejimida, foydalanuvchi HTML
sahifa maketini taxminan shunday ko'rinishda ko’rish murnkin.
Code View (Pexum pa3meTkn) rejimida esa hujjatning oynasida
belgili matn sahifasining barcha deskriptorlari, senarivlari va
kommentariyalari tasvirlanadi. Dasturning bu rejimlari orasida kichik
koordinatsiya mavjud. Kodlarni o'zgartirish maket modifikatsiyasiga.
vizual rejimda rejalashtirish yoki formatlashga o‘zgartirish kiritish
imkonini beradi;

2) Dreamweaver tizimi qobig'iga barcha zaruriy qurilmalarga ega
bo'lgan to'lagonli kodlar tahrirlagichidan iborat dastur integratsiya
gilingan, Linda HTML hujjatlarining dastlabki matnlari bilan ishlashni
yengillashtiruvchi vositalar: kiritilgan teglarning sarlavhalari, turli
kodlarni rangli belgilash, tez qidirib topish vositalari aks etgan.
Sintaktik noto’g’ri loyihalarni aniglash, uzun qatorlarni avtoniatik
ko'chirish, avtokorreksiya rejimi yo‘lga qo‘yilgan, Dastur vositalari
yordamida nafagat gipermatnli sahifalarni, balki matnli ko'rinishga ega
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liar ganday hujjatlarni, dasturlar, senariylar, oddiy matnlar, XML belgili
hujjatlar va boshqalarni tahlil gilish mumkin.

3) Gipermatnlarni belgilash kodlari bilan ishlashni niaTumot
panel i ancha soddalashtiradi. Bu dastur ichiga qurilgan interfaol ma’lu-
motnoma gipermatnli belgilash tilining barcha standart loyihalarini va
u hilan bogiangan vositalarni: diskreptorlar, atributlar, ierarxik stildagi
o'ziga xosliklarning deklaratsiyalari (Cascading Style Sheet), Java Script
tilining sintaktik loyihalarini gisgava lo'nda shaklda tavsiflaydi.

Tajribadan ma'lumki xatto eng tajribali, HTML tilini chuqur
biladigan Web-ustasi ham bu til standartiga kiruvchi yuzlab kodlar va
atributlarni eslab golishga godir emas. Ma’lumotlar paneli deskriptorni
anig va ravshan tavsiflab beradi, uning atributlari hamda ko‘rib chiqish
dasturining turli versiyalari bilan mos tushishi hagida ma’lumot beradi.

4) Java Script senariylar

Java Script dasturlash tilida yozilgan senariylardagi yashirin xa-
tolarni aniglash imkoni beriladi. Bu vosita nafagat hozirgi vaqtda
WEB-dasturlash sohasida qgo‘llaniladigan ko'p sonli analizatorlar uchun
giyin boTmagan, sintaksis xatolarni aniglashga qodir. Kodlarni tuzatish
vagtida dastur ichiga qurilgan nazorat nuqgtalari va gadamba-gadam
bajariladigan dastur ko'rsatmalari hamda o'zgaruvchilarning holatini
nazorat mexanizmlariga ham ega.

Doimo sezilarli potentsialga ega bo‘lgan vizual loyihalash tah-
rirlagichining uskunalari vana bir vosita bilan boyitildi. Bu gipermatnli
sahifalarni rejalashtirish va yaratish uchun mo‘ljallangan maxsus dastur
ishchi rejimidir. U sahifani aks ettirishning maxsus rejimi (Layout Viev)
va ikkita nskuna kcrrinishida amalga oshirilgan boTib. ular yordamida
maket elernentlarini chizish mumkin.

Tahrirlagichning oldingi versiyalari vektorli animatsiyalashgan
tasvirlar sohasida birinchilar gatorida boTgan Flash dasturi bilan juda
yaxshi o'zaro alogada boTishi bilan ajralib turgan. Dasturning joriy
versiyasiga animatsiyalashgan obyektlarni generatsiya giLishning
ikkita ascsiy buyrug‘i integratsiya qgilingan. Endi bevosita dastur
oynasida interfaol tugma yoki «jonli matn» yaratish mumkin. Bunga
o‘xshash obyektlarni kiritishning texnik tomoni o‘ta soddalasbtirilgan
va loyihalashtirishdan ko'ra ko‘prog anketalashtirishga o ‘xshab
ketadi. Foydalanuvchidan Flash - texnologiya sohasida chuqur
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bilimlar talab gilinmaydi. U fagat mulogot oynasi sohasini toTdirishi
kerak. Zamonaviy dasturlarning ko'pcliiligi animatsiyalashgan Flash
- grafikani aniq aks ettiradi. Bu tipdagi obyektlar a'lo darajada
masshtablanishi bilan ajralib turadi va tarmoq bo‘ylab uzatishda ham.
diskda saqlashda ham juda kam resurs talab giladi. Dasturga Kiritilgan
yangiliklarni gisgacha sanab o'tamiz:

- ierarxik stildagi oZziga xosliklar (CSS) bilan ishlash vositalari
sezilarli darajada takomillashtirilgan.

- Macromedia firinasi tomonidan islilab chigilgan Fire woks
grafik muharriri bilan Dreamweaver dasturining integratsiyasi yanada
rivojlantirildi.

- yangi Assets (resurslar) palitrasi yaratildi. U dasturda bitta WEB
- tugunning bir necha sahifasi tomonidan birgalikda ishlatiladigan
turli xildagi ma’lumotlarning omborxonasi vazifasirti bajaradi. Bular
tasvirlar, animatsiya roliklari, ranglar, senariylar, kutubxonalar va
boshqgalar b o ‘lishi mumkin. Saglanayotgan resurslarni turli sahifalarning
talab gilinadigan sohalarida joyini o'zgartirish (yoki surish) vo'li bilan
joylashtirish mumkin.

Site Report (OTtueT 0 caitte) buyrug‘i loyiha holati hagidagi batafsil
hisobotni hosil giladi. Hisobot o'ziga kcrp sonli giperbogianishli
hujjatlarni biriktiradi:

- tahrirlagichga versiyalarni va dasturiy taininotni yangilasimi
boshqgarishni nazorat gilishning yetakchi dasturiy vositasi bo'lgan
Microsoft Source Safe paketli integratsiya vositalari qo'shilgan. Bu
narsa Dreamweaver tizimini Internet uchun murakkab loyihalarni
ishlab chiquvchi jamoalar uchun asosiy uskuna sifatida qo'Uanilishiga
asos boiadi.

- dasturning bu versiyasi WEBDav bayonnomasini to'lagonli
go'llab-quvvatlaydi. Bu versiyalarni boshgarish va tagsimlangan ishni
tashkil gilish bo‘yicha kengaytirilgan imkoniyatlarga ega boigan klassik
bayonnomasidir.

- interfeysni standartlashtirish va saygal berish bo'yicha Kkat-
ta ish qilindi. Macromedia firmasi ko‘pgina dasturlarning tasliqi
koTinishi noturg‘un palitralarning yagona konsepsiyasiga asoslanadi.
Muharrirning oxirgi versiyasida palitralarning ko‘rinishi standart-
lashtirilgan. Ularning deyarli hammasi tarkibiy majmuaviy palitralarga
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birlashish imkoniyatiga ega bo‘ldilar. Oldingi versiyalarning ro‘yxatga
olishdagi ba’zi kamchiliklar bartaraf etildi.

- klaviatura kombinatsiyalari bir shaklga Kkeltirildi. Ular web-
dizayn uchun Macromedia firmasi tomonidan ishlab chigilgan, bar-
cha dasturlash vositalari uchun umumiy bo‘lgan ichki standartga
moslashtirilgan. Ichiga qurilgan boshgaruv tizimi yordamida tugma-
larning har ganday tuzilishini o‘zgartirish mumkin.

Savol va topshiriglar:

1 Dreamweaver M X dasturi nima magsadda qgo*llaniladi?
2. Dasturning ganday yangi imkoniyatlari mavjud?
3. Dastur avvalgi web-muharrirlaridan nimasi bilan farq giladi?

2.1. Dasturni o‘rnatish va ishga tiishirish

Tajribali foydalanuvchi dasturni o‘rnatish jarayonida 0°zi uchun
hech ganday yangilik ko‘rmaydi. Distributiv diskda Dreamweaver MX
Installer.exe (uHcTanaTop) faylini gidirib topish va ishga tushirish lozim
(avto ytiklanish bo“lmagan holatda). Windowsning ko'pchilik ilovalari
kabi bu dastur ham bir necha bosgichda o'rnatiladi. Ularning har biri
alohida mulogot oynasidan iborat.

Dasturni o‘rnatishning asosiy bosqgichlarini ketma-ket sanab o'tamiz

3], [
& -[ ]Extracting Files. Bu bosgichda DREAMWEAVER tizimdagi
gurilmalar va dasturning instalyatori ishlashi uchun zarur bo'lgan
Fayliar arxivdan ochiladi. Bosgich foydalanuvchining aralashuvini talab
gilmaydi.

- Welcome (Xush kelibsiz). O'rnatishning birinchi bosgichi bo'lib,
unda foydalanuvchi tanlangan dastur va uni installyatsiva qilish
goidalari hagida asosiy ma’lumotlarni oladi.

- License Agreement (Litsenziya shartnomasi). Ikkinchi bosqichda
litsenziya shartnomasi va muallifning dasturiy mahsulotiga huquglari
bilan tanishish taklif etiladi. Foydalanuvchi taklif gilinayotgan
majburiyatlarni gqabul gilishi yoki rad etishi kerak.

- Macromedia Dreamweaver Serialization (dasturni ro‘yxatdan
o'tkazish). Uchinchi bosgichda mulogot oynasi hosil boMadi, uning
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yordamida foydalanuvchining rekvizitlari va dasturning serial nomerini
kiritish zarur bo‘ladi.

- Choose Destination Location (joylashuv). Bu bosgichda dasturni
o‘rnatish uchun disk va papkani olish zarur boTadi. Taklif gilinganidan
farg giluvchi manzilni ko'rsatish Windows tizimi uchun standart boTgan
faol disk va katalogni tanlash yo‘li bilan berish mumkin. Buning uchun
Browse tugmasini bosish kerak.

- Default Editor o'rnatishning bu bosgichida Dreamweaver dasturi
keyin ishlatila digan asosiy tahrirlash fayllarini tanlashni taklif giladi.

- Select Program Folder (Dastur papkasini tanlash). Bunda fov-
dalanuvchi dasturni ishga tushiruvchi yorlig joylashgan papkani
ko rsatish kerak boTadi. O ‘rnatishning keyingi barcha operatsiyalari
foydalanuvchining aralashuvini talab etmaydi. Instalvator arxivlarni
ochadi, kataloglar va kichik kataloglar tizimini yaratadi. unga ish uchun
zarur boTgan barcha fayllardan ausxa ko‘chiradi va ekranga gipermatnli
fayIni dastur imkoniyatlarining tavsifi, foydali ma’lumotlar manbalari
hagida gisqacha ma’lumotlar bilan chigarib beradi.

Dasturni ishga tushirish

Paket o'rnatilgandan keyin Windows bosh menyusiga Dream-
weaverni yuklash va unga tegishli fayllar maxsus boiimi qo‘shiladi. Har
ganday holatda ham dasturni yuklash buyrug‘i: Myck > porpammbl >
Macromedia > Dreamweaver MX ko'rinishida bo‘ladi.

Dasturni yuklashni bir nechta universal usullari mavjud. Bu bizga
oddiy Microsoft Office paketi dasturlaridan ham ma’lum.

Savol va topshiriglar:

1 Dreamweaver MX dasturini o‘rnatish ketma-ketligini aytib bering?
2. Dasturni o'zingiz Tmistaqil ravishda o‘rnating?

3. Dasturni ishga tushirish ketma-ketligini aytib bering?

4. Dasturni ishga tushirishning yana ganday usullari bor?

2.2. Interfeys. Dastur oynasi gismlari

Interfeys deganda informatikada dasturdagi turli komponentlar
va foydalanuvchi o'rtasiclagi oTaro alogani ta’minlovchi vositalar va
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goidalar yig'indisi tushuniladi. Dreamweaver paketi taklif etadigan
muomala usuli zamonaviy fbydalanuvchi uchun odatiy boTib qolgan
grafik oynali interfeys prinsiplariga asoslanadi. Dreamweaver paketi
o'slia sinfdagi boshga dasturlar bilan taggoslaganda ancha anig.
moslashuvchan va shu bilan bir paytda kuchli interfeys hisoblanadi.
Palitralar, ko‘p sonli klaviatnra kombinatsiyalari va menyu gatori uning
asosiy vositalari hisoblanadi. Barcha operatsiyalar to'xtatilgach ekranda
goladigan oynalarni palitralari (Palette) yoki panellar (panel) deb atash
gabnl gilingan. Ekranning maxsus ajratilgan pozitsiyaiarida emas, balki
ixtiyoriy joyida joylasha oladigan oynalar ko'chib yuruvchi palitralar
(floating plette) deb ataladi. Dreamweaver dasturi mulogot oynalarining
ko'pchiligi ko'chib yuruvchi palitralar ko'rinishida ishlaydi. Palitralar
va panellar orasidagi kichik farglar dasturni tavsiflash uchun sezilarli
ahamiyatga ega emas. Shuning uchun kelgusida bu ataraalarni
sinonimlar sifatida g o ‘llaymiz.

Deyarli barcha palitralar birlashish xususiyatiga ega. Bu har xil
palitralarni bitta mulogot oynasida joylashtirish mumkinligini bildiradi.
Birlashtirish amali turli mavzu yoki buyruglarga tegishli boshgaruv
vositalariga ega bo'lgan ko‘p funksiyali terma palitralarni olish
imkoniyatini beradi. Birlasliish jcususiyatiga ega boTgan palitralarni
(ular dasturda ko'pchilikni tashkil etadi) modulli (dockable) palitralar
deb atayrniz. Bir nechta alohida modullardan iborat murakkab palitralar
terma (tabbed) palitralar deb ataladi.

2.1-rasmda to'rtta ochig mulogot oynali dasturning tashqi ko‘rinishi
ko'rsatilgan. Boshgaruvning eng talab qilinuvchi vositasi so'zsiz,
Properties inspector (xossalar nazoratc hisi) palitrasi hisoblanadi. Uning
yordamida HTML sahifalarida obyektlarni formatlash va HTML
sahifasidagi obyektlarni tahrirlash bo"yicha ko'plab amallar bajariladi.
Behavieros (rejimlar) palitrasi —bu modul ko'chib yuruvchi palitraga
misol bo'ladi. Dreamweaver dasturi turli loyiha masalalarini hal gilishga
moTjallangan obyektlarga ega.

Rasmda ikkita oddiy modulli Layers va History palitralardan
iborat bo‘lgan terma palitraga misol keltirilgan. Objekts palitrasi
tashqi obyektlar: rasmlar. jadvallar, qatlamlar, freymlar va boshqa
obyektlarni go'yish uchun mo‘ljaUangan. Rasmda ko‘rsatilgan boshga
barcha boshqgaruv elementlari hujjat oynasining ajralmas tashkil etuvchi
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2.1-rasm. Dastur oynasining ko‘rinishi.

gismi hisoblanadi. Tes.nik tizimlarning ishonchli ishlashi. dasturiy
mahsulotlarni interfeyslarining qulayligi asosida to'g'n tashkil giiingan.
Dreamweaver paketi formatlash va tahrirlashning deyarli barcha
asosiy buyruglari uchun amalga oshirishning bir necha xil usullarini
taldif etadi. Keng formatli ekranlarning egalari barcha buyruglarni
palitralar va panellar yordamida bajarishlari mumkin. Bundan mahrum
foydalanuvchilarga esa dastur menyu qatori buyruglarini va klaviatura
tugmalari kombinatsiyalaridan foydalanishadi.
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Hujjat oynasi

Hujjat oynasi - bu gipermatnli hujjatlar yaratiladigan ish may-
doni hisoblanadi (2.2-rasm). U HTML sahifasi 0‘z ichiga oigan
matnlar, rasmlar, jadvallar, shakllar va boshga obyektlarni saglaydi.
Dreamweaver, WYSIWYG sinfiga kiruvchi tahrirlagich dastur
hisoblanadi. Bu uzun atama inglizcha What you see is what you
get (siz nimani kotayotgan bo'lsangiz shuni olasiz) iborasining bosh
harflaridan tuzilgan. Bu narsa HTML sahifasining hujjat oynasida
aks ettirilishi uning vanada ommaviyrog ko‘rib chigish dasturlari
- Microsoft Internet Explorer va Netscape Navigator brauzerlarida
ifodalanishidan uncha farg gqilmasligini bildiradi. HTML kodlari
bilan to‘g‘ridan-to"g“ri ishlash yuqori professionallik hisoblanishiga
garamay. hatto eng tajribali WEB-dizayner ham grafik interfeys va
W'YSIWYG rejimida hujjat yaratishda beradigan qulayliklardan voz
kecha olmaydi.

Ko‘pchilik Windows ilovalaridan fargli ularoq Dreamweaver dasturi
bitta dastur oynasida bir necha hujjatlar bilan ishlay olmaydi. Tanlab
olingan parametrlarni o'rnatishdan kelib chigib yangi hujjat dasturning
alohida oynasiga joy lashtiriladi yoki joriy oynada avval ochilgan hujjat
o'rniai egallaydi. Bunday ish rejimida dastur oynasi va hujjat oynasi
orasida deyarli farg y 0 ’g. Shuning uchun ham biz kelgusida bu nomlarni
sinonimlar sifatida ishlatamiz.

/£ Untitled Document (Untitled-1) - Dreamweaver Ne LU \
Fle Eit Miew insert Modify Jext Commends Site Window Help

Untitled Document Y, | 4?» i

<body> 447 X0 » 1K/ 1sec ei, lai il ® ©

2.2-rasm. Hujjat oynasi.
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Ish rejimlari

WYSIWYG rejimida gipermatnli hujjat yaratish oddiy matn mu-
harriri bilan ishlashdan ko‘p farg gilmaydi.

Matnni Kiritish va formatlashning bazaviy amallan, obyektlarni
joylashtirish buyruglari, navigatsiya va tanlash texnikasining barcha
amallari Dreamweaver dasturida so'nggi bir iiecha yil davomida
vizual muhitda ustunlik qilish usulida amalga oshirib kelinmoqda.
Fovdalanuvchi loyilialash yechimlarini HTML tili vositalari tomonidan
gandav yoclga qo'yilishi hagida o‘ylab o'tirmasdan tahrirlash va
formatlashning odatdagi vositalaridan foydalanib ishlashi mumkin.
Dreamweaver paketi dastlabki matnni avtomatik ravishda yaratadi,
unda hujjatning ma’lumot bilan toMdirilishi va ro‘yxatga olinishi bilan
gipermatnni belgilash «lining kodlari yoziladi.

Yaratuvchanlik ishining katta gismi WYSIWYG rejimida baja-
rilishi mumkinligiga garamay ba’zan to‘g‘ridan-tog‘ri kodlashga
murojaat qgilishga to'g’ri keladi. Buning bir nechta sababi bor. Asosan,
bu belgilash kodlarini juda ehtiyotkorlik bilan sozlash zarurligidir.
Bundan tashgari HTML tili standartida yuzdan ortiq deskriptorlar
hagida eslatib o'tiladi. Ularning har biri bir nechta atributlar va
modifikatorlarga ega bo‘lishi mumkin. Gipermatnli belgilashning
eng ko‘p talab gilinadigan vositalari Dreamweaver tizimi interfevsi
doirasida joylashtirilgan.

Dreamweaver dasturining hamma versiyalari. birinchisidan boshlab.
foydalanuvcliiga belgilash kodlarini to'g'ridan-to”ri tahrirlash imkonini
beradi. Bu ish uchun ganday vositalar goilaniladi?

Birinchidan, bu maxsus ichiga qurilgan Code Inspector (kodlar
inspektori) tahrirlagich bo'lib, u Dreamweaver dasturini eng bi-
rinchi versiyalarida ham mavjud edi va bu oxirgi versiyalarda vaqt
davomida fagatgina dizayniga o'zgartirishlar Kkiritildi. Ikkinchidan,
fovdalanuvchi HTML tiliga tashqi tahrirlagichlarni ulash imkoniyatiga
ega. Turli dasturlar: universal vazifali (masalan. Bloknot) oddiy matn
tahrirlagichlaridan boshlab. to murakkab gipermatnli hujjatlar bilan
ishlashga mo’ljallangan (Allaire Home Stile) yuqori darajali dastur
vositalarigacha bu rolni bajarishi mumkin. Dasturning MX versiyasida
juda qulay yangilik - hujjat oynasining ish rejimi paydo boTadi. Hujjat
oynasi uchta rejim yoki ko'rinishlardan birida bo‘lishi mumkin.
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1 him «Code Inspector
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(MpaBka </[FONT><d><FONT COLOR="#000000"">8.gt </fontx/IXFONT F/
B nto6om criyvae Ha akpaHe nosiBUTCA Ananorosoe okHo </[FONTxFOh
(HacTtpoiikn). </fontx/p>

<P>

P>

<p><FOMTFACE="Times New Roman" C01_OPY¥#000000"">BbInonHuTe BC
e 3TOMJNanoroBoM OKHe U BBefuTe UXB AeCTBME LLEe TYKOM Ha KHOMK
<p>

<FONTFACE="Times New Roman' COLOR=""#000000"">

<P ALIGN- DUSTIFY"">Paccm 0 TpUM 3T1 HacTpoiiku (puc. 2.23):</P>

2.3-rasm. Hujjatning belgili rejimida ko'rinishi.

2.3-rasin. Belgilash rejimidagi hujjat oynasi Code and View
(belgilash va rejalashtirish rejimi). Bu aralash rejiin bo'lib, unda hujjat
oynasi ikkita gismga boiinadi. Bir gismda gipermatnli belgilash kodlari
aks etadi, boshgasida dastur sahifani barcha obyektlar va formatlash
atributlari bilan rejalashtirishni ko'rsatadi. 2.4-rasmda bo‘sh sahifali
ajratilgan hujjat oynasi ko'rsatilgan.

Ish rejimini o‘zgartirishning bir necha usuli bor. Birinchidan, bu
menyu gatori buyruglari: View > Code, View —Design, View - Code
and Design. Ikkinchidan, uskunalar panelida bir rejimidan boshgasiga
tez o'tish imkonini beruvchi tugmalar bor. Va nihoyat, Ctrl + Tab
tugmalar kombinatsiyasi yordamida rejalashtirish rejimidan belgilash
rejimiga va aksincha, yoki ajratilgan oynaning bir gismidan boshgasiga
0‘tish mumkin.

Ajratilgan hujjat oynasi gismlarining oTchamlarini o’zgartirish
mumkin. Buning ucliun ko'rsatkich yordamida ajratuvchi chizigni
ko‘chirishkerak bo‘ladi. Oxirgi pavtlarda dasturchilar orasida «dastlabki
matn» atamasi paydo boidi. Yuqori saviyali dasturlash tilida yozilgan
dastur islilab chigishning dastlabki bosgichlarida shunday deb ataladi.
Bu atama gipermatnli hujjatning kodli gismi va ko‘rinadigan obrazi
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File Edit View Insert Modify lent Commands Site Window Help
4 is- tt) : Title: Untitled Docurent

|<heaci>

Ictit. le>Untitled Document</citle)

|<meta hllp-equiv="Content-Type" content="text/htitil; c;
:/head>

cbody bgeolor~"FFFFFF" te:-:t="#100000”>

2.4-rasm. Bo‘sh sahifali hujjatning aralash rejimda ko'rinishi.

o‘rtasida mavjud bo‘lgan munosabatlardan tashkil topadi. Hujjatning
HTML tilida yozilishini dastlabki matn deb ataymiz.

Menvu qatori

Menyu gatori - bu Windowsning ixtiyoriy ilovasining zaruriy
atributidir. U buyruglar yordamida, mulogot oynalariga, tugmalarga
yo‘l ochadi, wular yordamida hujjat yaratish, dasturni sozlash.
vizuallashtirish jarayonini boshqarish kabi dasturning barcha
funksional imkoniyatlarini o'z ichiga olgan samarali ishlar bajariladi.
Menyu qatorining har bir bandi vazifasi jihatidan bir-biriga yagin
kiritilgan menyu va kichik menyular ierarxiyasini hosil giluvchi
buyruglar guruhini birlashtiradi. Bti bandlarning gisqacha tavsifini
keltiramiz.

* File menyusi (Paiin) fayllar bilan bog‘liq buyruglarni, gipermatnli
hujjatlar shablonlari bilan ishlash, eksport qilish, import qilish va
brauzer dasturlaridako‘rish buyruglarini 0z ichiga oladi.

« Edit (MpaBka) tnenyusiga tahrirlash va gidirish bilan bog'lig
buyruglar kiradi.
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e View (Bug) menyusi interfeysning yordamchi elementlarini
va gipermatnli hujjat obyektlarining ko”rinishlari ustida ishlovchi
buyruglarni oz ichiga oladi.

* Insert (BctaBka) menyusiga har-xil obyektlarni import qilish
buyruglari kiradi: rasmlar. jadvallar, shakllar, gatlamlar. maxsus belgilar
va boshgalar.

* Modify- (M3meHuTb) menyusi 0'z ichiga gipermatnli hujjat
obyektlari atributlarini o ‘zgartirish buyruglarini oladi.

e Text (Tekct) menyusi matnli fragmentlarni hosil gilish va ularni
formatlash bilan bog‘lig buyruglarni oz ichiga oladi.

* Commands (KomaHgbl) menyusi gipermatnli hujjatlarni avtomatik
gavta ishlash buyruglarini o'z ichiga oladi.

» Menyu gatorining Site (Caint) boiimi sayt bilan ishlash vositalari
va gipermatnli hujjatlar bilan bog'lig murakkab tizimlar vositalarini 0‘z
ichiga olgan.

» Window (OkHO) menyusi dasturga tegishli palitralar, panellar va
mulogot oynalarini ornatish va aksincha olib tashlash bilan bog'liq
buyruglarni o'z ichiga oladi.

e Help (CnpaBka) menyusida dasturdan frydalanish hagidagi
interfaol ma'lumotlarni chagqirish, elektron go‘llanmani chagirish kabi
buyruglar j ovlashgan.

Uskunalar paneli

Uskunalar paneli dasturning asosiy dispetcherlik pulti vazifasini
bajaradi (2.5-rasm). U eng ko‘p ishlatiladigan buyruglar va tahrirlash
resurslarini chagirish tugmalarini birlashtiradi. Bu ixchamgina panel
kiritilgan rnenyu va kichik menyu lar tizimi navigatsiyasi bilan bog'liq
sarf-harajatlarni anchagina gisgartiradi.

Unda jovlashgan barcha boshgaruv elementlarini sanab o‘tamiz
(chapdan o'ngga):

* Code View (Pexum pasmeTtku) - gipermatnli hujjatning fagat
belgili kodlari tasvirlanadi (dizayni tasvirlanmaydi).

j Ju Lritle: Untitled Docurment | Q 4 {3, *SL,

2.5-rasm. Uskunalar paneli.



e Code and Design View (Pexum pasMeTKm W MNaHUPOBKMK).
Tugmasi bosilganda liujjat oynasi ikki gismga ajraladi: birinchi oynada
belgili kodlar beriladi, ikkinchi oynada esa gipermatnli sahifaning
dizayni. ya'ni tashqi ko'rinishi beriladi.

» Design View (Pexum nnaHupoBku). Dasturda ishlashning vizual
- WYSIWYG rejimiga o‘tish tugmasi.

» Title (3aronoBok) —bu matnli maydon hujjatning sarlavhasini
kiritishga mo!ljallangan.

» File Management (¥YnpasneHue caiinamu) - tarmoqda ma'lumot
almashish uchun xizmat giladigan fayllar bilan ishlash buyruglaridan
tarkib topgan menyuni ochish tugmasi.

» Preview/Debug in Browser ([pocmoTp/oTnagka B 6pay3e-
pe) - tugmasi gipermatnli hujjatni ko'rish va undagi Java Script
kodlarini tanlangan brauzerda ishlash yoki ishlamasligini tekshiruvchi
buyruglaridan iborat menyuni ochadi.

» Refresh Design View (O6HOBUTL cTpaHuuy) - bu buyruq beril-
gandan so ‘ng, hujjatning belgili matnlarida bo‘lgan barcha o'zgarishlar
loyihalash rejimiga uzatiladi. Ana shu vaqtda kodlarni interpritatsiyasi
va sintaksik tekshiruv boshlanadi. Xato fragmentlari sarig rangda
ko'rsatiladi. To'g'rilari esa sahifada tasvirlanadi.

» Reference (CnpaBka) - tugmasi elektron ma’lumotli go‘llanmani
ekranga chiqarib beradi. Bu qo'llanmada gipermatnli belgilash tili
deskriptorlari ifodalangan.

e Code Navigation (HaBuraumsa no kogam) - tugmasi Java Script
tilida yozilgan belgili kodlarni tuzatishni boshgaruv buyruglaridan
tarkib topgan menyuni ochadi.

* View Options (MapameTpbl o0TO6paXkeHns) - tugmasi hujjat
oynasining go‘shimcha elementlari vizualizatsiyasini boshgaruvchi buy-
ruglar menyusini ochadi. Bu menyuga asosiy menyu qatoridagi View
menyusining bir necha buyruglari kiradi.

Sahifalar o‘lchamlarini belgilash

Virtual to'plam hech ganday tartib-goidalarga va standartlarga
bo‘ysunmasdan, targoq holda rivojlanadi. Bu esa ishlab chiquvchilar
va dasturchilar uchun ko'p sonli giyinchiliklar manbai bo'lishi

76



«Internet almashuvi»ning juda tez o ‘sishi sabablaridan biridir. Aslida
saliifaga yoki saytni ishlavotganda muallif o'z asarini turli kompyuter
tizimlarida aks etishi mumkinligini yodda tutishi kerak. Agar u tashrif
buyuruvchilarini (foydalanuvchilarini) yo'qotishni istamasa, u holda har
xil oicharnli va har xil texnologiyalarni qoilovchi (elektron-nur trubka
bazasida boMishi shart emas) monitorlarda hujjatning aniq va gisqa
ifodalanishi hagida o‘ylab ko‘rish kerak.

Onlay nli hujjatlarni ko'rib chigishda brauzer oynasi oichamlarini
o‘zgartirishga majbur giluvchi boshga sabablar ham bor. Har bir savodli
inson o'gish tezligi boshga sabablardan tashqgari gator uzunligiga ham
bogriigligini tushunadi. Agar gatorlar biror me’yordan sezilarli farq gilsa
o'gilganning gabul qilinishi muralckablashadi. Psixologik tadgiqotlar
koisatish icha. matn qatorining optimal uzunligi alfavit simvollari
soni bilan uzviy bogliq. Qulay o'gish zonasini aniglash uchun alfavit
oichamini 15 dan 2 gacha giymatni gabul giladigan koeffitsiyentga
ko'paytirish kerak. Bu narsa rus tilida matn gatorlari 70 simvoldan
uzvin bo'hnasligini bildiradi. Ko‘p fovdalanuvchilai bunday formulaning
mavjudligi hagida o‘vlab ko‘rmaydiiar va xaddan tashqari uzun gatorlar
paydo bo‘lishining oldini olish uchun brauzer oynasining o‘lchamlarini
cheklab go‘yadilar.

Dreamweaver paketini yaratuvchilari dasturni turli oTchamdagi
monitorlarda hujjat ganday ko‘rinishga ega boTishini tasavvur gilish
imkonini beruvchi maxsus vosita bilan ta’minlab qo‘yganlar.

Holat gatorining o'rta gismida (2.2-rasm) hujjat oynasining joriy
olchamlari piksellarda chigariladigan maydon joylashgan. Birinchi
sor-kenglik giymatini, ikkinchi son balandlikni oTchamini ifodalaydi.
Agar maydonning ixtiyoriy nugtasida sichqoncha tugmasini bosilsa, u
holda Windows va Macintosh platformalarida hisoblash tizimlarining
eng ommaviy konfiguratsiyalari uchun vyettita standart oichamga
ega bo'lgan yetti mulogot oynasi chigadi. OTchamni belgilash uchun
oynaning tegishli gatorini tanlash yetarli.

Menyuning birinchi bandi hujjat sohasining 592 pikselga teng
bo'lgan kengligini belgilaydi va sohaning joriy balandligini o‘zgarishsiz
goldiradi. Edite Sizees (0‘lchamlarni to'glilash~ing oxirgi bandi
hujjat oynasining oichamlarini tanlash va ularni standartlar ro‘yxatiga
kiritish imkonini beradi. Ekranda Preferences (Sozlashlar) mulogot

77



oynasi paydo boiadi, unda Width (kenglik, eni) maydonida kenglik,
HEIGHT (balandlik) maydonda esa soha balandligi belgilanadi.
Yangi standartning matnli tavsifi Description (tavsiya) maydonida
ko‘rsatiladi.

Barcha oichamlar dastur oynasining xizmat elementlarini: o‘lchov
chiziglari va menyu gatorini inobatga olmasdan hisoblab chigiladi.
Fagatgina hujjat va uning obyektlari uchun ajratilgan ishchi soha
hisobga olinadi.

Palitra va tez yuklanish paneli

Tez ishga tushirish palitrasi (Launcher) — bu asosiy mulogot
oynalari va dasturlar panellarini ekranga chigarish uchun moijallangan
yordamchi, xizmatchi palitra. Palitrani aks ettirish uchun Windows >
Launcher buyrug‘ini bajarish kerak. Bu buyrugning takroran bajarilishi
palitrani ekrandan olib tashlaydi.

Palitraning Launcher (tez ishga tushirish) tugmasini bosish natija-
sida ekranga shu nomdagi mulogot oynasi chigadi. Agar ochilgan
palitra ekranning oldingi gavatida joylashgan boisa, buyrug tugmasini
takroran bosish uni yopilishiga olib keladi. Agar faol palitra hech
bo‘Imaganda gisman boshga obyektlar bilan to‘silgan bo‘lsa, u oldingi
gavatga o'tadi.

Palitra yettita eng ko‘p talab gilinadigan dastur komponentlarining
tez ishga tushirish tugmalarini birlashtiradi:

Site (Caiit) - katta saytlarni boshgarish uchun mulogot oynasi,
murakkab kesishuvli bogianishlarga ega gipermatnli hujjatlar tizimi
uchun moijallangan.

o Assets (bubnmoteka) - bu nom harfma-harf tarjimada faollar
yoki fondlar ma’nolarini beradi. Bu panel dasturda kutubxona rolini
o‘ynaydi. U gipermatnli hujjatlar dizayniga tegishli elementlarni o‘zida
saglaydi. Bu elementlarga: tasvirlar, ranglar, tashgi bogianishlar, Flash
-roliklari, shablonlar va boshqalar kiradi.

e HTML Styles (Ctmuam HTML) - bu palitra matnli gator va
abzatslar uchun HTML belgili stillar bilan ishlashga moijallangan.

* CSS Styles (KackagHble nucTbl ctuneit) - bu palitra stillarni
kaskadli sahifalar bilan boshgarish uchun xizmat giladi. Keyinchalik
bu jumlani «ierarxik stillar spetsifikatsiyasi» koTinishida ham
goilaymiz,.
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* Behaviors (Pexumbl) — palitrasi gipermatnli sahifalarni inter-
faolligini boshgarish vositalarini o'zida birlashtirgan. Senariy sahifani
ko‘rish jarayonida ro'y beradigaa hodisalar asosida quriladi. Bu
jarayonning chizmasida ko'plab interfaol effektlar yig'iladi: oddiy
animatsiyalashgan tugmalardan tortib ma’'lumotlar bazasini qayta
ishlashning murakkab protseduralarigacha.

« History (Mpeabictopusa) - palitrasi foydalanuvchining HTML
hujjatni tahiirlashdagi xatti-harakatlarini yozib boradi va saqlaydi.
Tahrirlash jarayonidagi operatsiyalarni bekor gilish imkonini beradi va
avrim zanjirli ketma-ketliklarni buyruq ko'rinishida saqlaydi.

+ Code Inspector (MHcnekTop Kopga). Dasturning eng muhim
palitralaridan biri. HTML kodining ichki tahrirlagichi boMib Dream-
weaverning grafikli rejimiga o'zaro bog'langan.

Tez ishga tushirish palitrasining o'ng tomondagi pastki burchagida
to'g'ri burchakli tugma jovlashgan. Bu vosita palitraning yo‘nalishini
o‘zgartirishga moTjallangan. Tez ishga tushirish palitrasini o‘zgartirish
mumkin. Bwiing uchun Edit > Preferences buyrug‘ini berish kerak.
Dasturning asosiy sozlashlariga ega bolgan mulogot oynasi ochiladi.
Unda Panels (panellar) kategoriyasini tanlab oling va palitra ichidagi
Show in Launche (tez ishga tushirish palitrasida kcrrsating) bo‘limida
beriladigan vositalar yordamida o ‘zgartiring. Holat qatorining o'ng
gismida (2.2-rasm) joylashgan.

Kontekstli menyu

Kontekstli menyu Windows operatsion tizimining boshlovchi
foydalanuvchilari uchun ham yaxshi tanish. Boshgaruvning bu
standart usuli ushbu operatsion tizimi boshgaruvida ishlovchi
ko‘pchilik ilovalar (dasturlar) tomonidan ko'p qoTlaniladi. Uning
mohiyati sodda. Sichgonchaning o'ng tugmasini hujjat oynasining
obyekti wustida bosilsa, ekranga obyekt turiga bogTiq bo'lgan
mazmundagi menyu chigadi. Bu inenyuda shu obyektga tegishli yoki
ushbu holatda talab gilinishi ko'proq ehtimolligi bor boTgan buyruglar
to'plangan.

Dreamweaver dasturining barcha versiyalarida kontekstli menyu
mavjud. Kontekstli menyuning o‘lchami ya'ni buyruglari safi kengaydi,
go'shimcha darajalarga ega bo'ldi va endi liar ganday holatda
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Paragraph Format
List

Align

Font

Style

CSS Styles

Size

Templates

Element View

Edit Tag <body>... Shift+F5
Quick Tag Editor...

Make Unk

Remov« Lir -

Target Frame

Create New Snippet

Paste Ctrl+Vv

Paste Special...

Design N otes for Page...

Page Properties...

2.6-rasm. Kontekstli menyu.

chaqirilishi mumkin. 2.6-rasmda oyna
ixtiyoriy bo"sh nuqtasida sichqgonchaning
o'ng tugmasi bosilsa dastur chigarib
beradigan kontekstli menyuga misol
keltirilgan.

Property Inspector palitrasi

Property Inspector (MHcnekTop
csoiicTs) palitrasi - bu dasturning aso-
siy  uskunasidir., HTML sahifasida
joylashgan obyektlar atributlarini o‘z-
gartirish  ishlarining asosiy qismini
uniag yordamida bajariladi. (2.7-rasm),

Property Inspector palitrasi kcfchib
yuruvchi palitradan iborat bo'Tib, uning
tarkibi bajarilayotgan operatsiyaga, tan-
langan obyekt turiga va kursorning
holatiga garab, mos ravishda o‘zgarib
turadi. Palitrani ekraiiga chigarish uchun
quyidagi Window > Properties (OkHO
> CaoiictBa) buyrugni berish yoki
CTRL+F3 tugmalar kombinatsiyasini
bosish kerak. Bu buyrugni qaytadan
berish palitrani ekrandan olib tashlaydi.

2.7-raam Property' Inspector palitrasi.



Palitraning asosiy maydonlari va tugmalarini sanab o‘tamiz.
Palitraning sliu boshgaruv elementlari matnni formatlash va gipermatnli
bog'lanishlarni hosil gilishga tegishli vazifalarni o‘z ichiga oladi:

* Formal (®opmart) ro‘yxati matnning standart strukturali tiplaridan
birini tanlash imkonini beradi (1).

e Link (Ccbinka) wushbu hujjatga tegishli giperbog‘lanishlar
ro'yxatini o‘zida saqlaydi. Har bir boglanishni bir necha marta qoTLash
mumkin. Ya'ni bir marta tuzilgan bog'lanishni, boshqga faol hududlarga
ham takror gollash mumkin (2).

* Matn fragmenti shriftini belgilash imkonini beradi. Bu ro'y-
xatning purktlari shriftlar to'plamidan iborat bo'lib. qo‘llanilishiga
garab joylashgan (3).

« Size (Pa3smep) ro'yxati shrift o'lchamini tanlash uchun mo‘l-
jallangan (4).

« Standart ranglar palitrasini chaqirish tugmasi. Bu palitra tan-
langan matnli fragment rangini tanlash imkonini beradi (5).

+ Tanlangan rangning kodi tasvirlangan yoki kiritiladigan maydon
(6).

 Shriftni holatini tanlash tugmasi. K o ‘rinishi va funksiyasi standart
boshqa dasturlardagidek (7).

* Matnni tekislash tipini tanlash tugmalari (8).

* Interfaol yordamni chaqirish tugmasi (9).

* Marker-ko'rsatkich. Uni tegishli fayl yoki simvolga surish bilan
gipermatnli bog'lanish hosil gilinadi (10).

e Select File (BbibpaTb ann) mulogot oynasini ochish tugmasi.
Fayllar tizitnida harakatlanish va gipermatnli bog'lanishlarni asosi
bo'lib xizmat giladigan hujjatni tanlash (11).

» Target (HasHauyeHume) ro‘yxati gipermatnli bogTanishda ko‘r-
satilgan hujjatni ekranda yuklanish usulini tanlash imkonini beradi. Shu
boTimda havolali hujjat chigish oynasi yoki freymni belgilanadi (12).

» Ko‘pchilik tahrirlagich dasturlarda standart ko'rinishda, matnli va
HTML, royxatlarni belgilash va nomerlash tugmasi (13).

+ List Item (Pasgen cnucka) tugmasi List Properties (CsoiicTBa cnu-
cka) mulogot oynasini ochish uchun ishlatiladi. Bu oyna barcha tipdagi
ro'yxatlarnitahrirlashga mo'ljallangan (14).

* Ikkita tugma, matnli fragmentlarni gorizontal surilishini bosh-
garadi (15).
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+ Kodlarni ekspress-tahrirlash oynasini chaqirish tugmasi (16).

+ Expander arrow (PacwwnpeHune) palitra o'lchamlarini o'zgartirish
uchun xizmat giladi. Uning yordamida Property Inspector (MHcnekTop
csoncTB) palitrasini ochish va yopish mumkin (17).

Property Inspector paneli yordamida bajariladigan buyruglarning
ko'pchiligi gayta ishlanavotgan obyektlar: rasm, matn yoki jadvallarga
tegishlilari paydo bo'ladi. Xossalar panelida harakatlanish uchun TAB
tugmasini bosish yoki kerakli gismga sichgonchani chap tugmasini
bosish kerak. Tanlangan boMimda kerakli ko'rsatkichni kiritib, ENTER
tugmasini bosish uni o'rnatilishi uchun yetarli.

Property Inspector paneliniag ko‘plab boshqaruv elementlari
o’zida matnli yoki ragamli maydonlar kombinatsiyasi va bekiladigan
ro‘yxatlaridan iborat. So‘ralgan giymatni klaviaturadan terish yoki
menyudan tanlash yoTi bilan tegishli parametrlarni o‘rnatish uchun eng
gulay usul hisoblanadi.

Dreamweaver opining bir gancha qo'shimcha funksiyalari bilan
foydalanuvchilarga manzur bo'ldi: birinchidan. Dreamweaver barcha
palitralari erkin holatda turadi. Ularni qayerga surib qgo'ysangiz
o‘'sha joyda joylasha oladi. Bu esa. monitorning ish maydoni xududini
boshgaruvning xizmatchi elementlari va hujjatning oynasiga eng
optimal bo‘lish imkonini beradi. Ikki monitorli tizimda ishlaydigan
foydalanuvchilar barcha yordamchi oyna va palitralarni bitta monitorga
joylab. ikkinchisida esa hujjatlar bilan ishlashi mumkin. Ikkinchidan.
dastur palitralari birlashish xususiyatiga ega. Uchinchidan, barcha
ochiq palitralarni dastur ish stolidan olib tashlovchi buyrug mavjud.
Bu operatsiyalarni F4 tugmasini bosish bilan ham bajarish mumkin. Bu
tugmani takror bosish esa yana tiklash imkonini beradi.

Obyektlar palitrasi

Fagatgina eng oddiy gipermatnli hujjatlar o'zida harola bo'yicha
boshqa hujjatlarga oTuvchi buyruglar biriktirilgan gipermatnli
fragmentlarni birlashtiradi. Amino ko‘pchilik zamonaviy HTML
sahifalari multimedialashib bormoqgda. Ya'ni ularning tarkibiga quyidagi
tashqi obyektlar kiradi: multimediali fayllar, ijro etish vositalari.
kartirxkalar, animatsiya fayllari va boshqgalar. Objects (MannTpa 06beK-
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2.8-rasm. Obyektlar palitrasi.

tob) palitrasi ana shunday tashqgi obyektlarni yaratish va go'yish uchun
xizmat giladi. Bu palitrani ekranga chigarish uchun Window > Objects
(OkHOo > OO6bekTbl) buyrug'ini bajarish kerak. Xuddi shu buyrugni
klaviaturadan CTRL -KF2 tugmalar kombinatsiyasini bosish bilan ham
berish mumkin. Bu buyrugni takror berish palitrani ekrandan olib
tashlaydi.

Palitra yettita nomdagi gismlardan iborat. Bular: Characters, Com-
mon, Forms, Frames, Head, Invisibles, Special.

* Characters (CneunanbHble cumsosbl). Klaviaturada uchramay-
digan maxsus simvollarni go'yish (savdo markasi, kopirayt va bosh-
galar).

e Common (O6wwne) - bo'limi eng ko'p qo’llaniladigan obyektlarni
birlashtiradi. Bu jadvallar, rasmlar, gorizontal chizg‘ich, joriy ka-
lendardagi sanalar va boshqalar.

* Forms (®opwmbl). Formalar va elementlar, ularning tashkil giluv-
chilari: yoqgib-o'chiruvchilar. ro‘yxatlar, matn maydonlari va boshqalar.

* Frames (®penmbl). Freymlar tizimini vyaratish. Har xil
ko'rinishdagi freymlar gismlaridan tarkib topgan freymlar tizmini hosil
gilish. Ya'ni yaratilayotgan saytni sahifasini freymlarga bo‘lib olish.

* Head (3aronosok) —gipermatnli hujjatning sarlavha gismiga tav-
sif berish.

* Invisibles (CkpbiTbie 06beKkTbl). HTML sahifani brauzer dastur-
larida namoyish qilishda, ko‘rinmaydigan yashirin obyektlarni joylash.
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Bu palitraning eng kichik gismi bo'lib, u fagat uchta tipdagi obyektlarni
go‘shib beradi: simvollari. izohlar va senariylar.

* Special (CneuwanbHble 06bekTbl) - bu bo’'lim o'zida maxsus
obyektlarni go‘yish tugmalarini birlashtiradi. Bularga appletlar. ActiveX
obyektlari /ma boshga tashgi to‘ldiruvchilarni (plagins) kiritish mumkin.

Palitraning pastki gismida ilcki guruhga bolingan to’rtta tugma
joylashgan: Layout (KomnoHoBka) va View (Bmg). Ular maketlash
rejimiga o‘tish va sahifannig strukturasini tezda yaratishga imkon
beradi. Bu elementlar bilan gisqacha tanishib o‘tamiz:

« Draw Layout Cell (Co3gaHne makeTHoN siveiikm) - maketli ka-
takcha yaratish uskunasini faollashtiradi.

* Draw Layout Table (Co3maHme makeTHOW Ta6bnuupbl). Maketli
jadval yaratish uskunasini faollashtiradi.

e Standard Vie>v (CtaHgapTHbIn pexum). Hujjat bilan ishlashning
standart rejimiga o'tish.

* Layout View (Pexum makeTuposaHusa) - Hujjatni maketlash reji-
miga o‘tish.

Ushbu bo‘limni nomi palitra sarlavhasi qatori ostida tasvirlanadi.
Bo‘limni o chish uchun shu nonini sichqgoncha chap tugmasi bilan
bosing. Oc hilgan menyudan foydalanuvchi kerakli gismni tanlashi
mumkin. Palitraning ayrim bo'limlarida hamma tugmalar ham
tasvirlanmaydi. Masalan, Common (O6wme) bo’'limi yigirmaga yaqin
tugmani o':z ichiga oladi, ularning hammasi ham palitra oynasiga
sig‘maydi. Boshqga tugmalarni ko'rish uchun prokrutkadan foydalanish
(prokrutkan i vazifasini palitraning chetida joylashgan strelkali tugmalar
bajaradi) yoLi mulogot oynasining o‘lchamini kattalashtirish kerak.

Aksariyat hollarda obyektlarni go‘yish uchun qo'shimcha para-
metrlarni kiritishga to'g'ri keladi. Bunday holatlarda ekranda foy-
dalanuvchi tanlashi yoki ma’lumot kiritishi mumkin bo'lgan mulogot
oynasi paydo bo‘ladi. Bu oynaga foydalanuvchi obyektning kerakli
obyektlarini tanlashi yoki kiritishi kerak.

Kodlar nazoratchisi bilan ishlash

Ko'p sorxli HTML tahrirlagichlari sinfi orasida Dreamweaver dasturi
gipermatnli hujjatlar kodlari bilan ishlash imkoniyatlari jihatidan keskin
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farq giladi, Foydalanuvchining HTM L kodlarni go‘lda tahrirlashdan
qutilishi eng katta yutuq va tezkorlikni taTninlab berdi.

Kodlar bilan to'g ‘ridan-to‘g‘ri ishlash, yashirin xatolarni iden-
tifikatsiya qilish, ortigcha kodni bartaraf etish, gipermatnning
tanlangan fragmentiga tezkor o'zgartirish kiritish, hujjatning struk-
turasini yoki uning formatlanishini optimallashtirish imkoniyatlari
mavjud.

Dream”veaver paketi tarkibida gipermatnli hujjatlarni belgilash
kodlarini koTish va tahrirlashga mo‘ljallangan maxsus vositasi mavjud.
Bu vosita Code Inspector (MHcnekTop koga) deb nomlanadi. Uni
quyidagi usullar bilan o‘rnatish mumkin: birinchidan, Window > Code
Inspector (OkHO > MHcnekTop Koga) buyrug‘ini berish yo'li  bilan,
ikkinchidan. bu F10 tugmasini bosish yoTi bilan. Bu buyruglar takror
bosilganda Code Inspector yana ish stolidan yo‘qoladi.

2.9-rasmda Kodlarni nazorat gqilish oynasi koTsatilgan. Palitrada
kodlarning belgilanishini tanishtirishni View Options (IMapameTpbl 0TO-
6paxeHuns) tugmasi yordamida ochiladigan buyruqglar boshgaradi. Bu
buyruglarni ko‘rib chigamiz:

1 him - Code Inspector th. iy
Ik ¥ Code Inspector) ©
w, x {i, cL
act 1 1llLc> i
</HEAD > 3
<body background=/FON.JPG>
<ul>
divj<o><font face="Ti mes New Roman CYR" size=3xa href="#1">2. C
03aaHue web-y3na</‘a></font></b>
Jli>
<ul>
<lixfontface="Times New Roman CYR" size=3><a href="#2*>2.1.
MpoekTHpoBaHWe</e> ></ffont>
<ul>
<lixfont face="Times New Roman CYR" size=3><a. hret=#3">C

2.9-rasm Kodlar nazoratchisi.



* Word Wrap (MepeHoc no cnosam). Kod gatorini ko'chinsh rejimi.
Agar u yogilgan bo'lsa, HTML tili bayonnomasi tahrirlagich oynasining
o'lcharniga yetganda avtomatik ravishda yangi gatorga cftadi.

* Line Numbers (Homepa cTpok) - nomerlashni o‘rnatish buy-
rug‘i. Agar bu rejim o‘rnatilgan bo‘lsa, har bir gator tartib bilan
nomerlanadi.

* Highlight Invalid HTML (MomeTka HeKOpPPEKTHbIX KoAOB). Bu
buyruq sintaktik xatoga ega konstruktsiyalarni Property Inspector
panelida va hujjatning oynasida sariq rangda ajratish rejimini faol-
lashtiradi. Shundan so‘ng Property Inspector xato hagida xabar beradi
va ayrim hollarda uni tuzatish uchun ko'rsatmalar beradi.

* Syntax Coloring (Packpacka CUMHTaKCU4YeCKUX KOHCTpyKumMs). Bu
rejimda belgili kodlar turli xil ranglarga ajratiladi. Bu esa hujjatning
kiritiladigan matni va belgili kodlarini tez ajratib olishga imkon
beradi. Bundan tashqgari Dreamweaver dasturi HTML tilining har bir
deskriptori uchun alohida rang belgiksh imkoniyatiga ega. Ranglarni
belgilashning dastur asosiv ko'rsatkichlarini Code Colors (LiBeTa koga)
boTimida axnalga oshiriladi.

* Auto Indent (ABTOMaTuueckmini oTcTyn) buyrug'i kodlar na-
zoratchisi oynasiga Kkiritilgan belgilash diskreptorlari uchun avtomatik
joy goldirisli rejimini faollashtiradi.

Kodlar nazoratchisi oynasining o’'ng gismida uchburchak formada
tugma joylashgan. U hujjatning mavjud matnlariga xizmat qiladigan
buyruglardan iborat menyuni chaqgiradi. Bu buyruglarni sanab o'tamiz:

* Find and Replace (Halitu n 3ameHuTb). Qidirish va almashtirish
vazifasini bajaradi.

* Find Next (Halitu panee). Avval qidirilgan namunani mavjud
parametr asosida qidirish. Buiida qidirish va almashtirish muloqot
oynasi chigmasdan to‘g‘ridan-to‘g‘'ri amalga oshiriladi.

+ Reference (CnpaBouHoe pykoBogctBo). HTML, JavaScript va CSS
manbalari asosidagi maTumotli gollaninani chagiradi.

+ Set Breakpoint (BcTaBMTb KOHTPO/IbHYK TO4Ky). Matn kursori
pozitsiyasid a nazorat nuqtasini belgilaydi.

* Remove AIll Breakpoint (YpansiTb BCe KOHTPOJibHble TOYKMW).
Hujjatning mavjud matnidan barcha nazorat nuqtalarini olib tashlaydi.

* Cut (BbipesaTb). Tanlangan kodli fragmentni buferga qirqib olish.
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* Copy (Konumposatb). Tanlangan kodli fragmentni nusxasini bu-
ferga olish.

» Paste (BcTtaBnTb). Buferga olingan fragmentni go'yish.

Kodlar nazoratchisini matn muharriri uchun biroz g‘ayri oddiy
holda muvaffagiyatli qo'llash mumkin. Dreamweaver dasturi ASCII
simvollarini qo'llash bilan yozilgan fayllarni, masalan oddiy matnli
fayllarni yoki dasturning dastlabki matnini muvaffagiyatli o'qgiydi.
Bunday hujjatlar Open (OTKpbITb) buyrug‘i yordamida ochiladi va kodli
rejimda ishlaydigan oyna hujjatiga yuklanadi. Bunda dasturning ba’zi
resurslariga kirish mumkin bo‘lmay goladi.

Dasturning kutubxonasi

Kutubxonalar —bu gipermatnli sahifaning dizayniga tegishli ko'p
marta goMlaniladigan elementlarni saglash vositasidir. Bu elementlarga:
tasvirlar. bog'lanishlar. matn bo’laklari va boshqgalar kiradi. Dream-
weaver dasturida esa kutubxonaning ishlash prinsipi biroz boshqgacha.
Dastlab kutubxonaga saglashning bitta elementi hisoblangan,
obyekt yoki obyektlarga tegishli gipermatnli belgilash fragmentlari
saglanadi. Dreamweaver dasturida kutubxona elementlari maxsus
Library papkasida saqglanadi. Bu papka saytning asosiy papkasi ichida
joylashadi. Har bir Web-uzel o‘zining standart elementlari va ularni
saglash papkasini tashkil giluvchi shaxsiy kutubxonasiga ega. Ular bilan
ishlash uchun palitraning Assets (Pecypcol) bo'limidan foydalaniladi
(2.10-rasm). Kutubxonalar bilan boshgarish ishlarining asosiy gismini
palitraning Assets (Pecypcbl) bo'limi buyruglari yordamida amalga
oshiriladi.

Dreamweaverda kutubxonalarning asosiy imkoniyatlarini sanab
o'tamiz:

+ Kutubxona elementi deb <body> deskriptori orasida yotgan har
ganday fragmentni aytish mumkin;

» Kutubxona elementlari qo‘llanilishida cheksiz imkoniyatlarga
ega. Ularni gipermatnli sahifalarga hech qanday tahrirlashsiz go'yish
mumkin:

+ Kutubxona elementlariga o‘zgartirish Kiritilsa. ularni boshga
gipermatnli sahifalar va hujjatlarda qoMlashda saqlanib qoladi.
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Assets fc* Site"!”
Reference (5 Assets] ’
m Horay
YN s sablarkUnrigitem
To et started, didkthe Lar Editbuttonadadd conternt.

4 *
Wi
Name Size FUl Path
B 1 1KB /Library/1 |k
_n 2 1 KB yLibrary/2-bi
S 3 OKB /Librat3i/3.Ibi
[L
M. v CYB LU L\

2.10-rasm. Palitraning Assets bo'liini.

+ Sahifalardagi kutubxona namunasi va uning nusxalari orasidagi
alogani uzishga ruxsat etiladi.

+ Dastur alohida saytlar o‘itasida kutubxona elementlaritii almashish
buyrugqlariga ega.

* Kutubxonalar dinamik xususiyatga ega bo'lgan obyektlarni
saglash xususiyatiga ega.

* Vaqt diagrammalari (timeline) va stillarning kaskadli sahifalari
kutubxonada saglanishi mumkin emas.

Holat gatori Ta uni o‘rnatish

Status Sar (Ctpoka coctosfHMA) bti kichik bo‘lim dasturning holat
gatori ko'rinishi ko'rsatkichlarini belgilaydi (2.11-rasm). Bu element
hujjat oynasining pastki gismida joylashgan. Odatda bu qatorda
joriy oyna o ‘Ichami haqidagi ma’lumotlar va uning yuklanishi uchun



Status Bar

Window Sizes: Width ~ Height | Description

600 300 (640x480, Max...
760 420 (800 x 600, Max...
795 470 (832 x 624, Max...
955 600 (1024 x 768, M..

544 378 (WebTV)

c 1 v

Connection Speed: {28.3 «*] Kilobits per Second

Launcher: W Show Launcher in Status Bar

2 .11-rasm. Status Bar bo‘limi.

ketadigan vaqt ko ‘rsatiladi. Undan tashgari holat gatorining o‘'ng gismini
tezyuklanish paneli egallaydi:

Window Sizes (Pa3smepbl o0kHa). Gipermatnli sahifalar har xil
o‘lchamdagi oynalarda tasvirlanishi mumkin. Window Sizes (Pa3s-
mMepbl OkHa) paneli standart oMchamlar ro‘yxatini toidirish uchun
moijallangan. Barcha tahrirlash amallari klaviaturadan shu panelning
tegishli maydonlariga kiritish yordamida bajariladi.

Connection Speed Kilobits Per Second (CkopocTb coeAuMHeEHMS,
Kéut/c). Bu maydonga server bilan bogianishning taxminiy tezligi
kiritiladi. Bu joriy sahifani taxminiy yuklanish vaqtini belgilaydi.
Odatda 28.8 Khit/s tezlik o‘rnatilgan boiadi.

. Show Launcher in Status Bar (IMaHenb 6bICTPOro 3anycka B
cTpoke cocTosiHuA) bu bayroqcha tez yuklanish panelini holat gatorida
chiqgishini boshqaradi.

Savol va topshiriglar:

1. Dreamweaver dasturida kodlar bilan ishlashning ganday imkoniyatlari
bor?

2. Kodlar nazoratchisini o‘rnatish usullarini sanab bering?

3. Kodlar nazoratchisi nima va uning vazifalari nimalardan iborat?

A Dastuming kutubx.onasi nima?



2.3. Fayllar bilan ishlash

Dastuming fayllarni ochish texaikasi Windows tizimida ishlaydigan
boshga dasturlardan fargi yo‘q. Buning uchun File > Open (®aiin
> OTKpbITb) buyrug‘ini berish kerak. Bu buyrugni klaviaturadan
CTRL+O tugmalar kombinatsiyasini bosish bilan ham bajarish mumkin.
Bundan tashqari dasturda fayllarni ochishning surib kelish usuli ham
mavjud. HTML fayl belgisini sichqoncha yordamida surib kelib, liujjat
oynasining ixtiyoriy yeriga tashlansa fayl ochiladi. Dasturda bir vagtda
bir nechta oyna bilan ishlash imkoniyati fagatgina kompyuterning bo'sli
xotirasi bilan mos ravishda cheklanadi. Agar dasturda bo’sh sahifa bilan
ish boshlangan bolsa, u holda vangi fayl har ganday holatda uni oTnini
egallaydi.

Drearnweaver dasturi ochiladigan HTML sahifalarida sintaktik
xatolarni tekshiradi. Dastur standart HTML gipermatnli belgilash
tili asosida yozilgan barcha kengaytmali fayllarni ocha oladi. Ularga
quyidagilar kiradi: .HTM, .HTML, .ASP, .CFM. .CFML, .TXT, .SHTM,
SHTML, .STM, .LASSO, XML. .CSS. .PHP.

Fayllarni saglash

Dreamweaverda fayllarni saglash ham Windows tizimining boshqga
standart dasturlaridagi singari amalga osbiriladi. Buning uchun: File
> Save (®anin > CoxpaHuTb) yoki File > Save as (®arin > CoxpaHUTb
Kak) buyruglarini berish kerak. Birinchi buyrugni CTRL+S tugmalar
kombinatsiyasini bosish bilan ham bajarish mumkin. Bu buyruq
shu nomdagi mulogot oynasini hosil giladi. Oynada foydalanuvchi
tomonidan fayining nomi, tipi va saqlash joyi belgilanadi.

Gipermatnli hujjatlar fayllari Windows operatsion tizimida .htm
kengaytma oladi, Macintosh platformasida esa .html kengaytma oladi.
Ammo bu kengaytmadagi fayllarni dasturlarda ochish va saglash
buyruglari bajarilishi teng kuchli. Dasturda ochilishi mumkin bo'lgan
barcha tipdagi faydlar. xuddi shu dasturda saqglanadi ham.

Tabiiy sharoitda yoki ilmiy laboratoriyalarda o'tadigan ko!pgina fizik
jarayonlar gaytmas hisoblanadi. Bu tabiatshunoslikda olamning butun
ilmiy manzarasini shakllantiruvchi fundamental qoidalaridan biridir.
Zamonaviy hisoblash mashinalari insoani bu falsafiy kategorivadan
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gisman qutqarishga qodir. Ko'pchilik zamonaviy dasturlar qonigarsiz
natijani bekor gilishga imkon beradi. Ya'ni hujjatning avvalgi holatiga
gavtish. qgabul gilingan qarorlarni gadamba-qadam orgaga qaytarish
inikonini beradi.

Dreamweaver dasturida buning uchun Edit > Undo (lMpaBka > OT-
mMeHa) buyrug‘ini bajarish yoki CTRL+Z tugmalar kombinatsiyasini
bosish yetarli.

Dastur bekor gqilishni bir nechta o‘zaro bog'langan ketma-ket
gadamda amalga oshiradi. Bu ketma-ketlik gadamlarining soni
dastuming tegishli ko‘rsatkichida ifodalangan songa teng: odatda bu
son IOC ga teng.

Bu sonniquyidagicha o‘zgartirish mumkin:

1. Edit>Preferences (MpaBka>HacTpoiikun) - buvrug'ini bering;

2. General (O6wue) kategoriyasini oching;

3. Maximum N umber of History Steps (MakcuMmanbHOe 4unCNO
3anmcein xypHana) maydoniga o0‘zingiz saglamoqchi bo‘lgan ketma-
ketliklar maksimal sonini Iciriting.

Tahrirlash ishlari va buymaqlarini yozish va saqlash foydalanuv-
chidan go'shimcha Hisoblash manbalarini talab giladi.

Undo (OtmeHa®) buvrug'i  «eng muhim izlarni» bekor giiish
imkoniyatini beradi. Ammo bu usul bilan jarayonni bir necha bor
bajarib «bekor giiish» buyrug'idan yaxshi natija olib boimaydi. Chunki
uning yordamida fagatgina eng muhim izlarni bekor giiish mumkin
xolos. Bundan tashgari, ayriin buyruglarni bu usul bilan bekor qilib
bo'Imaydi. Bekor qilib bo'Imaydigan buyruglarni orgaga qaytarish
yoki ancha oldin bajarilgan operatsiyalarni gaytarish uchun File >
Revert (®alin > BepHyTbCcA K coxpaHeHHoMY) buyrug‘idan foydalanish
mumkin. Bubuyruq hujjatni ojcirgi saglangan holatini tiklab beradi.

Buyrugni ishlatish yo‘li oddiy. Qaytarib bo'Imaydigan buyruglar
niavjud ketma-ketlikni tiklashga berishdan oldin hujjatni diskka saglab
olish kerak. Agar isln yaxsh i natija bermasa, u holda Revert (®ann > Bep-
Hy TbC/1 K cOXpaHeHHOMY) buyrug'i hujjatni o‘sha holatida tiklab beradi.

Dasturda bajarilgan  operatsiyalarni takrorlash ham mumkin.
Edit > Redo (paska > TloBTopnTb) buyrug'i oxirgi buyrugni yoki
tahrirlash ishlarini takroran bajaradi. Bu buyrugni CTRL+Y tugmalar
kombinatsiyasi yordamida liam berish mumkin.
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gisman qutgarishga godir. Ko'pchilik zamonaviy dasturlar gonigarsiz
natijani bekor gilishga imkon beradi. Ya’'ni hujjatning avvalgi holatiga
gaytish. gabul gilingan gqarorlarni gadamba-gadam orgaga gaytarish
imkonini beradi.

Dreamweaver dasturida buning uchun Edit > Undo (IMpaBka > OT-
meHa) luyrug‘ini bajarish yoki CTRL+Z tugmalar kombinatsiy~asini
bosish yetarli.

Dastur bekor qilishni bir nechta o‘zaro bogiangan ketma-ket
gadamda amalga oshiradi. Bu ketma-ketlik gadamlarining soni
dasturning tegishli ko‘rsatkichida ifodalangan songa teng; odatda bu
son 10Ogateng.

Bu sonni quyidagicha o‘zgartirish mumkin:

1. Edit>Prefeiences (MpaBka>HacTpoikn) - buyrug‘ini bering;

2. General (O6wue) kategorivasini oching;

3. Maximum Number of History Steps (MakcMmanbHOe 4YUCAO
3anuceil xypHana) maydoniga o‘zingiz saglamoqchi bo4gan ketma-
ketliklar maksimal sonini kiriting.

Tahrirlash ishlari va buyruglarini yozish va saglash foydalanuv-
chidan go'shimcha hisoblash manbalarini talab giladi.

Undo (OTmeHa) buyrug'i «eng muhim izlarni» bekor qilish
imkonivatini beradi. Ammo bu usul bilan jarayonni bir necha. bor
bajarib «bekor qilish» buyrug'idan yaxshi natija olib boTmaydi. Chunki
uning yordamida fagatgina eng muhim izlarni bekor gilish mumkin
xolos. Bundan tashqgari, ayrim buyruqglarni bu usul bilan bekor qilib
boTmaydi. Bekor qilib boiinaydigan buyruglarni orgaga gaytarish
yoki ancha oldin bajarilgan operatsiyalarni qaytarish uchun File >
Revert (®alin > BepHyTbCs K coxpaHeHHOMY) buyrug‘idan foydalanish
mumkin. Bu buyrug hujjatni oxirgi saglangan holatini tiklab beradi.

Buyrugni ishlatish yoli oddiy. Qaytarib bo'lmaydigan buyruglar
mavjud ketma-ketlikni tiklashga berishdan oldin hujjatni diskka saqlab
olishkerak. Agar ish yaxshi natija bermasa, u holda Revert (bann> Bep-
Wi1TbCA K coxpaHeHHOMY) buyrug‘i hujjatni o‘sha holatida tiklab beradi.

Dasturda bajarilgan operatsiyalarni takrorlash ham mumKkin.
Edit > Redo (MpaBka > [MoBTopuTb) buyrug‘i oxirgi buyrugni yoki
tahrirlash ishlarini takroran bajaradi. Bu buyrugni CTRL+Y tugmalar
kombinatsiyasi yordamida ham berish mumkin.

a



Shimi esda tutish kerakki, dasturning ish bayonnomasiga fagatgina
natijaviy operatsiyalar yoziladi, masalan: simvollarni Kiritish va
o ‘chirish, obyektlarni qgo'yish, formatlash buyruglari va boshgalar.
Fagat shunday holatlarni bekor qilish yoki takrorlash mumkin. Ko’plab
yordamchi tipdagi buyruglarni bekor gilib yoki takrorlab bo'Imaydi.
Kursorni surish. obyektlarni belgilash, hujjatni saglash va boshgalar
shular jumlasidan.

Savol va topishiriglar:

Dasturda fayllarni ochish yo'llarini sanab bering?

Dastur yordamida ganday kengaytmali fayllarni ochish mumkin?
Dasturning fayllarni saglash usullarini aytib bering?

Dasturning bekor gilish va takrorlash imkoniyatlarini sanab bering?

PoN -

2.4. Web-uzel yaratish

Jahon o‘rgimchak uyasining (World Wide Web) barclia informatsion
manbalarini ikkita katta sinfga boiish qabul gilingan: sahifalar va
uzellar yoki saytlar. Biz yuqorida web - sahifalar ta%ifi bilan tanishdik.

Web-uzellar ya'ni saytlar - deganda o;ziga sahifalami birlaslitirgan
tizim tushuniladi. Boshgacha aytganda uzel deganda minglab hujjatlarni
o‘zida birlashtirgan, ko'psonli bog‘lanishga ega. maltimediali murakkab
tizim tushuniladi.

Dreamweaver paketi - bu ko'p qgirrali dastur. Uni alohida sahifalar
yaratish uchun oddiv gipermatnli hujjatlar tahrirlagichi sifatida ham
ishlatish mumkin. Bundan tashqari dastur har ganday murakkablikdagi
Web-uzellarni ham yarata oladi.

Chizigli struktura

Kompvuter paydo bolgunga gadar barcha chop etiladigan: badiiy
kitoblar, go'llanmalar, ma'lumotnomalar. texnik koTsatmalar chizigli
strukturaga misol bo'la olar edi. Bugungi kunga kelib bularni multimediali
go'llanmalar va elektron ko'rsatmalar ko'rinishida qo'llanmoqda.
Chizigli zanjir elektron rnagazinda buyurtma berishni rasmiylashtirish
gadamlari, ayrim tarmoq manbalariga kirish uchun ro‘yxatdan oltish yoki
rasmiylashtirish ketma-ketliklarini tushunish mumkin.
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2 .12-rasm. Chiziqii struktura.

Chizigli strukturaga kirish nuqgtasi bo'lib birinchi sahifa xizmat
giladi. Bu bosh sahifa odatda index.htm yoki main.htm deb nomlanadi.
Bu esa kitob yoki jurnallardagi mugova rolini bajaradi. Bu sahifa bir
vaqtning ozida ham namoyish bob, ham tanishtiruv sahifasi. ham
maMumotli sahifa bo‘Imog‘i lozim. Qidiruv mashinalari har bir sahifani
alohida indekslaydi. Shuning uchua barcha ichki sahifalarni bosh
sahifaga olkazadigan harakatlanish tugmalari bilan to‘ldirish kerak.

lyerarxik struktura

Saytlar yaratishning zanjirli prinsipi sahifalar joylashuviga va ular
orasidagi bir-biriga o’'tishlarga qat'iy cheklashlar qo‘yishga asoslanadi.

2.13-rasm. lyerarxik struktura.



lyerarxik bcfysunish prinsipi bo'yicha qurilgan tugunlar ancha katta
moslashuvchanlikka ega. Ko‘plab korxonalar, tashkilotlar lyerarxik
struktura chizmasi asosida qurilgan. Bu esa lyerarxik strukturaning
kamchiliklari va yutuqlari yaxshi o”ganilganidan darak beradi. Bu
strukturani ba'zan daraxtsimon struktura ham deyilib. bitta bosh o'zak
(butun saytga kirish nuqtasi hisoblangan) sahifaga egabo'ladi.

Har ganday ichki sahifa jnformatsion manba hisoblanib bosh sahifa
bilan mantiqiy bog'langan bo'ladi.

Ko'p bog‘lanishli struktura

Ko'p bog'lanishli strukturada hech ganday cheklanishlar bo‘lmaydi.
Ya'ni har bir sahifa boshga barcha sahifalar bilan bogMangan bo’lishi
kerak. Katta saytlarda tashrif buyuruvchilarning mo'ljal olishi uchnn
maxsus indeksatsiyatizimlariyoki saytning aylanish kartasi ifodalanishi
kerak.

- \Y i - i -

2.14-rasm. Ko'p bog'lanishli struktura.

Materialning tagsimoti

Materia_Ining Web-uzelda bo’'limlar bo'yicha tagsimoti mantigiy
ravishda amalga oshirilishi kerak. Har bir sahifaga faqat belgilangan
predmet yoki mavzudagi material joylanishi kerak. Tanlangan
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gipermatn ostida aynan shu inavzudagi hujjat borligi foydalanuvchining
ishonchini yanada orttiradi. Ayrim hollarda buning aksini, ya'ni
tanlangan gipermatnga xos bo'Imagan hujjatning ochilishini ham ko'rish
mimkin.

Saytai gismlarga boiishda ham ma’lumotning katta-kichikligiga,
malum mavzu yoki predmetga xosligiga garab boiish ham magsadga
jnwofiqdir. Yuqorida aytilgandek biror sahifada bir predmet yoki
mavzuga xos bo’lgan matnlar bilan birga, rasmlar, jadvallar, ani-
matsiyalar va boshga ko'rinishdagi materiallarning ham shu bo‘limga
xosligi katta ahamiyatga ega. Ma'lumotlarning mos kelmasligi foyda-
lamvchilaming ishonchini yo ‘qotib. ularning sonini keskin kamaytirib
yuboradi. Bunday holatga tushib qgolmaslik uchun Web-dizaynerdan
guat bilan ishlashni talab qiladi. Agarda tayyorlanavotgan saytdagi
inateriallar Web-dizaynerga notanish mavzuda bo'lsa, u holda o'sha
sohadagi biror yetuk mutaxassis bilan hamkorlikda ishlashga to"g"ri
keladi.

Web-saytlarni internetga joylash uchun manzil berish

Saytlargainternetda manzil berish uchun URL (Uniform Resource
Locator) deb nomlanadigan ibora qo'llaniladi. URL-internetga mu-
rojaat gilishning eng oddiv usuli boMib. u manzilni ifodalaydi. URL
manzilidan ixtiyoriy sondagi foydalanuvchi bir vaqgtning o'zida
foydalanishi inumkin. URL manzili gat'iy format asosida yoziladi (2.15-
rasm).

MpoTtokon: //xocT :nopT /nyTb/hannn #dDparmMeHT

2.15-rasm. URL manzili strukturasi.

Manzilni to‘'ligroq tushunish uchun quyidagi misolni ko‘rib chi-
ghainiz:
http ://wwxv.pedagog. uz/index. php

bu URL manzili tarkibiy qismlari quyidagicha:

http — resursdan foydalanishda gipermatn bayonnomasi ishlati-
layotganini bildiradi.
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www.pedagog.uz - ma'hmotlar joylashgan Internet sayt nomini
bild iradi.

Index.ph p - faylning kompyuterdagi tolla noniini bildiradi.

IVlanzilning asosiy tashkil giluvchi larini ko'rib chigamiz:

* MpoTokon - bayonnoma. Internet - mijozlari va serverlarinilig
bog~lanishi usulini tavsiflovchi gism. Odatda http (HyperText Transfer
Protocol) gipermatnli uzatish maxsus bayonnomasidan foydalaniladi.
Manzil kichik lotin harflari biian yoziladi (http://).

* Wms cepsepa. Blinda joylanadigaii ma'lumotlarni saglaydigan
hisoblash tizimining (bu hisoblash tizimini server deb nomlash gabul
gilingan) nomi ko'rsatiladi. Serverga berilgan ta'rifda ham - tarmoq
ishini nazorat qgiluvchi kompyuter deb aytilganligi bejiz emas. Server
nomi domen nomi kabi wvw bilan yoki usiz yoziiishi mumkin.
Masalan, www.macroinedia.com. Boshgacha usulda nomni IP —adres
ko'ri nishida ifodalash mumkin Masalan, 199.227.52.143.

* [TopT. Port ragamini ko'rsatisli bitta serrer ichidagi jarayonni
adresatsiya qilish uchun talab etiladi. Biroz vaqtdan keyin port
ishlatiladi va uning ragamini tushirib goldirish mumkin.

- MyTb nowucka. Kataloglar va ostki kataloglar zanjiri, faylning
joylashgan o'rnini belgilaydi. Bu zanjirning elementlari «/» simvoli
bilan ajratiladi.

e ®ann. Faylning nomi uning kengaytmasi bilan birga yoziladi
(fagat kengaytma so'ralgan platformada). Agarda faylning nomi tushirib
goldirilgan boisa, u holda Web-brauzer ko‘rsatila.digan faylni gidiradi.
Brauzer reaksiyasi va uning keyingi harakatlari faylning nomini
kengaytirishga bog‘liq bo'ladi. Masalan, grafik fayllari GIF yoki JPG
koTish dasturiga tasvirlarning yuklanishini boshlab beradi. Arxiv
fayllar (ZIP, RAR va boshgalar) bilan uyg'unlashgan kengaytmalar -
mijoz kompyuterida faylning saglanishini boshlab beradi.

e OparmeHT. URL adresining fakultativ gismi. U U (panjara)
maxsus simvoli bilan boshlanadi. Bu belgi gipermatnli hujjatning
lavhasini ajratib ko‘rsatuvchi maxsus belgidir. Tarkibga go‘shib go'yish
simvoli nomining Kiritilishi butun sahifaga emas, balki uning ma’lum
bir gismiga murojaat qilish irakonini beradi.

http bayonnomasi bo'yicha bog"lanish Internet tarmog'ida eng ko'p
targalgan usul. Internetdagi obyektlarning manzillari, aloganing boshqga
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ushiWarini va bayonnomalarini o'z ichiga olishi mumkin. Ulardan bir
riechtasiii sanab o‘tamiz.

2 .1-jadval
Bayonnoma  Yozish Qoilanish sohasi
nomi goidasi
FTP ftp.// Fayllarni uzatish bayonnomasi. FTR-serveri bilan
bogManish uchun go‘llaniladi
File file:// Kompyuter yoki lokal tarmogda berilgan fayl-

larga bog‘lanish bayonnomasi
Gopher gopher://  Gopher serveriga bog'lanish bayonnomasi

JavaScript javascript: JavaScript tilida yozilgan dasturni chaqirish

Mailto mailto: Elektron pochta manzili
Newt news: Tel ekonferensiyalarga bog'lanish bayonnomasi
Telnet telnet: kompyuterga bog'lanish bayonnomasi

Internetning bugungi ommaviyligini tushuntiruvchi sabablardan
biri HTTP bayonnomasi imkoniyatlarining kengligidir. O'zidan avvalgi
avlodlarining ba'zi bayonnomalarini u butunlav yutib yuboradi.
Ba'zilarini esa shunchaki siqib chigaradi va ko‘rgazmali grafik inter-
feys yordarnida go’llab-qu'vvatlash yo‘li bilan vaxshiroqg imkonivat
yaratadi.

Lokal uzel yaratish. Uzel kartasi

Dreamweaver dasturida saytlar va sahifalar yaratishning har
xil yo'llari bor. Bulardan saytlarni yaratish bo‘yicha eng mashhur
teoologivani ko'rib chigamiz. Buning uchun quyidagi ketma-ketlikni
bajaramiz:

» saytning lokal versiyasini yaratish;
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« lokal versiyam Internet tarmog‘ igajoylash.

Lokal wuzel - bu foydalan uvchi yoki foydalanuvchilarning kompyu-
terid a joylashgan hagiqgiy virtual Web-uzelning versiyasidir. Lokal uzel
tarmoqdan ko'rinmaydi, unga fagat inualliflarigina bogMana olishlari
rnumkin.

Lokal wuzelning ma'lumotlari diskdagi belgilangan katalog ichida
saglanadi. Bu katalog vazifasini diskdagi har ganday katalog bajarishi
munxkin. Yangi lokal uzel hosil gilish ncliun quyidagi ketma-ketliklarni
bajaring:

I- Site > New Site (Caiir > Co3gaTtb) buynig‘ini bering. Ekranda
2.16-rasmda ko'rsatilgan Site Definition (OnpegeneHue caiita) mulogot
oynasi hosil bo‘ladi.

2. Oynaning chap gismidai Local info (MHpopmauna o nokanbHOM
y3ne) boiirnini tanlang. Mavdcnning giymatini kiriting.

3. Remote Info (CBegeHns 06 ypaneHHoMm cepBepe) kategoriyasiga
sayt saglanayotgan Server hagidagi malimotlarni kiriting.

1Site Definition for Unnamed Site 1 NALV
Category Local Info
Remote Ifo JeLbre! unnamed sie 1

Design Notes
R VIE I Catirns Lo Rectfdr; | \Roganle\MdaredaDesrines
R/ ReftshLac FleLisAutatically

HITPActress [Nip7
Fhisacbiesserddles trelirk Geder o
S%HI HIMPliksthet rdartoyaroan

Cxe BddeCde
f h}wma nairtars fleadasset

Asetg*el Inkw%tel\ép
(6.4 Cancel |'Hp

2.16-rasm. Lokal uzelni sozlash.
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4. Mulogot oynasining yuqorida sanalgan maydonlar to‘ldirilishi
shart. Site Wap Layout (MnaHupoBka kapTbl y3na). Design Notes
(KommeHTapumn paspaboTtumka) va File View Columns (KonoHku oTo-
6paxkeHns ainosbix atpnbyToB) maydonlari to‘ldirilishi shart emas
(foydalanuvchi 0‘z xohishiga qgarab to‘ldirishi mumkin).

5. Barcha kerakli ma’lumotlar kiritilgach OK tugmasini sichgoncha
yordamida bosing yoki EN TER tugmasini bosing.

Uzel kartasi

Uzel Kkartasi - lokal uzel yaratishning qulay interfaol vositasi
hisoblanib. unda ko'plab texriik giyinchiliklarga ega boTgan topshiriglar
graftkli ko‘rinishda yengillik bilan amalga oshiriladi. Bu rejimda
saytning kartasi tasvirlanadi. Uzel dispetcheri oynasi ikki gismga
boTingan. Chap tomonda uzelning kartasi kiritiladi (Kartada - sahifa
belgilari HTML fayllarni ifbdalaydi). Hujjatlar orasidagi gipermatnli
bogManishlarni strelkalar ifodalaydi.

O'ng tomonda esa uzelning fayliar va kataloglar ro'yxati beriladi.
Kartaning ko'‘rinishi organizatsion diagrammani eslatibyuboradi. Kartada
ikki darajani ko'rish nrumkin. Yuqgori darajani uzelning asosiy sahifasi
egallaydi. Quyi darajada esa unga tegishli va o‘zaro giperboglanishga ega
sahifalar tushuniladi. Uzelning gipermatnli hujjatlaridagi boglanishlar
ko‘krangda tasvirlanadi. Agar bog'lanishda ko‘rsatilgan fayl kengaytmasi
.HTM, .HTML va boshqa situ formatdagilardan farq qilsa u holda yashil
rangda tasvirlanadi. Agar bog'lanishda go'pol xatoliklar bo'lsa, u holda
bogManish gizil rangda ifodalanadi. Tashqi fayllar, boshga fayllarda
joylashgan fayllar va maxsus boglanishlar (masalan, mailto: yoki
javascript:) globus koTinishidagi maxsus belgi oladi. Bulardan tashqgari
agar ko'k rangli belgi qo‘yilgan bo'lsa - bu fayl foydalanuvchining o'zi
tomonidan taqiglangan ini bildiradi. Qulf belgisi ostidagi belgi faqat
o'gish uchun mo"ljallangan fayllarni bildiradi.

Servo! va topshiriglar:

1. Lokal uzel nima?
2. Lokal uzel hosil gilish ketma-ketligini aytib bering?
3. Uzel kartasi nimal
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2.5. Hujjatlarga havolalar o‘rnatish va olib tashlash

Tegislili hujjatga havola o‘rnatish unchalik inurakkab emas. Bun-
da foydalanuvchini chalkashtiradigan eng asosiy muammo - bu ope-
ratsiyani bajarish usul va uslublaiining ko'pligidir. Qachonki biror
hujjatga yoki sahifaga havola o'rnatmoqchi boMsangiz. bulling uchun
quyidagi uch holatdan birini belgilash kerak. Ular bir-biridan faylning
holati va y uklanish texnikasi bilan farqqgiladi.

+ Havola uchun ko'rsatilgan hujjat uzelning hisobidagi obyekt
sanaladi. Ya'ni favlaing nomi fayllar va papkalar ro'yxatidan iborat
uzelning kartasi va panelida ifodalamdi. Bunday faylga havola o'rnatish
uchun asosiy hujjatni tanlash, sichgoncha yordamida marker ko‘rsat-
kich bog'lab olib. uni tegishli hujjatga olib o‘tish lozim. Marker-
ko‘rsatkich — bu havola o'rnatish uchun maxsus interfaol vosita hi-
soblanadi. Markerni uzel dispetcherining har ganday paneliga (kartaga
yoki fayllar nryxatiga) surib kelish numkin.

e Butun hujjat saytning tarkibiga kiradi, ammo uning ro'y-
xatidan o‘ tmagan. Ya'ni uning nomi o'ng paneldagi fayllar ro'yxatida
mavjud, ammo u uzel kartasida yo‘q Bunday holatlarda marker ko‘r-
satkichni o'ng panel ustiga surish va uni fayl nomi ustiga tashlash
kerak.

« Butun hujjat saytga kirmagan. Bunday holatda marker-ko'rsat-
kichini surishni teskari yo'nalishini goTlash kerak.

Havolani o‘zgartirish

Havola larni o‘zgartirish uchun eski bog‘lanishga tegishli ko'rsat-
kichlarni o ‘chirib tashlab. yangi faylga tegishli ko‘rsatkichlarni Kiritish
mumkin. Ammo Dreamweaverda buni o'zgartirish uchun maxsus
vositalar mavjud:

1. Uzel kartasidan hujjat belgisini tanlang:

2. Uzel dispetcheri oynasidan Site > Change Link (Cait > W3-
MEeHUTb ccblinKy) buyrug'ini bering. Xuddi shu buyrugni - CTRL-L
tugmalar kombinatsiyasi yordamida ham berish mtimkin;

3. Select HTML Files (Bbibop runepTtekcToBbix haiinos) mulogot
oynasi ochiladi. Unda yangi faylning nomi va joylashgan katalogini
ko‘rsatish kerak;
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Change Link Sitewide (Site -Unnamed Site 3 copy)

Charge All Links To: oK
Cancel
Into Links To
Help

2.1 7-rasm. Bog'lanishni yangilash.

4, Fayl tanlangandan keyin, Dreamweaver dasturi Update Files

(O6HoBNeHne aiinos) mulogot oynasi ochiladi. Barcha o‘zgarishlarni
go'shish uchun Update (O6H0BMTbL) tugmasini bosing.

Agar bir nechta hujjatlar bilan bitta hujjat o'rtasida bogianish

o’'rnatmogqchi boTsangiz buning uchun maxsus buyrug mavjud. Bu
buyrug yordamida barcha obyektlardagi havolalarni global tarzda
o'zgartirish mumkin. LJ barcha gipermatnli havolalardagi koTsatilgan
faylni nomini o‘zgartirib chigadi.

1 Uzel dispetcheri oynasini oching;
2. O'zgartirilishi kerak boTgari hujjatni oling;
3. Site > Change Link Sitewide (CaT > M3MeHUTb CBA3WN MO BCEMY

canTy) buyrug'ini bering. Shu nomdagi mulogot oynasi ochiladi (2.18-
rasm).

Charge Link Sitewide (Site -Unnamed Site 3 copy)

Change All Links To: oK
Cancel
Into Links To:
Help

2.18-rasm. Havolani global o‘zgartirish.
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1. Tanlangan faylning noini Change All Links To (3MeHUTb BCe
ccblikn Ha) maydonida ifodalanadi. Yangi faylning nomini Into Links
To (Ha ccbinkm Ha) maydoniga Kiritish yoki standart protseduralar
yordamid a tanlash mumkin.

2. OK. tugmasini (kHonka) bosing yoki ENTER (knaBuwa) tug-
masini bosing.

3. Update Files (O6HoBneHne aiinos) mulocjot oynasi ochiladi,
bunda bog'‘lanishga ega va ayni vaqtda yangilanishni talab etadigan,
fayllar nomi aks etadi. Fayllarni tanlang va ularga tegishli havolani
o'rnating.

Change Link Sitewide (M3mMeHUTb cBSA3M MO BceMy caliTy) buyrug'i
ham havolalarni oinmaviy almashtirish uchun juda qulay. Masalan.
bunday almashtirishlarni ko'pincha saytning barcha sahifalaridagi
elektron pochta adresini almashtirish uchun go'llash mumkin.

1. Change Al Links To (MN3meHUTb Bce cCbiIKM Ha) maydoniga
o'zgartirilishi kerak bo'lgan havolani to‘liq Kiriting.

2. Into Links To (Ha ccbinkn) maydoniga toTiq yangi havolani
kiriting.

3. OIC tugmasini bosing.

Havolani olib tashlash

Havolani olib tashlashni bir nechta usullari mavjud. Masalan,
havolaga tegishli, ya'ni manba hisoblangan hujjat faylini ochish va
uni oddiy yoT bilan o'chirib tashlash mumkin. Bu usul balki noqulay
tuyulishi mumkin, ammo maksimal aniglikda bo‘ladi. Uzel dispetcheri
orgali amalga oshiriladigan boglanishni olib tashlash usulini ko‘rib
chigamiz:

1. Uzel dispetcheri oynasini oching;

2. Uzel kartasidan bogTanishni ko'rsatuvchi hujjat belgisini oling;

3. Site > Remove Link (CanT > YganuTb ccbifiky) buyrug'ini bering.
Bu buvrugning klaviaturada ikkita ekvivalenti bor: CTRL+SHIFT+L
tugmalar kombinatsiyasi yordamida ham berish mumkin.

Sarlavhani o‘zgartirish

Dreamweaver dasturi HTML hujjatining sarlavhasini uzel dis-
petcheri oynasida almashtirish (o'zgartirish) itnkonini beiadi. Shuni esa
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tutish kerakki gipermatnli hujjatning sarlavhasini <title> deskriptori
belgilaydi. Bu matn qatori hujjatning nomi hisoblanadi va gqidiruv
tizirnlarida hujjatni indeksatsiyalashda muhim rol o‘ynaydi. Eng
mashhur Internet Explorer va Netscape Navigator brauzerlar sarlavhani
dastur oynasining sarlavha gatoriga chigarib beradi.

Sarlavhani o‘zgartirish uchun quyidagilarni amalga oshirish kerak:

1L Uzel dispetcherini oching (ALT+F8).

2. View > Show Page Titles (Bug > lMoka3aTb 3arofioBKu cTpa-
HuUY) buyrug‘ini bering. Bu buyrugni CTRL+SHIFT+T tugmalar
konibinatsiyasi yordamida ham berish mumkin. Natijada uzel kartasida
gipermatnli fayllar nomi o ‘rnida ularning sarlavhasi beriladi.

3. Hujjatni tanlang va File > Rename (®ann > lNepenmeHOBaThb)
buyrug'ini bering yoki klaviaturadan F2 tugmasini bosing.

4. Yangi sarlavhani Kiriting va ENTER tugmasini bosing.

Savol vci topsliiriglar:

Giperhavola nima?

Gipermatn nima?

Ixtiyoriy hujjatga havola o‘rnatish tartibini aytib bering?
Havolani o‘zgartirish ketma-ketligini aytib bering?

PN -

2.6. Dasturning HTML bilan ishlash imkoniyatlari

Dreamweaver dasturining foydalanuvchilari gipermatnli hujjatlar-
ning ko‘plab tahrirlash operatsiyalarini to‘g‘ridan-to;g'ri HTML
deskriptorlari yordamida bajarishi mumkin. HTML tili hagida
biz yuqgorida batafsil ma'lumot oldik. Bu tilning elementlarini
deskriptorlar yoki teglar deb nomlash qgabul gilingan. Ingliz tilidan
tag (yorlig, belgi va boshga ma'nolarni beradi). Deskriptorlarni
sagqlash uchun ASCIIl belgilari qgo‘llaniladi. Shuning uchun har
ganday gipermatnli hujjatni belgilashni har qganday oddiy matn
muharrirlarida bajarish mumkin. Buning uchun xatto bnok-
HOT dasturi ham y*etarli. HTML tilining kodlari hujjatning matnli
massivlari gismi hisoblan adi.

Endi deskriptorlar bilan tanishib chigamiz. Deskriptorlar ikki xil
bo'ladi. Yakka va ju ft deskriptorlar. Juft deskriptorlar ayrim xollarda
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konteymerlar deyiladi. Hujjatga tegishli matnlar va uning belgili
kodlarini ajratish uchun, HTML tili kodlari burchakli gavslarda
yoziladi. Masalan, <br> yoki <p>. Juft deskriptorlar (konteynerlar)
o'z icHiga deskriptorlar juftligini, ochiladigan (boshlang‘ich) va
yopilad igan (oxirgi) deskriptorlarni oladi. Bu juftliklar <tag> </tag>
ko'rinishida yozilib, o'z giymatini juftlik orasidagi hujjat fragmentiga
o'tkazadi. Boshgacha aytganda kontevner juftliklari orasiga hujjat
fragmenti yoziladi. Deskriptorlar ana shu fragment uchun ishlaydi
xolos. Yakka deskriptorlarda yopiladigan teg boTmaydi. Masalan.
<hr> deskriptori gorizontal chtizig hosil giladi, <br> — esa matnli
gatorni ifodalaydi, eng muhiin yakka deskriptorlardan biri <img>
maxsus kodi hisobalanadi. U rasinlarni qo'yiladigan holatini va
joylashuvini belgilaydi.

Endi Dreamweaver dastnrida shablon asosida yangi hujjat hosil
gilamiz. Yangi hujjatning bo'sh (to'ldirilmagan) boTishi hammamizga
ixiaTum. Quyida bunday sahifaning Dreamweaver dasturidagi
gipermatnli belgilari keltirilgan:

<htmI>

<head>

<title>Untitled Document</title>

<meta http-equiv-»Content-Type» content-»text/html; charset=iso-
8859-1»>

</head>

<body bgcolor=«#FFEFFF»>

</body> </litml>

Bundagi deskriptorlarning vazifalari bilan HTMLda tanishib
chiqdik. Undan tashgari <meta> deskriptorining charset atributi
internetda tanlangan simvollarni namoyishini ta'minlovchi kodirovkani
ifodalaydi. Odatda yangi shablondagi (iso-8859-1) kodli to’plam Kiril
simvollarini ifodalay olmavdi.

Deskriptorlarni kiritish qoidalari

Belg ilash kodlarini to‘g‘ridan-to‘g'ri kiritish hujjatning fagat max-
sus rejimida amalga oshiriladi. Bu rejimga otishning bir nechta
imkoniyatlari bor. Ulardan ayrimlarini ko'rib chigamiz:
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*« Window > Code Inspector buyrug‘ini bering. Xuddi shu buyrugni
MO tugmachasini bosish yordamida ham berish mumkin;

» Uskunalar panelin ing chap gismida joylashgan Code View (Pe-
XM pasmeTkun) tugmasini hosib kodlarni tasvirlash rejimiga o‘tish
mumkin;

e Uskunalar panelidagi chapdan ikkinchi Code and Design View
(Pe3kum pa3meTKu M nnaHup oBkM) tugmani bosish bilan hujjat oynasini
ikki gismga boTish munrkin.

Kodlar nazoratchisida joriy hujjatning kodlari tasvirlanadi. Bel-
gilashda qollaniladigair kxrpchilik deskriptorlar alohida rangda
tasvirlanadi. Deskriptorlarning ranglari dasturning asosiy ko‘rsat-
kichlariga kiradi. Ranglarni foydalanuvchining xohishiga qarab
o'zgartirish mumkin. Agar foydalanuvchi hujjat ustida biror tahrirlash
ishlarini olib bormoqchi bo‘lsa u holda F5 tugmasini bosish yoki View
> Design View' (Bng > O6HoBUTb) buyrug‘ini berish kerak. Bu buyruq
hujjatning kodlarni belgilaslr rejimidan tahrirlash rejimiga o‘tkazadi.
Tahrirlash rejimidagi o byektlarni qgo'yish, formatlash buyruqglari va
har gandaj o‘zgarishlar darhol kodlar inspektoriga ko‘chadi. Agar
tahrirlash rejimida biror obyekt vyoki fragmentni belgilasangiz,
kodlarni belgilash rejinrida ham shu obyekt yoki fragmentga tegishli
kodlar belgilanadi. Bu e sa dasturda ikki yoglama ishlash imkoniyatini
ta’'minlab beradi.

Kodlardan nusxa olish

Dreamweaverda bosTiga HTML tahrirlagichlari bilan gipermatnli
belgilashdagi kodlarni almashish imkoniyati mavjud. Buning uchun
Window's operatsion tiz:imining ko’'pchilik dasturlarida mavjud boT-
gan, belgilangan f'ragincntclan nusxa olish va go'yishning standart
buyruqlaridan foydalaniladi. Aytaylik HomeSite dasturida ochilgan
gipermatnli hujjatning belgilash kodlaridan nusxa olishimiz kerak:

Nusxa olish uchun Edit > Copy (MpaBka > KonupoaTb) yoki
CTRL+C tugmalar kombinatsivasidan foydalanamiz;

Buferga olingan nusxani qo'yish uchun Edit > Paste (MNpaBka >
BcTtaBuTb) yoki CTRL+V tugmalar kombinatsiyasidan foydalanamiz.

Matn muharrirlarida tanlangan fragmentni sichqon yordamida surish
voTi bilan ko'paytirish imkoniyati mavjud. Bu imkoniyat Dreamweaver
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dasturida ham ishlaydi. Buning uchun CTRL tugmasini bosgan holda
belgilangan fragmentni sichqon kc'rsatkichi bilan kerakli joyga surib
ko'paytir ish mumkin.

Savol va topshiriglar:

HXML so'zining lug’aviy ma'nosi ganday?
. Deskriptorlar nima?
. De skriptorlarning ganday ko‘rinishlari mavjud?
4-. De skriptorlarni Kiritishni tushmtirib bering?

W N -

2.7. Hujjatning o‘lchamlarini belgilash

Dasturda vyaratilgan har ganday yangi hujjat bo'm-bo'sh oq
rangdagi fonli sahifadan iborat bo'ladi. Hujjatda ish boshlashdan oldin
uning bir gancha muhim parametrlarini Kiritib olish kerak. Bular ish
maydonining o‘lchami, fon rangi, hujjat sarlavliasi. havola ranglaridir.
Bu parametrlarni ish jarayonining ixtiyoriy vaqtida ham o‘zgartirish
mumkin. Sanalgan barcha parametrlarni yagona Page Properties (Csoi-
cTtBa cTpaHuuybl) mulogot oynasi yordamida kiritiladi (2.19-rasm). Bu
muloqot oynasini bir necha yoTlar bilan ochish mumkin:

* Dastur menyu gatoridan Modify > Page Properties (M13meHnTbL >
CsoiicTBa cTpaHumubl) buyrug!ini berish bilan;

« CTRL+J tugmalar kombinatsiyasini bosish bilan;

+ Kontekstli menyudan Page Properties (M3MeHuTb > CBoiicTBa
cTpaHunybl) buyrug'ini berish bilan.

Endi Page Properties (CsoicTBa cTpaHuuybl) mulogot oynasining
boshqaru'v elementlari bilan tanishib chigamiz:

 Title (3aronosok). Sahifaning sarlavhasini kiritish uchun xizmat
giladi.

« Background Image (®oHoBbIVi pucyHOK). Hujjatga fon sifatida
go'yiladigan rasm ko'‘rsatiladi.

* Background (®oHoBbIi UBeT). Sahifaning fon rangini tanlash
imkoniyatmi beradi.

« Text (TekcT). Shriftning rangini tanlash inikoniyatini beradi.

e Linbs (Ccbinkn). Bu bo'limda giperhavolLalar rangi va grafikli
havolalar ramkasi rangi belgilanadi.
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Page Piopeities

life: O X
Edgourdimege. Jfile;—VCI/Ecok/FQNJPG Bronge. Ay
Bdgond MP Cancel
Tt . T VisitedLinks  ,,!J
ks Active Lirks
Left Mrgin MerginWidt
TesVagn Margin Higt
Dounert Ercoding [Grilite (Windons-4251) — « 3 Reload
Tredng Imege: | Bronge...
O _ JP—
Transparent Qe
Docurent Folder: C\WIMDOV/S\PaBodHt crark
SteFolcer: CVWINDOWS\Pa6odwr cronk Hip

2 .19-T'asm. Page Properties mulogot oynasi.

* Visited Links (IMpocmoTpeHHble ccbiikK). Brauzerda ko‘rilgan
havolalar rangini tanlash.

« ActivtLinlcs (AKkTnBHbIE ccbiikn). Faol havola rangini belgilash.

« Left Margin (Jlesoe none). Sahifaning chap tomonidan qol-
diriladigan maydonni pikselda belgilaydi.

e Top Margin (BepxHee none). Sahifaning yuqori gismidan qol-
diriladigan maydonni pikselda belgilaydi.

* Margin Width (WwupuHa noneir). Sahifa maydoni enini bel-
gilaydi.

¢« Margin Height (BbicoTa noneii). Sahifa maydoni bo‘yini bel-
gilaydi.

« Document Encoding (KoampoBka pokymeHTa). Kiril simvol-
laridan iborat salxifalar tuzish uchun juda muhim ko‘rsatkich. Chunki
uning yordamida qanday simvollarni brauzer dasturlarida tasvirlab
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berish kcrrsatlladi. Rus alifbosini fagat quyidagi to'rtta kodirovka
tasvirlab bera oladi xolos 15SO-8859-5, MacCyrillic, KOI8-R va
Windows-1251.

* Reload (MoBTopHas 3arpy3ka). Tugmasi yordamida hujjatning
grafik tahrirlash ishlari bilan bog‘liq oxirgi saglangan ko‘rinishni tiklash
inikonini beradi.

* Tracing Image (TpadapeTHoe nzobpaxeHue). Sahifaning dizayni
bilan ishlashda namuna sifatida ishlatiladigan tasvirlarni ifodalaydi. Bu
tasvirlar sabifani ko'rish rejimida ko‘rinmaydi.

* Image Transparency (IMpo3payHocTb U3obpaxesans). 1z goldirish
uchun tanlab oLingan rasmning shaffoflik darajasi belgilanadi.

*« Docu inent Folder (Manka gokymeHTa). Hujjatning gaysi katalogda
joylashganini ko ‘rsatib turadi.

« Site Folder (KopHeBas nanka y3na). Tegishli Web-uzelning o'zak
katalogiga toTiq yo‘l ko‘rsatadi.

Yugoridagi ko‘rsatkichlar tanlaagandan so'ng. barcha o'zgarishlarni
saglab. ularni ko'rish uchun File > Preview in Browser (®awnn > Mpo-
cMoTp B 6pay3epe) buyrug'i beriladi.

Gorizontal va vertikal chizg‘ich

Gorizontal va vertical chizgich hujjat bilan ishlashda oMchash va
etalon vazifalar ini bajaradi. Chizg'ichga garab obyektlarning oTchamini
boshqa obyektlarga nisbatan joylashuvini ko‘rish mumkin. Boshgaruvda
chizg‘ichlar maxsus buyruq yordamida ornatiladi. Buning uchun View
> Rulers (Bupg > JluHeiikn) buyrug‘ini berish kerak. Bu inenyuning
punktlarini sanab o‘tamiz.

« Show (Mokasatb) buyrug'i chizg‘ichni o‘rnatib beradi. Bu
buyrugni — CXRL+ALT+R tugmalar kombinatsiyasi yordamida ham
bajarish mumkin. Buyruqni takror berish chizg;ichni ekrandan olib
tashlaydi.

+ Pixels (Mwukcensbl). Inches (Atolimbl), Centimeters (CaHTUMeTpbI)
- buyruqlari o'lcham birligini tanlash inikonini beradi.

* Reset Origin (BoccTtaHOBMTbL HayaTo KoopguHaT). Koordinatalar
boshini sahifaning ixtiyoriy miqtasi bilan bog‘lash mumkin. Buning
uchun chiziqglar kesishuvida joylashgan krest shaklidagi markerni
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hujj atning ixtiyoriy joyiga olib o'tish yetarli. Ushbu buyrugning ba-
jarilishi sanogq nuqtasini dastlabki vaziyatga gaytaradi.

Montaj to‘ri

Montaj to‘'ri — hujjat elementlarini tekislash va joylashtirish uchun
moMjal olish vositasidir. Hujjat elementlariga: matn, rasmlar, jadvallar
va boshqalar kiradi. Montaj to‘ri sahifani rejalashtirishning eng asosiy
vositasidir. Loyihaning dizayn bilan bog‘liq ishlari tugagach to'rni olib
tashlash inuinkin. To‘rni yana ekranga chigarish uchun View > Grid
> Show Grid (Bupg > Pa3meTo4yHas ceTka > [lokasaTb ceTKy) buyrug'i
beriladi yoki CTRL+ALT-G tuginalar kombinatsiyasi bosiladi. Olib
tashlash uchun shu buyruq takror beriladi.

View > Grid > Edit Grid (Bug > Pa3meTouHasi ceTka > HacTpouTb
ceTky) buvrug'i 2.20-rasmd a ko'rsatilgan mulogot oynasini ekranga
chigaradi. Uning tarkibiv qismi bilan tanishib chigamiz:

o Color (LiBeT) - to‘r rangini tanlash imkonini beradi.

0 Show Grid (IMoka3aTb ceTKy) — to'rni o'rnatish yoki olib tashlash.

° Spacing (PacctosiHua) — ole hash birligi va chiziglar orasidagi
bo'linish gadamini belgilaydi.

o Display (OTobpaxeHue) —to'r chiziglari ko‘rinishini belgilaydi.

color j-i(nsagHé OK
™ S nap to Grid
Cancel
Spacing: [so
Display: (+ Lines
C' Dots Help

2.20-rasm. Montaj to'rini o'rnatish.
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Savol va topshiriglar:

1. Hujjat o'lchamlarini belgilash uchun gaysi buyrugdan foydalaniladi?
Bu buyrugning mos kombinatsion tugmalarini ayting?

2 . Page Properties mulogot oynasi gismlari vazifaLarini aytib bering?

Chizg'ich va uningvazifalari nimalardan iborar?

4. Montaj to'ri nima va uning vazifalari nimalardan iborat?

w

2.8. Dreamweaverning ro‘yxatlar bilan ishlash imkoniyatlari

Ro~xatlarn i nomerksh deb —bo'lim yoki gismlar ketma-ketligini
tartibga soluvchi va ularning har biri navbatdagi yangi son bilan
tartiblanishini tushunish mamkin. HTML tilida ro‘yxatlarni hosil
gilish bilan biz yuqorida batafsil tanishib chigdik. Bundan tashqari
tartiblangan ro‘yxatlar asosida murakkab iyerarxik ro'yxatni tuzish
mum kin. Bunda murakkab ro‘yxatning gismlari bo'lib quyi (oddiy)
ro'yxatlar olinadi.

NTomerlangan ro'yxatlar quyidagi yoi bilan hosil gilinadi.

1. Hujijatning bir nechta tizimli boiagini oling. Buncay bo'laklarga
abzatslar, har ganday standart sailavhalar yoki boshga ro'yxatlarning
bo‘limlarini kiritish munikin.

2.. Dreamweaver

3. Homesite

4. Hotmetal Pro

Text > List > Ordered List (TekcT > Cnucok > HymepoBaHHbI cnn-
cok) buyrug‘ini bering. Bu buyrugni CTRL+F3 tugmalar kombinatsiyasi
yordamida ham berish mumkin.

Belgili ro‘yxatlarni varatish

3elgili ro'yxatlar deb - ma’'lum belgi ostida ketma-ket bo'linilarni
sanash tushuniladi. Bunday ro‘yxatlarni HTMLda hosil gilish bilan biz
yugoiida tanishib chigdik.

Srauzerlarning oxirgi versiyalarida ro‘yxatlarni belgilash uchun
type atributi bor. Bu atributni quyidagi giymatlarini qoilash mum-
kin: circle (aylana), disk (disk), square (kvadrat). Ya'ni ro'yxatning
har bir bo'limi shu belgilar bilan belgilanadi. Bundan tashqgari kichik
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xajmdagi rasmlarni ham ro'yxatning maxsus belgisi sifatida qo‘llash
mumkin.

Betartib ro'yxatlarni yaratish tartibi quyidagicha:

L. Hujjatning bir nechta bir—biriga qo'shni strukturali bloklarini
tanlarg. Text > List > Unordered List buyrug'ini bering. Bu buyrugni
CTRL+F3 tugmalar kombinatsiyasi yordamida ham bajarish inurnkin.

* Toshkent
Samarkand
Buxoro
Xorazm

Savol vet topshiriglar:

1. Ro'yxatlarni belgilash deganda nimani tushunasiz?
. HTMLtilida rcTyxatlar gaysi deskriptor yordamida hosil gilinadi?
. Belgiliro‘yxatla_r ganday hosil gilinadi?

w N

2.9. Matnlarni formatlash. Shriftlar

Bizga boshga dasturlardan belgilangan matnni yoki butun hujjatdagi
matnni shriftini o’zgartirish ma’ lum. Endi ana shu jarayonni HTML
tilida ganday bajarilishini ko'rib chigamiz. Bu vazifani HTMLda
maxsus deskriptor <font> yordamida bajariladi. Uning qiymatlari
bolib bir nechta shriftlar nomi ishlatilishi mumkin. masalan: <font
face = «Courier. Helvetica, sans-serif>Shriftni belgilash </font>.

Shriftlarni belgilashni texnik tomoni esa matn muharrirlaridan hech
ham farq gilmaydi:

1. Matnni belgilang yoki matn kursorini hujjatning shrifti o'zgarishi
kerak bo‘lgan joyiga go'ying;

2. Text > Font (TekcT > LWpwudTt) buyrugMni bering va kerakli
shriftni tanlang. Xuddi shu ishni Property Inspector (MHcnekTop
cBolicTB) palitrasi yoi'damida hair» bajarish mumkin.

Tanlangan shriftning nomi shriftlar 10yxatining nomi hisoblanadi.

Shriftlar ro'yxatini tahririash

Shriftlar to'plami ro'yxatiga foydalanuvchi o'z xohishiga qarab
yangi shriftlar go'shishi yoki go’l lanilmavdigan shriftlarni olib tashlashi
ham mumkin:



Edit Font List

t.bl - Forl List X

gégi ! N'arN erxﬂ?/mmm Tires, sarif Gaoel
rgia, Tines ies,

;Verdgna Aid, Hehetica, sarssanif

'Times Uzb Roren

eeneva, Aid, Helvetica, sans-sexif
Add fonts inlist below

Chosen Fonts: Avilable Fots:

Aid
#id Black
«  AidNarow
Arel Unicock VB
Batang

as Hip

2 .21-rasm Shriftlar to'plamini tahrirlasb mulogot o) nasi.

1. Text > Font > Edit Font List (TekcT > LpudT > PegakTnposatb
cnucok wpugToB) buyrug‘ini bering. Bu buyrugni CTRL+T3 tugmalar
kombirmtsiyasini bosish bilan ham bajarish mumkin. Buyruqni berish
natijasida Edit Font List mulogot oynasi hosil bo'ladi.

2. bn oyna yordamida foydalanuvchi o‘ziga kerakli shriftlar roy-
xatini qaytadan tuzib olishi mumkin.

3. Ishni tugallashdan oldin mulogot oynasidaOK. tugmasi bosiladi.

* IMulogot oynasining tugma va maydonlari bilan tanishib chi-
gamiz:

* Font List (Crnncok wpugTtos). Mulogot oynasining bu bo‘limida
ayni vaqtdagi ro'yxatga tegishli shriftlar berilgan. Endi qo‘shiladigan
shriftlar esa ro‘yxatning eng oxiriga joylashadi.

* Chosen Font (BbibpaHHble WwWpudTbl). Tanlangan shriftlar nomi.

* Available Fonts (HannuHble wpudThl). Ushbu hisoblash tizimida
o ‘rnatilgan shriftlar ro'yxati. Bu shriftlardan birortasini tanlangan
shriftlar to'plamiga g»‘shish uchun, oynadagi chapniko‘rsatish yo'nalish
tugmasini bosish kerak.

* To'plamdagi tanlangan shriftni o'chirish uchun «-» belgili
txigmani, to‘plamga yangi shrift go‘shish uchun «+» belgili tugmani
bosish kerak.
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. Yuqoriga va pastga (qaragan strelkalar esa tanlangan shriftni
ro'yxatdagi holatini o' zgartirish, ya'ni yuqoriga va pastga yurish im-
konini beradi.

JMatn o'lchamini belgilash

HTMLda main o' Ilchamini ganday belgilash bilan tanishib chi-
gamiz. Euning ucliun <font> deskriptorida size atributi qo‘llaniladi.
Masalan. <font size =«4»>“ OTchamni belgilashning absolyut tizimi </
font>. Bundan tashqari <body> deskriptori yordamida ham <basefont
size=«giymat»> shriitni belgilash mumkin. Bunda sizening qiy-
matiga birdan to yettigacha bo'lgan har ganday gqiymatni go‘yish
mumkin,

Kattalashadigan 0 Ichamlarda esa size atributi qiymati oldiga +
(kattalashtirish) yoki — (Icichiklashtirish) belgisi go‘yiladi. Nisbiy ti-
zimda shriftni o‘lcham ini o ‘zgartirishga misol keltiramiz:

<fontsize=«+I»>NTisbiy tizimda o‘lcham</font>

Shrift oichamini quyidagi yo'l bilan Ozgartirish mumkin:

1. Matnni belgilang yoki Kiritiladigan joyga kursorni go‘ying.

2. Absolyut o'lchamni belgilash uchun Text > Size (TekcT > Pa3s-
mep) buyrug‘ini bering yolei nisbiy tizimida o'Ichamn i berish uchun Text
> Size Change (TekcT > M3meHnTb pasmep) buyrug‘ini bering. Ikkala
buyrugni ham Property Inspector (MHcnektop cBoiicTB) palitrasidan
berish mumkin. Palitraning Size (Pasmep) ro‘yxatida shrift oichamini
o'zgartirishning barcha imkoniyatlari ko'rsatilgan.

3. Absolyut yoki o'sish oichamini tanlang.

M atnlarga rang berish

Agar matnga biror rang berilmagan boisa, u holda Windows
operatsion tizimidagi yoki brauzerda tanlangan rang tasvirlanadi.
Ko‘pincha bu rang qora rang boiadi. Butun massivnhing simvollariga
rang hujjatning asosiy ko'rsatkichlarida belgilanadi. Ko'pincha hujjat
yaratib olingach, bu kabi ko'rsatkichlar Kiritilib olinadi. Buning uchun
yuqorida ko‘rganimizdek Modify > Page Properties (A3mMeHUTb >
CeoicTtBa cTpaHuubl) buyrug‘ini berish kerak (CTRL+J). Har ganday
simvollar to'plamiga alohida rang berish mumkin. Ranglarni saglash
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uchuu -<font> deskriptorida color atributi ishlatiladi. Masalan. yashil-
ko'lI< rangini belgilovchi kod quyidagiclia yoziladi:

<forat color=«#66FFFF>»bu moviy rangning kodi</font>

Shuni esda tutish kerakki HTML tilida rang o'n oltilik sanoq tizimi
kodlari yordamida belgilanadi. Palitraning ayrim elementlari o'ziniug
nomiga ega, masalan green (ko'k). red (qgizil) va boshgalar.

Dasturda ranglarni tanlashni Property Inspector (MHcnekTop
ceoiicTs) palitrasidan foydalanib ham uskunaviy yo‘l bilan belgilash
murnkin. Bu jarayon xuddi boshga matn muharrirlarida bajarilgandek
boradi.

Matnli mavdonlar

Matn maydoni —sahifaning asosiy gismi hisoblanadi. Chunki har
ganday J11'eb-sahifaning asosiy belgilovchi gismi matnlar hisoblanadi.
JMatnli maydonlar uchxil ko‘rinishda bo‘ladi (2.22-rasm):

. Single line (OpgHocTpoyHoe). Qisqa xabar yoki javoblarni kiritish
uclrun xizm at qiladi.
® Multi line (MHorocTtpouHoe). Ixtiyoriy uzunlikdagi xabarni

kiritish uchu n moijallangan.

"TekcTOBOE none

MHoOroe TpoliHoe J
TeKCTO BOe Mofe

Submit jp7 a iMounck

2.22-rasm Matn maydoniarming tiplari.
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» Password (IMaponb). Parolni kiritish uchun moijallangan.

Matnning uchala Ico'rinishi ham bitta buyruq yordamida go'yiladi.
Ularni tiplarga ajratish esa Property Inspector (MHcnekTop CBOWCTB)
palitrasi yordamida amalga oshiriladi. Buning uchun shu nomlardagi
uchta qayta ulagich xizmat qiladi.

Single line matn mavdoni

Bitta qatordan tarkib topgan oddiy matn maydoni. TJ <input>
deskriptori yordamida belgilanadi. Quyidagi misolda shunday obyektni
ifcdalovchi belgili kod gatori keltirilgan:

<input ty"pe = «text» name = «maydon_nomi»>

bu yerda type atributi maydonning tipini bildiradi, name atributi esa
obyektning nomini bildiradi.

Oddiy matn maydoni bilan bog‘lig ko'‘rsatkichlar bilan tanishib
chigamiz:

» Text Field (TekcTtoBoe none). Palitraaing bu bo‘limi matn may-
donining nomini belg ilaydi. Bu yerda maxsxis belgilardan foydalanish,
birnomni takrorlash va maydonni bo‘sh goldirish ham mumkin emas.

¢ Char Width (WwupnHa B cumBonax). Matn maydonining enini
simvollar soni bo‘yicha belgilash. Odatda bu oicham 20 ta simvolni
tashkil qiladi.

* Max Chars (MakcumanbHblli 06bem). Matn maydoniga Kkiriti-
latligan simvollarning maksimal soni.

* Init Val (HayanbHoe 3HauyeHme). Bu maydonga qarab ko'rish
dasturi sahifani birinchi yuklashdan keyin olib chigadigan matn
gatorini kiritish mumkin.

Password matn maydoni

Kiritilgan simvollarning oynada aks etmasligini ta'minlash mag-
sadga muvofiq bo' Ilgan holatlar ham mavjud. Ko'pincha bunday zarurat
maxfiy axborotlarni. masalan. parollar yoki kalit so'zlarni kiritishda
yuzaga keladi.

Password (Maponb) matn maydoniga Kkiritilgan ma’lumot fagat
yulduzclialar ko'rinishida tasvirlanadi. Matn maydoni bunday xususiyati
bilan boshga tipdagi matn maydonlaridan keskin farq qilib turadi.



Multi Line matn maydoni

Katta hajmdagi matnli rm'iumotlarni Kiritish uchun Multi Line
(MHorocTpo4Hoe) tipidagi maydonlar ishlatiladi. Bunday tipdagi
obyektlarni yaratish uchun. sahifaga matn maydoni qo'yish kerak,
masalan Insert > Form Objects > Text Field (BctaBka > O6beKTbl (hopm
> TekcToBoe none) buyrug'i yordamida. Xossalar paneli ochish va bu
palitradan jvdulti Line (MHorocTpouHoe) gayta ulagichni oling. Natijada,
bir qgatorli matn maydoni ko'p gatorli matn maydoniga avlanadi. Uning
uzunligi 18 simvoldan, balandligi esa 3 gatordan iborat.

Bu tipdagi obyektlar ishlash uchun yana Property Inspector (H-
cnekTop cBoicTB) palitrasiga murojat gilamiz:

* Text Field (TekcTtoBoe none) - ko'pgatorli maydonning nomi.

e Char W idth (WunpnHa B cnmBonax) - matn maydonining siinvol-
larda belgilanadigan kengligi.

* Num Lines (4Yucno cTpok) - matn maydonining qatorlar soni.

e Int Val (HauyanbHoe 3HaudeHue) - maydonining boshlang'ich qiy-
mati.

* Wrap (IMepeHoc no cnosom) - ko'p qatorli matn maydonida
matnni yang i gatorga ko'chirish imkoniyatlarini belgilaydi.

Sctvol va topshiriglar:

1. Matnlarni formatlash jarayonida shriftni belgilash uchun qaysi
deskriptordan foydalaniladi?

2. Shriftlar ro'yxatini tahrirlash ketma-keligini aytib bering?

Matn oicham ini belgilash uchun gaysi deskriptordan foydalaniladi?

4. Matnlarga rang berish ketma-ketligini aytib bering?

w

2.10. Grafikli forinatdagi fayllar bilan ishlash

Grafik tasvirlar ishtirokisiz tuziladigan liujjatlar juda kamchilikni
tashkil giladi. Aynigsa Web - sahifalarini rasmlar, logotiplarsiz tasavvur
ham qilib boMmaydi. Bu kabi grafikli maTumotlarning turlari juda ham
ko'p. Ularni fagat formati bo'yicha ajratish mumkin. Masalan, birgina
rasm degan maTumot ostida har xil fonnatdagi fayllar votadi. Faylning
forrnati deganda ma'lumotni yozish va saglash uchun belgilangan
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standart qoidalar to'plami tushuniladi. Hozirda o'nlab grafikli form atlar
mavjudki, tilar turli tizimlarda har xil magsadda qoilaniladi. Grafikli
formatlar uchta sinfga boiinadi. Bular: rastrli, vektorli, metafaylli. Bu
formatlar hagida keyingi boblarda batafsil ma’lumot berilgan.

Dasturning rasmlarni go‘yish imkoniyatlari

Rasmlar Web-sahifalarga jilo beruvchi vositalar hisoblanadi.
Rasmlarni qo'yish — bu oddiy texnik operatsiya hisoblanadi. Dasturda
rasmlarni go'yishning bir nechta >ro‘llari bor. Avval rasmni qo‘yish
buyruglaridan birini tanlaymiz:

* Objects (O6bekTbl) palitrasini oching, Common (O6wwe) bo4i-
miga o'ting, palitraning yuqori - chap gismida joylashgan Insert Image
(BcTtaBka nsobpaxeHuns) tugmasini bosing.

* Insert > Image (BcTaBka > WM3o06paxeHune) buyrug‘ini bering.

- CTRL+ALT+I tugmalar kombi natsiyasidan foydalaning.

e Tasvirni Assets (®oHpgbl) palitrasidan hujjat oynasining kerakli
gismiga ko‘chiring.

« Saytning dispetcheri oynasidan rasmning belgisini olib hujjatning
oynasiga tashlang.

e Rasmni ish stolidan hujjat oynasining kerakli joyiga tashlang.

HTML tilida esa bu vazifalarni <img> deskriptori bajaradi. Bu
deskriptor rasmning barcha ko‘rsatkichlarini belgilaydigan bir nechta
atributlarni o'z ichiga oladi. Quyidagi misolda deskriptor o'ziga to'g-
gizta atributni bog'lagan:

<img src=«Temp/anini l.gif» width=«170» height=«180» alt=
=«Tushuncha» boider=«l» name= «ins» align=«right» vspace= «50»
hspace=«60»>

Shtmingdek qo'y ilgan rasmga ramka ham go'yish mumkin;

<img src=« 10.jpg» border=«1>»

Bu misolda border atributi ramkaning qalinligini bildiradi.

Rasmni fon sifatida go'yish

Biz yuqorida gipermatnli hujjatning parametrlarida fonga rang
tanlash, fonga rasm qo‘yish bilan tanishib chiqdik. Endi rasmlarni fon
sifatida go'yish bilan batafsLI tanishib chigamiz:
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1. Modify > Page Properties (MN3MeHUTbL > CBOWNCTBa CTpaHWULbl)
buyrug’ini bering.

2. Background Image (®oHOBbIVi pucyHOK) maydonida rasm faylini
ko‘rsating.

Xuddi shu vazifani HTML tilida <body> deskriptori yordamida
bajariladi. Masalan, <body background=«image.jpg»> bunda rasm huj-
jat saqlangan katalogda joylashgan.

<body background= «ww'w.images.com/source/back.gif»> fragmenti
esa internetning ko'rsatilgan manzilidagi rasmni fon sifatida qo'yib
beradi.

Interfaol rasmlar

Hozirgi kunga Kkelib rasmlar va animatsiyalarsiz sahifalarni
uchratish juda giyin. Aksariyat Web-sahifalar animatsiyalar. animatsion
tugmalar yoki harakatlanisli tugmalari, rasinlar, interfaol rasmlar bilan
boyitilgan.

Interfaol rasmlar so‘zi «rollover image» iborasidan olingan bo'lib
so‘znaa-so‘z tarjimada «tasvirni ko‘chirib o‘tkazish» ma’nosini bil-
diradi. Agar Web-sahifada biror rasm ustiga sichqon koTsatkichini
olib borganingizda boshga rasm pavdo bo‘lsa bilingki u rasm
interfaol rasmdir. Interfaol rasmlarni qo'yish quyidagi yoi bilan
bajari ladi:

1. Matn kursorini rasm qo‘yiladigan joyga qo‘ying.

2. Insert > Interactive Image > Rollover Image (BctaBka > [AuHa-
MUUYecKMe n3obpaxeHus > VHTepakTUBHOE M306paxeHue) buyrug'ini
bering. 2.23-rasmda koTsatilgan muloqot oynasi hosil boladi.

3. Bu mulogot oynasining tegishli maydonlarini to'ldiring:

0 Image Name (Mma wmn3obpaxeHusa) maydonda rasmning nomi
ko‘rsatiladi.

0 Original Image (McxogHoe wu3o6paxeHne). Joriy holatda ko-
rinadigan rasmning nomi ko rsatiladi.

° Rollover Image (MHTepakTMBHOE M306paxeHme). Sichgon I<o'rsat-
kichi kelishi bilan almashinadigan rasmni nomini ifodalaydi.

0 Preload Rollover Image (IMpeaBapuTensHaa 3arpyska) - bu
bayrogcha rasmni ko'rish dasturlarida yuklash rejimini ishga tu-
shiradi.
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Insert Rollover Image

Imege Name: |
Qigrd Image: | Browse... |
Rollover Imege: | Browse... |
Preload Rollover Imege
When Clicked, Go To URL: Browee... |

2.23-rasill. Interfaol rasmni qo'vish ovnasi.

0 When Clicked Go To URL (nepexog no agpecy) - bu yerda
gipermatnli o‘tish buyrugM saqlanadi.

4. Tegishli ko’'rsatkichlar Kkiritilgandan so'ng OK tugmachasini
bosing yoki klaviaturadan EN TER tugmasini bosing.

Dreamweaver dasturi rasmlarning dinamik almashinuvini ko'rsat-
maydi. Bu jarayonni faqat brauzer dasturlarida ko’'rish mumkin. Brauzer
dasturlarini chagirishning eng gisqa yo'li F12 tugmasini bosishdir.

Stivol y4i topshiriglar:

1. Rastrli formatlar nima?

2. Vektorli formatlar nima?

3. Metafayllar nima?

4. Sahifaga rasin qo'yish ketma-ketligini aytib bering?

2.11. Jadvallar go‘yish va ular bilan ishlash

Jadvallar - matnli va grafikli ma'lumotlarni saglash uchun tayyor
forma hisoblanadi. Bundan tashqgari sahifalarda rasmlarni birlashtirish
uchun, matn ostiga rasm qo'yish uchun ham jadval kataklaridan
foydalanish mum kin. Qatordagi ikkita yonma-yon joylashgan katak-
chalardan kolonka sifatida foydalansa bo'ladi. Bir katakli jadvaldan
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tortib to murakkab jadvalgacha - bularning barchasi gator, ustun,
katakcbalarning oddiy kombinatsiyasidan tuzilgan.

HTML tilida jadvalga tegishli barcha amallar yoki ma'lumotlar
<table> </table> deskriptorlar juftligi orqali ifodalanadi. Bu deskrip-
torning ko'plab atributlari mavjud. Bu atributlar yordamida jadvalning
eni, foni rangi. chegarasi, tekislash, maydon, kataklar orasidagi masofa
va bostiqa ko‘rsatkichlarni belgilash mumkin. Biz yugorida HTMLda
jadvallarni go'yishning barcha imkoniyatlari bilan tanishib chiqdik.
Endi esa Dreamweaverda jadval qo'yish bilan tanishib chigamiz.

Jadval go‘ish

JadA/al go'yish - bu uncha giyin bolmagan texnik jaravondir.
Dreamweaverda jadval go'yish uchun quyidagi ketma-ketlik bajariladi:

1. Jadval quyilishi kerak bo‘lganjoyga kursomi qgo'‘yiag.

2. Insert > Table (BctaBka > Tabnwuuya) buyrug‘ini bering. Bu
buyrugni bajarishning alternativ variantlari ham bor:

° CTRL+ALT+T tugmalar kombinatsiyasi;

° Object (O6bekTbl) palitrasidagi Common (O6wwne) boiimining
Insert Table (BcTtaBuTb Tabnuyy) tugmasini bosish bilan;

3. Insert Table (BctaBka Tabnumubl) mulogot oynasi maydonlariai
toldiring (2.24-rasm). Bu ovnaning boshgaruv elementlarini ko'rib
chigamiz:

(04 I
Rows: (] Gl Padding [
Cancel
Columns: p Gl Spacing:  f
Help

Width:  JS [percent

Border: fi

2.24-rasm. Insert Table mulogot oynasi.



Rows (Ctpoku). Jadva Ining gatorlari soni.
Colums (Cton6uybl). Jadvalning ustunlari soni.
Width (LWunpwuHa). Jad'valning eni.
Border (Pamka). Har bir katakchaning va butun jadvalning
chegara ramkalari eni. Piksellarda beriladi.

o Cell Padding (Mons saueiikn). Katakcha chegarasi va ichidagi
ma’lumot orasidagi may'don Kkattaligi.

° Cell Spacing (PaccTtoaHmne mexnay sdeinkamn). Kataklar orasidagi
masofa.

4. OK tugmasini bosing.

Ixtiyoriy ko‘rsatkichli jadval qo'yilgandan keyin, uni to‘ldirish
vaqtida yoki undan keyin ham o‘zgartirish mumkin.

o o O

o

Jadvalli nxa'lumotlarni import qilish

Dreamweaver dasturida tashqgi matnli fayllarni o'gish va undagi
jadvallarni o'girib olish nchun maxsus buyruglar mavjud. Jadvalli
ma'lumotlarni import gilish quyidagicha amalga oshiriladi:

1. File > Import > I mport Tabular Data (®ann > UmnopT > MmnopT
TabnnuHblix gaHHbiX) buyrug'ini bering.

2. Import Table Data (MmMnopT Taban4yHbIX gaHHbIX) mulogot oynasi
hosil bo'ladi (2.26-rasm). Bu mulogot oynasining asosiy boshqaruv
elementlari bilan tanish ib chigamiz:

o Data File (®ain paHHbIX). Bu maydonga jadvalli mallumot
joylashgan faylni gidirish uchun to'liq yo'l ko‘rsatiladi.

° Delimiter (PasgenuTtenb). Bu ro‘yxatda matnli fayldagi jadvalni
bolirvchisi kiritiladi. R_o‘yx.at o'z ichiga quyidagi bandlarni oladi: Tab
(CvmBon Tabynaumm), Comma (3ansatasa), Semicolon (Touka c 3ans-
Toi), Colon (ABoeToune), Other (Opyroi).

° Fit to Data (Mopgb6upaeTca no gaHHbiM). Agar bu gayta ulagich
o‘rnatilgan bo‘lsa, jad"val Rengiligi har bir ustunda eng uzun gator
oichami bo'yicha tanlab olinadi.

o Set (PaBHa). Agar bu gayta ulagich oTnatilgan bo'lsa, u holda
jadvalning enini oldindan belgilash mumkin boTadi.

o Cell Padding (Mona sauveikn). Katakcha tashkil etuvchilari va
chegarasi orasidagi masofani belgilaydi.
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Fomat Va? Vv Ddadfat v SeNrev BJ

Lirk v.(j  Tag S N ei
m- Gl HdBakv v NP ]Bg 3> |
FILC \ot DRkv H HekF] By B 1y

2.25-rasm. Property Inspector palitrasi.

Insert Tebular Dale . M M .
. U , pk |
Data File: [fite:7-VVCI/Book/Chapter 2/1 him IBiowse... | s 1
G
Delimiter: [Tab
[T —' Help
T able Wiidth: <" Ftto Data
n Set: | 1Percent *~|
Cell Padding: | Formet Top Row: j[NoForrrattirgl T|
Cell Spacing: | Border: fi

2.26-rasm. Jadvalli ma'lumoctlarni import gilish.

0 Cell Spacing (PaccTtosaHune mexay fdveiikamn). Jadvalning yonma-
yon turgan kataklari orasidagi masofani belgilaydi.

o Format Top Row (®opmaTmpoBaHMe BepxHel CcTpokwu). Jad-
valning birinchi gatorini formatlash uchun to'rtta 'variantni taklif qi-
ladi.

° Border (Pamka). Bu yerda jadvalning chegaraviy ramkasining
galinligi belgilanadi. Agar ramka zarur boTmasa u holda bu maydonda
nol ko'rsatish kerak.

3. OKL tugmasini bosing.

Agar muloqgot ovnasida ko'rsatilgan jadval tashkil giluvchilari matnli
faylda.gija.dval tashkil giluvchilariga to'g‘ri kelmasa. u holda jadvalni
import gilish noto”'ri bajariladi. Anigroq aytganda jadval buzilgan
holda Ico‘chadi.
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Savol va topshiriglar:

1. Jadvallar bilan ishlashda qaysi deskriptorlardan foydalaniladi?

1. Jadval qodyish ketma-ketligini aytib bering?

3. Jadvalli ma’lumotlarni import gilish ganday amalga oshiriladi?

A Jadvalga gator y old ustun qo'shish va ularni o‘chirish ganday amalga
oshiriladi?

2.12. Sahifalarni brauzerlarda ko‘rish

Dreamweaver HTML - sahifalarni vizual tahrirlash dasturlari sin-
figa kiradi. Dreamweaver dasturi HTML sahifalarni maxsus dasturlar
yordamida tabiiy taswlarga yaqin ko‘rinishda ko‘rsata oladi. Bunday
dasturlar brauzer dasturlari deb yuritiladi. Biz bu dasturlar hagida
yuqorida batafsil ma'lumot bergan edik. Brauzerlarda ko‘rish ketma-
ketligi bilan tanishib chigamiz:

1 Sahifani brauzerda ko‘rish uchun File > Preview in Browser
(®ann > MpocmoTp B 6Gpay3epe) buyrug‘ini bering;

2. Ochilgan oynadan brauzerni tanlang;

B buyrug hujjat ovnasida ham, uzel dispetcheri oynasida ham
mavjud. Asosiy brauzerni yuklasb uchun F12 tugmasi xizmat giladi.
Asosiy vayordamchi brauzerlarni tanlash quyidagicha:

1. File > Preview in Browser > Edit Browsers List (®ann > npo-
cMOTp B Opay3epe > WM3meHUTb CcnMcOK 6paysepoB) yoki Edit >
Preferences (IMpaBka > HacTpoiiku) buyrug’ini bering. Qaysi buyrugni
berishdan qgat'iy nazar, ekranda Preferences (HacTtpoikn) mulogot oynasi
hosil bo'‘ladi:

2. Bu mulogot oynasida barcha tegishli ko'rsatkichlarni kiriting va
ularni o'rnatilishi uchun OK tugmasini bosing.

e + belgisi ostidagi tugma, hisobga olingan ko'rish dasturlari
ro‘yxatiga yangi braiazerni go'shadi;

 — belgisi ostidagi tugma tanlangan brauzerni ro‘'yxatdan o‘chi-
radi;

* Edit (M3meHunTb) tugmasi ro'y xatga olingan brauzer parametrlarini
o'zgartirisliga imkon beradi;

* Primary Browser (MepBnuHbIii 6pay3ep) bayrogchasi ro'yxatda
tanlangan dasturni birinchi darajali brauzerga aylantiradi (birinchi
darajali brauzerni chaqirish uchun F12 tugmasini bosish kerak);
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« Secondary Browser (BTopuuHbiini 6pay3ep) bayroqchasi ikkin-
chi darajali brauzerni tanlaydi. Bu vazifa CTRL+F12 tugmalar
kombinatsiyasi y'ordamida bajariladi:

* Previexv Using Local Server (IpocMOTp HeNoKalbHOM CcepBe-
pe) bayroqclia yordamida lokal server yordainida sa-hifalarni ko'rish
rejimini o’rnatish yoki olib tashlash murnkin. Barcha serverga tegishli
dasturiy ta’'minot lokal kompy uterga oldindan o'rnatilgan bo'lishi lozim.

Dasturning bunday imkoniyatlari web-sahifani tayvorlash ja-
rayonining o‘zida ko'rish nchun qulaylik yaratib beradi. Bunda
foydalanuvchu nafagat bitta, balki bir nechta brauzerdan bittasini tanlash
imkoniyatiga ega bo'ladi. Brauzerlar sahifani bir xil ko'rsatsada, ammo
ulardan foydalanish. boshgarish va interfevs har xil bo'ladi. Shuning
uchun ham Foydalanuvchi o'zi xohlagan brauzerni tanlash imkoniyatiga
ega bo'ladi.

Savol va topshiriglar:

1. Sahifani brauzer dasturida ko'rish uchun ganday buyruq beriladi?

2. Asosiy va yordamchi brauzerlarni tanlash ketma-ketligini aytib be-
ring?

3. Preferences (HacTtpoiikn) mulogot oynasi tuzilishini tushuntirib
bering?
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I11-bob. KOMPYUTER GRAFIKASI VA DIZAYN
3.1. Koinpyuter grafikasi va dizayn

Bizga ma'lumki web dizaynning ajralmas gismi bu kompyuter
grafikasi hisoblanadi. Boshgacha aytganda kompyuter grafikasi
yordamida saytlarni dizayni mukamallashtiriladi. Saytlarni be-
zash uchun turli xil illustratsiyalar (rasmlar, grafiklar, roliklar.
animatsiyalar, bannerlar va boshqalar) yaratishda va tayyor grafik
formatdagi ma’'lumotlarni o‘zgartirishda kompyuter grafikasidan
keng foydalaniladi. Kompyuter grafikasi va uning tarkibiy qismi
bo'lgan grafik va turli tasvirlar axborot texnologiyasida muhim crrinni
egallaydi. Pedagogika oliy ta’lim muassasalarida ta’lim olayotgan
talabaj(irga kompyuter grafika vci dizayn fanlarini o‘rganish,
ularga grafik axborot texnologiyalari haqgidagi bilimlarni beradi va
professionalfaoliyatida ulardan samaralifoydalanishga tayyorlaydi.
Boshgacha aytganda liar ganday bo‘lajak o‘qituvchi, kelajakda
o'ziniiig fani boyicha elektron o‘quv resurslarini yarata olishi
kerak. Bu bilan esa ta’'lim samaradorligiga erishiladi. O ‘qituvchi
dasturlash texnologiyasician yaxshi xabardor bo‘lishi lozim. Ammo
a yaratgan resurslari tcilabalarni o‘ziga tortadigan dizayn bilan
boyitiimagan bo'lsa, u /jo/da liar ganday dasturiy mahsulotning
o‘gitisJi jaruyonidagi sumaradorlioi past bo‘ladi. Shuning uchun
ham dasturlash bilan birga kompyuter grafikasini ham mukammal
o'rganish tcuab gilinadi.

Kompyuter grafikasi va dizayn fanidagi materallarni o‘rganish
natijasida quyidagilarni bajara olish mumkin:

- rasmlar bilan ishlash:

- ko'p bo‘g‘inli statik rasmlar bilan ishlash;

- grafik muharrirlar imkoniyatlaridan foydalanish;



- turli magsadlardagi grafikli paketlarni go'llagan holda rang-
barang grafik obyektlarni yaratish;

— nashrga tasvirlarni tayyorlash.

Kompyuter grafikasi fani asosan elektron rasrn va tasvirlar bilan
ishlashni o‘rgatadi. Hozirgi kunda grafik dasturlar soni juda ko‘p
bo‘lib ular ishlash prinsipiga ko‘ra har xil grafikada ishlashi mumkin.
Masalan: Rastrli grafika bilan ishlovchi dasturlar Paint, Adobe
Photoshop, CorelPhotoPaint va boshqalar (grafik muliarrirlarning
umumiy ro‘yxati 3.1-jadval).

3.1-jadval
Grafik muharrirlar ro‘yxati
No Grafik muharrir Izoh
1. A.dobe Photoshop Rastrli grafikani qayta ishlash uchun
moijallangan
2.  TwistedBrush Pro Studio Tasvirlarni chizish va tahrirlashga
15.74 moijallangan grafik muharrir

3. CorelDraw Graphics Suite X4 Vektorli grafika bilan ishlashga mo'l-
jallangan grafik muharrir

4. CorelDraw Graphics Suite X4  3D-modellashtirish, animatsiya va vi-
zualizatsiya uchun moijallangan

5. Adobe Flash CS3 Professional Professional animatsiyali Flash-fayl-
larni yaratish uchun moijallangan

dastur.

6. Paint.NET Grafik muharrir (standart Paint das-
turini o'rnini bosuvxh i)

7. AutoCAD 2010 Eng murakkab loyilialarni chizishga
moijallangan dastur

8 Adobe lllustrator C S3 Har ganday tnurakkablikdagi vektorli
tasvirlarni yaratishga moijallangan

9. Adobe Creative Suite 5 Loyilialarni chizish va. gayta ishlashga

Master Collection i moijallangan dastur
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10. ZBrush 3.0 Ikki va uch oTchamli loyihalashga
moTjallangan grafik muharrir

11.  The GIMP Rastrli grafik muharrir

12. Adobe InDesign CS3 Har ganday dizayndagi chop etiladigan
va Internet nashrlarini loyihalashga
moTjallangan professional dastur

13.  Xara Xtreme Pro rastrli va vektorli grafikani qoTlagan
holda  professional  web-grafikani
yaratish uchun mo'ljallangan grafik

muharrir

14. Adobe Fireworks CS3 Web-saytlar uchun grafikani tayyor-
lashga va moTjallangan grafik mu-
harrir

15.  Corel Painter 11 Illyustratsiyalar chizish va tayyor-

lashga moTjallangan dastur

Rastrli grafik mukarrirlarida liar bir tasvir nugta ya'ni piksel asosida
qguriladi. Bu dasturlar yordamida yaratilgan fayliar *.bmp. *.jpg, *.psd,
*tif va boshga fonnatlarda sacjlanishi mumkin. Bu turdagi fayllar
ranglari yorqinligining juda sifatliligi bilan ajralib turadi, ularning
kamchiligi sifatida esa tasvir ni kattalashtirish bilan uning sifati yo‘qolib
borishini va xotiradan ko'pjoy egallashligini aytib o‘tish lozim. Shuning
uchun ko‘pincha ulardan tayyor rasmlarni qgayta ishlashda foydalanish
tavsiya qilinadi.

3.2, Axborotva uni tagdim etishning turli ko‘rinishlari

Hozirgi kunda inson faoliyatining turli sohalari ichida o‘zining
muhimligi bilan ajralib turuvctii soha — bu tashkiliy, ya'ni ishlab
chigarish va xo’jalik hamda ijtimoiy jarayonlarni boshgaruv sohasidir.
Busiz barcha sohalarda faoliyat yuritib bo'Imaydi. Boshqgaruv axboroti
jarayon bisoblanib, tizimlar holatini ganday o‘zgarishiga garab go'yilgan
magsadga erishish uchun yetakchi yo'nalishdir. Har ganday tizim to‘g‘ri
va teskari aloga tamoyilidan iborat.
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IVIa’'lumki. insonlar bir-biriga axborotlarni uzatish jarayonida matn,
jadval, tovush va tasvir ko'rinishdagi signallardan foydalanadi.

Axborotlarni uzatish turli xil usullarda, ya'ni xabarchi yordamida,
pochta orqgali. transport vositalari yordamida, aloga tarmogMdan uzoq
m asofaga uzatish yordamida amalga osliiriladi. Aloga tarmog’i bo'yicha
ixzoq masofaga uzatish usulida ma'lumotlarni uzatish vaqtini sezilarli
darajada kamaytiradi. Buning uchun maxsus texnika vositalari mavjud.
A.xboTotlarni yig‘ish va hisobga olishni texnik vositalari ish joyida
o ‘rnatilgan datchiklar yordamida axborotlarni avtomatik ravishda
y ig‘adi. hamda kompyuterga uzatadi.

IVIutn ko‘riimishda berilgan axborotlarni qayta ishlash texnologiyalari

Maiumki, eng ko!p targalgan kompyuter texnologiyalari quyi-
dagilardan iborat:

— matnli ma’lumotlarni tahrir gilish:

— jadval ~vagrafik ko‘rinishdagi ma' lumotlarga ishlov berish.

Matnlar bilan ishlash uchun mata muharrirlaridan foydalaniladi.
HTozirgi paytda ko'plab matn muharrirlari ishlab chigilgan. Umuman
ularning vazifasi bitta ammo, beradigan imkoniyatlari va ularni
am alga oshir ish vositalari turlicha. Bu grafik muharrirlari va elektron
jadvallarga ham tegishlidir.

Formatlash vositasining yordamidan foydalanib hujjatni tashqi
ko'rinishini yaratish, stilini o‘zgartirish. tagiga chizish, kursiv harflarini
ajratish, sim'vollar o'lchamlarini o'zgartirish, satr boshini ajratishi,
ularni o'ng, chap tomonlari va markazga nisbatan tekislash va ramka
(hroshiya) ichiga olish mumkin.

Jadval ko‘rinishda berilgan axborotlarni qayta ishlash texnologiyalari

Jadval ko'rinishidagi hujjatlar har ganday korxonada liujjat
ayrlanishining katta qismini tashkil giladi. Elektron jadval kompyuter
xotirasida joylashgan ikki oichanili massivning satrlari va ustunlarini
o‘zida ifodalaydi.

Jadval muharrirlari ko'plab moliyaviy va ma'muriy masalalarni
yechish imkonini beradi. Masalan, oylik maoshni hisoblash va boshqga
hisobga olish masalalari: sotuv hajmini, bozor o‘sishini, daromadlarni
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tahlil qilish; foiz stavkalari va soliglarini tahlil gilish; moliyaviy
deklaratsiyalar va balans jadvalarini tayyorlash; sotish hajmini va
strukturasini hisobga olish uchun hisobchi daftarini yuritish; smeta

kalkulyatsiyasi; pul cheklarini hisobga olish; budjetga va statistikaga
oid hisoblashlar.

Tasvir ko‘rinishda berilgan axborotlarni gayta ishlash texnologiyalari

Ixtiyoriy matn yoki hujjatda grafiklar. diagrammalar, chizmalar.
rasmlar, yorliglarini Kiritish ehtiyoji grafik muharrirlarini yaratish
zaruriyatini hosil qiladi. Grafik muharrirlar qurol vositalardan iborat
boMib. ular o'ziga mos axborot texnologiyalardan foydalanib grafik
obrazlarini yaratish va o‘zgartirish imkoniyatlarini beradi.

Axborot texnologiyalarida grafik muharrirlar quyidagi turlardan
foydalanadi:

- tijorat grafikasi;

- tasviriy grafika;

- ilmiy grafika.

Tijorat grafikasiixing axborot texnologiyasi aylanma diagrammalar,
ustunli gistogrammalar, chizigli grafiklar hamda boshqga tipdagi ikki
va uch o'lcliamli grafik ko'rinishda elektron jadvalli muharrirlarida,
ma’lumotlar bazalarida va alohida lokal fayllarda saglanayotgan axbo-
rotlarni ekranga akslantiradi.

Tasviriy grafikaning texnologiyasi turli xil matnli hujjatlar uchun
regulyar va noregulyar struktura ko'rinishdagi foydalanuvchining
rasmlari (piksei grafikasi) tasvirini yaratish imkoniyatlarini beradi.
Tasviriy grafika texnologiyasini amalga oshiruvchi muharrirlar
foydalanuvchiga chiziq qalinligi va rangi, palitra quymasi, matnni yozish
uchun shrift, oldin yaratilgan grafik obrazlarini tanlash uchun vosita
beradi. Bundan tashqari, foydalanuvchi rasmni o‘chirish, girgish va
uning gismini bir joydan boshgasiga surishi mumkin. Ammo, tasvirlarni
slavdda. maxsus effektlar va ularni jonlantirish rejimida ko'rish
imkoniyatlarini beruvchi (CorelDraw, Stonyboard, 3DStudioMAX va
boshgalar) informatsion grafik texnologiy alar harn bor.

IImiy grafikaning texnologiyasi kartografiya masalalari, kimyo-
viy, matematik va boshga formulalarni o'z ichiga oluvchi ilmiy
hisoblashlarni bezabj oylashtirish uchun xizmat qgiladi.
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Kompyuter grafikasi qo'llanikdigan asosiy sohalarai ko'rsatib
o‘tamiz:

1) Grafxklarni chizish;

2) Kartograflk-geografik. tabiiy yoki iqtisodiy hodisalarni o'zaro
chegaradosh mamlakatlar, viloyatlar, o'lkalar va shu kabilarni aniq
tasviri;

3) Chizma va konstruktorlik ishlarini avtomatlashtirish;

4) Modellashtirish va multiplikatsiya;

5) Turli texnologik jarayonlarni boshqarish - real dunvo massh-
tabida interfaol rejimda ishlash. Texnologik jaravonni eng kerakli
nuqtalariga o'rnatilgan dastlabki axborot manbai bolgan datchiklardan
kelayotgan axborotlar giymatini vizual idrok qilish;

6) Nashr ishlarini avtomatlashtirish va chop etishni elektron usuli.
Reklama va san’at - qandaydir fikrni ifodalash va estetik yoqimli
tasvirlar orqgali jamoani diqqatini tortish.

Tasvir ko rinishda berilgan axborotlarni gayta ishlashning
umumiy mccsalctlari

Tasvir ko ‘rinishida berilgan axborotlarni koinpyuterda gayta ishlash
texnologiyasi xilma-xil bo'lib. juda ko'p amaliy masalalarni ha! gilishga
tatbig etiladi. Axborotlarni gayta ishlashning bu sohasini quyidagi uch
yo'nalishga ajratiladi:

1. Kompyuter grafikasi (COMPUTER GRAPHICS);

2. Tasvirlarni gayta ishlash (IMAGE PROCESSING);

3. Tasvirlarni tanib olish (COMPUTER VISION).

Tasvir ko‘rinishga ega boMniagan axborotlarni vizuallashtirish (ya'ni
tasvirni yaratish) masalalari bilan kompyuter grafikasi (COMPUTER
GRAPHICS) shug'ullanadi.

Vizuallaslitirish  tasvirlanishi zarur boigan obyektning tasnifi
(modeli) asosida bajariladi. Hozirgi paytda vizuallashtirish usullari va
algoritmlari jxida ko‘p bo'lib. ular niinani va ganday qilib aks ettirish
bilan bir-biridan farq qiladi.

Vizuallashtirishga misollar (murakkablashib borish tartibida) sifatida
quyidagilarni ko‘rsatish mumkin:

— funksiyalar grafigi;

— diagrammalari;
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- geografik xaritalar;

- animatsiyalar.

Shuni takidlab o‘tish kerakki, grafiklar vagtga nisbatan cfzgarmas
(statik) bo'ladi.

Tasvirlarni gavta islilash (IMA.GE PROCESSING) — bu tasvir-
larni almashtirish bilan bog'lig masalalar. Tasvirlarni gayta ishlash
algoritmlari uchun boshlang'ich ma’ lumotlar ham tasvirlar. natija ham
tasvirlar husoblanadi.

Grafik ma’lumotlarni tasvirlash

1. Kompyuter grafikasi lurktri

Kompyuter grafikasi tasvirlarni shakllantirish usullariga bog‘liq
holda 3 turga boiinadi:

1. Rastrli grafika;

2. Vektorli grafika;

3. Fraktal grafika.

Ular bir-birlaridan tasvir kcrrinishdagi axborotlarni hosil qilish va
gayta ishlash texnologiyalari bilan farq qgiladi.

Rastrli grafika vositasida shakillangan tasvir asosan elektron va
poligrafiva nashriyotlarida qo* llaniladi. Rastrli tasvir ikki o'lchovli
massiv (matritsa) ko'rinishdagi nuqtalar to'plamidan iborat bo'‘lib, ular
piksellar deb ataladi. Rastrli tasvirning eng kichik elementi peksildan
iborat (3.1-rasm).

Uning atributlari boshqga piksellarning
atributlari bilan bog‘lic] emas. Komp-
yuterda go‘llaniladigan operatsion tizim-

NENEEEE
larning imkonitiyaga ko‘ra. 480x640, naaBia”MBn."ia
0,
800x600, 1024x768 va undan ko'proq scussssssi sassssmEs
pikselga ega boMgan tasvirlar joylashishi aaaaaaaa laaaaaaas
mu'mkm: Tas'V|rr?|ng okham.lga ko'r'a biiibiii mmumnamw
uning imkoniyati ham oshib boradi. |gEEEEET "o AenmERE
. . I : i mmmEHS 5 .Uﬁm. 1
Ekranning imkoniyati parametrik bo‘lib, ERRERREEBAisSiawti
I»EIIKERENQ

bir dyuymdagi nuqtalar soni bilan bel-
gilanadi. Rastrli grafik vositalari bilan

L. A ; 3.1-rasm. Rastrli grafikada
bajarilgan (tayyorlangan) tasvirlar juda

piksellarning ko'rinishi.
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kam hollardagina kompyuter dasturlaridan foydalanib ishlab chigiladi.
Bu magsadda professional rassom chizgan rasm yoki fotografiya texnik
mvositalar yordamida kompyuterga kiritiladi.

Oxirgi paytda rastrli tasvirlarni kompyuterga kiritish uchun
ragamli foto va videokameralardan foydalanilmoqgda. Shu sababli rastr
grafikasini asosiy maqgsadi tas'virni yaratish emas, balki mavjud tasvirni
gayta ishlashdir.

Rastrli grafikning ijobiy tomonlari sifatida quyidagilarni ko'rsatish
mumkin:

O universalligi (bu formada har qganday tasvirni taqdim etish
mumkin);

O sliakllantirishning soddaligi;

0 rang jilolarini berish anigligining yuqoriligi.

Usht»u usulning salbiy tomonlari sifatida quyidagilarni ko'rsatish
inumkin:

O rastrli grafik bloklar hajminitig juda kattaligi;

0 ularning masshtabi o'zgarganda tasvir sifatining pasay ishi.

Rastt_li grafikada har bir tasvirni kodlash va saqglash uchun katta
hajmdagi xotira talab etiladi. Tasvirdagi juda kichik obyektlarni ko‘rish
uchun uning masshtabini kattalashtirib bo'Imaydi. Bu rastrli tasvirlarni
gayta isbilash jaravonida ba'zi bir muammolarni pavdo bo'lishiga olib
keladi.

Rastrli tasvirlar quyidagi tiplarga bo'linadi: binar, kulrang. palitrali,
to’ lig kulrang. Bunda tasvirning elementlari fagat ikki giymatni (O-voki
1) qabul qilish mumkin. Bu tasvirlar turlicha paydo bo'lishi mumkin.
Ammo I<o'p hollarda kulrang, palitrali va turli rangli tasvirlarni
o‘zgarmas yoki adektiv chegaraviy son bilan binar tasvirga almashtirish
natijasida paydo boiadi. Binar tasvirlarni saglash uchun juda ham
katta joy talab qgilinadi. Ularning har bir elementi uchun 1 bit joy kerak
bo‘ladi. fCulrang tasvirning elementlari ma'lum bir rang intensivligining
turli xil qgiymatlarini gabul giladi. Odatda bu tasvirlarning har bir
elementini saglash uchun 8 bit ishlatiladi. Kulrang tasvirlar turli xil
ainaliy nrasalalarni hal gilishda eng ko‘p go‘llaniladigan tasvirlardan
biri hisoblanadi.

Palitrali tasvirlarning har bir elementiga ranglar xaritasining bir
katakchasidagi rang mos qo'yiladi. Palitra - bu ikki o'lchovli massiv
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bo'lib, lining gatorlariga turli ranglar, har bir ustunlariga esa ma'lum bir
rangning intensivligi joylashtiriladi.

To'liq rangli tasvirlar elementlari rangni tashkil etuvchi yorginliklari
hagidagi axborotni o'zini saqlaydi. Shu bilan u palitrali tasvirlardan
farg giladi. Amaliy masalalar yechishda gavsi tipdagi tasvirni tanlash
masalasining o'ziga xos xususiyatlaridan bog'lab, tasvirdagi zarur
axborotni ganchalik to‘lig ifodalanishi bilan xarakterlanadi.

Vektorli grafilta vositasida shakllangan tasvir sodda grafik
obyektlar to'plamidan tuzilgan bo'lib. uning tipik elementiga mos
keladi. Vektorli tasvirning asosiy elementi chiziqg bolib hisoblanadi.

Kompyuter xotirasida bu chizig juda katta joy egallamaydi,
chunki xotirada chizigni fagat parametrlari ko‘rsatiladi. Unda
sodda obyektlar murakkab obyektlarga birlashtiriladi, shu sababli
vektor grafikasini obyektga yo‘naltirilgan graiika deb ham aytiladi.
Kompyuter xotirasida vektor grafikasi chiziglar sifatida saglanib
turishiga garamasdan, tasvir ekranga nuqtalar sifatida chiqgariladi.
Tasvirni ekranga chiqgarishdan oldin har bir parametrni hisoblab
chigadi. Shu sababli vektor grafikasini hisoblanuvchi grafika deb
aytiladi. Vektor grafikasi yordamida sodda turdagi bezash ishlarini
olib borish mumkin.

Vektorli grafik tizimning muhim tavsifi bo'lib. uning sodda grafik
elementlarining tarkibi xizmat qiladi. Sodda grafik elementlariga bir
nechta misol keltiraniiz:

- Koordinatasi ko'rsatilgan nuqtalar boshlanuvchi ma’lum bir
burchak ostida yo‘nalgan va berilgan uzunlikka ega boTgan chizig;

- Markaziy koordinatalari ko' rsatilgan nuqtada joylashuvchi, varim
oglarining uzunligi, chizigning rang va qalinligi, hamda uni bo'yash
rangi berilgan ellips;

- Chap tomondagi yuqori burchagiga joylashgan nugtaning koor-
diratalari, tomonlar uzunligi, chiziq qalinligi va rangi ko'rsatilgan
to'g'ri to'rtburchak.

Vektorli tasvirni ko‘rsatayotganda sodda elementlarning chizigli
geometrik atributlari, uning boshlang‘ich va zarur o'lchamlari
o'rtasidagi munosabatni, hamda chiqarish qurilmalarida (monitorlar,
chop etish qurilmasi) ruxsat berilgan xatolikni hisobga olgan holda
hisoblab chigadi. Sunday usul masshtablashtirish imkoniyatini sezilarli
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darajada oshiradi. Tasvir o'lchamini gancha ko'pavtirsa ham, uning
sifati o'zgarmaydi. Tasvirning o'lchamiarini juda kichiklashtirib
yuborganda, sodda elemenlarning chiziglari ustma-ust tushib golishi va
xatolarni ixcliamlash liisobiga uo‘zgarishi (buzilishi) mumkin.

Fraktal grafika vositasida shakllangan tasvirlar ham xuddi vektorli
grafika kabi matematik hisoblarga asoSiangan. Ammo kompyuter
xotirasida hech ganday obyektni saglamasligi bilan undan farq giladi.
Tasvir tenglama (yoki tenglamalar tizimi) bo'yicha quriladi. Shuning
uchun formulalardan boshga hech narsani saglash kerakemas.

«Fraktal» atamasi lotincha Fractus so'zidaa olingan va u «qis-
mlardan tuzilgan» ma’nosini anglatadi. Frantsuz matematigi Benua
Mandelbrot 1975-yilda «The fractal geometry of Nature» kitobini nashr
gildi va fraktal so'zi eng ko‘p tarqalgan atamalardan biriga aylandi.

Eng sodda fraktal obyekt sifatida qor uchqunlarini yoki
paporotnik bargini keltirish mumkin. Shuning uchun ham fraktal
obyekt chizish yoki bezash asosida emas, balki programmalashtirish
asosida hosil bo‘ladi. Koinpyuterda tashkil qilingan turli
o'yinlarda ham fraktal graiikasidan foydalaniladi. Fraktal grafikasi
kompyuter xotirasida saglanib turmavdi. Har bir tasvir tenglama
yoki tenglamalar sistemasi asosida quriladi. Fraktal grafikadagi
tenglamaning biror koeffitsiyentini o‘zgartirish orgali butunlay
boshga tasvirni hosil qgilish mumkin.

Sanab o'tilgan kompyuter grafikasi turlarini tashkil gilish va ularni
boshgarish uchun bir gator dasturiy vositalar ishlab chigilgan.

Rastrli tasvirlar va ularning asosiy xarakteristikalari

Rastr - bu juda kichik yuzaga ega bo'lgan geometrik figuralar
(piksellardan), masalan kvadratchalardan tuzilgan matritsa. Har bir
piksel o'z raagiga ega bo'lishi mumkin. Turli ranglarga ega bolgan
rastrlar to‘plami tasvirni tashkil etadi. Tasvir ko'rsatilayotgan sirtda
piksellarni joylashishiga nisbatan rastrlar turli tiplarga boiinadi:
kvadrat, to‘rt burchak, doira va shu kabilar. Piksellar joylashishini
tasvirlash uchun turli xil koordinata tizimlaridan foydalaniladi. Bu
tizimlarni hammasi uchun umamiy bo'lgan xossa, ularda piksel
koordinatalarining diskret giymatlar gatoridan (batun son boTmasligi
niumkin) tashkil topgandir. Ko'p hollarda butun sonlar koordinatasidan
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foydalaniladi. Bunda piksellarning boshlang'ich koordinatasi chap
tomondagi yuqori burchakdan boshlanadi.

Rastninggeometrik xarakteristikalari quyidagilardan iborat:

O Ruxsat berilgan xatolik;

O 0 ‘Icham;

O Piksel shakli.

Rastrda ruxsat berilgan xatolik o'zaro go'shni (yonma-yon) joy-
lashgan piksellar orasidagi masofa bilan xarakterlanadi. Ruxsat berilgan
xatolik bir birlik uzunlikdagi piksellar soni bilan o‘lchanadi. Eng ko‘p
targalgan o‘lchov birligi bo‘lib. dpi (dots per inch) xizmat qiladi. U bir
dyuym (25,4mm) uzunlikdagi piksellar soni.

Rastrning o'lchami odatda gorizontal va vertikal o'qlar bo‘yicha
joylashgan piksellar soni bilan aniglanadi. Shuni ta'kidlab aytish
mumkinki, har ikki o‘gqlar uchun bir xil gadamli (ya'ni, dpiX =dpiY)
rastr kompyuter grafikasi uchun juda qulay. Bu aynigsa grafik
obyektlarni chigarish algoritmlari uchun qulay. Aks holda muammo
paydo bo'ladi.

Rastr piksellarining shakli tasvirni chigarish qurilmasining xu-
susiyatlari bilan aniglanadi. Vlasalan, piksellar quyidagi shakllarda
bo'lishi mumkin:

1 ICvadrat (yoki to'g'ri to'rtburchak shaklidagi piksellar). Ular
o'lchami bo'yicha rastr gadamiga teng (suyuq kristalli displeyda);

2. Doira shaklidagi piksellar. Ular o'lchami bo'yicha rastr gadamiga
teng boTmasligi mumkin (printerlar).

Ranglar soni (rang chuqurligi) ham rastrning eng muhim xa-
rakteristikalaridan biri. Ranglar soni fagat rastrli tasvir uchun emas.
Balki har ganday tasvir uchun ham muhim xarakteristika hisoblanadi.

Savol va topshiriglar:

1. K.ompyuter grafikasi nima?

2. Qanday grafik muharrirlar toor?

3. Grafikaning ganday turlari bor?

4. Kompyuter grafikasi ganday turlari bor?
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IV-bob. ADOBE PHOTOSHOP DASTURII
4.1. Adobe Photoshop dasturi hagida

Adobe Photoshop Windows mubhitida ishlovchi elektron ko'ri-
nishdagi foto tasvirlarni tahrir giluvchi dasturdir. Adobe Photoshop
dasturi Adobe System. Inc koinpaniyasi tomonidan ishlab chigarilgan
boTib, ishlatishdagi alohida qukyliklari bilan mashhur hisoblanadi.

Adobe Photoshop grafik muharriri yordamida fotosuratlarga qo'-
sliimchalar kiritish, fotosuratdagi dog'larni o‘chirish va eski rasmlarni
cqavta ishlash va tiklash, rasmlarga matn Kiritish, go‘shimcha maxsus
effektlar bilan boyitish. bir fotosuratdagi elementlarni ikkinchi
fotosuratga olib Otish. ranglarni o' zgartirish. almashtirish mumkin.
A.dobe Photoshop imkoniyatlari keng gamrovli bo'lib. a gazeta va
jurnallarni turli tuman rasmlar bilan boyitishda juda katta qulayliklar
yaratadi.

Adobe Photoshop avnigsa dizaynerlar. rassomlarning ijodiy im-
koniyatlarini to‘la amalga oshirishlarida yordam beradi. Jurnalistika va
bevosita matbuot yoki nashriyot sohasiga alogador bo‘lgan shaxslarning
mazkur dastur bilan ishlashni bilishi ular uchun qgo‘shimcha
imkoniyatlarni yaratib beradi. Adobe Photoshop juda murakkab
dasturdir. Foydalanuvchilar uning asosiy imkoniyatlaridangina foy-
dalanadilar xolos.

Dasturni ishga tushirish ketma-ketligi quyidagicha: Windows
95, 98. ME, 2000, XR yoki NT operatsion tizimlarida Start (Iyck)
tugmasi ustida sichqoncha chap tugmasini bosing Programs (Mporpam-
Mbl) bo'limiga kiring so'ngra Adobe Photoshop elementi ustiga vana
sichgoncha chap tugmasini bilan bosing. Bundan tashqari ish stolida
mavjud Adobe Photoshop uchun maxsus belgida «sichgoncha»ning
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chap tugmasi ikki marta bosish yo‘li bilan ham dasturni ishga tushirish
mumkin.

Adobe Photoshop dasturidan chigish uchun quyidagi usullarning
biridan foydalanish mumkin:

Alt + F4 tugmalarini bosish.

®arin menyusining Beixoa buyrug‘ini tanlash.

Ekranning yuqori qismi ong burchagida joylashgan x belgili
tugmachani bosish yoki ®aiin > 3akpbiTb buyrug'ini berish:

Dasturning liar bir versiyasi o‘zida yangi elementlarni mu-
jassamlantirgan. Bu o'zgarishlar Photoshop 7.0 versiyasida ham ku-
zatiladi.

4.2. Adobe Photoshop dasturi oynasi gismlari

Adobe Photoshop dasturi ishga tushirilgandan so'ng ekranda Adobe
Photoshop tasvir tahrir giluvchi oynasi hosil bo'ladi.

Adobe Photoshop oynasining yuqori qismida sarlavha satri
va Windowsga xos elementlar joylashadi. Sarlavha satridan so‘ng
menyu satri joylashadi. Menyudagi kerakli buyruqglarni tanlashingiz
mumkin.

Adobe Photoshop dasturi menyusi 9 banddan iborat. Har bir menyu
tarkibida ochiladigan menyu bandlari mavjud. Ularni ko'rish kursor
yordamida amalga oshiriladi. Dasturning barcha buyruqglari uchun
Asosiy menyu (FnaBHoe MeHt) mavjuddir:

®ainn (File) menyusi quydagi holatlarda ishlatiladi: yaratish (cos-
patb), ochish (oTkpbITb), joylashtirish (pasmecTtnTb), vopish (3a-
KpbITb), saglash (coxpaHuTb), skanerlash (oTckaHepoBaTb), import
va eksport, gog'ozga chigarish (HaneyataTb wu3o6paxeHue), faylni
tannoq orqali uzatish (nepegatb ¢aiin no cetn), bir nechta Opsiyalarni
avtomatlashtirish uchun va albatta Photoshop dasturidan chigish uchun.

Mpaska (Edit) menyusida, tasvirni tahrirlash ya'ni sozlash uchun
buyruglar: nusxalash (konupoBaHus), o'zgartirish (TpaHchopmaynn),
joylashtirish va tasvir ranglarini tusini va muyqalam galinligi va turini
tanlash mumkin.

Pexxum (Mode) menyusi orgali Image (/306paxeHue) menyusi,
tasvir sakkiz turdagi tasvir urinishlarini tanlash mumkin.
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Cnowi (Layer) menyusida joylashgan buyruglar, bir necha qat-
lamlarda joylashgan tasvir ustidagi amallar ya'ni: qatlamlararo
bog‘lanishni qatlamlar ketma-ketligini va gatlamlarni umumiy gatlamga
birlashtirish imkoniyatini beradi.

Boigenntb (Select) menyusida joylashgan buyruqglar - kerakli
gatlamlarni tanlashda (belgilashda) ishlatiladi.

duntp (Filter) menyusi o'zida tasvirlarni birlashtirish va umumiy
holga keltirish uchun kerakli boigan filtrlari mavjuddir.

Bug (View) menyusidagi buyruglar, ekrandagi tasvirni Kko'ri-
nishlarini va dastur oynasi gismlarini nazorat giladi.

OkHo (Window) menyusi buyruglari, ekrandagi boshqa tasvirlarni
aks ettiradi va ulardan kerakli bo'lgan paytda foydalanish imkonini
beradi.

Momowb (Help) menyusidagi buyruglar foydalanuvchi uchun kerakli
bo'lgan maslahatlar orgali ko'mak va hozirda bajarish mumkin bo'lgan
imkonivatlar bilan tanishtiradi hamda Photoshop yaratuvchilari rasmiy
saytiga murojat gilish imkoniyatini beradi.

4.1-jadval
Dastur menyulari va ulardagi buyruglar
®ann (File) menyusi buyrugqlari
Hosbili (Cii-HM) Yangi fayl yaratish
OTKpbITb (CLri+0) Bu buyrug yordamida diskda mavjud fayllar
ochiladi

OTKpbITb Kak (AH+OrH-O)  Faylni ganday ko'rinishda ochishni tanlash
CoxpaHnts (CM+B) Faylni xotiraga mavjud formatda yozish

CoxpaHutb Kak 5blii+CIrl+3 Faylni xotiraga boshga nom bilan yoz-
ish. Ushbu buyrug fayl nomi, format
va joylashgan papkasi kabi atributlarini
o'zgartirishda foydaianiladi

CoxpaHntb Konuto Tasvir nusxasini xotiraga yozish
(AV-HOrH-B)
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BepHyTb
MomecTnTb

MmnopTt

aKcnopTt
®daiin nHhopMaumst

'YcTaHOBKa CTpaHuULbl
(ShifHCtrl+P)

Mevatb (CtrHP)

[MpeanoyTeHun

HacTtpoiika neeta
Adobe online

Bbixopg (Ctrl+Q)

BepH (Ctrl+2)

Pe3atb (Ctrl-bX)

Konunposatb (Ctrl+C)

BctasuTth (Ctrl+V)

BctasuTh (Shift+Ctrl+V)

OuncTnTb

Tasvirning dastlabki holatiga gaytish
Boshga mustagqil fayl bilan birlashtirish

Boshga papkada joylashgan faylni Adobe
Photoshop dasturiga olib Kirish

Tasvirni boshga papkaga jo'natish
Fayl hagidagi ma’lumotlarni kiritish

Tasvirni  printer yordamida chop etishga
tayyorlash, gog‘oz shaklini tanlash

Tasvirni printergajo'natish

Adobe Photoshop dasturini kerakli tartibda
sozlash

Tasvir ranglarini sozlash
Internet bilan bogTanish

Adobe Photoshop dast uridan chigish

MPABKA (Edit) menyusi

Tasvir ustida bajarilgan oxirgi amalni bekor
gilish

Tasvirning ajratilgan qismini buferga (xo-
tiraga) oiish

Nusxa olish

Buferdan (muvaggat xotiradan) kursor ko'r-
satgan joyga qo'yish

Buferdan (muvaggat xotiradan) belgilangan
joyga qo'yish

Tasvirda belgilangan maydonni tozalash,
o‘chirish. Bunda o'chirilgan maydon fon
rangiga bo'yaladi.
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3anutb WTpunx

TpaHcthopmauyms (CM+T)

TpaHcopm

Ouyuncrtka

davomi
Tasvir yuzini asosiy rang bilan bo'yash

Tasvirda belgilangan inaydonni shtrixlab
ko*rsatish

Tasvir shaklini o‘zgartirish. Tasvir shaklini
turli ko‘rinishlarda o‘zgartirish

«McTopusi» darchasida tasvir olib borilgan
o'zgartirish amallarini butunlay o‘chirish. Bu
amal bajarilgandan so'ng o‘zgartirishlarni
ortga gaytarish mumkin emas

N3OBPAXEHWE (Image) menyusi

Pexunm

Hactpolika

Ay6nukar

Hanoxwuntb nsobpaxeHune
BbluncneHue

Pazmep n306paxkeHmns
Pasmep xosncrta
O6pesaHune

MepeBepHYTb XONCT

fuctorpamma
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Rang modellarni o‘zgartirish

Tasvir ranglarini sozlash

Tasvirdan nusxa olish

Tasvirni go‘shimcha ranglar bilan boyitish
Tasvirdagi ranglar kanallarini o'chirish
Tasvir shaklini va oTchamlarini o‘zgartirish
Tasvir ramlcasi o'ichamlarini o‘zgartirish
Belgilangan maydondagi tasvirni kesib olish

Soat strelkasi bo'ylab yoki soat strelkasiga
garshi 180°, 90° burish

Tasvirdagi ranglar miqdori hagidagi ma’-
lumotlar darchasi



C/IOW (Layer) menyusi

HoBblin
[yb6nukare cnos

Ypanutb cnom

AhhekTbl

Fpynna ¢ npeablayLumnm
(Cn-M)

PasrpynupoBartb
(BAN+arr10)

CKneTb Bce crion

yangi gqatlamni hosil gilish
gatlam nusxasini hosil qilish

mavjud gatlamni muvaqggat xotiradan
o‘chirish

gatlamga turli effektlarni go‘shish

gatlamlarni bir-biriga birlashtirish

gatlamlarni bir-biridan ajratish

mavjud barcha gatlamlarni birlashtirish

13bIBOP (Select) menyusi

Bce (OrH-A)

Y6patb Bbigenerve (CnbH3I)

BblaenuTtb 3aHOBO
O6paTtHo 51i-K~rl+1)

LiseToBoit psg (BblA+0rT+Ll)

Mogaudunuposatb
YBennuntb
Mpeobpa3oBatb BblAeneHune

CoxpaHuTh BblagneHmne

tasvirni belgilash

tasvirning belgilangan gismini muvaqggat
xotiradan o‘chirish

gaytadan belgilash
so’nggi bajarilgan amalni gaytarish

tasvirdagi ranglar asosida belgilash
maydonini aniglash

belgilash chizig‘ini piksellarda kengaytirish
belgilash maydonini kengaytirish
belgilangan maydon shaklini o‘zgartirish

belgilangan maydon shaklini xotiraga
joylashtirish
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OUNIBTP

MocnefHuin punetp  Foydalanuvchi tomonidan ohirgi ishlatilgan filtrni

go'llash.
3aTouka >
Mukcenn >
MaTHO > OTnatiladigan filtrlar ro‘yxati
Ctunn >
Wym >
Opyroe > Boshqa filtrlar

BWA (View) menyusi

Hosblili BUA Asosiy tasvirni yangi darchada ochish

yBenunuutb (Crid++) Tasvirning ekrandagi korinishini kattalashtirish

OKHO (Window)
[OKyMEHTbI > OuunraH xyxokatnap (pacMnap) pyixatu

Pabouee nNpocTpaHcTBO. VIHCTpYyMeHTbI. Onuuu,
Bbpaysep alina, Hasuratop, WHdpopmaLus,
Lieet, O6pa3sunku, Ctunu, Vctopus, Oeicteus,
MpenycTaHOBKU WHCTPyMeHTa, Cnowu, KaHanbl,
MyTtu, Kuctn, Cumson, Maparpad, CTpoka co-
CTOSAHNSA

Dastur oynasi gismlari

noMoLub (Help)

Momowb Photoshop Photoshop dasturi bo'yicha yordam ma’lumot olish
Fl

O nporpamme Photoshop dasturi hagida maTumot olish. Unda
Photoshop dastumiag nomi versiyasi ishlab chiquvchilar ha-
gida ma’lumot beriladi.
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System info .. Foydalanuvchining kompyuteri hagidagi ma’lu-
motlarni ko‘rsatadi.

Updates ... Internetga ulanish orqgali Photoshop dasturini yan-
gilash (o6HoBNEHMSA) imkonini beradi.

Registration ... Registratsiya (Adobe Photoshop dasturini ro‘y-
xatdan o ‘tkazish)

Adobe Online ... Adobe kompaniyasining Web-saytini ochib beradi.
Unda dastur bilan ishlash bo‘yicha maslahatlarni
0z ichiga oigan punktlar beriladi.

Adobe Photoshop dasturida jami 46 ta uskunalar mavjud bo‘lib,
ulardan 20 tasi bevosita dastur ishga tushirilganda darchada ko‘zga
tashlanib turadi. Qolganlarini qo'shimcha buyruglarni bajarish orqali
ishga tushirish mumkin. Agar uskunalar panelidajoylashgan tugrnaning
ostki gism o'ng burchagida kichik uchburchak shakli tasvirlangan
bo'lsa, bu tasvir ushbu tugma tarkibida o'xshash buyrugni bajaruvchi
uskunalar yashiringanligidan darak beradi.

Yashiringan uskunani faollashtirish uchun kursorni maxsus belgili
tugma ustidan sichgonchaning chap tugmasini bosgan holda uskunalar
panelidan tashqgariga olib chigiladi va kerakli tugma ustida kursorni
keltirilib sichgonchaning chap tugmasi qo’yib yuboriladi.

Har bir tugmaga kursor yagqinlashtirilsa, kursor belgisi ostidagi
uskunaning gandav vazifani bajarishi haqidagi axborot paydo bo*-
ladi. Quyida Adobe Photoshop dasturida ishlash jaravonida keng
go‘llaniladigan uskunalarning gisqacha tavsifi keltiriladi.

MpsAmoyronbHas 06nacTb: Tasvirda to‘g‘ri to'rtburchak shaklidagi
maydonni belgilab olish uchun qollaniladi. Bu uskuna yordamida
tasvirdagi alohida maydonni belgilab olingandan keyin tasvirga
kiritilgan barcha o'zgarishlar faqat belgilangan maydon ichiga ta’sir
etadi. Ushbu tugmaga qo'shimcha tarzda Shift klavishi ishlatilsa,
belgilangan maydon hududi ortadi. Sliift klavish o'rnida Alt klavishi
go'llanilgan taqdirda belgilangan maydon hududi qisqaradi. Ushbu
amal Jlacco va Bonwe6Hasa nanouyka uskunalari bilan ishlashda
goTlaniladi.
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3nmmntnucCKaH o6nacTb; Tttsviitla uoixa bhakiidagi maydonni
belgilab olish uchun gqo‘llaniladi. Bu uskuna yordamida tasvirdagi
alohida maydonni belgilab olingandan keyin tasvirga kiritilgan barcha
o‘zgarishlar fagat belgilangan maydon ichiga ta’'sir etadi.

Ctpoka nukcenei: Tasvirda gorizontal shakldagi chizigni
belgilaydi. Amalda bu uskunajuda kamqoilaniladi.

Crtonbey nukcenei: Tasvir yuzida vertikal chizigni belgilaydi.
Amalda bu uskuna ham juda kam qollaailadi.

KagpuposaHue: Ushbu uskuna, asosan, tasvir chetlarini va
keraksiz qismlarini kesib tashlash uchun qoTlaniladi. Bu buyruq
faollashtirilganda tasvir yuzida to‘g‘ri to‘rtburchak shaklidagi ramka
hosil boTadi. Ramkaning chetlari kichik kvadratchalardan iborat bo'lib,
bu kvadratchalar yordamida ramka hajmi o'zgartiriladi. Tasvir ramka
ostiga olingandan so‘ng Enter klavishi bosilsa, ramka tashqarisida
golgan ortigcha bo'laklar kesib tashlanadi. Ushbu buyrugni Esc
klavishini bosib rad etish mumkin.

MepemeweHne: Ushbu uskuna tasvirdagi belgilangan maydonni
yoki gatlamni siljitish va kesib olish uchun xizmat qiladi. Ba'zan MNepe-
MeweHne buyrug‘ini bajaradigan aynijarayonni boshqga ayrim uskunalar
(masalan. Bonwe6Haa nanoyka uskunasi) yordamida ham amalga
oshirish mumkin.

Jlacco: tasvirdagi turli shakldagi obyektlarni belgilash uchun ish-
latiladi.

MHoroyronbHoe nacco: Asosan tasvirdagi to'g‘ri chiziglardan
iborat obyektlarni belgilashda ishlatiladi. Alt klavishi bilan
go‘llanilganda oddiy flacco uskunasi vazifasini bajaradi.

MarHuntHoe nacco: Bu uskuna ishlatilganda Adobe Photoshop
dasturi tasvirdagi obyekt chegaralarini o‘zi belgilaydi. Ammo bu
uskuna piksellardagi ranglarni o‘zgarishiga bogTig tarzda chegaralarni
aniglashi bois kam qo‘llaniladi.

BonwebHaa nanoudka: Bir-biriga yaqin bo‘lgan rangdagi piksellar
joylashgan maydonni belgilaydi. Shift bilan birgalikda qo‘llansa,
belgilangan maydon hajmi ortadi. Alt bilan ishlatilganda esa belgilangan
maydon hajmi kamayadi.

Asporpad: Tasvirni boyashda ishlatiladi. Aerografni bir joyda
ushlab turish siyohni tasvir bo‘ylab yoyilib ketish effektini beradi.
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Buyogning tasvir bo‘ylab oqishi kursorni qcryib yubormaguncha davom
etadi. Odatda bu uskuna bilan yumshoq chutkalar ishlatiladi. Aerograf
kursorni ushbu uskuna ustida bosish yoki klaviaturadagi J klavishni
bosish orgali faollashtiriladi.

Knctb: Aerograf uskunasi kabi tasvirni buyashda ishlatiladi.
Ammo Kist yordamida tasvirni sifatli bo'yash mumkin. Bu uskuna
aerografga nisbatan ko‘p qoTlaniladi. Kist uskunasini V klavishini
bosish orgali faollashtirish mumkin. Brushes darchasi yordamida buyoq
mo‘ygalamlarining shaklini o‘zgartirish mumkin.

Wramn: Tasvirdagi kichik bir bolak nusxasini ko‘chirish uchun
ishlatiladi. Bu uskuna tasvirdagi ayrim nugsonlarni. dog'larni yo'gotish
va eski rasmlarni tiklashda keng qo‘llaniladi.

Knctb npeablgyuwmnx coctosHuin: Bu uskuna tasvir hagidagi
dastlabki ma’lumotlar asosida ishlaydi. Uning yordamida tasvirga
kiritilgan so'nggi o ‘zgartirishlarni bekor gilish mumkin.

Nactnk: Tasvirni o ‘chirish uchun ishlatiladi. U qoilanganda
tasvirda fon gaysi rangda boTsa, o'sha rangdagi chiziglar hosil boiadi.
Alt klavishini go'llash yordamida kompyuter xotirasiga olinmagan
so‘nggi o‘zgartishlarni bekor gqilish mumkin. Tastik uskunasi E
klavishini bosish orgali faollashtiriladi.

Kapangaw: Turli chiziglarni chiz;ish uchun foydalaniladi. Alt
klavishi bosilganda kursorning ekrandagi tasviri o‘zgaradi va bevosita
tasvirdan kerakli rangni tanlash mumkin. Bu amal bajarilgandan so‘ng
KapaHgaw ofsha rangda chiziq tortadi.

Nnnna: To‘g‘ri chiziglarni chizishda qoTlaniladi.

PasmbiBka: Ushbu uskuna ishlatilganda, tasvirdagi yorqinlik pa-
sayadi. Alt klavishi bilan goTlanganda yorqinlik ortadi.

PeskocTb: Ushbu uskuna ishlatilganda tasvirdagi yorqinlik ortadi.
Alt klavishi bilan qoTlanganda esa tasvir xiralashadi.

Maney: Tasvirdagi ranglar chayqgaltirib. tasvirdagi obyektlar o‘r-
tasidagi chegaralarni bir-biriga go‘shishga xizmat qgiladi.

Ocsetutenb: Piksellardagi ranglaryorginlashadi. Alt klavishi bilan
goTlanganda esa piksellardagi ranglar xiralashadi.

3ameHuTenb: Tasvir ustida harakatlantirilganda piksellardagi rang-
lar qoramtir tus oladi.
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ryéka: Tasvir ustida harakatlantiriiganda, tasvirdagi rangiar
miqdori pasayadi. Gubka bir joyda ko‘p harakatlantirilsa, tasvirning
o‘sha joyi kul rang tus oladi.

Mepo: Peroni tasvir ustida harakatlantiriiganda, nuqtalar hosil
bo‘ladi. Ushbu nugtalar yordamida chizilgan tasvirni o‘zgartirish
mumkin.

MarHmnTtHoe nepo: Bu uskuna xuddi MarHutHoe Jlacco Kkabi
harakatlanadi. Biror-bir tasvirdagi obyekt atrofida harakatlantiriiganda,
Adobe Photoshop dasturining o;zi obyekt clietlarini belgilab chigadi.

MpownssonbHoOe nepo: Juda qulay uskuaa bo‘lib, xohlagan shakidagi
tasvirni u yordamida ifodalash mumkin.

BcTtaBuTb TO4Ky: Bu uskuna Pero yordamida chizilgan chiziqg
ustiga go‘shimcha nuqtalami go‘shadi.

Ypanutb Touky: Pero yordamida chizilgan chiziqg ustidagi ortigcha
bo‘lgan nuqtalarni o'chiradi.

HenocpeagctBeHHoe BblgeneHue: U yoki bu pero bilan chizilgan
chiziglarni tahrir qilish uchun xizmat qiladi. Uning yordamida
chizigdagi nuqtalarni yakka tartibda harakatlantirish va kerakli jovga
siljitish mumkin.

NMpeo6pa3oBaTb TOuUKy: Tasvir ustida chizilgan chizigchalarda
o‘rnatilgan liar bir nugta. burchak yoki voy vazifasini bajaradi. Ushbu
uskuna yordamida nuqtalarning vazifalarini o'zgartirish, ya'ni yoyni
burchalcka va burchakni yoyga almashtirish mumkin. Buning uchun
kursorni nuqgta ustiga olib borib sichqgonchaning chap tugmasi bir marta
bosiladi.

TekcT: Ushbu uskuna yordamida tasvirga turli matnlarni Kiritish
mumkin. TekcT uskunasi faollashtirib, kursor tasvir ustida bosilsa. matn
kiritish uchun alohida darcha hosil boiadi. Bu darchada harf oichami,
turi, rangi va boshga ko‘rsatkichlari kiritiladi. Bu uskuna yordamida
kiritilgan matnni gayta tahrir gilish iinkoni mavjud emas.

TekcT-macka: «TekcT» uskunasi kabi bu uskuna faollashtirilib,
matn ustida bir marta bosilganda, «TeKcTOBbIi1 MHCTPYMeEHT» darchasi
hosil boTadi. Lekin bu matn oddiy matndan tubdan farqg qiladi.
Harflarning cheti xuddi Jlacco uskunasida belgilashkabi ko‘rinishga ega
bo‘ladi. Harflarni turli ranglarga bo‘yash va «[lepemeweHune» uskunasi
yordamida o'rnidan siljitish yoki boshga rasmga olib o‘tish mumkin.
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BepTukanbHbIl TeKcT: Agar tasvirga pastdan yuqoriga shaklda
(vertikal shaklda) matn kiritmogchi bo‘lsangiz ushbu uskunadan
foydalanishingiz mumkin.

BepTukanbHasa TekcT-macka: Xuddi TekcT-macka uskunasi Kkabi
bir xil vazifani bajaradi. Ammo bu uskuna qo‘llanganida harflar ustma-
ust ustun kabi joylashtiriladi.

MN3mepuTenb: Tasvirda turli o‘lchov!arni bajarish uchun ishlatiladi.
Bu uskuna bilan bir nuqgtadan ikkinchi nuqgtaga kursor olib borilishi
kifoya. Shundan so‘ng dastur avtomatik tarzda ikki nuqta orasidagi
masofani o‘lchaydi.

MpagueHT: Bu uskuna ishlatilganda. tasvirdagi belgilangan may-
donda ranglar kombinatsiyasi hosil bo'ladi. Asosiy rangning tasvir
foniga sizib o'tish effekti hosil bo‘ladi.

Kosww: Ushbu uskunadan asosan. tasvirni yoki tasvirdagi ajratib
olingan hududni bo'yashda foydalaniladi. Ranglarni qgo‘shimcha
buyruglarni bajarish orqgali tanlanadi. Bu uskunani faollashtirish uchun
K klavishi bosiladi.

NMuneTtka: Tasvirdagi asosiy yoki tasvir foni rangini o‘zgartiradi.
MuneTtka tasvir ustidagi biror nugtada bosish bilan o‘sha nuqtadagi,
ya'ni pikseldagi rang asosiy (faol) rang sifatida tanlanadi. Agar
ayni jarayonga Alt klavishasi qo’shilsa, tanlangan rang tasvir fonini
o‘zgartirishiga olib keladi.

Boibopka uBetoB: Ushbu uskuna tasvirdagi ranglar hagida axborot
olishga xizmat qiladi. Info darchasida belgi go‘yilgan nuqgtada necha
foiz qizil, ko'k va qora ranglar mavjudligi hagidagi axborot hosil
bo’ladi.

Pyka: Tasviming ko;zga tashlanmay turgan gismlarini ko'rsatadi.
Buning uchun ushbu uskuna faollashtirilib tasvir ustida sichgonchaning
chap tugmasini bosgan holda kerakli tomonga harakatlantiriladi. Ayni
jarayonni Adobe Photoshop dasturi darchasidagi Navigator yordamida
ham amalga oshirish mumkin.

MacwTab: Tasvirni kattalashtirisb yoki kichraytirib ko'rsatish
uchun xizmat giladi. Agar ushbu uskuna bilan birgalikda Alt klavishi
ishlatilsa. tasvir kichrayadi. Kursor ushbu uskuna faollashtirilgandan
so‘ng o'z shakliai o‘zgartiradi va lupa ko‘rinishini oladi. KLursor
tasviming qaysi nugtasida bosilsa, Adobe Photoshop dasturi
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aviomatik tarzda o‘sha nugiani ekranga yagqiniashtiradi. Masshtab
uskunasini faollashtirib, Enter klavishi bosilsa, Onuua macwTabn-
posaHusa darchasi ochiladi. Bu darchada maxsus tcfrtburchak ichiga
belgi go‘yilsa? tasvir o‘lchamlari o‘zgartirilganda tasvir darchasi ham
mos tarzda o ‘zgaradi. Har safar tasvir oichamlarini kattalashtirish
yoki kichraytirish uchun MacwTa6 uskunasini faollashtirish zarur
emas. Boshqga uskuna bilan ishlash paytida Ctrl-Probei bosilsa.
ishlatilayotgan uskuna vaqtinchalik MacwTtab usktmasi vazifasini
bajaradi va tasvir kattalashadi. Ctrl + Probel o‘rnida Alt+Probel
gollanilsa, tasvir o'lchami kichrayadi. Shuningdek, tasvir oTchamini
Ctrl + «+» (plyus) klavishlari yordamida kattalashtirish yoki Ctrl+
«—» (minus) yordamida kichraytirish mumkin. Adobe Photoshop
dasturi darchasi ostida «Ctpoka coctosaHus» satrida tasvir olchamlari
hagida axborot beruvchi maxsus darcha mavjud. Bu darchada tasvir
o‘Ichamlari sonlarda ifodalangan. Ushbu sonlarni o'zgartirish orgali
tasviming aniq oTchamlari kiritiladi.

OcHoOBHOI4 UBeT: Ushbu uskuna ustida kursor ikki marta ketma-ket
bosilganda Adobe Photoshop dasturining yangi darchasi (Bbibop uBeTa)
hosil bo'ladi. Bu darchada kerakli rang tanianib, OK yoki Enter tugmasi
bosiladi va tanlangan rangni KapaHgaw. Kwuctb, Asporpadg, Fpagm-
eHT kabi uskunalari yordamida qgollash mumkin. LBeT ¢oHa: Ushbu
tiigma ustida kursor (sichgoncha chap tugmasi) ikki marta ketma-ket
bosilganda Adobe Photoshop dasturining yangi darchasi (Color Picker)
hosil bo'ladi. Bu darchada tasvir fonining rangi aniglanadi. Tasvir
fonidagi rang Jlactouka va l'pagueHT uskunalari uchun go'llaniladi.

MepeknoyeHne uBetoB: Ushbu belgi ustida kursorni bosish bilan
asosiy rang bilan tasvir foni ranglari o‘rni almashtiriladi.

LiseTta no ymonyaHuio: Bu belgi ustida kursorni bir marta bosish
bilan asosiy rang goraga vatasvir foni ranglari ogga aylanadi.

Mapuwwupytouwne mypasbu: Bu tugmayordamida Adobe Photoshop
dasturida tez nigoblash holati bekor qilinadi. Ekranda belgilash
chegaralari chumolilar harakatini eslatuvclii punktir chiziq yordamida
aks ettiriladi. Bu Adobe Photoshop dasturida odatda standart holat deb
ataladi.

BbicTpaa macka: Ushbu tugma ustida kursor bir marta bosilishi
bilan Adobe Photoshop dasturi tez nigoblash holatiga o‘tadi va
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natijada tas\irdagi n igoblanmagan xudud qizil rang bilan bo‘yaladi.
Ushbu uskuna tasvirdagi turli obyektlarni anig nigoblashda
ishlatiladi. Kuct uskunasi yordamida nigobga ishlov berish mumkin.
Blinda qora rang bilan tasvir nigoblanadi, oq rang bilan tasvirdagi
nigob o'chiriladi.

CraHpgapTHOe OKHO: Uskuna faollashtirilganda tasvir standart
holatda bo‘ladi.

MonHbliA 3KpaH ¢ MeHI: Bu holat tasvir kompyuter ekraniga sig‘-
magan holda ishlatiladi. Ushbu uskuna faollashtirilganda ekranda
fagatgina menyu satri hamda uskunalar paneli goladi.

MonHbii akpaH: Ekranda fagat tasvir va uskunalar paneli hamda
menyu satri qora fonda qoladi.

Tasvir o‘lchami

Adobe Photoshop dasturida ekranda tasvirning barcha gqismini yoki
tasvirdagi kichik detallarni ko'rish uchun xohlagancha kattalashtirish
yoki kichraytirish mumkin. Masalan, 100% — bu tasvirdagi piksellar
soniga ekrandagi piksellar soni tengligini anglatadi. Ya'ni 1:1. 200%
ga tasvir kattalashtirilganda ekrandagi bir pikselga katta migdordaga
piksellar migdorini to'g'ri kelayotganligidan dalolat beradi.

Tasvirning haqiqiy o‘lchami

Adobe Photoshop dasturida 100% li oicham tasvirning real oTchami
deyiladi. 100% li o'lcliamda tasvir anig va ravshan koTinadi.

Tasvirning real o'lchami quyidagi amallarni bajarish orgali o‘rna-
tiladi:

O Menyular satrida Buag menvusida PeanbHblii pasmep buyrug‘ini
tanlang;

O Ctrl+Alt+ O(nol) tugmalarini birgalikda bosish orgali;

O Uskunalar panelidagi MacwTa6 tugma ustida sichqoncha tug-
masini ikki marta ketma-ket bosish orqali.

To‘lig ekranli rejim

Adobe Photoshop dasturi tasvirni birinchi marta ochganda uni
maksimal o'lchamda ochadi. Tasvir bilan ishlash jarayonida uning
o’lchamini bir necha marta kattalashtirish yoki kichraytirishga to‘gi
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keladi. Ana shunday liolatlaida tasvirni xohiagan paytda dastia'bki
MonHo3KpaHHbI pexum holatiga gaytarish munxkin. Bulling uchun
qguyidagi amallarni bajarish loziin:

O Menyular satrida Bupg menyusidagi Mo pasmepam 3kpaHa
buyrug‘ini tanlash;

O Ctrl+ 0 (nol) tugmalarini birgalikda bosing;

O Uskuraalar panelidagi Pyka tugmasi ustida sichgoncha chap
tugmasini ikki marta ketma-ket bosing.

Tasvirning bosma shakldagi o‘lchami (Pasmep nevatu)

Adobe Photoshop dasturi tasvirning printerda chop qilingandagi
ko‘rinishini chop gilmasdan avval ekranda ko'rish imkonini beradi.
Buning uchun Menyular satrida WM3o06paxeHne tnenyusi tarkibidagi
Pasmep un3o6paxeHua buyrug‘ini tanlanadi. Ammo, hamma vagt ham
tasvirning ekrandagi ko'rinishi bilan chop etilgandagi o‘lchamlari
aynan mos tushaverniaydi. Tasvir kattaliklari 0,2% dan 16000% miqdor
o‘rtasidagi sonlar bilan belgilanadi.

Navigator darchasi bilan ishlash

Adobe Photoshop dasturida tasvirdagi mavda detallar bilan
ishlash jarayonida tasvirni bir necha marta kattalashtirishga to‘g‘ri
keladi. Tasvirga kiritilgan o’zgartirishlar sifatli chigishi uchun
Navigator darchasida amal bajariladi. Navigator darchasi asosan
tasvir o'lchamlarini o'zgartirish va tasvirni boshqarish uchun xizmat
giladi. Agar Navigator darchasi Adobe Photoshop dasturi ishga
tushirilganda ekranda mavjud bolmasa. uni faollashtirish uchun
menyular satrida OkHO menyusidagi NMoka3ate HaBuratop buyrug‘ini
bering.

Action darchasi bilan ishlash

Action darchasi Adobe Photoshop dasturida ishlashni vanada
tezlashtiradi va bir nechta tasvir ustida amalga oshiriladigan bir
xil amallarni har safar takrorlashga zarariyat qoldirmaydi. Adobe
Photoshop dasturidagi Action darchasi bilan ishlashni bilsangiz, gisqa
fursat ichida ko‘p miqdordagi tasvirni tahrir qilishingiz mumkin.
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Biining uchun Action darchasida yangi Action ochiladi. Uni kerakli
nom bilan nomlagandan so'ng Record tugmasi bosiladi. Shu dagiqadan
beshlab Adobe PhotoShop dasturi sizning tasvir ustida bajargan barcha
amallaringizni konipyuter xotirasiga ketma-ket joylashtiradi. Tasvir
ustida barcha amaliar yakunlangandan so'ng Action darchasidagi
Stop tugmasi bosiladi. Adobe PhotoShop dasturi sizning barcha
amallaringizni tartibli ravishda Action darchasida joylashtiradi. Boshga
tasvirlarga ushbu amallarni gollash uchun yangi tasvir ochilgandan
sc’ng Action darchasidagi BbinonHeHue buyrug‘ini ishga tushirish
lozim. Adobe PhotoShop dasturi avtomatik tarzda yangi ochilgan
tasvirda ham siz amalga oshirgan vazifalarni hech bir o'zgarishlarsiz
bajaradi,

Yangi tasvir yaratish, dublikat olish va tasvirni
doimiy xotir-aga joylashtirish

Adobe PhotoShop dasturida ishlashdan avval yangi fayl tuziladi
yoki kompyuter xotirasida mavjud bo‘lgan tasvir ochiladi. Yangi fayl
tuzish va avvaldan mavjud bolgan fayllarni ochishning quyidagi
yo'llari mavjud:

O daiin > HoBbIn. Menyu satrida ®ainn menyusini ochib HoBbl i
buyrug'ini tanlang yoki Ctri+N tugm alari kombinatsiyasidan fovdalanib.
yangi fayl yarating. Yuqoridagi amal bajarilganidan so'ng Adobe
PhotoShop dasturi yangi faylni tashkil etish uchun uning o'lchamlari
hagidagi ma’lumotlar bitilgan yangi darchani hosil qgiladi. Bunda
yangi tuzilayotgan fayl nomi. uning o'lchamlari Kkiritilishi talab etiladi.
Kerakli oMchamlar Kkiritilganidan so;ng OK tugmasini bosish lozim.
Adobe PhotoShop dasturi oq rangdagi (bo'sh) yangi tasvirni tuzadi.
Eu tasvirga xohlagan o'zgartirish Kkiritish yoki boshga tasvirlardan
ayrim detallarni ko'chirib o'tkazib, umuman yangi tasvirni ijod qilish
mumkin.

O dainn > OTKpbITb: Menyu satrida ®aiin menyusini ochib OTk-
pbiTe buyrug'ini tanlang yoki Ctrl+O tugmalari kombinatsiyasidan
foydalanib kompyuter xotirasida mavjud bo‘lgan faylni oching.
Juda kam hollarda ®ain - OTKpbITb Kak (Ctrl+Alt+0O) buyrug'i
tanlanadi.



Tasvir formadari

Adobe PhotoShop dasturi 20 dan ortig formatdagi fayllar bilan
ishlash imkoniga ega. Eng ko'p qoTlaniladigan formatlar:

BMP (Windows Bitmap) —~Windows mubhitida ishlovchi kompyu-
terlarda ekran osti tasvirlarini go’llovchi dastur Microsoft Paintda keng
go‘llaniladi.

JPEG (Joint Phonographic Experts Group) —hozirgi kunda eng ko'p
go'llaniladigan formatlardan biri bo‘lib. uning asosiy afzalliklaridan
biri maxsus dastur yordamida fayl hajmini yetarlicha sigish imkonining
mavjudligidir. Ammo faylni sigib hajmini kichraytirish jarayonida
tasvir sifatida o'zgarish bo‘ladi. Fayl kuchli sigilganda tasvir sifati
yomonlashishi mumkin. L’shbu formatdagi favllar kompyuter xotirasida
ko'p joy egallamaydi. Hajm jihatidan kichikligi sababli mazkur
formatdagi tasvirlar bilan ishlashni ancha osonlashtiradi. Aksariyat
ragamli fotokameralar, videokameralar va skanerlar yordamida olingan
rasmlar JPEG formatida saglanadi.

TIFF (Tagged Image File Format) - bu formatdagi fayllar ham keng
go'llaniladi. Lekin TIFF formatidagi fayllar kompyuter xotirasida ko'p
joyni egallaydi. Adobe PhotoShop dasturida ushbu formatdagi tasvirlar
bilan ishlashda dasturning ishlash tezligi sezilarli ravishda pasayishi
mumkin.

GIF (Graphics Interchage Format) - ushbu formatdagi tasvirlar 256
turdagi rang bilan tasvirlanadi. Bu formatdagi tasvirlar asosan Internet
tizimida keng qo’llaniladi.

Ranglar bilan ishlash

Adobe PhotoShop dasturida uskunalar panelida ranglar bilan ishlash
uchun to‘rtta uskuna ajratilgan:

O OcHoBHOW wuBeT. Ushbu uskunada ganday rang ko‘rsatilgan
bonlsa. KoBw, NnHua, Kapangaw. Kncte. Asporpad va shuningdek Alt
klavishi bilan birgalikda go'llanganda Maney uskunalari uchun o‘sha
rang asosiy hisoblanadi. OcHoBHOI1 uBeT uskunasidagi rang MuneTka
yoki ushbu uskuna ustida sichgoncha chap tugmasini ikki marta ketma-
ket bosish orgali o’zgartiriladi.
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O LeeT ¢oHa. Ko'rsatilgan rang lactuk uskunasi bilan ishlaganda
go'llaniladi. LiBeT ¢poHa uskunasidagi rang OcHoBHOW uBeT uskunasida
rangni o'zgartirish uchun ganday amal bajarilgan bo‘lsa, bunda ham
xuddi o'sha amalga rioya qilish lozim voki NMunetka uskunasi bilan Alt
klavishini birgalikda bosish orqali rangni almashtirish mumkin.

O MepekntoyeHne uBeToB. Kursorni ushbu tugma ustida bir marta
bosish orgali asosiy rang va fon rangi o'rin almashadi.

O CTaHgapTHbIn uBeT. Kursorni ushbu tugma ustida bir marta
bosish asosiy rang va fon rangini standart ranglar - qora va oq rangga
almashtiradi.

Ranglarni tanlashda Adobe PhotoShop dasturida Color vyoki
Swatches darchalaridan ham foydalanish mumkin.

RGB (Red. Green. Blue-qizil, ko'k, yashil) moduli tasvirni ekranda
tahrir gilish nuqtai naz:aridan kelib chiggan holda juda qulay va u 24
razryadli ranglar platasi yordamida deyarli barcha 16 million ranglarni
monitorda aks ettiradi. RGB ranglar majmuasi bilan ishlangan barcha
tasvirlarni xohlagan formatda diskka yozish mumkin. RGB ranglar
majinuasidagi ayrim ranglar umuman tabiatda uchramaydi.

CMYB-tabiatda mavjud bolgan ranglar majmuasi, quyosh
nurlari inson ko‘zlari ajrata oladigan barcha ranglarni o‘zida mu-
jassamlashtirgan. Quyosh nurlari biror bir jismga tushganda uning ta’siri
ostida inson ko'zlari jism shakli va rangini idrok etadi. Misol uchun
binolarning o't o‘chirish burchaklariga osib go'yilgan o‘t o'chirgichlar
to‘g ko‘k va zangori ranglar bilan bo‘yalgan bo‘lishiga garamay. bizning
ko'zimizga to'q qizil rangda ko‘rinadi. Ranglarni bir-biriga go‘shilishi
natijasi boshga ranglar hosil gilinadi:

S - havo rang; M — hinafsha rang; Y - saridrang;B - gora rang.

Bosma mashinalari va bosmaxonalarda tasvirlar yugorida keltirilgan
ranglarning kombinatsiyasidan foydalangan holda to'la tasvirni
ifodalaydi.

RGB ranglar majmuasida oq rang uchala ranglarning maksimal
aralashmasidan hosil gilinadi. Qorarang esa buning aksi ularoq olinadi.

CMYB ranglar majmuasi bilan ishlaganda qora va oq ranglarni
hosil gilish uchun buning aksini bajarish lozim. Ya’ni to'rt rangning
minimal qo‘shilishida oq rang hosil bo'ladi. Qora rang esa alohida
kanalda mavjud.



WD xaiigiai fiiajiiiui Keflg  kiClaintagi nuigiami TaKiil  efadi,
Lekin ularning ko'p qismi (aynigsa, yorqginlari) tasvirni chop
etganda m cnitordagi bilan keskin farq cjiladi. Shu bois ham ko‘plab
mutaxassislar tasvirni chop etishdan avval uni CMYB tizimiga
o'tkazadilar. Ayrim mutaxassislar esa tasvir bilan CMYB tizimida
ishlashni maslahat beradilar. Ammo bu tasvir bilan ishlash turli
giyinchilik larni  tug'diradi. Ana shunday qiyinchiliklardan biri-
kompyuter juda sekin ishlaydi. Bunga asosiy sabab Adobe PhotoShop
dasturi RGB tizimiga sozlangan boTib, har bir buyrugni bajarib. uni
RGB tizimidan CM YB tizimiga almashtirgunga gadar kompyuter
go'shimcha vaqt talab giladi. Bundan tashqari, skaner va monitor
RGB tizimida ishlashga moTjillangan. Ranglar bilan ishlovchi barcha
uskunalar (rangli printerdan tashqgari) RGB tizimida ishlaydi. Shuning
uchun yaxshisi tasvirni chop etishdan avval CM YB tizimiga o4kazib
olish magsadga muvofig. Tasvir ustida barcha amallarni poyoniga
yetkazib, menyular satrida W3o6paxeHune - HacTpoitka tarkibidagi
CMYB buyrug‘ini tanlang.

History darchasi bilan ishlash

Adobe PhotoShop dasturi ishga tushirilganda ekranda History
darchasi mavjud boMmasa, OkHO menyusida T[loka3atb History
buyrug‘ini tanlang. History darchasida tasvirga Kkiritilgan so'nggi
o‘zgartirishTar haqidagi ma’lumotlar joylashadi. Tasvir ustida bajarilgan
har bir muhim amallar History darchasida ro‘yxatga olinadi. Xohlagan
paytda yogmagan amallarni History darchasi orgali rad etish mumkin.
Buning uchun kursor bajarilgan so‘nggi amaldan oldingi buvrug’i
ustida bosiladi yoki Ctrl+Alt-t-7 klavishlari bosiladi. Adobe PhotoShop
dasturi bajarilgan so'nggi 20 amalni ro‘yxatga oladi, yigirma birinchi
amal bajarilganda Adobe PhotoShop dasturi avvalgi amallarni
o‘chiradi.

Qatlamlar bilan ishlash

Adobe PhotoShop dasturi tasvirdagi biror obvekt Mpsamoyronb-
Has ob6nactb. 3dnauntuyeckas obnactb, Jlacco, Bonwe6bHasa nanou-
Ka, bbicTpasa Macka yordamida tasvirdagi detallar belgilanib ularning

154



nusxalari olinganda Adobe PhotoShop dasturi yangi gatlam hosil
giladi. Bu gatlam alohida obyekt bo'lib, uni tahrir gilish ham alohida
tarzda bo‘ladi. Bir nechta tasvirlardagi ayrim detallarni yagona
tasvirga jamlanganda Adobe PhotoShop dasturi ko'chirib o ‘tilgan
tasvir bo‘laklarni qatlamlarga ajratadi. Ayni jarayon tasvir detallarini
joylashtirish uchun juda qulay. Bir aecha qatlamlar bilan ishlaganda
ularni boshqgarish qiyinlashadi. Adobe PhotoShop dasturi bajarilganda
yangi darcha hosil bo'ladi. Bu darcliada tasvirdagi yangi gatlamlar
hagidagi axborotlar joylashadi. Yangi gatlam hosil gilinganda Adobe
PhotoShop dasturi uni Cnoii darchasida ro’yxatga oladi. Bu darchada
gatlamlar tartibli tarzda joylashtiriladi. Shuningdek, gatlamlarning
O‘'mini almashtirish yoki vaqtinclia o‘chirib qo'yish mumkin.
Qatlamlarni o'chirish uchun avval kerakli gatlam Cnoii darchasida
belgiiab olinadi va menyular satrida Cnoit menyusi tarkibidagi Yaa-
nmtb Cnoi buyrug‘i tanlanadi. Qatlamlarni bir-biriga birlashtirish
imkoniyati ham mavjud.

Filtrlar bilan ishlash

Adobe PhotoShop dasturida tasvirni qgo‘shimcha effektlar bilan
boyitish uchun filtrlardan foydalanish inumkin. Buning uchun menyular
satrida ®dunTtpbl  buyrug'i tarkibidagi filtrlardan fovdalanishingiz
muinkin.

Photoshop va ImageReady dasturlariga tasvirni tez ko‘rib chi-
gish moduli kiritilgan. Oldingi vaqtlarda bu ishni amalga oshirish
uchun tashqgi dastur (utilit)lar ishlatilar edi. Masalan ACDSee yoKki
ThumbsPlus. Cho'ntak kompyuterlari uchun rasmni importi va eksporti
WBMP formatli filtrlari kiritilgan. Kompyuterning ishlash chegarasi
doirasida avtomatik tarzda rasmning sifatini buzmagan holda moslashuv
(optimizatsiya)ni bajaradi.

Photoshop 7.0 dasturiga guruh (rpynnosoii) bo‘lib ishlash
uchun go’shimcha imkoniyatlar Kkiritildi. Bu bir kompvuterda turli
foydalanuvchilar tomonidan Adobe dasturida ishlash imkoniyatini
beradigan AfterCast kengaytgich qo’'shildi. Agar bir foydalanuvchi
tasvirga o'zgartirish kiritsa bir vaqgtning o'zida hamma foydalanuvchilar
kuzata oladi. Ammo AfterCast sozlashni fagat administrator boshgara
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oiadi, iekin bu shaxsiy kompyuteriarda Photoshop dasturida ishiovciii
foydalanuvchilar bu muammoga duch kelmaydilar. Biz yuqorida
fagatgina Photoshopning 7-versiyasini asosiy imkoniyatlarini sanab
chigdik.

Uskunalar paneli

Ekranda turgan dastur uskunalarini ishgatushirish uchun sichqoncha
bilan uni ustiga bosing va ekranda ko‘rinay?®tgan piktogrammani ustiga
bosing. Bir xil piktogramnmlar yonida kichik ko'rsatkich (strelkacha)
lar mavjud. Agar uni ustiga bosilsa tasvirga to‘g‘ri keluvchi oynalar
ko’rsatiladi. U yerdan siz kerakli uskunalarni tanlashingiz miimkin.
Har bir uskuna uchun o‘zining o'lcham lari ekran tepasida joylashgan
Opsiyalar panelida mavjuddir (masalan, pexxum cmewWwmnBaHus, 3Ha4YeHne
Henpo3payHocTn).

Opsiyalar paneli

Opsiyalar paneli har bir uskunaning parametrlarini sozlash uchun
ishlatiladi (masalan, shaffoflik darajasi yoki tasvirni aralashtirish
rejimini) (4.1-rasm). Opsiyalar panelining o‘ng tomonida maxsus
ranglarni saglovchi bo‘lim mavjuddir. Parametrlarni ko'rsatilishi gaysi
rasmni tanlanganiga bog‘liq (4.1—4.6-rasm). Fovdalanuvchi tomonidan
kiritilgan tasvir ko'rinislii boshqa o‘zgartirishlar Kkiritilgunga qadar
saglanadi. Palitra va Opsiyalar panelini ham ekranning istalgan joyiga
siljitish mumkin.

I y |unt g Vo Mk N AN Qudty [034>] How B M
4.1-rasni. Brush uskunasi uchun Opsiyalar paneli.
- JCjP B Fetrx Style: (Nl
4:2-rasm. Rectangular Marquee uskunasi uchun Opsiyalar paneli.
1/1 » 117k 0B Mk Vana £] Qpedity. I35 P |

4.3-rasm. Gradient uskunasi uchun Opsiyalar paneli.
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[T i £ ] ] J J 17 Auto Add/Del™ ]

4.4-rasm. Pen uskunasi uchun Opsiyalar paneli.

(hZil-j wj ajr-JJ 5 m\ mf? -

4.5-rasm. Rectangle uslcunasi uchun Opsiyalar paneli.
£ET ™ |Helvttica -1 [Medum  j»] X|IEPT A dap
4.6-rasm. Ture uskunasi uchun Opsiyalar paneli.

Opsiyalar panelining o‘ng tomonida faol uskuna piktogrammasi
ko‘rsatilgan. Agar piktogramrna yonidagi strelka ustiga bosilsa.
ko'rinmay turgan menyu ochiladi, unda boshga kerakli bo'lgan
uskunani tanlash mumkin. Bu jadvalga o‘zgartirishlar kiritish mumkin.
ya:ni kam ishlatilayotgan uskunalarni olib tashlab o‘rniga kerakli
bo'lgan wuskunalarni joylash mumkin. Har bir Opsiyalar paneliga
kiritilgan o'zgartirishlar avtomatik tarzda saglanib golinadi. Tugmalarni
gayta tiklash va joylashtirish ishlari paydo bo'luvchi paneldan amalga
oshiriladi.

Yordainchi maslahatlar

Istalgan piktogramrna ustida sichqonchani chap tugmasini bos-
masdan olib boring shunda siz ishlatmoqchi boigan uskunaning nomi
va uni klaviatura orqgali ishga tushiradigan tugmachalar ko'rsatiladi.
Shu bilan bir gatorda ishlatilayotgan Opsiyalar ovnasi va uning vazifasi
hagida gisgacha ma’lumot olish mumkin. Edit> Preferences > General
(MpaBka > YctaHoBKM > O6wume) oynasidagi yordainchi maslahatlar
oynasini ishlatish uchun Show Tool Tips ovnasi ustiga bayrogchani
o‘rnating (Moka3biBaTb BCN/bliBalOLLLME NOACKA3KN).

Istalgan tasvirni xohlagan paytda o'zgartirishlar kiritish imkonini va
12 turdagi Photoshop kengaytmalarida saglash imkonini beradi. Ammo
odatda ko’pincha quyidagi Photoshop formatlari ishlatiladi: TIFF. GIF,
JPEG, EPS.
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bajariladi. Ekranda ko'p joy egallamasligi uchun palitralar o'zaro
guruhlarga biriktirilgan: Navigator / Info (Boshgaruv / Ma’lumot).
Color / Swatches / Styles (Rang / Namuna / Uslublar), History /
Actions / Tool Presets (Tarixi / harakatlar / Uskunalar tanlash), Layers
/ Channels / Paths (Qatlamlar / Kanallar / Konturlar) va Character /
Paragraph (Shrift / Abzats).

Palitralar

Photoshop dasturida ko‘p operatsiyalar palitralar orqali bajariladi.
Ularni o‘zaro aralashtirish ham mumkin. Istalgan palitrani ochish uchun
esa Window (OkHO) menyu buyruglari yordamida amalga oshiriladi.
Belgilangan palitra boshga shu guruhga kiruvchi palitralardan eng
yugorida avtomatik tarzda joylashadi.

Photoshop dasturidan chigish: Windows operatsion tizimida bu
dastur oynasini yopish uchun File > Exit (®aiin > Bbixog) buyrug’ini
bering yoki (Ctrl+Q) tugmalar kombinatsiyasini bosiig.

Savol vatopshiriglar:

1 Adobe Photoshop dasturi ganday ishga tushiriladi?

2. Adobe Photoshop dasturining asosiy menyusi nimalardan tashkil
topgan?

3. Opsiyalar paneli nima uchun ishlatiladi?

4. Palitra operatsiyalari orgali nirna bajarish mumkin?

4.3. Adobe Photoshop dasturida tasvir va rasm bilan ishlash

Adobe Photoshop Windows mubhitida ishlovchi elektron ko'ri-
nishdagi foto tasvirlarini tahrirlovchi dasturdir. Adobe Photoshop
dasturi Adobe System Inc kompaniyasi tomonidan ishlab chigarilgan
bo’lib, ishlatishdagi alohida qulayliklari bilan mashhur hisoblanadi.

Adobe Photoshop grafik muharriri yordamida fotosuratlarga
go‘shimchalar kiritish, fotosuratdagi dog‘larni oxhirish, eski rasmlarni
gayta ishlash va tiklash ishlarini amalga oshirish mumkin. Rasmlarga
matn Kiritish go;shimcha maxsus effektlar bilan boyitish, bir foto-
suratdagi elementlarni ikkinchi fotosuratga olib o‘tish. suratdagi

158



ranglarni o‘zgartirish, almashtirish mumkin. Adobe Photoshop im-
koniyatlari keng gamrovli boiib, u gazeta va jurnallarni turli tuman
lasmlar bilan boyitishda juda katta qulayliklar yaratadi.

Adobe Photoshop aynigsa jurnalistlarning, rassomlarning ijodiy
imkoniyatlarini to‘la am alga oshirishlarida yordam beradi, jurnalistika
Ta bevosita matbuot yoki nashriyot sohasiga alogador bo'lgan shaxs-
larning mazkur dastur bilan ishlashni bilishi uchun go'shimcha
imkoniyatlarni yaratib beradi.

Adobe Photoshop grafik muharriri juda murakkab dasturdir.
Foydalanuvchilar uning asosiy imkoniyatlaridangina foydalanadilar
xolos. Opsiyalar panelida Brush muygalamni tanlash uchun strelkasi
ustiga bosing. Har bir piktogramma ustidagi ragamlar muygalamni
galinligini piksellarda ko'rsatadi. Agar siz istalgan muygalam ustiga
olib bcrsangiz shu muvqgalamning galinligi va turi hagida ma'lumot
chigadi. Boshqga turdagi muygalamlarni tanlash uchun muyqgalamlar
kutubxonasini yuklash kerak. Muyqgalam panelini yopish uchun
paneldan tashqgaridagi ekranning istalgan joyga bosing va avtomatik
tarzida panel yopiladi. Mode (Pexxum cmewmnBaHus) bo‘limini tanlang,
hamda Opacity (HenpospauHocTb) boiimini foiz ko‘rsatkichida Brush
(Knctb) uskunasi uchun tanlang (4.7-rasm). Agar ko‘rsatilgaa qism
parametri 100% ni tashkil gilsa muyqalam shtrixi pastki piksellarni
mutloqg goplaydi.

Eslatma: Fagatgina shafof bo‘hnagan gatlamlarning rangini o‘z-
gartirish uchun Layers (Cnou) palitrasidagi Lock transparent pixels
(3athmkcmpoBaTb Mpo3payHble TOUKKM) ustiga bayroqgchani o'rnating.

Photoshop 7.0 dasturi yordamida siz bir gancha standart muy-
galamlar yoki 0‘zingiz: o‘lchamlari va ko'rinishini kiritgan hold a juda
gizigarli rassomchilik ishlarini amalga oshirishingiz mumkin.

Rasmlar bilan ishlash uchun dasturning yangi versiyalari o‘ta
giziqarli bo‘lgan rasmlarni yaratish imkonini beradi. Photoshop 7.0
dasturida standart va avvaldan foydalanuvchi kiritgan rasmlarni

Mode: jNormal 3 Opacity: \Q% *

4.7-rasm. Opacity parametrini belgilash.
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nusxalab unga savaal berish shn hilar hinga_tasvirga nsasgns guwag
muyqalam usullarida bezak berish mumkin. Muyqalara paketiga barg
va o'tlarni tasvirini yaratadigan maxsus effekt muyqgalamlari Kiritildi.
Maxsus original tasvirlarni yaratish uchun skanerdan o'tkazilgan
rasm va matnlarni orga fon sifatida shaffof ko’rinishda tasvirga
kiritish mumkin. Photoshop 7.0 dasturida fagat yangi tasvir yaratish
imkoniyatlari bilan cheklanib qolmay balki. boshgaruvni soddalashtirish
ham e’tiborga olingan.

Mavjud bo‘lgan muyqgalamni o‘zgartirish

Photoshop dasturiga qo'shimcha sifatida muyqalamlar bazasi ham
beriladi va siz u yerdan istalgan muygalamni tanlab uni xohishingizga
ko'ra o‘zgartirishingiz mumkin.

1 Opsiyalar panelidan Brushes (k ncrs) tugmasiga bosing undagi
menyudan Brush Tip Shape bo‘limini tanlang.

2. Diameter (Onametp) effektni kerakli joygacha cho'zing yoki
muygalam diametirini kiriting (1 dan 999 pikselgacha).

3. Muygalam izi shaffofsizligini belgilovchi Hardness ()KecTkocTb)
koeffitsentini tanlang yoki uni ham foiz miqdorda kiriting (0—100%
gacha).

4. Muygalam qoldirgan izlari oralig'ini Spacing (UHTepBan) orgali
belgilanadi (0-99%). Foiz miqgdorini oshirilgan sari shtrixlar orasidagi
tnasofa kattalashib boradi. Shuningdek bu vazifani kursor yoki
muyqgalam ham bajarishi mumkin. Buning uchun Spacing (MHTepBan)
tugmasidan bayroqni olib tashlashni o‘zi kifoya. Qanchalik kursorni tez
harakatlantirsangiz shuncha oraliq kattalashadi va aksincha. Ko‘pgina
standart o'rnatilgan muyqalamlar uchun asosan Spacing va Diameter
bo‘limlarini o‘zgartirish mumkin.

5. Muyqgalam izini doira yoki boshga ellips ko'rinishlarini belgilash
uchun Angle (Yron) bo'limidan (-180° dan +180° gacha) giymatlarni
ko'rsating yoki ekranning chap tarafidagi rasmdagi strelkani xohishga
ko‘rajoylashtiring.

6. Muygalamni tiniglashtirish uchun Roundness (OKpyrnocTb)
(0-100%) parametrlarini bering. Foiz niigdori ortgani sari nuqta izi
tiniglashadi.
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Vangi muygalamni yaratish

Brush (muygalam) menyusidan New Brush (Yangi muyqgalam)
buyrug'ini tanlang.

1 Mavjud muygalamni o‘zgartirish (M3meHeHne cywecTByto el
kuctu) boTimidan 2 dan 8 gacha bo'lgan buyruglarni tanlang. Create
New Brush (Yangi muygalamni yaratish) boiimiga bir marta bosing
va kerakli o‘lchamlarni bering. Agar siz ushbu tayyor muygalamni
saglab golmoqchi bo'lsangiz, uni nomini kiriting va OK tugmasini
bosing. Saglangan muyqalam piktogrammasi tanlash panelining oxirida
joylashadi.

Tasvirdan iborat boTgan muygalamni yaratish uchun quyidagi
ketma-ketlik bajariladi:

1 Rectangular IVlarquee (MpsamoyronbHaa o6nactb) uskunasini
faollashtirish uchun klaviaturadan IM tugmasini yoki Shift+IM tug-
malarini bosing.

2. Berilgan figuralar joylashgan oq fondagi tasvirni chegarasini
belgilang (niaksimum 1000x1000 pikselgacha).

3. Edit > Define Brush (Pravka > OnpepeneHue kucta) buyrug‘ini
tanlang.

4. Yugorida aytib o’tilgandek ushbu yangi muygalam nomini kiri-
ting va OK tugmasini bosing. Bu muygalamdan Brush (KucTtb) menyusi
bilan ishlayotganda foydalanish mumkin. Paydo bo'luvchi muygalam
o'lchamlarini, Spacing (WHTepBan) tugmasidan shtrixlar orasidagi
masofani aniqglashtiring (1—99%).

5. Belgilangan hududni gaytib o ‘z holiga keltirish uchun Ctrl+D
tugmalarini birgalikda bosing.

Muyqgalamni o‘chirish

Muygalam tanlash panelini oching:

Birinchi usul: Alt tugmasini bosib turib o‘chirmoqchi bo‘lgan
muyqgalamni belgilang. Bu harakatni orqaga qaytarish (0TMeHUTb)
mumkin emas.

Ikkinchi usul: Keraksiz bo'lyjan muygalamni ko‘rsating va Delete
Brush (Muyqalamni o ‘chirish) buyrug‘ini tanlang.

Background Eraser va Magic Eraser uskunalarini ishlatilishi.
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Magic Eraser menvusi sichqoncha tugmasi bilan o‘chirish imkonmi
beradi. U siz ko‘rsatgan rangga yaqin bo‘lgan piksellarni o‘chiradi. Buni
aksini esa Paint Bucket (Begpo ¢ kpackoii) uskunasi bajaradi. Agar siz
shaffofsizlikni 100%dan pastrogMni tanlagan bolsangiz unda Magic
Eraser uskunasi orqali keraklijoylarni shaffof ko'rinishga keltirishingiz
rnumkin.

Background Eraser uskunasi bu fondagi keraksiz joylarni o'chiradi
yoki kerakli ranga bo'yaydi. Bu uskunaning ustunligi shundaki u
bilan aralasfa fonlarni yakdil holatga va o'chirilayotgan maydonni yoki
chegaralarni hamohaagligini nazorat qiladi.

1 Xohlagan gatlamni tanlang. Eraser (o‘chirgich) uskunasi yor-
damida qatlamdagi keraksiz joylarni o'chirmoqchi bolsangiz unda
Lock transparent pixels (3adukcmpoBaTb Mpo3payHble TOYKM)
bo'limiga bayrogchani o‘rnating. Shunda o'chirilayotgan gatlam undan
oldingi gatlam foniga ega bo’ladi. Agar Lock transparent pixels (3a-
thmnkcuposaTb npospayvHble Toukn) boiimidagi bavroqcha olib tashlansa
unda o‘chirilgan gism shaffof holatga o'tadi.

2. Eraser (o'chirgich) uskunasini E tugmasi yoki Shift+E tugma-
larini birga bosib uni ishga tushiring,

3. Opsiyalar panelidan Brush (Kuctb) bo‘limiga kiring va kerakli
bo‘lgan muygalamni tanlang.

Mode (Pexum) bo'limidan kerakli rejimni tanlang: u yerda Brush
(kuetb), Pencil (kapaHgaw) yoki Block (Bnok)rH tanlang. Xoi bo‘yoqni
akslantiruvchi Brush (Kuctb) effektini tanlang. Opacity parametrlarini
ko‘rsating.

Avtomatik tozalash rejimi

Auto Erase (ABTonactuk) o0;z-o'zidan avtomatik tarzda ishlashga
mo‘ljallangandir. Agar siz uni 0z xohishingizga ko'ra ishlatmoqchi
bo‘lsangiz quydagilarni bajarishingiz shart:

1 Kerakli boigan fon rangini tanlang. Bunda Eyedropper (Munert-
ka) uskunasidan rang tanlashda fovdalanishingiz mumkin;

2. Kerakli boigan gatlamni belgilang:

3. Pencil (KapaHgaw) uskunasini faollashtiring, buning uchun V
tugmasi yoki Shift+B tugmalarini birgalikda bosing;
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4. Opsiyalar panelidan Auto Erase (ABTonactmk) uskunasi ustiga
bayrogni o'rnating;

5. Tasvirga shtrixlarni chizing. Asosiy pikseldan boshlab Icerakli
hududgacha kursorni tortib boring.

Savol va topshiriglar:

1 Brush uskunasi imkoniyatlarini sanab bering?
2. Background Eraser buyrug4 nima uchun ishlatiladi?
3. Obyekt rangi qanday o‘zgartiriladi?

4.4. Matnlar bilan ishlash

Adobe PhotoShop dasturi tasvirlar ustiga matnlarni kiritish
uchun yana bir keng imkoniyatni ochib beradi. Tasvir ustiga matn
kiritish uchun uskunalar panelida maxsus TekcT uskunasi mavjud. Bu
uskuna, asosan, tasvirga turli matnlarni kiritish uchun xizmat qiladi.
TekcT uskunasi tarkibida TekcT-macka, BepTukanbHblli TekcT kabi
uskunalar yashiringan. Bu uskunalar faollashtirilib, kursor tasvir
ustida bir marta bosishi bilan yangi TekcToBbli MHCTpyMeHT darchasi
hosil boTadi. Bu uskunalar fagat matnlarni tuzish uchun xizmat
giladi. Uning yordamida mavjud matnlarni tahrir gilishning imkoni
yo‘q.

Photoshop 7.0 dasturida matn vektor ko'rinishiga ega. Dasturda matn
0'zining aniqg chegara va konturlariga ega. Chunki dastur matnlarni
ishlatayotganda vektor konturini qoilaydi. Shu bilan bir gatorda matn
ham rasm sifatlarini o‘zida mujassamlashtirgan. Bu matn printerdan
chiqgarilishiga garamay u PDF yoki EPS formatlarida saqlanishida o‘z
tinigligini saqglab goladi.

Photoshop dasturi fagatgina matnlarni kiritibgina golmasdan, balki
ularni yozilayotgan vaqtida va yozilgandan so'ng ham ularni tusini,
rangini, koTinishini hamda yo‘nalishini o‘zgartirish mumkin.

Matn ni kiritish

Photoshop dasturida matn yozish uchun TekcT tugmasi tanlanadi
va avtomatik tarzda kerakli joyda o'z maxsus qatlamiga ega bo’lgan
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mumkin masalan: shrift, uslub, kegl, rang, kerning, treking, oraliqdagi
interval, to‘g'irlash, chiziglarni hajmi. Bundan tashqari bir tekstni o'ziga
bir gancha atributlarni kiritish mumkin,

Shu bilan bir qatorda matnning ma’nosini inexanik tarzda
o'zgartirish unga har xil effektlar qoilash va u joylashgan gatlam
ustida bir qancha imkoniyatlarni go‘llash mumkin. Matn qatlami
ustida ganday amallar go'llash mumkin? Unga filtrni go'llash. matndan
tozalash mumkin. Bu amallami bajarish uchun eng avvalo matn
gatlamini Layer > Rasterize > Ture (Cnoin > MNMpeobpa3oBaTb B pac-
TpoBbI hopmart > TekcT) uskunasi orgali belgilab undagi buyrugni
tanlash kerak.

Eslatma. Bitmap, Indexed Color va Multichannel rejimida yaratilgan
matn o‘z gatlamiga ega boimaydi va to'g'ridan-to'g'ri ekran foniga
tushadi hamda uni tahrirlash imkoniyati yo‘qoladi.

Turli xildagi matnlar (tahrirlanadigan va tahrirlanmaydigan) ko‘-
rinishlari Ture (Tekct), Layer (Cnoit), Character (WpwugT), Paragraph
(A63au) uskunalari va Opsiyalar paneli orgali yaratiladi.

Tahrirlanadigan matn gatlamini yaratish:

1. Eng avvalo Ture (Tekct) uskunasini T tugmasini bosish bilan
faollashtiring.

2. So‘ngra matnni joylashtirish kerak boTgan ekrandagi gismning
olchamlarini sichqgoncha orgali belgilang (so'zlar va matnlar bir-biriga
to‘qnashib ketmasligi kerak). Yaxshisi har bir so’zni alohida gatlamga
yozing shunda ularni bir-biridan mustaqil ravishda siljitish imkonini
go‘lga kiritasiz.

3. Opsiyalar panelida quyidagi amallami bajaring:

o] Ture tugmasiga bosing va matnning vo'‘nalishini ko‘rsating (go-
rizontal, vertikal):

° Shrift va uning o‘lchamini tanlang;

° Shuningdek Anti-aliased (Moslashtirish) menyusidan matn
gatlam chegarasini ko'rsating: Sharp (Tiniq) Crisp (qgattig), Strong
(kuchli) yoki Smooth (yumshoq). Bu matnni soyasi ko'rinishlarini
tubdan o‘zgartiradi va tasvirga moslaydi. Alignment (Bbikntou-



ka) tugmalaridan biriga bosing va kerakli boTgan matnni yozilish
chegarasini kTrsating (o'ngdan, chapdan, oitadan).

Opsiyalar panelidan matnni rangini ko‘rsating. Bundan tashqari
matn rangini Swatches (O6pasubl) va Colors (LBeta) palitralaridan
ham belgilash mumKkin.

4. Ekrandagi oynada matnni kiriting.

5. Yangi matn gatlamini yaratish uchun Enter tugmasini bosing.
Agar sizga boshqga gatlam kerak bo‘ Imasa Esc tugmasini bosing.

Eslatma: Agar siz matnlar bilan ishlayotganda kompyuter
to‘xtab qolaversa yoki tezligi pasaysa unda ochilgan golgan kerak
boimagan oynalarni yoping. Shunda dastur tezligi o'z holiga
keladi.

Eslatma: Har safar matn yozisbda yangi qatlamdan foydalan-
ganingiz ma'qul va xatolikka ega bo‘lgan gatlamlarni o‘chirib tash-
lang.

Matnni tahrirlash. Matnni o'zgartirishdan oldin uni faollashtiring
va matndagi so‘z, jumla va harfni belgilab o‘zgartirish Kiriting.
Shuningdek matnni belgilash uchun uning ramkasini ustiga bosish
kifoya.

Matnni masshtablash

Horizontal Scale (MacwTa6 no ropusoHTanu) va Vertical Scale
(MacwTab6 no BepTukanu) buyruglaridan matnni joylashish shaklini
o'zgartirish uchun foydalaning. Bir xil to'g'ri ko’rinishdagi masshtablash
uchun quydagi amallarga rioya qiling:

IMatn uchun maxsus effektlar

Eng avvalo quyidagilarni eslab goling. Agar siz matnni ram-
kasini masshtabini, hajmini va tuzilishini o'zgartirish uchun uni
tahrirlanadigan ko‘rinishda bajarish ingiz kerak boisa va so'ngra matnga
maxsus effektlar go'shish uchun uni rasm sifatiga keltirib undan keyin
effektlarni qoilashingiz mumkin.

\Y tugmasi orqgali ishga tushiriluvchi Move uskunasi orgali matnni
trasformatsiya gilish mumkin.
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Show Bounding Box (Mokasatb rabapuTtHyt pamky) uskunasiga
bayroqchani o‘rnating Layers (Cnon) uskunasi orqali kerakli gatlamni
belgilang. Ekranda matn gatlaini aks etadi.

Yakka holda kiritilgan juinla va so‘zlarni quyidagicha o‘zgartirish
mumkin:

e Layers (Cnou) oynasiga jumlani kiriting va Edit (MNpas-
ka) menyusidan Free Transform (Mpon3BonbHasa TpaHchopmayns)
buyrugini tanlang;

e Sichgoncha bilan matn oynasini kerakli shaklni olguncha
surib boring. Bu vazifani boshqa uskunalar yordamida ham bajarish
mumkin.

Matnni rasmli gatlam ustiga joylaslitirish:

1 Matnli gatlamni yarating.

2. Shu matn gatlamidan nusxa oling va uni saglab go'ying.

3. Matn nusxasini belgilang va Layer > Type > Convert to Shape
(Cnoin > TekcT > [MNpeobpasoBatb B urypy) buyrug‘ini bering. Matn
gatlami avtomatik rasmga avlanadi va uni tahrirlash endi mumkin emas.

4. Layer > Change Layer Content > Levels (Cnon > N3meHUTb
cogep>xmmoe cnosd > YposHu) buyrug‘ini bering. Yozilgan qatlam siz
boshga gatlamni kiritmaguningizga qadar buferda goladi va faol boiib
turadi.

5 Yozilgan matn boshga tasvirlar bilan hamohangligini jigarrang
tusga ega bo‘lgan piktogramma Input (Bsog) ustiga bosing va matn
rangini ochartiring yoki to‘qlashtiring;

6. OK tugmasini bosing. Ekran fonining bir gismiga bosing.

Koiinmaydigan matnlar yaratish:

1. Matn kiriting va uni gatlamini faol holatda qoldiring.

2. Layers oynasining pastki gismidan Add a mask (Jo6aBuTtb
Macky) tugmasini bosing. Belgilangan joy yonida kichik belgi (macka)
paydo boiadi.

3. G klavishasini yoki Shift-*-G tugmalar kombinatsiyasini bosgan
holda Gradient (FTpagneHT) uskunasini ishga tushiring.

4. Gradient uskunasi yonidagi strelkani bosing va kerakli rangni
tanlang. Linear gradient (InHeiHblA rpagneHT) tugmasiga bosing va
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Normal (HopmanbHblii) rejimini tanlang shaffofsizlik giymatini bering
(1% dan 100°/« gacha).

5. Matnniustiga kerakli boMgan hududni ramka sifatida sichqgoncha
bilan belgilang va shu gismlar ocharadi yoki to‘qlashadi.

Matnni effekt bilan ko ‘chirish uchun u joylashgan qgatlamni
faollashtiring va Move (MepemeweHune) uskunasini ishga tushiring.

Agar siz effektni o'zgartirmoqchi bo'lsangiz matn joylashgan gatlam
ustiga bosingshunda Layer Style mulogot oynasi paydo boMadi. Undan
boshqa effektlarni tanlashingiz mumkin.

Matn qgatlamini chegaralarini o‘rash:

1 Blending Options (Onuun cmewwnsaHus) oynasidan Layers
(Cnown) buyrug‘ini tanlang.

2. Style (Ctunb cnost) oynasining chap tarafida joylashgan Stroke
(O6Bopgka) buyrugli ustiga bosing va Preview (MpeaBapuTenbHblii
npocmoTp) uskunasiga bayroqcha o'rnatilganligini tekshiring. XJ yerdan
quyidagi bo‘limlarni koTib chiqing va kerakli o'lchamlami bering:
Structure (Ctpyktypa) Size (Pasmep), Position (Joylashish holati)
(uLar tashqaridan va ichkaridan bo'lishi mumkin Outside (CHapyxwu),
Inside (BHyTpu) yoki Center (markaz)), Blend Mode (Pexum cme-
wwusaHus), Opacity (Shaffofsizlik). Fill Type (bo'yash usuli) va Color
(rang).

OK tugmasini bosing (yoki Enter tugmasini bosing).

Savol vet tops/iiriglar:

1 Dasturda matn konturini o’zgartirish uchun gaysi buyruglardan foy-

dalaniladi?

2. Qaysi uskuna yordamida Photoshop dasturida matnlarni vyaratish
mumkin?

3. Gradient (I'pagueHT) uskunasi gaysi tugmalar yordamida ishga tu-
shiriladi?

4.5. Adobe Photoshop dasturida tasvirga ishlov berish. Qatlamlar

Qatlamlar xuddi oyna qatlamlariga o‘xshagan boiib, fagat tasvir
bo'lgan joylarigina ko‘rinishga egadir. Har bir gatlam uchun o‘zining
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shaffoflik darajasi boiib undan oldingi va keyingi turgan gqatlamlar
bilan hamohangligini moslash mumkin. Qatlamlarni joylashish oinini
almashtirish voki ularni yagona gatlamga birlashtirish mumkin. Bir
vaqtni o'zida har xil gatlamlarda turgan tasvirni birgalikda o‘zgartirish
va bir gatlamda turgan rasmai fagat bir gismini o'zgartirish mumkin
emas.

Layers (Cnou) oynasida gatlamlar ustida turgan qatlamdan eng
tagidagi gatlamgacha aks ettirilgan. Bunda fon gatlami oxirida
joylashadi. Hozirda belgilangaa gatlain faol boiib ko'rinadi va fagat shu
gatlam ustida amallar bajarishmumkin.

Istalgan qatlamni faollashtirish uchun Layers oynasidan kerakli
gatlam ustiga bosish kerak. Faol boigan gatlam nomi dastur nomi
yonida akslanib turadi.

Eslatma: Katta hajmdagi tasvirlar bilan ishlayotganda bajarilib
boigan gatlamlarni birlashtirish voki o‘chirib tashlagan ma’qul. Shunda
dastur ishlash tezlik unumdorligi oshadi va tasvir hajmi kamayadi.

Yangi gatlam hosil qgilish

1. Eng avvalo 100% shaffof gatlain hosil qgilish uchun Create New-
Layer tugmasi ustiga bosing.

2. Agar gatlamni oichamlarini o'zingiz bennoqchi bo’lsangiz unda
Alt tugmasini bosib turgan holda Create New Layer tugmasini bosing:

3. Name (Ums) boiimida qatlamni nomini kiriting Group With
Previous Layer (CrpynnupoBaTb ¢ npeabigywum cnoem) bo'limiga
bayroqchani o‘rnating;

4. Layers (Cnou) palitrasidan ko‘z va muygalam ko'rinishidagi
piktogrammalarga bayroqchani oTnating;

Mode (Pexum cmewmBaHua) va Opacity (Henpo3payHoCTb)
parametrlaridan tasvir uchun yangi parametrlarini bering (keyinchalik
bu parametrlar o‘zgartirilishi mumkin).

5. OK tugmasini bosing. Yangi gatlam ishlatilayotgan gatlam ustida
paydo boiadi.

Eslatma: Tasvir hajmini kamaytirish uchun Layers (Cnown)
menyusidan Palette Options (Onuwuu nanutpsl) buyrug‘ini tanlang va
shu tasvirga to‘gi'i keladigan eng kichik hajmni tanlang.
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Belgilangan gismni gatlamga aylantirish
1 Belgilangan gismni hosil qiling;
2. Layer > New > Layer Via Soru (Cnoii > HoBblli > T[ocpeg-
cTBOM KonupoBaHusi) menyusidan buyrugni bering (Ctrl+J tugmalari).
3. Tasvirni belgilangan gismini qirgib olib tashlash uchun Layer
> INew > Layer Via Cut (Cnoi# > HoBbll > [ocpefcTBOM Bbipe3aHus)
buliug‘ini bering (Ctrl+ Shift-t-J tugmalari).

Qatlamni siljitish

1 Layers (Cnown) oynasida o ‘zgartirish kiritmoqchi bolgan gatlamni
belgilang;

2. Move (MepemeweHune) uskunasini faollashtiring (V klavishasi);

3. Qatlamni kursorni ushlab turgan holatda siljiting.

Eslatma: Auto Select Layer (ABToBbigeneHue cnos) bo'limida
bayroqcha turgan boisa Move (MepemeweHune) uskunasi yordamida
tezda gatlamni siljitish mumkin, ammo bu siljitish shaffofligi 50% dan
kam bo‘lgan gatlamlar uchun ishlamaydi.

Qatlamlar bilan ishlash uchun uskunalar

Barcha uskunalar gatlamlar bilan ishlaydi. Lekin bu bilan qat-
lamning shaffofsizligiga katta tasir o'tkazadi. Shuning uchun qgatlam
shaffofsizligini doimo nazorat qilib turing.

Qatlamni o‘chirish

Qatlamni uchirishdan oldin uni nomiai faolligini tekshiring va uni
belgilab o‘chirib tashlang.

Qatlamga effektlar qoilash

Qatlamga quyidagi maxsus effektlarni qoilash mumkin: Drop
Shadow (OT6pocutb TeHb). Inner Shado-w (BHyTpeHHSs TeHb), Outer
Glow (BHewHee cBeueHue), Inner Glow (BHyTpeHHee cBeueHue), Bevel
and Emboss (Ckoc u penbed), Satin (Atnac), Color Overlay (Hano-
XeHue ugeta), Gradient Overlay (HanoxeHue rpaguneHta) va Pattern
Overlay (HanoxeHue ysopa). Effektlarni istalgan paytda istalgancha
xohlagan gatlamga go'llash mumkin.
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Eslatma: Uslublar va effektlarni bir-biri hilan chalkashtirib
vubormang. Uslub (Ctunb) - bu bir gancha gatlam effektlarini ha-
mohangligidir.

Effektlarni qo‘yish Layer Style (Ctunb cnosi) mulogot oynasi orgali
amalga oshiriladi.

Effekt yonidagi belgi bu effekt shu gatlamga qo'llanilganini
koisatadi. Qatlam effektlarini asosiy fon uchun goilash mumkin emas.

Hamma qatlainlarni birgalikda ishlatish

Agar Opsiyalar panelida quyidagi uskunalar ishlatilayotgan boisa:
Blur (PasmbiTue), Sharpen (Pe3skocTs), Smudge (Maneu), Paint Bucket
(Begpo c¢ kpackoii), Magic Eraser (Bonwe6Hbiit nactuk) yoki Magic
Wand (Bonwe6Has nanoyka) unda Use All Layers (Wcnonb3oBaTb
Bce cnomn) boiimiga bayrogchani o‘rnating shunda rang va boshga
oichamlar olinayotganda mavjud bo'lgan ranglarga yaqin bo'lgan
tuslar birinchi navbatta ko;rinadi. Fagat faol boigan gatlamda ranglar
o‘z:garadi.

Ikki gatlamni birlashtirish

1 Birlashtirmoqchi boigati ikki gatlamdan qaysi birisi oldinroq
bo4sa uni belgilang.

2. Layers (Cnou) menyusidan Merge Down (Cnutb ¢ HWX-
HuMm) buyrug‘ini bering yoki Ctrl+E tugmalarini birgalikda bosing.
Faol gatlam o‘zidan pastda turgan gatlam bilan birlashadi. Bir gancha
belgilangan gatlamlarni birlashtirish uchun Merge Layer Set (Cautb

Ha6bop cnoes) buyrug‘ini bering.
Qatlamlarni birlashtirish

Eslatma: Flatten Image (Mnockoe wu3obpaxeHue) buyrug'i gat-
laxtilarni pastdan boshlab birlashtiradi va yashirilgan qatlamlarni
avtomatik tarzda o'chiradi.

Hamma qatlamlar ko‘rinib turganligiga amin boiing va qaysi
gatlam faol bo'lishi muhim emas. Layers (Cnou) menyusidan Flatten
Image (Mnockoe wn3o6paxeHue) buyrugini bering. Agar dasturda
bekitilgan gatlamlar boisa unda ogohlantirish beriladi va OK tugmasini



hosing va birlashtirishni davom ettiring. Agarda pastki qatlamlarda
k orinmaydigan nuqtalar bo'lsa ular og ranga kiradi.

Layers (Cnou) menyusidan keraksiz gatlam nomini tanlang. So ngra
Trash (KopsuHa) tugmasini bosilgandan keyin Yes (4a) tugmasini ham
bosing.

Qatlamni o‘chirishni yana bir usuli keraksiz gatlam nomi ustiga
olib borib sichgonchani o'ng tugmasini bosing va menyudan Delete
Layer (Ypanute cnoi) buyrug'ini tanlang hamda Yes tugmasini
bosing.

Scivol va topshiriglar:
1 Qanday usulda gatlamlar hosil gilinadi?

2. Qatlamlarga ganday effektlar go‘llash mumkin?
3. Ajratilgan gismda yangi gatlamni hosil gilishni ko'rsatib bering.
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V-bob. COREL DRAW DASTURI
5.1. COREL DR W dasturi bilan tanishuv

Kanadaning Corel nomi bilan ataluvchi firmasi dasturiy ta'minot
bilan shug4illanuvchi peshqadamlardan biri hisoblanadi. Corel
firmasining dasturiy ta’minoti asosini tashkil etuvchi CorelDRAW
11 2002-yilning avgustida ishlab chigarildi. U reklama mahsulotlarini
ishlab chigarishda, nashrlarni tayyorlashda, hamda Web-sahifalari
uchim tasvirlarni yaratishda katta imkoniyatga ega.

Corel DRAW —bu grafikli dastur boiib, lining yordamida vektorli
tasvirlarni, grafikli matnlarni, hamda sizning tassavvuringizdagi barcha
ijodiy g'oyalaringizni amalga oshirishga yordam beradi.

Corel DRAW dasturi ishlaydigan barcha tasvirlar ikki sinfga
boiinadi: nuqtali va vektorli. Vektorli grafikada tasvirning asosiy
elementi sifatida chiziq qaraladi. Rastrli grafikada bunday chiziglar
nuqtalar (piksellar) yordamida vyaratilsa, vektorli grafikada esa
tasvirlar yaratishda nugtaga nisbatan umumiyroq boigan chiziglardan
foydalaniladi va shuning hisobiga tasvirlar aniqroq bo'ladi.

Vektorli grafikaning ixtiyoriy tasviri chiziglardan tashkil
topadi va oddiy chiziglardan inurakkablari hosil gilinadi. Vektorli
grafikaning matematik asosini geometrik figuralarning xossasini
o’rganish tashkil gqiladi. Vektorli tasvirlarni kompyuter xotirasida
ifodalanishi nuqtaliga qaraganda murakkabrog. Xuqtali tasvirning
kamchiligi - kompyuter xotirasida ularni saqlash katta joy talab
etiladi. Nuqtali tasvirlar bilan yugori aniglikda ishlashda. ularga mos
fayllarning oMchami yuzlab megabaytlarni tashkil etadi. Ko’pincha,
bunday katta obyektlar bilan ishlaganda zamonaviy kompyuterlarning
tezligi yetmay qoladi. Vektorli tasvir bilan ishlash juda ham oson.
Uni katta y~oki kichik qilish uchun, fagat uni boshgaradigan tasvir
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parametrini o’zgartirish mumkin. Bunda vektorli tasvir faylining
o'ichami birbaytga ham oshmaydi.

Ma’lumotlar tasvirlar orgali berilganda ularni tahlil qilish va
gabul qilish tezligi, maiumotni eshitish kanallari orgali berilgan
ma'lumotlardan koi'a ancha yuqori bo'ladi. Shuning uchun ham
tasvirdan iborat birgina reklama plakaii (osongina kerakli tasirni bera
oladigan) tomosha qilayotgan odamga bir mecha qator eiondan ko'ra
kuchli ta’sirkoTsatadi.

Har ganday hajmdagi maiumot koiish k.anali orgali uzatilsa odam
tomonidan yaxshi gabul gilinadi (bolalarga rasmlardan iborat kitoblar
yogadi). Boshga formatda esa bunday maiumotni gabul qgilib boimaydi
(birjalardagi jadval lar). Shu sababli ham grafikli ma’lumotlarga boigan
ehtiyoj kundan kumga ortib bormoqda.

Bunday grafiklar va tasvirlar bilan ishlashga moijallangan dasturiy
vositalar juda harm ko'p va xilma-xil. Ana shunday dasturlardan biri
CorelDRAW dasturidir.

CorelDRAWnNing 12 versiyasi o‘zida zamonaviy imkoniyatlarni
birlashtirgan boiito 2004-yilda ishlab chigarilgan. Bu dastur sanoat
dizaynida, reklama mahsulotlarimi ishlab chigishda, nashriyot tizim-
larida va web sahifalar uchun turli tasvirlar yaratishda ishlatiladi.
Corel DRAW dastnri paket dastur hisoblanib o‘z ichiga bir nechta gism
dastnrlarni oladi. Bu dasturlar o'zaro maiumot almashishning yengil
kechishini taininlaydi.

Paketning yaxiitligi uning tarkibiga kiruvchi dasturlarning ma-
lumotlarni yengil almashinishi yoki shu rmaiumotlar ustida ketma-ket
turli xil vazifalami bajarishi bilan belgilanadi.

«Obyektga yo'naltirilgan» - atamasi tasvirlarni yaratish va o‘zgar-
tirish jarayonidagi barcha operatsiyalar. rasmning o'zi yoki uni tashkil
gilgan piksellar bilan emas balki tasvimi tashkil gilgan semantik
belgilangan elementlar ustida boradi. Standart obyektlarni qoilagan
holda (aylana, to”~g”ri toitburchak, matn va boshqgalar) foydalanuvchi
murakkab obyektlar qurishi va ularni birlashtirib yagona butun obyekt
sifatida garashi mumkin. Shu tarzda, rasm iyerarxik tuzilishga ega
bo'lib. eng yuqorisida butun vektorli tasvir boigan, eng quvida esa
standart obyektlardan iborat bo'ladi.
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Paket obyektga yo‘naltirilishiniag yana bir afzailigi har bir
obyektlarning standart sinfiga boshgaruv parametrlari yoki atributlar
o‘rnatiladi. Vlasalan. to‘rtburchak balandligi 200 mm va eni 300 mm,
ko‘k rang bilan toTdirilgan, qalinligi 3 punkt bo'lgan sarig rangdagi
chiziq bilan chegaralangan. Joylashuvi vertikal bo‘yicha 150 mm.
gorizontal bo‘yicha 250 mm, 32 gradusga burilgan kabi boshgaruv
parametrlariga ega.

Paketning obyektga yo'naltirilishinmg uchinchi afzalligi obyekt-
larning har bir standart sinfiga standart operatsiyalar ro‘yxati bel-
gilangan. Masalan, yuqoridagi to'rtburchakni burish, o‘lchamlarini
o‘zgartirish.  burchaklarini o'zgartirish, boshga sinf obvektlariga
aylantirish kabi amallar. CoreIDRAVning obyektga yo'naltirilganligi
foydalanuvchiga ish vaqgtida obyektlar ustida cheksiz o‘zgaruvchanlik
amallarini bajarish imkonini beradi. Agar buyurtmachi ishning oxirgi
bosqgichida o‘z fikrini o‘zgartirsa va reklama plakatidagi olma o'rniga
anorni tasvirlashni xohlab qoldi, bunday holatda ishni boshidan
boshlash shart emas. Buning uchun ayrim obyektlarni almashtirish
kifoya. Bunday holatda bir marta qurilgan obyektni saglab qo'yib
keyingi yangi ishlarda foydalanish mumkin.

CoreIDRAW paketi quyidagi dasturlardan iborat: Corel CAPTURE,
Corel BARCODE WIZARD, CorelDRAW, Corel Photo-PAINT, Corel
OCR-TRACE, CorelTRACE, Corel VENTURA, Corel SCRIPT Editor,
Corel SCRIPT Dialog Editor.

Corel CAPTURE dasturi CorelIDRAW dasturi oynasi va uning
gismlarini rasrnga olish uchun ishlatiladi. Uning yordamida dastur
oynasi ayni ko ‘rinishini tolig yoki menyu ko‘rinishini hamda biror
gismni to’rtburchak shaklda, aylana yoki ellips shaklida va ixtiyoriy
shaklda aylantirib belgilab olish mumkin.

Corel BARCODE WIZARD das-
i turi  esa shtrix-kod bilan ishlashga

L b 0
1\-/- ------ 1"\—/l]I 100% v mo'ljallangan. Unda benlgan standart-
L*) Corel CAPTURE lardan birini tanlab, so‘ng Kkeltirilgan
Corel BARCODE WIZARD namuna bo‘yicha ragam va xarflarni
éoreflﬂlﬁ)ﬂﬂ/ kiritamiz.

Corel Photo-PAINT dasturi esa

23 Corel PHOTO-PAINT rasmlar chizishga mo'ljallangan.
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CoreiDEAW i ishga tushirish. Corei DRAW 12 gratik muharririni
ishga tushirish uchun Myck > Mporpammbl > Corel DRAW 12 buyrug'i
beriladi yoki Windows XP isli stolida uning yorlig‘i ustida sichqoncha
chap tugmasi ikki marta bosiladi.

CorelIDRAW dastnrini ishga Tushirish Windowsning standart
usullari singari: asosiy menyu orgali (unda paketni o‘rnatganda
CorelDRAW ni yuklash buyrug'ini o'z ichiga oigan yangi buyruglar
gurulii paydo bo'ladi) yoki ish stolida joylashgan yorlig yordamida
hamda CorelDRAW dasturida yaratilgan fayllar ustida sichgoncha
chap tuginasini ikki marta bosish yo'li bilan ishga tushiriladi. Bunday
fayllarni biz albatta uning kengaytmasidan bilib olamiz. CoreIDRAW
dasturida yaratilgan fayllar .CDR. .CMX. W MF kabi kengaytmalarini
oladi.

Kengaytmalar hagida 5.2-jadvaldan batafsil ma'lumot olishingiz
mumkKiin.

5.2-jadval

CorelDRAW dasturida kengaytmalarning ro‘yxati

Ne Kengaytma Izoh

1 CDR CoreIDRAW

2. CDT CorelDRAW shabloni

3. CGM Kompyute r graiikasi metafayli

4. CM X Corel Presentation Exchange 5.0.
5. CM X Corel Presentation Exchange

6. CSL Corel siiwollari kutubxonasi

7. DES Corel DESIGNER

8. DWG AutoCAD

9. DXF AutoCAD

10 EMF Kengaytirilgan Windows metafayli
11 FMV Vektorli freym metafayli

12, GEM GEM fayli
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13 PAT Clzor fayli

14 PCT Macintosh PICT rasmlari

15 PLT HPGL plotter fayli

16. SVG IMasshtablanadigan vektor grafikasi
1. SVGZ Siqi SVG

18 WMF Windows metafayli

19 WPG Corel WordPerfect grafikasi fayli
20. CLK Corel R.A.V.E.

Dastur vuklangandan so'ng ekranda foydalanuvchi interfeysining
asosiy eletnentlaridan iborat CoreIDRAW oynasi paydo bo‘ladi (5.1-

rasm).
Vlenyu gatori  Standart uskunalar paneli Atributlar paneli
Lp-s il >, .
Iffvjs l«it  To»s
w a*#4.
QDN Wrm r A ytigm
* X
. & IE'. 0
Ish 40a'0zi Ish maydoni aOpwi
q g QQ@M]\ -
D"BLEY ] ¥ VBT
i -Uskunalar to'plami \>/nla1lfd|l\h/_)’.))l*
A
L. G mmnm -
n
c
MPw 1T K i J M
><
(00,383; 220,383}  N»*t cbe for Cf Swondti"Tor Rot«ie/Si<*w; Obl-cfcfongtool«tot« «leb... u|
Sahifadan-sahifaga o ‘tish Holat gatori Palitra J

5.1-rasm. CoreIDRAW oynasining ko'rinishi.
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Windows standartidan fargli oynaning sarlavha satri ostida menyu
gatorijoylashgan.

5.2. Corel DRAW dasturi ovnasi gismlari

O Sarlavha satri. Bu yerda: Corel DRAW 12 - dastummg nomi.

[Risunok 1] — hujjatning formai nomi. Ish yakunida formai nomga
real (haqiqiy) nom beriladi.

O Menyu satri.

Windo'ws standartlariga mos bo'lgan menyu satri. CoreIDRAWda
menyu satri murakkab bo'lib. gism menyu va alarga mos buyruglardan
iborat. Boshqga dasturlardagi kabi bu menyu ham Corel Drawning
ko‘pchilik funksiyalariga kirisimi ta'minlaydi. Lekin ko’pchilik ha-
rakatlar u siz ham bajarilishi muinkin. Menyuni sozlashning
chegaralanmagan imkoniyatlari foydalanuvchini chalkashtirib yuboradi.
Foydalamrvchi xohlagan vaqtda CoreIDRAWning har ganday buyruq
va uskunalarini boshga menyuga ko‘chirish mumkin. Shuning uchun
keyingi paragraflarda birinchi navbatda menyusiz ishlash yo'llarini,
zarur bo"lganda wuning buyruqlariga murojat qiishni o'rganamiz.
Menyu satri 11 ta menyudan iborat. Har bir menyu o ‘ziga xos buyruglar
to‘plamidan tashkil topgan. Corel DRAW inenyusi murakkab tuzilgan
bo‘lib. hax- bir menyuda bir necha. ichki menyular boiishi mumkin.

Standart uskunalar paneli

Menyu satrining ostida Standart uskunalar paneli joylashgan. Bu
satrda eng ko‘p bajariladigan buyruglarga mos boshgarish elementlari
joylashgan. Masalan, OTkpbITb Gochish), 3akpbiTb (yopish), CoxpaHutb
(saglash) buyruglari, tizimli almashtirish buferining operatsiyalari,
rasmlarni ko'rish holati uskunakri joylashgan.

w nu

Standart uskunalar- paneli tugmachalarining vazifalari:
1 - vangi hujjat yaratish; 2 - mavjud hujjatni ochish; 3 - hujjatni saglash: 4 -
hujjatni chop qilish; 5—qirgish: 6 - nusxa olish; 7 - go'yish; 8 - oxirgi harakatni
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bekor gilish; 9 - oxirgi h.arakatni takrorlash; 10 - import (bir hujjatni ikkinchisiga
ulash); 11- eksport (fayllarni jo‘natish); 12 - ilovani yuklanish moduli; 13 - Corel
DRAWNiIng saytiga kirish; 14 —masshtabni kattalashtirish darajasi.

O Atributlar panel i.

Standart uskunalar panelining ostida «atributlar paneli» (naHenb
aTpubyTtoB) satri joylashgan. LJ belgilangan obyektning parametrlarini
o‘zgartiradigan boshcjarish elementlari to'plamidan iborat. Atributlar
paneli ichidagi elementlar belgilangan obyektning shakliga qarab
o'zgarib turadi. Bu panel fovdalanuvchining asosiy ish paneli deb
ataladi.

JEEN UIEM MBS 0 aworiooa v

Ranglar palitrasi. Ovnaning cfng chegarasi bo‘ylab «Manutpa uBe-
ToB» (ranglar palitrasi) paneli joylashgan. U rangni to'ldirish va rasmli
obvektlarning atrofini himoyalash, aylantirib bo‘yash uchun qoilaniladi.

Uskunalar paneli. Ish maydonining chap gismida uskunalar to‘plami
(toolbox) oynasi joylashgan. Undagi kerakli uskunani tanlash uchun
uning ustida sichgoncha chap tugmasi bosiladi. Kerakli uskunani
tanlash bilan foydalanuvchining tasvir ustida barcha harakatlari
boshlanadi.

Uskunalar panelidagi asosiy uskunalar va ularning vazifalari:

1 - YkasaTenb (ko‘rsatkiich). tasvirni belgilaydi: 2 - ®opma (shakl) uskunasi; 3 -
Bbipes3aTb (Qirgib olish); 4 - MacwTa6 (oMcham). Obvektni ko'rinishini o‘zgartiradi
(kattalashtiradi va kich iklashtiradi); 5 — Cso6ogHas pyka. Ixtiyoriy shakldagi
chiziglami chizadi; 6 - "ABTopucosaHune uskunasi. Erkin chiziglarni hosil giladi; 7 -
MpamoyronbHnk uskunasi. To‘rtburchaklar sinfini hosil giladi; 8 - Aylana va uning
sinfiga tegishli obyektlarni chizadi; 9 - MuoroyronbHuk (ko‘pburchak) uskunasi.
Ko'pburchaklarni chizadi: 10 - MpocTbie ¢opmbl (oddiv formalar); 11 - TekcT
(matn) uskunasi: 12 - Ta6nuuya. Jadval uskunasi; 13 - MHTepakTMBHOe nepeTekaHue
uskunasi: 14 - Munetka uskunasi; 15 - KoHTyp uskunasi; 16 - 3anueka uskunasi;
17- NHTepakTUBHAA 3anNMBKa uskunasi.
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52 -rasm. Fill uskunasining yoyilgaii paneli.

Uskunalar panelidagi ayrim tugmalarning pastki ong burchagida
uctiburchak shakli berilgan. Bu ko'rsatkich tugmachaga aslida bitta
emas balki bir nechta uskuna o'rnatilganligini bildiradi. Tugmaga
tegishli boshga uskunalami birga ko'rish uchun uni sichgoncha chap
tugmasi yordamida bosamiz.

5.2-rasmda Fill (3annBka) uskuna tugmasi ostida joylashgan panel
ko‘rsatilgan.

Ochilgan paneldan zarur tugmani tanlash vabosish yo‘li bilan turli
vazifalar bajariladi.

CorelDRAW oynasining pastki gismida holat gatori joylashgan
(status bar). Unda ish jarayonida belgilangan obyekt hagidagi va
dasturning ish rejirai haqgidagi boshga yordamchi ma'lumotlar beriladi.
Holat gatorini ish stolining ixtiyoriy joyiga ko'chinsh mumkin. Ammo
tajribalarning ko'rsatishicha holat gatorini ish stolining pastki gismiga
joylashtirgan rna’qul.

CorelDRAW ish maydoniaing asosiy gismida hujjatlar oynasi
(drawing windows) joylashtirilgan. CoreIDRAW vyangi hujjat yaratish
buyrug‘i berilgandan so'ng illyustratsiya joylashtiriladigan sahifa paydo
boTadi. Sahifaning chegaralari ramka ko’rinishida joylashtirilgan boiib
ular tasvirning elementlari hisoblanmaydi. Bo‘lajak illyustratsiyani
tash kil qgiluvchi obyektlari ana shu ramkalar ichida joylashgan bo'lishi
lozim. Illyustratsiya oynasining qolgan maydoni ish stoli deb nomlanib,
ulardan obyektlarni vaqtincha saglash maqgsadlarida foydalaniladi.
CorelDRAW ish stoli o‘lchami uning ekranda korinib turgan gismidan
ko‘ra juda ham katta. Oynaning ko’rinmaydigan gisinini ko'rish uchun
o‘ng va pastki tomonda ikkita prokrutkalar joylashgan. Gorizontal
prolcrutkadarx chapda ko'p betli hujjatlarning alohida betlariga o‘tish
imkonini beruvchi (harakatlanish) tugma va yorliglardan (betning nomi
berilgan) iborat boshgaruv elementlari joylashgan. Ularni birgalikda
navigator deb ataladi.
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Hujjat oynasining chap va yuqori chegaralarida koordinatali
chizg‘ichlar (rulers) joylashtirilgan. Ular yordamida obyektlarning
koordinatalarini va joylashuvi yo'raalisHini aniglab olinadi.

CoreIDRAW interfeysida birlashgan (dockers) oynasi ulkan
ahamiyatga ega. Bu oyna yig‘ilgan pavtida nomlangan yorliglardan
iborat bo‘lib, ranglar palitrasidan chapda joylashgan. Ular opining
funksiyasiga ko'ra muloqot oynasini eslatadi. Ammo ularning muloqot
oynasidan fargli tomoni ish muhitida doimo ko‘rinib turishidadir.

5.3. Hujjatlar bilan ishlash
Yangi hujjat yaratish

Har doim CorelDRAW dasturi yuklangandan so'ng yangi hujjat
ochiladi. Agar ish jarayonida yana bitta yangi hujjat yaratish kerak
bo'lsa u holda, File (®ain) nxenyusidan New (HOBblii AOKYMEHT)
bnyrug'ini bering yoki standart uslcunalar panelining chap gismida
joylasligan New (HoBblIli goKymeHT) tugmasini sichqgoncha chap tugmasi
yordamida bosing.

Agar uskunalar panelidagi tugmalarni vazifalarini yaxshi bil-
masangiz yoki unutib go’ygan bo’lsangiz u holda. shu tugma ustida
sichqon koTsatkichini biroz ushlab tursangiz. uning ustida nomi aks
etgan eslatma paydo bo‘ladi.

Hujjatni ochisH va yopish

CorelIDRAW dasturida awaldan tayyorlab quyilgan hujjatlar
Windowsning boshga amaliy dasturlari singari quyidagi yoMlar bilan
ochiladi: CoreIDRAWda yaratilgan faylni bosib ochish orgali yuklash;
File (®alin) menyusidagi Open (OTkpbiTb) buyrug‘ini berish orqali
yoki standart uskunalar panelidagi Open (OTKpbITb) tugmasini bosish
orgali amalga oshiriladi. Oxirgi ikki holatda ekranda Open Drawing
(OTKpbITb AOKYMeHT) mulogot oynasi paydo bo‘ladi (5.3-rasm). Bu
mulogot oynasida Windowsning barclna amaliy dasturlaridagi hujjatlarni
ochisli 03'nasining standart elementlari mavjud. Undan tashqari,
fayllar ro‘yxatining o‘'ng tomonida (Preview (MpeaBaputenbHbili npo-
cmoTp) belgisi faollashganda) tanlangan faylda saglanayotgan tasvirni
ko’rish mumkin. Bu esa biz ochmoqchi bo‘lgan faylni aynan shu tasvir
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5.3-rasm. Open Drawing mulogot oynasi.

ekaaligini bilib olish udiun imkon beradi. CorelIDRAW hujjatlarini
saglashda berilgan kalit so’zlar yoki eslatmalar Keywords (KntoueBble
cnosa) va Notes (3ameuaHusi) maydonida pavdo boiadi.

FLujjatlarni yopish uchun esa File > Close buyrug‘iai berish yoki
ekranning yugori o‘ng burchagida joylashgan Close tugmasini bosisli
kerak. Shundan so’ng agar hujjat yaratilgandan keyin unda biror
o'zgarish bo‘lgan bo'lsa u holda hujjatni saglash yoki saglamaslik
hagida oyna chigadi. Agar bu oynada Ja tugmasi bosilsa, Save
mulogot oynasi (hujjatni saglash oynasi) paydo bo‘ladi. Aks holda, Hert
bosilsa, u holda hujjatdagi barcha o‘zgarishla.r saglanmasdan o‘chib
ketadi. Bu ogohlantirish oynasida ikki tugma bilan birga uchinchi
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tugnia Cancel ham mavjud. Ayrim hollarda hujjatni bekitishga buyruq
berilsandan so‘'ng inulogot oynasi avtomatik holda chiggandan keyin,
foydalanuvchining fikri o'zgarib yuqoridagi ikki holatdan birini
emas. balki uchinchi holat. ya'a i hujjatga gaytib, islini davom ettirishi
mumkin. Buning uchun Cancel tugmasini bosish kerak.

Hujj atni saqlash

CorelIDRAW hujjatini saqglash standart uskunalar panelidan Save
(CoxpaHutb) buyrug‘ini berish orqgali bajariladi. Agar avval bu hujjat
saglanmagan bo4sa, ekranda 5.4-rasmda berilgan Save Drawing (Co-
XpaHuTb AoKymeHT) mulogot oynasi paydo bo'ladi.

Hujjatni saqlash uchun File name (Mma d¢alina) maydoniga fayl
nom ini kiritish, fayl saglanishi kerak bo'lgan papkani tanlash va
Save (CoxpaHutb) tugrnasini bosish kerak. Shuningdek Save (Co-
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5,-4-rasrri. Save Drawing mulogot oynasi.
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XpaHutb) tugmasini bosishdan oldin muloaot oynasidagi Keywords
va Notes maydonchalariga Icalit so'zlar va eslatmalarni kiritib saglash
ham mumkin (yuqorida aytilganiiek fayllarni ochish paytida bu
ma'lumotlardan foydalanish mumkin).

Endi diggatingizni ochiluvchi Version (Bepcua) ro‘yxatiga garating.
Bu ro'yxatdan siz faylni CoreIDRAWning avvalgi versiyalarida
saglamoqchi bo‘lsangiz. u holda bu ro‘yxatdan o'zingizga kerakli
alternativ versiyani tanlashingiz kerak bo'ladi. Agar fayl avval
saqlangan. bo"lIsa, u holda diskda takroriy saglashda Save Drawing (Co-
XpaHuUTb AOKymeHT) mulogot oynasi ochilmasdan amalga oshiriladi.
Agar faylning nusxasini olishingiz kerak bo'lsa. u holda uni boshga
papkaga saqlang. Options tugmasi saglash rejimining ikkinchi darajali
funksiyalaridan iborat boshgaruv elemeatlarini ochish yoki yopish
imkonini beradi.

5.4. Sahifaning parametrlarinio‘zgartirish

Yangi hujjat varatilgandan so‘ng gohida uning oichamini o0'z-
gartirishga to‘g‘ri keladi. Buning uchun atributlar panelining ele-
mentlariga nnurojat gilinadi. Rasmda birorta ham obyekt bel-
gilanmagan bo'lsa. u holda atributlar panelida sahifaning oicham-
larini o'zgartirishga imkon beruvchi eleinentlar paydo bo‘ladi (5.5-
rasm).

Qog'oz fbnnati Sagifa oriyentatsiyasi  K<rp gatorli hujjat rejimi

Sahifa o'lchami
O‘Ichov birlisi

*1
U 297.9 " x - dt ) N
Ad m s m A " rr1| ‘o Units: millimeters
«B» 2,54 mm 52 6.35 mm
y 6,35 mm

5. 5-rasm. Belgilangan obyektlar bo'lmagan hold a atributlar panelining ko‘rinishi.
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Hujjatning chop etiladigan sahifa o‘lchami atributlar panelining
eng chap gismida joylashgan Paper Type/Size (Tun/cdopmat byma-
rm) bekiladigan ro‘yxatdan tanlanadi. Chop etiladigan sahifaning
o'lchaini illyustratsiya chop etiladigan qgog‘ozning formatiga mos
kelishi shart emas. Faqatgina illustratsiya gog‘ozning o’lchamidan
ortib ketmasa bo'ldi. Agar chop etiladigan sahifa o‘lchami
gog‘ozning o'lchamidan kichik bo'lsa, u holda gog‘ozning chetida
toza bo'sh joy goladi. Shuning uchun chop etiladigan sahifaning
oichamini bo'lajak illyustratsiya o’lchamidan (standart gog'ozning
o'lchamlaridan emas) kelib chigib oldindan belgilab olinadi. Agarda
illyustratsiyaning oichami kichik bo‘lsa, u holda bitta qog‘ozga bir
nechta nusxani joylashtirib chop etish maqgsadga muvofig. Bunga
misol qilib, kichik taklifnomalar, tashrif gog'ozlarini aytish mumkin.
Nostandart o'lchamda chop etiladigan sahifani yaratish uchun uning
oichamlarini gog‘oz formatlari royxatidan o‘ngda joylashgan Paper
Width and Height (W npuHa n BbicoTa nucta) maydoniga kiritiladi.
Undar yana o‘ngda esa chop etiladigan sahifaning orientatsiyasini
(kitob yoki albom ko‘rinishi) belgilashda ishlatiladigan Portrait
(KHn3kHasa) va Landscape (Anb6oMHas) tugmasi joylashgan. Bu
tugmalarda standart A4 gog‘ozning tasviri nomiga mos ravishda
evertikal \a gorizontal ko'rinishda joylashtirilgan. Shuningdek
Drawing Units (EguHnybl  n3mepeHusi) ochiladigan ro‘yxatdan
Corel DRAWda koordinatani va oichamlami aniglash uchun o‘lchov
birligini o‘zgartirish mumKkin.

55. CoreIDRAAVda oddiy shakllarni chizish imkoniyatlari

To‘g‘riburchaklar chizish

Yuqorida aytilganidek CorelDRAWda tasvirlar bilan ishlashning
asosiri obyektlar tashkil qiladi. Buni quyidagilarda ham ko‘rish
mumkin: bu dasturda foydalanuvchi tomonidan bajarishi lozim bo'lgan
barcha grafikli obyektlarni ikkita kategoriyaga ajratish mumkin -
chiziglar va belgilar (matnlardan tashqari).

Berilgan obyektLardan eng chapda - «knaccuk» to‘g'ri burchak.
To'g’'Tiburchaklar yaratilgandan keyin aynan shunday namoyon bo‘ladi.
Ikkinchi obyekt esa yaratilganidan keyin 45° ga burilgan ko'rinishi.
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5.6-rasm. To‘g'riburchaklilar sinfi eiementlari.

Uchinchi obyektda esa yaratilgandan keyin, to'rttadan uchta burchagi
dnmaloqglangan.

Agarda sizda biror chizilgan obyektning qaysi tipga tegishliligiga
shubha o‘yg‘onsa, u holda o‘sha obyektni sichgoncha yordamida
belgilang va holat gatoriga qarang. Kolat gatorida Rectangle on
Layer 1 (MpamoyronbHUkK Ha cnoe 1) xabari paydo bo‘lsa, u holda
uning to'g'riburchaklar sinfiga tegishli ekanligiga hech ganday shubha
golmaydi. CorelDRAWda barcha primitivlar tegishli uskunalar
yordamida quriladi. Yuqorida biz uskunalar paneli bilan tanishib
chigqdik. Shuningdek uskunalar orasida Rectangle (MpAMOYronbHUK)
tugmasini ham ko‘rib o'tdik. Endi shu uskuna yordamida birinchi
obyektimizni quramiz.

To'g'riburchak chizish

Ushbu mashqni bajarisa bilan biz to'g'riburchak qurishning asosiy
imkoniyatlari va shu bilan birga CoreIDRAW 12 ish mubhitining
go ‘shimcha elementlari bilan tanishamiz.

1 Yangi hujjat yarating. Bu mashgni bajarish uchun ixtiyoriy
oslchamdagi sahifa gog'ozini olisli mumkin.

2. Uskunalar panelidan Rectangle (MpsamoyronbHuk) uskuna tug-
masini bosing. Shundan keyin sichqgon ko‘rsatkichi ekranda krest
shakliga o‘tib, uning oldidato‘g‘riburchak ham paydo boiadi (5.7-rasm).
B u esa ayni vaqtda to'g'riburchak chizish uskunasi faolligini bildiradi.

Rectangle (MpamoyronbHuk) uskunasini boshga yol bilan ham
faollashtirish mumkin, masalan. sahifaning bo'sh joyida sichqonchaning
o'ng tugmasini bosishva kontekstli menyudan F6 buyrugMni oling.
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Ramkali belailash markerlari

Obyekt markazidagi marker

Obyekt uzeli

Recta ngle uskunasi uchun
- sichgoncha ko‘rsatkichi

Rectangle onLayer 1

5.7-rasm. Belgilangan to'g'riburctiak va holat gatoridagi xabar.

To‘g‘riburchak chizishda digqatingizni holat qgatoriga qaratsangiz,
u yerda chizilayotgan to"g‘riburchakning bo'yi va eni o‘lchamlari
(pikselda) ko‘rsatiladi. Ekranda esa chizilayotgan to'g'riburchakning
doimiy ozgarib boravotgan ko‘rinishi tasvirlanadi. Holat qatorida
esa yuqcrida aytilganidek uriing oichamlari to'xtovsiz o‘zgarib
borayotganini ko4isliingiz mumkin. Chizilayotgan to'g"ri burchak
foydalanuvchi xohlagandek y uzaga ega bo'lganda sichgoncha tugmasi
go'yib yuboriladi. Bunda esa to‘g‘riburchak shu oxirgi o*Ilchamdagi
holatda ekranda pavdo fcoladi. Sichgoncha tugmasini qo'yib
vuborgunga gadar to‘g‘riburchak bo'yi va enini o'zingiz xohlagandek
oMchamga yaqinroq qilib chizib o lishingiz mumkin.

Ellips uskunasi (Ellipse)

Ellips uskunasi ell ipslar va ay lanalar chizish uchun mo'ljallangan.
Ellips o'ziga tashqi chizilgan to‘rtburchak burchaklaridan boshlab

chiziladi. Ellipsni chizish uchun markazda <Shift> tugmasi, aylana
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uchun <Ctrl> bosilishi lozim. Obyekt xossalari paneli yordaniida ellips
parametrlarini o‘zgartirish mumkin. Ellips tugmachasining yuqori
gismidagi belgi orgali ellipsning tipini tanlash mumkin. Ellips, Sektor,
Y*oy tugmalari xossalari uskunalar gatorida. qaytariladi.

Uchta wuskuna, ko'pburchak (mHoroyronbHuk), Spiral (Cnu-
panb), Koordinata sahifasi (PasannHoBaHHasa 6ymara), obyekt guruhiga
yig ‘ilgan bo‘lib uskunalar panelidan alohida panel ko‘rinishida ajratish

mumKkin.
Spiral uskunasi

Spirallar yaratish uchun mo'ljallangan yoki uzluksiz egri chi-
ziglar shaklidagi geometrik shakllarni chizish mumkin. Spiral
ch izish jarayoni to'rtburchak chizish jarayoni bilan bir xil. Fagatgina
Ixyydalanuvcni semetrik va logorifmik tagmalar orqali spiral turini
tanlash mumkin. Muntazam spiral yaratish uchun Ctrl tugmasini bosib
turish kerak. Spiral parametrlarini atributlar panelidan o‘zgartirish
mumkin.

Saval va topshiriqUir:

1 Dasturda kvadrat chizish uchun qaysi standart tugma bosiladi?
2. To‘g ‘ri to‘rtburchak uskunasi yordamida nimalar chizish mumkin?

3. Dasturda geometrik figuralar ganday yaratiladi?
4. Kontur va tayanch nugtalar hagida ma'lumot bering?

5.6. COREL DRAW dasturida murakkab chiziglar va shakllar
Egri chiziglar guruhi uskunalari (Curve)

Egri chiziglar guruhi usku-
nalari panelida quyidagi usku-
nalar bor: Chizish (Freehand). Bez'’e
(Vezier), Pero (Natural Pen), Chiziq

o'lc-hami (Dimension), Bog‘lovchi chizig (Connector Line) va Bog'lovchi
(Connector).
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Ko" pburchak uskunasi (MHoOroyronbHuk)

Ko'pburchakni kerakli tomonlarga ega bo‘lgan geometrik obvekt
sifatida tushunish mumkin. Ko'pburchakning bir varianti sifatida
yulduzchani olish mumkin. Bunda ichki chizilgan ko'pburchakni
maydonini kesib o'tadi. Ko'pburchakni yoki yulduzchani chizish
toi'tburchak chizishdan farqgi yo‘g. Ctrl tugmasini bosib turgan holda
muntazam ko'pburchak chiziladi. Ko'pburchak parametrlarini atributlar
paneli orgali o'zgartirish mumkin.

Ko'pburchak belgisini tanlab atributlar panelida uning qirralar
sonini biritish mumkin. Qirralar o'tkirligi maydonida shartli birliklarda
girranimg o‘tkirlik darajasini kiritish mumkin.

Koordinata qog'ozli uskunasi (PasnnHoBaHHas Gymara)

Kordinata qog‘ozli uskuna berilgan parametrli panjara yaratish
imkonini beradi. Bunday panjarani grafiklar yoki diagrammalar uchun
koordimtali asos qilib olish mumkin. Bu instrument parametrlarini,
parametrlar mulogot oynasida koordinatali gog‘oz bo'limida o'zgartirish
mumkin. Katakchalar soni maydonida eniga (Number of cells wide)
bo'yiga (Number o f cells high) ko‘ra katakchalar migdorini o'zgartirish
mumkin. Kvadrat katakchali panjaralarni tayyorlash uchun <Ctrl>
tugmasini bosib turish kerak.

Chizish uskunalari (Freehand)

Chizish uskunalari istalgan chiziglarni chizish uchun mo'ljallangan.
Bu uskuna ishi natijasida vektorli kontur hosil bo‘lib. bu kontur tayanch
nuqtalari dastur yordamida avtoinatik qo‘viladi. Bu konturlar ustida
erkin tahrirlash imkoni mavjud. Bu uskunalarda chizayotgan paytda
chiziglar galinligi va rangini o‘zgartirish mumkin.

Chizib boiingan chizigni istalgan paytda davom ettirish mumkin.
Buning uchun kursorni uning oxirgi nuqtasiga olib kelib (kursorning
egri chiziglari ko'rsatk ichga aylanadi), sichgoncha chap tugmasini
bosgar holda chizigni davom ettirish hamda chizish uskunalari
yordarnida to'g'ri chizig chizish mumkin.

besbe wuskunasi yordamida maksimal aniglik va maksimal rat-
sionallik bilan ixtiyoriy konturni yaratish mumkin. Bu uskuna
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foydalanuvchini grafik dizaynda barch.s. llars2.nl hsl qiluvchi Formel
yaratuvchisiga aylanishiga imkon beradi.

To‘g‘ri chizigli segmentlar tuzish

To'g‘ri chizig yaratish uchun Be3be uskunasi qulay keladi. Buning
uchun besbe uskunasini tanlash kerak. Kursorni boshlang'ich nuqtaga
olib kelish va sichqgonchaning chap tugmasini bosish kerak. Tugma
bosilgan joyda segmentning boshlang‘ich tayanch nugrasini ifodalovchi
gora nugta paydo bo'ladi. U keyingi nuqta yaratilgunga gadarfaol bo'lib
turadi. So'ng kursorni keyingi nuqta joylashadigan yangi joyga olib
o‘tish kerak. Ikki nuqgta to'g‘ri chizig bilan tutashadi.

Tayanch nugtalarning turlari

Bir necha segmentlarning tutashishida tayanch nuqtalari Corel Draw
dasturida uch tipli bo4ishi mumkin:

1 lkki egri chizigni «bukilishda» tutashtiruvchi tayanch nuqgtasi
- burchak tayanch nuqgtasi deyiladi. Bunday tayanch nuqtasida boshqa-
ruvchi chiziglar ham yo‘nalishi ham uzunligi bo'yicha mustaqildir.

2. lkki egri chizigni sinishsiz tutashtiruvchi tayanch nuqtasi - sillig
tayanch nuqtasi deyiladi. Bunday tayanch nuqtalarda boshqgaruvchi
chiziglar bir-biridan fagat o‘lchami bilangina mustaqil, yo‘nalishi
bo'yicha esa umumiy tutashuvchi to‘g‘ri chizigni tashkil qiladi.
Boshgaruvchi chiziglardan birining o'rin almashishi ikkinchisining ham
o‘rin aim ashish iga olib keladi.

3. Sinishsiz va bir xil giyalik bilan tutashgan tayanch nuqtasi
simmetrik tayanch nuqtasi deyiladi. Bunday tayanch nuqtalarda
boshqgaruvchi chiziglar bir-biriga yo’nalishi bilan bog'lig bo’ladi.

Savol va topshiriglar:
1 Egri chiziglar guruhi uskunalari panelida ganday uskunalar bor?
2. Dasturda ko'pburchaklar ganday yaratiladi?
3. Koordinata qog’ozli uskunasi (Graph Paper)ning imkoniyatlari?

5.7. CORELDRAW dasturida ranglar bilan ishlash

Imitatsiya uskunasi nugtali grafika dasturlarida ko‘proq ishlatiladi.
Shunga garamay vektorli dastur ham bu uskunani tagdim etadi. Bu
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uskuna orqali Peroda chizish o'rnini bosa oladi. shu bilan birga bezakli
shtainp o‘rnini ham bosadi. Bu uskunaning ajoyibligi shundaki u asosiy
konturni chizib. bu kontur bo'ylab turli obyektlar joylashib manzarali
va grafik effektlarni beradi.

Namuna rejimida shunday obyektlarni yaratish mumkinki, bunda
bu obyektlar tayyor namunalarga garab o‘z shaklini o‘zgartiradi. Bu
rejimda shaklli chiziglarni ishlatish raumkin.

Muvgalam rejimi (Brush) —bu rejimda murakkab tuzilishga ega
bo’lgan bezakli shakllarni yaratish raumkin.

Purkagich rejimi (Object Sprayer) kontur trayektoriyalari bo'ylab
turli grafik obyektlarni joylashtiradi. Bu rejim murakkab ramkalar,
bezakli gatorlarni yaratish uchun mo‘ljallangan.

Kalligrafiya rejimi (Calligraphic) — bu rejimda qalin pero yoki
enli muygalam egri chiziglarini chizish mumkin.

Rgessure rejimi — bu rejimda shunday chiziglarni chizish mum-
kinki bu chiziglarni klaviatura orgali boshgarish mumkin.

Xossalar uskunalar qgatorida bu rejim tanlansa quyidagi para-
metrlarga ega bo‘lamiz: tekislash maydoni (Freehand Smoothing) asosiy
chizigni 0 dan 100 diapazonigacha tekislash imkoniyati (rasmda 1
ragami bilan ko ‘rsatilgan).

Oicham maydoni (Size) (2 ragam) bezakli shtrixlarning o'lchamini
foizlar hisobida o'zgartish imkonirLi beradi 1 dan 99% gacha.

Obyektlar ro'yxati maydoni C3 ragam) - bu ro‘yxatda turli for-
matdagi purkaladigan obyektlarning namunalari keltirilgan.

Save tugmachasi (4 ragam) muyqalam rejimida ish yuritish bilan bir
xil.

0 ‘chirish tugmachasi (Delete) ro‘yxatdagi xohlagan variantlardan
birini o’chiradi.

oot Acksr aeKiakVPonerBAnNTroogHinem«
M D o. g —Rtill b @ 1 5 19Gm A |
1Si %
2 1 3 45
5.8-7-asm. Property Barpaneli.
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roVxatini tagdim etadi: tasodifan (Ramdom), ketma-ketli (Sequentially),

ycfnalish bo‘ylab (By Direction).

Obyektlar ro‘yxatiga qo'shish tugmasi (Add to Spraylist)
obyektlar ro'yxatiga yangi elementlarni go‘shish imkonivatini beradi.
Ulardan keyinchalik «ljrochi» qatorini (play list) tashkil qilish

mumkin.
Savol va topshiriglar:

Imitatsiya uskunasi (Artistic Media) - deganda nimani tushunasiz?

2. Kalligrafiya rejimi (Calligraphis)da ganday chiziglarni chizish mum-
kin.

3. Obyektlarni purkasb nima?
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VI-bob. FLASH DASTURI HAQIDA

Flash MX - Web sahifalaridagi animatsiyalar, bezaklar va
boshga manbalarni o'z ichida saglagan yuqori darajali dizaynlar
yaratish uchun moMjal langan dasturiy vosita hisoblanadi. Flash M X
dasturi yuqori darajadagi imkoniyatlari inavjud boUgan texnologik
vositalar sirasiga kirib uni bir so"z bilan Flash texnologiyasi deb
atashimiz mumkin. Flash texnologiya yordamida animatsiyalar,
Web—saytlar va ular uchun bannerlar, har-xil tnultimediali prezen-
tatsiyalar yaratish mumkin. Flash texnologiyasi yordamida yaratil-
gan turli loyiha va mahsulotlar — har doim harakatni yorgin aks
ettirib, undagi tovush va video ko‘rinishlar Internet loyihalarida
harakatliligi bilan ajralib turadi. Shuning uchun bu texnologiya
yordamida saytlar yaratish imkoniyati juda yuqori [5], [6], [7].
Lekin Flash texnologiyasining Internet tizimida ishlashda ayrim
kamchiliklari mavjud. Jumladan:

1 Flash elementlarini saytda tasvirlab berish uchun, brauzerda
Flash-player o”rnatish zarur. Internet Explorerda esa dastlabki o'r-
natishdan keyin Flash-player o'rnatiladi. Agarda siz boshga brauzerlarni
go'llaydigan bo'lsangiz, u holda Flash-playerni o'rnatishga to'g'ri keladi.

2. Flash-saytlari HTM L saytlariga qaraganda katta hajmni egal-
laydi, shuning uchun ularning yuklanishi birmuncha sekin.

3. Flash-texnologiyani ko'pincha reklama maqgsadida qo‘llaniladi.
Shuning uchun informatsion portallarda go‘!lashga tavsiya gilinmaydi.
Chunki bunday portallar hajmijuda kattalashib ketadi.

4. Flash-saytni yaratish biroz mehnat talab giladi. Shuning uchun
ham bunday saytlarning narhi, HTM L saytlar narhiga garaganda ancha
yuqori baholanadi.
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vaqtning liisobiga yo'gotadi. Ya'ni sayt kompyuter ekranida to'liq
tasvirlanib bcrlgunga gadar ketgan vaqgtning evaziga foydalanuvchilarni
yo'qotadi. Ammo bunday saytlar har ganday foydalanuvchini o'zining
yuqori darajali grafikasi, ko‘pgirrali imkoniyatlari, rang-barangligi
bilan foydalanuvchilarning asosiy qismini yo'qotgani yo'g. Natijada
Flash dasturi Web - ishlab chiquvchilar orasida o'zining keng gamrovli
oi'niga ega bo’lib bormoqda.

Flash usulida tayyorlangan prezentatsion saytlar yuqori darajadagi
grafik ahnashinuvlar, boy interfaol g‘oyalari va rasmlarning vuklanish
tezligi yaxLshiligi bilan tashrif buyuruvchilarda katta taassurot qoldiradi.
Bundan tashqgari harakatlanuvchi panellar, dinamik harakatlar,
sinxron tovushli kliplar ham har qanday foydalanuvchini digqgatini
o‘ziga tortadi. Siz xattoki informatsion sayt yaratayotgan bo'lsangiz
ham, flash-texnologiyani gqisman qo'llash yo'li bilan ham, tashrif
buyuruvchilaringiz uchun yaxshi taassurot qoldiradigan Internet resurs
yaratishingiz mumkin.

Umumiy ma'lumot va yordamchi jihozlar

Flash dasturi bilan tanishishni boshlaymiz. Bu yerda roliklar ustida
ish olib boradigan oynani ko‘rish mumkin. shuningdek uskunalar
paneli va bir necha yordamchi panellar mavjud. Bu yordamchi panellar
obyektlarning turli xossalarini tanlashga yordam beradi (masalan, rang,
galinligi va kontur ko'rinishi va boshga xususiyatlar). Flash dasturi
boshga dasturlar kabi ozining yorlig‘iga ega.

Savol va topshiriglcir:

1 Flash ganday tip dasturlarga kiradi?

Flasb dasturidan nima magsadlarda foydalanish mumkin?

3. Flash texnologiyasini Internet tizimida ishlashining ganday kam-
chiliklari mavjud?

4. Flash saytlari oddiy saytlardan nimasi bilan farglanadi?

N

6.1. Flash M X dasturining oynasi gismlari

Flash dasturi oynasi bir nechta gqismdan iborat. Ular bilan
tanishib chigamiz. Dastur oynasining asosiy gismlaridan biri uning
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6.1-rasm. Flash dasturi oynasi ko‘rinishi.

ish  nmydonidir. Ish mavdonida biz obvektlarni chizish, tahrirlash,
harakatlantirish imkoniyatini amalga oshiramiz. Undan yuqorida
esa - vagt diagrammasi yoki vaqt shkalasi (timeline) joylashgan (6.1-
rasm).

Uskunalar paneli

Uskunalar paneli rasmda ko'rsatilgandek to‘rt gismdan iborat.
Yugoridagi qismida Tools (uskunalar) obyektlarni yasash (chizish) va
ularni transformatsiyalavdigan uskunalar joylashgan. Keyinroq ular
bilan batafsil tanishib chigamiz. Kevin tasvirni Viev (Bug) boshgaruvchi
uskunalar keladi: bu qo‘l (Hand tool) rasmi va lupa (Zoom tool).

<QOdO>£N - d
« 0\ o\ Nes U’

6.2-rasm. Tools uskunalar paneli.
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Bu uskunalar boshga dasturlarda ham tez-tez uchrab turadi. Qo’l
uskunasi yordamida ishchi sohani ko‘chirish mumkin. Lupa uskunasi
yordamida kattalashtirsa yoki kichiklashtirsa bo‘ladi (kichraytirish
ucliun ishchi sohada ALT tugmasini bosish kerak). Bu uskunalar fagat
rolik tasvirini boshgaradi uning mazmuniga ta’'sir o‘tkazmaydi.

Endi dastur oynasining navbatdagi gismlari bilan tanishib chigamiz.
Ular quyidagilar:

Yorlig qatori: dastur nomi va faol fayl nomini tasvirlab turadi.

Dasturning gorizontal menyu qatori

Flash M X dasturining gorizontal menyu qatori quyidagilardan
iborat: File, Edit, View, Insert, Modify, Text, Control, Window, Help.
Endi menyulardagi asosiy buyruglar ketma-ketligi, ularning vazifalari
va ularning mos funksional tugmalar bilan tanishib chigamiz.

6.1-jadval

File menyusi buyruqlari

Buyruglar tugmalar (Windows)
New Yangi film <Ctrl>+<N>
Open Ochish <Ctrl>+<0>
Close Yopish <Ctri>+<W»>
Save Saglash <Ctrl>+<S>
Import Import gilish. <Ctrl>+<R>

Export Movie
Publish Settings
Publish Preview
Print

Exit
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Eksport gilish
Nashr o'lchamlari
Nashrni ko‘rish
Chop etish

Dasturdan chigish

<Ctrl>+<Alt>+<Shift>+<8>
<CtrI>+<Shift>"<F12>
<F12>
<Ctrl>+<p>

<Ctrl>+<Q>



Undo

Redo

Cut

Copy

Paste

Clear
Duplicate
Select All
Deselect All
Cut Frames
Copy Frames
Paste Frames

Edit Symbols

Goto
Zoom In

Zoom Out

Magnification

6.2-jadval

Edit menyusi buyruglari

Buyrugqlar

Bekor gilish
Takrorlash

Qirqgib olish

Nusxa olish

Qo'‘yish

Tozalash

Aynan nusxa olish
Hammasini belgilash
belgilanishni bekor gilish
Kadrlarni qirgib olish
Kadrlardan nusxa olish
Kadrlarni go‘yish

Simvollarni tahrirlash

tugmalar (Windows)
<Ctrl>+<Z>
<Ctrl>+<yY>
<Ctrl>+<X>
<Ctrl>+<C>

<Ctrl>+<V>

<Backspace>, <Delete>

<Ctrl>+<D>
<Ctrl>+<A>
<Ctri>+<Shift>+<A>
<Ctrl>+<Alt>+<X>
<Ctrl>+<Alt>+<C>
<Ctrl>+<Alt>+<P>

<Ctrl>+<E>

6.3-jadval

View menyusi buyruglari

Buyruqlar
kadrga o'tish

masshtabni kattalashtirish

masshtabni
kichiklashtirish

kattalaslitirish

tugmalar (Windows)

<Ctrl>+<=>

<Ctrl>+<— .
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davomi
<Ctrl>+<L>
<Ctri>+<2>

<Ctrl>+<3>

<CtrI>+<Alt>+<Shift>+<0>

<CtrI>+<Alt>-<Shift>+<F>

100% 100%

Show Frame kadrni ko’rsatish
Show A1l1 hannnasini ko‘rsatish
Outlines Konturlar

Fast tez

Timeline vaqt diagrammasi
Work are a ish maydoni

Rulers chizg'ich

Hide Edges girrani bekitish
Hide Panels panelni bekitish

Convert to Symbol
New Symbol

Frame

Remove Frames
Keyframe

Blank Keyframe
Clear Keyframe
Create Motion Tween
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Insert menyusi buyruglari

Buyrugqlar

simvolni holatini o'zgartirish
yangi simvol

kadr

kadrlarni o'chirish
bog’langan kadr

bo'sh bogTangan kadr
boglangan kadrni o'chirish

harakat hosil qgilish

<Ctri>1<Alt>-+<T>
<CtrI>+<Shift>+<W>

<Ctrl>+<Alt>+<Shift>+<R>

<Ctrl>+<H>

6.4-jctdval

tugmalar (Windows)
<F8>
<Ctrl>-i-<F8>
<F5>
<Shift>+<F5>
<F6> \
<F7>

<Shift>+<F6>



Layer..
Scare ..

Document

Transform

Scale

Rotate
Frames
Lock

Unlock All

Group

ungroup

Fort
Size
Style
Align

Scrollable

6.5-jadval
Modify menvusi buyruglari

Buyruglar tugmalar (Windows)
gatlam parametrlari <CtrI>+<F>
sahna parametrlari <Ctrl>+<M>
hujjat parametrlari <CtrlI>+<Alt>+<Shift>+<C>

ko'rinishni o'zgartirish -

o‘lchamni o'zgartirish <Ctrl>+<Alt>+<S>
uchun belgilash

Burish

kadrlar ustida amallar

bekitish (qulflash) <CtrlI>+<Alt>+<L>

bekitish (qulflash)ni bekor <CtrI>+<A.It>+<Shift>-i-<L>

gilish

Guruhlash <Ctrl>+<G>

guruhni bo‘laklash <Ctrl>-i-<Shift>+<G>
6.6-jadval

Text menyusi buyruqlari

Buyrugqlar tugmalar (Windows)
shriftni o‘zgartirish -
shrift o‘lchamini o‘zgartirish <Ctrl>+<Shift>+<B >
shrift stilini o'zgartirish <Ctrl>+<Shift>+<I>
matnni tekislash -

markerni o‘rnatish <Ctrl>+<Shift>+<C>
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N gohG!

Control menvusi buyruglari

Buvrugqlar tugmalar (Windows)
Play ijro etish <Enter>
Test Movie filinni ko‘rish <Ctrl>+<Enter>
Test Scene sahnani namoyish qgilish <CtrI>+<Alt>+<Enter>
6.8-jadval

Window menyusi buyruglari

Buyrugqlar tugmalar (Windows)
New Window yangi oyna <Ctrl>+<Alt>+<N>
Toolbars Panellar -
Tools ma’lumot <Ctrl>+<Alt>+<!>
Timeline tekislash <Ctrl>+<K>
Properties belgi <Ctrl>+<T>
Actions Protseduralar <Ctrl>+<Alt>+<A>
Movie Explorer filmlarni boshqgaruvi <CtrlI>+<Alt>-<M>
Library Kutubxona <Ctrl>+<L>

6.9-jctdval

Help menyusi buyruglari

Buyrugqlar tugmalar (Windows)
What’s new Yangi imkoniyatlar -
Lessons Flash boyictia darslar -
Using Flash Yordam maTumotlari Fl
Samples Flash faylga misollar -
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Buyruglardan foydalanishni tegishli bo'liinlarda batafsil ko‘rib
chigamiz.

Vaqt diagrammasi

Ish maydoni ustida vaqt diagrammasi (Timeline) paneli joylashgan.
Vaqt diagrammasi, filmning anig sahnalashtirilishiga xizmat qiladi.
U vyaratilgan qatlamlarni alohida-alohida sahnaga yozib qo‘yishni
ta'minlaydi. Sahuada namoyish gqilinadigan obyektlarning o'zgarishi
ketma-ketligini ifodalaydi. Vaqt diagrammasi shuningdek animatsiya
yaratishda, film interfaol elementlari xatti-harakatini belgilashda asosiv
uskuna hisoblanadi. Vaqt diagraminasi murakkab tuzilishga ega boiib.
ko‘p sonli boshgaruv elementlaridan iborat. Vaqt diagrammasi panelida
quyidagi umumiy elementlar berilgan (6.3-rasmda):

e filmning mavjud sahnasi uchun qatlamlar ro"yxati (ustma-ust
ustun ko‘rinishida) ko'rsatilgan. Qatlamlarning nomi va atributlari
ko‘rsatilgan;

e vaqt diagraminasi har bit gatlam wuchun kadrlar shkalasidan
iborat;

e vaqt diagrammasidagi kadrlarni formatini o‘zgartirishning yig’ma
menyusi;

e filmning ayrim parametrlarini ifodalaydigan vaqt diagrammasidagi
holat gatori mavjud.

Vaqt diagrammasining kadrlar shkalasi bilan tanishib chigamiz.
Shkala sahnaning barcha gatlamlari uchun umumiy bo‘lib. ammo har
bir gatlam o’zining kadrlar gatoriga ega. Unda kadrlar o'sish tartibida
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6.3-rasm. Vaqt diagrammasi.
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nomerlantjani tasvirlangan. Nomerlanish har 5 qadarnda beriigan bo'lib,
kadrlarning har ganday formatida o‘zgartirib boTmaydi.

Vaqt diagrammasi ko‘rsatkichi (Play head) animatsiyaning faol
kadrini kcrrsatadi. Qaysi kadr sichqon yordamida tanlansa, o‘sha kadr
ustida kcrrsatkich paydo bo’ladi. Ko‘rsatkich faol kadrning nomerini
ko'rsatib turadi. Bu esa animatsiyaning tasvirlanayotgan jarayonga
sinxronligini ta’minlaydi.

Kadrlaroi formatlash menyusidagi buyruqglar kadrning katakchasini
gorizontal bo'yicha o'lchamini belgilaydi: Tiny (mayda); Small (kichik);
Normal (odatdagi); Medium (o'rta); Large (katta).

Boshgaruv elementlari paneli (Properties)

Yuqorida boshqaruv elementlari panelida beriigan ma'lumotlarga
go'shimcha ravishda quyidagilarni aytish mumkin:

* matnli maydonda u rL ish maydoni matnli gismini belgilaymiz
va shu maydonda to'liq Web-manzilni ko'rsatamiz (URL - Universal
Resources Locator). Bog‘langan resurs uchun siz haqiqgiy giperhavolaga
ega bo'lasiz;

Boshqga vizual tahrirlagichlardan fargli tomoni, gipermatn namoyish
vaqtida ostiga chizilgan shrift bilan emas balki, shtrixli chizig bilan
beriladi. Flash texnologiyada giperhavola hosil qilishning ikkita
kamchiligi bor: birinchidan, URLni noavtomatik (qolda) yo‘l bilan
kiritiladi va ikkinchidan, Flash URLning xatto lokal fayllar uchun
aniqgligini tekshirmaydi;

- Target (LleneBoin) ro‘yxati; u resursni ganday brauzer oynasida
namoyish qilinishini (yuklanishini) ko‘rsatishda qo‘llaniladi (ko'r-
satilgan URL bo'yicha chagqirilgan resursni). URL maydoniga hech
bo‘Imaganda bitta simvol Kkiritilgandan keyin ro‘yxat faollashadi,
ya'ni o‘'nga murojaat qilish mumkin. Ro‘yxat quyidagi variantlardan
iborat (ular HTML tilining TARGET atributi giymatlari bilan
o‘xshash):

0 - blank - chagirilayotgan hujjat har doim yangi oynada yuklanadi
(asl oynaning o‘zida emas);

o -self - chagirilayotgan hujjat xuddi shu oynaning o‘zida yuk-
lanadi (qaysiki havola o‘rnatilgan oynaning o'zida);
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« —parent - chagqirilayotgan hujjat bosh oynada yuklanadi; agar
bu oyna bosh oynaga ega bo'lmasa, u holda yuklanish xuddi _self
ko‘rsatkichidagidek bo‘ladi;

o-top - chagirilayotgan hujjat eng yuqori gismdagi oynada yuk-
lanadi (agar ushbu oynaning o‘zi eng yugori gismda bo'lsa. u holda _
self ko'rsatkichdagidek yuklanadi);

< Selectable (Bbigensembiin) tugmasi; bu tugma xuddi bayrogchadek
go'llaniladi: tugmani bosish bilan matnga tegishli xususiyatlar panelini
o‘rnatish yoki aksincha o'rnatilgan bo'lsa uni bekor giladi;

* Change Direction of Text (matn Yyo'nalishini o'zgartirish) foyda-
lanuvchi menyuni ochib matnning yo'nalishini tanlab olishi rnumkin:
gorizontal yoki vertikal. Menyu o'z ichiga quyidagi uchta buyrugni
oladi:

o Horizontal (Topu3oHTanb);

0 Vertical, Left to Right (BepTukanb, chapdan o'ngga);

0 Vertical, Right to Left (BepTukanb, o'ngdan chapga);

Matnning vertikal yo'nalishini o'rnatishda formatlashning tugmalar
tarkibi o‘zgaradi va undan tashqari Rotation faollashadi:

e Rotation (burish) tugmasi bavroqcha vazifasini bajaradi va
matndagi simvol joylashuv holatini o'zgartirishni ta'minlaydi;

* Use Device Font belgisi —agar belgi o'rnatilgan bo'lsa. Flash —
pleyerda filmni namoyish qilish mobaynida o'quvchining brauzeri uchun
o'rnatilgan shriftlar go'llaniladi. Bu film fayli o'Ichamini kichraytiradi
va kichik shriftning qulay o'qilishini ta’'minlaydi.

Xususiyatlar paneli crng chegarasi yaginida Format (®opmar)
tuginasi joylashgan. Uni bosish bilan. qo'shimcha mulogot oynasi
ochiladi va undan foydalanib matn maydonini formatlash parametrlarini
o'l'Viatish mumkin.

Format Option oynasi to'rtta matnli maydondan tarkib topgan:

- Indent - yangi gator uchun abzatsning o‘lchami (pikselda);

* Line Spacing - yon atrofdagi qatorlar bilan joylashuvi (satrlar
orasidagi interval); vertikal matnlar uchun bu parametr matnning
ustunlari orasida beriladi;

* Left Margin (chap maydon) — matn mavdonining chap chegarasi
va qatorning birinchi simvoli orasidagi masofa;
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* Right Margin (0'ng maydon) —matr, maydonining o‘'ng tomon
chegerasi va gatorning oxirgi simvoli orasidagi masofa.

Format Option mulogot oynasi matn maydonining har ganday
ko'rinishi uchun o'rinli.

Dasturning ish maydoniva uning ko‘rsatkichlarini o‘zgartirish

Agar ishchi maydonida birorta ham obyekt tanlab olinmagan bo'lsa
yoki umuman mavjud bo‘lniasa, u holda boshqaruv paneli xossalari
filmning umumiy parametxlarini ko'rsatadi. Qandaydir obyektni
olsangiz uning formati avtomatik ravishda o’zgaradi.

* Document (JokymeHT) matn maydoni. tahriiianadigan fayl nomi
tasvirlanadi;

e Size (Pasmep) tugmasi, ish stoli o‘lchamini tasvirlab beruvchi
tugma;

e Publish (My6nukauuns) tugmasi; uni bosish bilan avval o' rnatilgan
parametrlar asosida film nashrini boshlaydi;

e Background (PoH) tugtnasi; uni bosish bilan filmning fon rangini
tanlash palitra oynasi hosil bo'ladi. Shu oynadan filmning kerakli foni
rangi tanlab olinadi;

* Frame Rate (CkopocTb KagpoB) matnli maydon, animatsiyaning
kadrlar almashish tezligini belgilaydi;

* ?(so‘roq) belgisi tasvirlangan tugma HTML-formatidagi kontekst-
li ma’ lumotnomani chaqirib beradi:

* Yulduzchalar tasvirlangan tugma. Bu tugmani bosish bilan
Accessibility (JocTynHocTb) panelini ochiladi. Bu panel filmning
barcha elementlari uchun go‘sliimcha xususiyatlarni o‘rnatishga mo'‘ljal-
langan.

Ish maydoni oynaning butun markaziy qismini egallaydi. Ish
maydonida obyektlar ustida har ganday tahrirlash ishlarini amalga
oshirish mumkin. Fagatgina montaj stolining tegishli kadriga oby~ektlar
mos kelsa magsadga muvofig boiadi. Ish maydoni keng bo‘lishidan
magsad:

» sahnadan tashqari ishlarni bajarish;

« obyektni sahnaga kirishidan oldin yoki chigib ketgandan keyingi
holatlarni hosil gilish uchun zarur bo'ladi;
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» ish maydoni ostida unga tegishli uskunalar paneli joylashgan.
Unda quyidagi interfeys elementlari joylashgan:

» strelkali tugma butun sahnani tahrirlash rejimiga qaytishni
ta'minlaydi; agar siz alohida simvol ustida tahrirlash rejimida ish-
layotgan bo‘lsangiz, tugma faollashadi:

* tahriiianadigan sahna nornli matnli maydon;

* sahnani tanlash tugmasi; bu tugmani bosish bilan film sah-
nalaridan tashkil topgan ]. yxatli inenyu ochiladi;

« simvolni tanlash tugmasi; bu tugmani bosish bilan film tugma-
laridan tashkil topgan ro ‘yxatli menyu ochiladi;

e masshtab, uning yordamida ish maydonini tasvirlash masshtabi
tanlanadi.

Ish maydonining ixLtiyoriy joyida sichqon o‘ng tugmasi bosilsa, ish
rnaydonining parametrlarini o'zgartirishga mo'ljallangan buyruglar
to‘'plamini oz ichiga olgan kontekstli menyu ochiladi. Bu menyu
hammasi bo'lib yigirmaga yaqin buyruglarni o‘z ichiga oladi.

Scene paneli yordamida siz quyidagi imkoniyatlarga ega bo‘lasiz:

e filmning sahnalari ro‘yxatini ko‘rish: sahnalarning filmda na-
rnoyish qilinish ketma-ketligi;

« filmning ro‘yxatidagi har ganday sahnasiga o ‘tish;

+ tanlangan sahnadan nusxa olish (asl sahnadan keyin nusxa hosil
boiadi):

» yangi (bo‘sh) sahna qo'shish (tanlangan sahnadan keyin bo‘sh
sahna qo’shiladi);

« tanlangan sahnan i o‘chirish.

Ish maydoni ko‘rsatkichlarini o‘zgartirish

Flash iMXda ish maydoni ko ‘rsatkichlarini o’zgartirish uchun
Modify menvusidan Document Properties buyrug‘i beriladi. Xuddi shu
vazifani ish maydoni ustida sichgonning o‘ng tugmasini bosib kontekstli
menyudan Document Properties buvrug'i tanlanadi. Natijada rasmdagi
Document Properties mulogot oynasi hosil boiadi.

Bu oynadan foydalanib. ish maydonining bo‘y i (height), eni (width)
peksillarda ko‘rsatiladi. Ish mavdoniga quyiladigan rang Background
Colorni tanlash orgali o'rnatish, shuningdek kadrlar almashish chas-
totalarini (Frame Rate) belgilash inumkin.
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FIASHda kutubxona bilan ishlash

Flash dasturida kutubxonadan foydalanib quyidagi funksiyalarni
bajarish mumkin:

* import qilinadigan va hosil gilinadigan simvollarni avtomatik
ravishda fi Im kutubxoaasiga qo'shilishi;

« fayllar tizimining butunligini nazorat qilish va avtomatik kuzatuv;

« simvollarning nomlari bir xillarini yo' gotmaslik;

* to‘g‘ridan-to‘g‘ri manipulyatsiya gilish texnologiyasi asosida yangi
simvollar yaratish (drag-and-drop).

Kutubx:ona oynasida simvollar bilan ishlashning ko'pgina imko-
niyatlari fagat kontekstli menyu orgali amalga oshiriladi. Masalan,
simvolni nusxasini hosil qgilish uchun, kontekstli menyudan tegishli
buyrugni berish kifoya.

Kutubxonaning yangi ko' rinishlari

Flash MXda ikki ko'rinishga boiingan kutubxonalar mavjud
(Shared Library):

Author-time - kutubxonasi, simvollar qayta ishlash vaqti bo'yicha
bo'lingan;

Rim -tim e —qo'yilgan vaqti bo‘yicha bo' lingan kutubxona.

Savol va topshiriglar:

1. Dastur oymasi nechta gismdan iborat?

2. Dastur oynasining vaqt diagrammasi nima vazifani bajaradi?
3. Uskunalar paneli nima vazifalarni bajaradi?

4. Dasturning kutubxonasi ganday imkoniyatlarga ega?

6.2. Flash MXda gatlamlar bilan ishlash

Boshqga dasturlarda boigani kabi Flaslida ham animatsiyalar hosil
gilishda yangi obyektLar yaratilib, ularni alohida harakatlantirishga
tcTgii kela.di. Flashda ushbu imkoniyatni ta'minlab berish, ya’ni
obyektlar ustida ishlash, ularga alohida liarakatlar biriktirish uchun
gatlamlardan (cnon - layer) foydalaniladi. Soddaroq gilib aytganda,
har bir obyekt go'yilishidan oldin unda alohida gatlam hosil qgilinadi.

206



Bulling uchun rasmda koi'satilgan Insert layer tugmasini bosish kerak
bo' ladi.

Tugma bosilgandan keyin gatlamlar orasiga yangi gatlam go‘shiladi.
Yangi gatlamga fovdalanuvchi xohishiga ko‘ra chizish yoii bilan
yoki obyektlarni import qilish yoii bilan biror obyekt biriktiriladi.
Obyektlarni har birini alohida vaqt mobaynida, bir-biridan keyin, har-
xil katta kichiklikda harakatlanishi, hosil boiishi yoki yo‘golib ketishi
imkoniyatlarini ta'minlaydi. Bunga quyidagi sodda animatsiyani misol
qilib beramiz:

> Flash ishga tushganda yangi ish maydonida bitta gatlam bo‘-
ladi.

> o‘sha gatlamni birinclii kadrini belgilab biror aylana chizamiz.
Hosil boigan aylana shu qgatlamga tegishli boiadi. Navbatdagi
gatlamlarni qo‘'yganda adashib ketmaslik uchun gatlam nomini
obyekt nomiga o‘zgartirgan ma'qul. Buning uchun gatlamning layer
matni ustida sichqgonni chap tugmasini ikki marta bosish bilan
nomini o‘zgartirishga imkon beradi. Qatlam nomini aylana deb
olamiz.

> endi navbatdagi gatlamni qo‘yamiz. Buning uchun insert
layer tugmasini bosamiz. Hosil boigan gatlamga endi to‘rtburchak
jonlantiramiz.

> lkkala gatlamning ham birinchi kadrlari ustida sichqonning o‘ng
tugmasini bosib, menyudan create Motion Tween (harakat hosil gilish)
buyrug‘ini beramiz.

> navbat bilan qatlarnlarda bir necha kadrdan keyin Insert
Ketframe buyrugini beramiz: gatlamlarda kadrlar orasida harakat hosil
boiadi.

> fagat uni sezilarli boiishi uchun vyangi qo'yilgan kadrni
tanlab tegishli obyektni kerakli yo'nalishda harakatlantiriladi. Ya'ni
koordinatalari o‘zgartiriladi. Buning uchun properties panelidan X va
U koordinatalari keraklicha o'zgartiriladi.

> animatsiyani koiisli vaqtida dastlabki kadrda obyekt joyida
boiadi, oxirgi kadrga octguncha esa obyektning harakati hosil
boiadi.

Quyidagi rasmlarda yugoridagi aylana pastga garab harakatlanib
kattalishib boradi, to‘rtburchak esa aksincha.



Savnl va tnpshiriglar=

Flashda gatlamlar va ularning vazifalari nimalardan iborat?
. Yangi gatlam go'yish uchun ganday buyruq beriladi?
Qatlamning nomi ganday o‘zgartiriladi?

. Qanday holatlarda yangi gatlam go'yiladi?

AW DN -

6.3. Obyektlarni chizish imkoniyatlari

Dasturning grafik imkoniyatlari ham ko'pqirralidir. Dasturning
barcha grafiklar bilan ishlash imkoniyatlari Tools uskunalar panelida
joylashgan. Ushbu paneldan foydalangan holda turli xil rasmlarni
chizish mumkin. Line Tool uskunasi yordamida to;g‘ri chiziqg, siniq
chiziglar, botiq chiziglar va xatto ko'pburchaklar chizish mumkin. Oval
Tool uskunasi yordamida oddiy aylana. ellipslar chizish va ulardan
boshga aylanaga o'xshash shakllar hosil gilish mumkin. Rectangle
Tool uskunasi esa to'rtburchak, kvadrat kabi shakllarni chizish uchun
ishlatiladi. Pencil Tool oddiy galam kabi chizish vazifasini bajaradi.
Brush Tool uskunasi aylana shaklidagi har xil oicham bilan rasm
chizish. boVash imkoniyatlarini beradi. Paint Bucket Tool uskunasi
tanlangan rangni quyish imkoniyatini beradi. Eyedropper Tool ish
maydoni boshga gqismidagi biror rangni tanlab berish imkoniyatini
beradi. Eraser Tool chizilgan rasmlarni biror gismini o‘chirish uchun
ishlatiladi.

Chizishdan oldin rang tanlash

Uskunalar panelida Colors ranglarni tanlash vositalari joylashgan.
Bu uskunalar yordamida osonlik bilan obyekt konturi rangi va uning
ichiga quyiladigan ranglarini tanlash imkoniyati mavjud.

Kontur rangini tanlash uchun Stroke color uskunasini tanlang. Agar
sichgoncha tugmasini darrov qo'yib yuborilsa rang tanlash palitrasi
ochiladi va sichgoncha ko‘rsatlcichi pipetka kotinishini oladi. Palitra
216 xil rangni o‘zida saglaydi.

216 xil rang palitraning chap tomonida va o'ng tarafida esa
gora ustunlar joylashgan. Chap yon ustun standart 6 ta kulrang
gradatsiyalarni (qora va oqdan tashqari), shuningdek 6 ta kompvuter



ranglarini (qizil, yash.il, ko'k, sariq, havo rang (cyan) va pushtirang
(magenta)) o‘z ichiga oladi. Albatta bular 216 xil rang ichida bor lekin
qulaylik uchun chap kolonkada nusxalari o'rnatilgan.

KLontur rangini tanlash oynasi

Rasmlarning katta elementlari va qalin konturlarini bo‘yashda
oldindan jarayonni obyektiv baholash kerak.

Windows operatsion tizimi uchun rang tanlash standart oynasida
16 million True Color ranglardan ixtiyoriysini tanlash mumkin.
Bundan tashqari Color oynasining o'ngida ranglarni och yoki
to'gligini belgilovchi chizg‘ich mavjud. Shuningdek rangning sonli
parametrlarini ham berish yoki «tur - to'yinganlik —och yoki to‘qligi»
(shunday nomlanadigan shkala HSB: Hue Saturation, Brightness), yoki
kcmpyuterdagi RGB «standart» formatida, qizil, yashil, ko'k ranglarni
tashkil giladigan kattaliklarni ko'rsatadi.

Masalan. gizil ranglarni tashkil giladigan 255 (maksimum), yashil
va ko'kdan - 0 (bo'larni gisqacha shunday yozish mumkin: RGB 255,
0. 0). Natijada fagat gizil rangga ega bo'lamiz. RGB 0, 255, 0-yashilni.
RGB 0. 0, 255 ko'k rangni beradi.

Har rangning ochigligi 0 dan 255 gacha o‘zgaradi. Masalan, RGB
0.0, 127 ifodani ko‘rsatib biz to‘g-ko‘k rangga ega boiamiz. Qizil va
yashil ranglarni teng proportsiyalarda aralashtirib (RGB 255, 255, 0),
biz sarig rangga ega boMamiz. RGB shkala bilan ishlash juda nozik
bo'lganligi uchun ko'pgina kompyuter dizaynerlari va rassomlari HSB
slikaladan foydalanishadi.

Windows operatsion tizimining standart ranglar tanlash oynasi
odatda tus burchak ifodasiga ega (Oc dan 360°), rangning to’qligi esa 0
dan 1 oraligdagi oral iqda o'zgaradi. Lekin Windows mulogot oynasida
bu parametrlar 0 dan 240 oralig;ida o‘zgaradi.

Quyiladigan rangni tanlash

Demak, yuqori sifatii rang tanlash oynasi yordamida yangi kontur
ranglarini ham hosil gilish mumkin. Obyekt ichiga quyiladigan rangini
tanlash uchun (Fill color), 3anuska belgisi yonida sichgoncha tugmasini
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bosiladi. 3 unda deyarli shunday rang tarilash oynasi diigadi. Rang
tanlash xuddi yuqoridagidek amalga oshiriLadi.

Chiziqgli gradient

Agar bu oynaga diggat bilan garalsa bir gancha farglarni sezish
mumkin. Flashda rang quyish nafaqat bir ranglarni balki gradiyentli
ham boiishi mumkin. Bu degaai bir hil rang suzib boshgasiga o‘tadi.

Doiraviy gradiyent

Gradiventlar nafagat chizigli balki doiraviy ham boiishi mumkin.
Quviladigan rangni tanlash ovnasi pastki gismida bir nechta tayyor
gradiyent) to'plami bor: uchta chizigli va 4 ta doiraviy. Bundan tashqari
216 xil ranglar palitrasi oynasidan foydalanishingizmumkin.

Savol va topshiriglar:

1. Dasturda grafiklarni chizish uchun gaysi panel uskunalaridan foy-
dalaniladi?

2. Line Tool. Oval Tool, Rectangle Tool, Pencil Tool, Brush Tool
uskunalarining vazifalarini aytib bering?

3. Grafik lar chizishda rang tanlashning qaaday imkoniyatlari bor?

6.4. Grafikli forinatlarni konvertatsiyasi

Flash — filmlari nafagat harakatli fayllarni balki, oddiy rasm
ko'rinishidagi fayllarni ham import, eksport qilish imkoniyatiga
ega. Quyida Flashda qoilanilishi mumkin boigan grafikli formatlar
keltirilgan.

6.10-jadval
Flashda goilanadigan ayrim grafikli formatlar
Fayl turi Kengaytmasi Eksport  Import
Adobe Illustrator (6.0-yoki ,eps, .ai + +

oldingi versiyalari)
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Bitmap bmp +

Enhanced Windows Metafile .emf .
FreeHand Jft7, ft7, .fog, J8.
fi9, [ft9

GIF ogif *

JPEG iPg +

PNG *png +
Flash Player swf + ~to
Windows Metafile wmf + —+

Agar kompyuteringizda QuickTime 4 o‘rnatilgan boMsa,
go‘shimcha ravishda quyidagi fayllarni goTlash mumkin:

PhotoShop psd +
QuickTime Image qtif + -+
Silicon Graphics .sai 4
TIFF tiff - —h

Flash —filmlarni eksport qgilish

Flashda yaratilgan filmlardan boshqa dasturlarda foydalanish uchun
ularni eksport qilib, har xil formatlarda saglash mumkin. Buning uchun
File > Export Movie YOKi Export Image buyruqglaridan foydalaniladi.
Bu yerda Export Movie filmni harakatli fayllarga (swf, avi, gif, spl,
wav va boshgalar) aylantirish uchun ishlatiladi. Export Image esa
rasmli fayllarga (bmp, jpg, gif, png \a boshqgalar) aylantirish tichun
ishlatiladi.

Quyidagi ketma-ketlikda Flash -fi Imdan gif - animatsiya eksport
gilish ketma-ketligini ko'rib chigamiz:

o avval yuqorida ko'rsatilgan misollardan foydalanib, Flash — film
yarating;



° uni saglab boigach. File > Export Movie buyrug‘ini bering.
Export Movie mulogot oynasi hosil bo‘ladi.

° oynada fayiga nom berib. Tun daiina bandidan gif faylni
k o ‘rsatib, «CoxpaHuTb» tugmasini bosing.

Natijada kiritilgan nomdagi va tipdagi favl ko'rsatilgan joyda hosil
bo‘ladi. Hosil boigan fayldan boshqga turli magsadlaida foydalanish
mum kin. Bu imkoniyatdan Web-tahrirlagichlar bilan ishlashda savtlarni
chiroyini boyitishda keng foydalanish mumkin.

Flash MX obyektlarini boshga dasturlarga
go‘yish va ulardan foydalanish

Flashda vyaratilgan swf filmlar yoki gif animatsiyalar Web-
sahifalarni yuqori darajadagi dizaynga ega bo;lishi uchun xizmat
gilib kelmoqda. Qaysiki savtga garamang. Flash-filmlari yoki Gif
animatsiyalari har ganday foydalanuvcliini o:ziga tortadi. Web-
saytlarning nafagat biror gismi, hattoki sahifaning butun gismi Flashda
tayyorlanayotgani dasturning keng gamrovli ekanidan dalolat beradi.
Flash-saytlarga bir nechta inisollar keltirainiz: www.flash-art.ru, www.
costroff.r-vision.ru, www.artflasher.com,www.rusmaster.com, www.
jasmin.ru

Web-sahifalarda esa Flashning swf yoki G if animatsiyalari oddiy
rasmni joylagandek gqo'yiladi. Swf faylini preamweaver dasturida
go'yish ketma-ketligi bilan tanishib chigamiz:

° buning uchun avval web sahifani yaratib olib kerakli joyiga
ko‘rsatkichni go'yib insert > Media > Flash buyrug‘i beriladi;

o Select File muloqgot oynasi hosil bo'ladi. Oynadan qo‘ymoqchi
bo‘lgan swf faylni ko'rsatiladi;

o swf fayl web-sahifaga qo'yilganda, ya'ni tahrirlash vaqtida
ishlamaydi. Web-sahifani saglab, bekitgandan keyin, faqat ko'rish
rejimida, ya'ni internet Explorer yordamida ko‘rishimiz mumkin.

Gif animatsiyani esa Dreamweaverda biroz osonroq, xuddi oddiy
rasm qo‘ygandek qo'yiladi. Buning uchun quyidagi ketma-ketlik
bajariladi:

0 Insert > Image buyrug‘i beriladi;

° hosil bo‘lgan Select Image Source muloqot oynasidan qo'yi-
ladigan fayl ko'rsatiladi;
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0 Web-sahifani saqlab yopiladi;
° Web-sahifani koiish uchun Internet Explorer dasturida ochiladi
va yaratilgan faylning koiinishi paydo bo'ladi.

FLASHda tayyor fayllarni go'‘yish

Flashda obyektlarni chizish imkoniyatidan tashgari yana tayyor
rasmlar, videolar va boshga ma’'lumotlarni fayllardan qo'yish
imkoaiyati bor. Ya'ni tayyor faylni import qilish imkoniyati mavjud.
Buning uchun File menyusidan Import buyrug'i beriladi. Natijada
Import mulogot oynasi hosil bo'ladi. Oynadan foydalanib import
gilmoqchi bo‘lgan faylni ko'rsatib. O Tkpbl Tb tugmasi bosilsa, tegishli
gatlainga tanlangan faylda saglanayotgan rasm yoki boshqga obyektni
go’yib beradi.

Import gilingan rasm lar ustida bir gancha amallar bajarish mumkin.
Ekranda import gilingan rasmni belgilang. Insert > Convert to
Symbolni yoki F8 ni bosing. Klipga nom bering. Uni klip (Movie clip)
yoki grafik (Grafts) shaklida joylang va OK tugmasini bosing.

Endi rasm ustida bir gancha tahrirlash ishlari olib borish imkoni
bor. Effektlar panelini oching Proporties > colors va royxatdan
«Ad\anced» buyrug'ini tanlang. Bir garashda bu giyinday tuyulishi
mumkKin, lekin buning ortida matematik mantiq yotadi. U quyidagilarni
anglatadi:

> Flash har bir kanal uchun rang belgisiga ega bo'ladi. Masalan, R
(qizil) va uning belgisi 255 (to'q qizil).

> Flash foizli belgisini tekshiradi va qizil rangni yangi belgisini
hisoblaydi. Ivlasalan, R uchun belgi —l00% bu normal holat hisob-
lanadi.

> Flash «go'shimcha» maydonga yangi belgi bilan qo‘shadi. Bu
misolda qo'shimcha maydon belgisi 0 ga teng, demak qizil rang belgisi
R 255 gateng bodib golaveradi.

> Analogik ravishda obyektning boshga rang kanallari -
yashil (G), ko'k (B). Ko'rinib turibdiki bu misolda hamma kanallar
aslidagidek goladi. Agar ular oinatilishiga biroz o‘zgartirish kiritsak
nima bo'ladi?

Keyingi bandlarda bu savolgajavob topishingiz mumkin.
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Kang kanaiiarini saraianishi

Ranglarni saralashning oson yoilaridan biri kaaallardan ba'zi
birlarini o'chirish kerak. Masalan, quvidagi belgilarni ishlatib ko‘-

ring:

Kanal Qiymati Qo'shimcha giymatlari
Red 100% 0
Green 0% 0
Blue 0% 0
Alpha 100% 0

Yashil va ko'k kanallarni saralab qizil tusdagi rangga ega boiamiz.
Kanallardan birini go‘shsak bu ajoyib natijaga olib keladi:

Masalan:
Kanal Qivmati Q9'shinicha giymatlari
Red 100% 0
Green 100% 0
Blue 0% 0
Alpha 100% 0

Bundan keyin sarig imidjga ega bo‘lamiz.

Rang kanallari manipulyatsiyasi

Yugoridagi kanallarni saralash har doim ham yaxshi natija
beravermaydi. E'tiborli odam darrov olingan imidj kamchiliklardan
holi emas ekanligini paygaydi. Bunda kontrast, yorugiik va ba'zi
diegara chiziqglari yo‘golib ketadi. Lekin kanal saralanishini bir necha
manipulyatsiyalari mavjud. Misol uchun hamma kanallarni bir vaqtning
o'zida o‘zgartiramiz.
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Kanal
Red
Green
Blue

Alpha

Qiymati
200%
200%
200%

100%

Qo‘shimcha giym atlari
0
0

Bu imidjni yorginroq qilishga yordam beradi.
Eslatma. % belgisi orgali 0% dan
natish mumkin. Lekin tahrirlangan maydonda 200 ni ham o ‘rnatish
mumkin. Yuqori darajali animatsiya foizlari 0% dan 100% gacha

o'zgarishi mumkin.

mumkin.
Masalar:

Kanal
Red
Green
Blue

Alpha

«Haqigiy» kontrast
Kanal
Red
Green
Blue

Alpha

Kanallarni

Qiymati
-100%
-100%
-100%.

100%

Amaliy misollar:

Qiymati
600%
600%
600%

100%

manfiy qiymatlarini

100% gacha belgilarni o'r-

ham berish

Qo‘shimcha giymatlari
256
256
256

0

Qo‘shimcha giymatlari
-5/2
-5/2
-5/2

0



«Haqigiy» yorgmlik
Kanal
Red
Green
Blue

Alpha

Sariq
Kanal
Red
Green
Blue

Alpha

Pushti rang
Kanal
Red
Green
Blue

Alpha

Moviy rang
Kanal
Red
Green
Blue

Alpha

Qiymati
100%
100%
100%
100%

Qiymati
200%
200%"i.
200°0

cod

Qiymati
250°0
250%
250%
100%

Qiymati
250%
250%
250%
100%

Qo‘shimcha givmatlari
256
256
256
0

Qo'shimcha givmatlari
-20
-90
-256
0

Qo'shimclia giytnatlari
-50
-183
-50
0

Qo‘shimclia givmatlari
-256
-200
-52
0



Ikki kanal aralashmasi —1

Kanal Qiymati Qo‘shimcha giymatlari
Red 100% 256

Green 100% 0
Blue 100% 256

Alpha 100% 0

Ikki kanal aralashmasi -2

Kanal Qiymati Qo”~himcha qgiymatlari
Red 100% 256

Green -100% 256

Blue -100% 256

Alpha 100% 0

Relef

Kanal Qiymati Qo ‘shimcha giymatlari
Red -100% 256

Green -100% 256

Blue -100% 256

Alpha 50% 0

Yana rasmlar ustida olib boriladigan ishlardan biri bilan tanishib
chigamiz. Bu imkoniyat rasmni turgan joyidan yo'golib koiinmay
golish yoki aksincha rasra yo'q joydan asta-sekin hosil bo!lishini
ta'minlaydi. Buning uchun quyidagi ketma-ketlikni koiib cliigamiz:
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; rasnini mijjui 1qiiib oiib, insert > Convert to Symbol buying'ini
yoki F8 tugmasini bosing;

- Proporties > Color > Alpha bandini tanlang.

«Alpha»ning koi'satkichini o‘zgartirish natijasida rasm quyidagicha
o'zgaradi:

Kanal Qiymati Ko‘rinish darajasi
Alpha 0% ko'rinmaydi
Alpha 50% 50% ga noaniqg ko'rinadi
Alpha 100% toTiq ko'rinadi

Xuddi shu effektlardan o‘xshash obyektlarni bir-biriga aylantirisli-
da foydalanish mumkin.

Savol va topshiriglar:

Grafikli fonnatlar konvertatsiyasi deganda nimani tushunasiz?
Fayllarni import gilish nima?

Fayllarni eksport gilish nima?

Flashda ganday formatdagi fayllarni import gilish mumkin?

Pwn -~

6.5. Flashda oddiy harakatlar hosil qilish

Flashda animatsiyalarni o'rganishni eng sodda harakatlarni ko'rish-
dan boshlayiniz.

1-misol. Dastlab biror chizilgan obyektni bir koordinatadan boshga
koordinataga o‘tish jarayoni bilan tanishib chigamiz:

0 File > New buyrug'ini berish bilan yangi ish maydoni hosil
gilamiz;

o ish maydonidagi yagona gatlamning (layer) birinchi kadrini
sichqon chap tugmasi bilan bosib belgilaymiz;

o endi sichgonni Tools paneliga olib kelib chizish uchun
moijallangan ixtiyoriy uskunani tanlaymiz;
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o sichqcn yordamida ixtiyoriy rasm chizamiz;

° gatlamning kadri ustiga sichqon ko'rsatkichini qo'vib, o‘ng
tugmasini bosamiz. Hosil boMgan menyudan create Motion Tween
buyrngMni beramiz.

o sichgon ko‘rsatkichini bir nechta kadrdan keyinga qo'yib Insert
Keyframe buyrug'i beriladi. Xuddi shu Keyframeni belgilagan holatda
rasmni o'zini kerakli koordinataga o'tkazamiz. Buning uchun Properties
panelidan X va Y koordinatalarini o'zgartiramiz.

o harakatni ko‘rish uchun control > Test Movie buyrugU beriladi.

Natijada dastlabki nuqtada turgan rasm biroz vaqt ichida boshga
koordinataga o'tadi.

2-misol. 1-misolni biroz o'zgartirsak, shu obvektni kattalashganini
kuzatishimiz mumkin:

o yugoridagi misolning 5 ta gadamini bajarib boigach. rasmning
koordinatasi o‘zgargan kadr ustiga sichqgon tugmasini bosish bilan
belgilavmiz;

0 natijada rasm belgilanadi, rasmni kattalashtiramiz. Buning uchun
Properties panelidan W: va H: giymatlarini kattalashtiramiz;

0 harakatni ko‘rish uchun control > Test Movie buyrug‘i beriladi.

Natijada aylana harakatlanib boshga koordinataga o‘tish bilan
kattalashib boradi.

3-misol. Navbatdagi misolda esa xuddi !-misoldagi chizilgan shar
boshga koordinataga o‘tishi bilan rangi o'zgarib boradi. Buning uchun
quyidagi ketma-ketlik bajariladi:

o] I-misoldagi birinchi 5 ta bandini bajarib boigach, rasmning
koordinatasi o‘zgargan kadr ustiga sichgon tugmasini bosish bilan
belgilaymiz;

o] natijada rasm belgilanadi, keyin Properties panelidan Color
ro‘yxatidan Advanced buyrug'‘i beriladi;

¢ ekranda hosil bo‘lgan Advanced Effect oynasidan 0‘zimizga
kerakli rang ko'rsatkichlarini tanlab OK tugmasini bosamiz;

¢ harakatni ko‘rish uchun Control > Test Movie buyrug‘i beriladi.

4-misol. Endigi misolda obyektlarni harakatlanish bilan biror
burchakka burilishi bilan tanishib chigamiz. Buning uchun quyidagi
ketrna-ketlik bilan tanishib chigamiz:
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° I1-misoldagi birinchi 5 ta bandini bajarib bo‘lgach, msmning
koordinatasi o'zgargan kadi ustiga sichgon chap tugmasini bosish bilan
belgilaymiz;

(o] natijada rasm belgilanadi. M odify > Transform > Scale and
Rotate buvrug'i beriladi;

° ekranda hosil boigan scale and Rotate mulogot oynasida tegishli
burchak giymatini ko'rsatib. OK tugmasini bosamiz;

° korsatilgan burchakka rasm buriladi.

Savol va topshirigfar:

1. Oddiy harakat hosil gilish ketma-ketligini tushuntirib bering?
2. Flashda oddiy harakat hosil giling?
3. Obyektning harakati natijasida kattalashishi animatsiyasini hosil qil-

ing?
4. Obyekt liarakatlanishi natijasida boshga ranga o’tish animatsiyasini
h.osil qiling?

6.6. Dasturning tovushlar bilan ishlash imkoniyatiari

Flashda filmlarga tovush ham berish mumkin. Kompyuterda
sagqlanayotgan tovush fayli yoki tovushni yozdirish orgali ham har xil
tovush fayllarini import gilish yo'li bilan go‘'yish mumkin. Buning
natijasida Flashda tovushli film hosil boiadi. Ya’'ni animatsiva namoyish
gilinayotgan vaqtda harakat bilan birga unga mos yoki unga tegishli
tovush ham ijro gilinadi. Buning uchun quyidagi ketma-ketlik amalga
oshiriladi:

m avval Flashda ixtiyoriy film yaratiladi;

m iilmga o‘rnatilishi lozim boigan tovushni maxsus dasturlar
yordamida kompyuterga yoziladi yoki kompyuter xotirasida tayyor
tovush saqlanayotgan boisa, undan ham foydalanish mumkin;

m tovushni tayyorlab olgandan soiig, File menyusidagi import
buyrug‘i beriladi:

B natijada import muloqot oynasi hosil boiadi. Oynadan foy-
dalanib o'rnatmoqchi boigan tovush faylini ko'rsatamiz. Natijada
tovush fayli import gilinadi.
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Sichgon yordamida ixtiyoriy qatlamdagi birinchi kadrni tanlab,
Properties panelidan Sound ro‘yxatini ochamiz. Ro'yxatdan o'zimiz
import gilgan tovnsh faylini tanlaganimizda. o'sha gatlamda tovush
o'rnatiladi.

Eslatma. Fihndagi tovush bilan animatsion harakat sinxron ravishda
berilishi ustida test o‘tkazish kerak. Agar ular sinxron boimasa filmdagi
animatsiya gatlamlaridagi kadrlar sonini ko'paytirish (buning uchun
kadrlar orasiga sichgon chap tugmasini bosib. F5 tugmasini bosish yoii
biian kadr qo'viladi. Natijada animatsiyaning namoyish vaqti cho'zilib
tovushga yaginlashadi) yoki kamaytirish yoii bilan sinxronlashtirish
mumkin.

Tovushli tugmalar yaratish

Yuqorida ko'rsatilgan misoldan foydalanib tugmalarga ham to-
vush berish mumkin. Buning uchun quyidagi ketma-ketlik amalga
oshiriladi:

m avval tugma qgo'yiladi yoki Flashning o‘ziga chizish yoii bilan
hcsil qgilinadi;

m go'yilgan yoki chizilgan rasmni tugmaga aylantirish uchun
uning ustida sichqon chap tugmasini bosish yoii bilan belgilanadi.
Sichgonchaning oiig tugmasi bosilganda quyidagi menyu hosil boiadi;

B menyudan convert to Symbol buyrug'i beriladi. convert to
Symbol mulogot ovnasi hosil boiadi. Oynadan Button bandi tanlanadi.
Naiijada tanlangan rasm tugmaga aylanadi;

i tugma ustida sichgon chap tugmasi ikki marta bosiladi;

m hosil boigan oynada Over ko'rsatkichi ostidagi katakka yangi
kadi go'yam iz;

i shu kadrni belgilab olamiz;

i File > Import buyrug‘'i yordamida tugmaga o'rnatmoqchi
boigan tovush fay lini import gilanxiz (import gilingan tovush avtomatik
ravisida Properties panelining Sound ro‘yxatida hosil boiadi);

m Properties panelining Sound ro‘yxatidan tovushni tanlaymiz
(bu blan biz tegishli tugmaga shu tovushni o'rnatgan boiamiz):

m boigan o'zgarishlarni saqglab. filmni ko'rish uchun Control
> Te.t Movie buyrugini beramiz; film namoyishi vaqtida tugma
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ustiga sichqon Kko'‘rsatkichini olib Kkelsaiigiz o‘rnatilgar. tovush
eshitiladi.

Xuddi shu yo'l bilan tugma ustiga sichqon ko'‘rsatkichini olib
kelinganda yoki bosilganda fagat tovush chiqishi bilan chegaralanib
golmasdan, balki tugma boshqasigaaylanishiJnam hosil gilish mumkin.
Bu bilan, foydalanuvchi menyudan tanlangan tuginani boshqasidan
ajralib turishini ta'minlaydi. Buning uchun yuqoridagi misolni biroz
davom ettirish zarur. Ya'ni. vaqt diagrammasining Over katakchasiga
kadr go‘yib, unga shu tugmaning boshga ranglisini o‘rnatamiz. Down
katakchasiga esa boshga rangli tugmachani o'rnatib, filmni ko‘rish
uchun control > Test Movie buyrug'ini beramiz. Namoyish vaqtida
tugma ustiga sichqon ko'rsatkichini olib borsak. tugmacha boshqga
rangga o ‘tadi, uni bosadigan bo'lsak yana boshga rangga o'tadi.
Bu bilan biz menyudagi tugmalardan qaysi biri ustida ko’rsatkich
turganini yoki gqaysi tugma bosilganini osongina ajratib olishimiz
mumkin.

Savol va topshiriglar:

1. Chizilgan obyektni tugmaga aylantirish uchun qaysi buyrugdan

foydalaniladi?
2. Tugmaga tovush biriktirish ketma-ketligini aytib bering?
3. Fihnga tovush biriktirish uchun dastlab qaysi buyrugdan

foydalaniladi?
4. Filmga tovush berish ketma-ketligini sanab bering?

6.7. Obvekt harakati trayektoriyasini bosligarish

Flashda asosiy qgatlam - Guide Layer tushiinchasi mavjud. Asosiy
gatlamlar ikkita xususiyatga ega:

* birinchidan, siz unga fagat tahrirlash rejimida koi'inadigan iz»hlar
joylashingiz mumkin. Bu izohlar SWF formatiga eksport gilinrmydi:
shu ma'noda Guide so'zini «boshqarish», «ko'rsatma» deb tushmish
mumkin;

* ikkindiidan, asosiy gatlam yordamida obyektning bir joydan
ikkinchi joyga ko‘chish harakati trayektoriyasini boshqarish rnunkin
(tweened-animatsiya harakati yordamida).
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Guide gatlamni yaratish uchun quyidagi ketma-ketlikni amalga
oshirish kerak:

1. Vaqt diagraimnasi panelida qatlamlar ro‘yxatidan ixtiyoriy
gatlam ustida sichqgon o'ng tugmasini bosing va kontekstli menyudan
Insert Layer buyrug‘ini bering.

2. Yangi hosil gilingan gatlam ustida sichqgon o‘ng tugmasini bosing
va kontekstli menyudan Guitie bandini tanlang. Natijada gatlamlar
ro‘'yxatida gatlam nomi yaqinida bolg‘acha koiinishidagi belgi hosil
bo'ladi. Bu belgi fagat tahrirlash uchun moljallanganini bildirib,
foydalanuvchilar buni koiishdan mustasno.

Yuqorida ayti lganidek bosh gatlamning ikkinchi ko’'rinishi
liarakatlanayotgan obyekt trayektoriyasini (bosib o‘tishi kerak bo‘lgan
yo'Ini chizmasini) belgilaydi.

Obyektni ko'rsatilgan trayektoriyada harakatlantirish uchun quyidagi
ketma-ketlikni bajarish kerak:

1. Animatsiyalangan obyekt gatlainining nomi ustida sichqon o'ng
tugmasini bosing.

2. Kontekstli tnenyudan Add Motion Guide buyrug‘ini bering.
Natijada gatlamlar ro'yxatida maxsus belgi ostida asosiy gatlam hosil
bo'ladi.

3. Asosiy gatlamni faollashtirish uchun uni nomi ustida sichqoncha
chap tugmasi bilan bosamiz.

4. Chizishning ixtiyoriy wuskunasi yordamida (Pen, Pencil. Oval,
Brush. Rectangle) obyekt harakatlanish trayektoriyasini tasvirlang.

5. Animatsiyaning birinchi kadri katakchasini sichqoncha chap
tugmasi bilan belgilang va Properties panelidan Orient to Path
(marshrut bo'yicha moljal olish) bayroqchasini o'rnating.

6. Animatsiyaning oxirgi kadri katakchasini sichqon chap tugmasi
yordamida belgilang va kadrning Properties panelidan xuddi shu
bayrogchani oinating.

7. Animatsiyalangan obyektdan belgilashni olib tashlab, filmni
namoyish gilish nchun Control > Test Movie buyrug‘ini bering.

Eslatma. Agar siz kesishadigan trayektoriya hosil gilgan bo'l-
sangiz, u holda obyekt kesishish natijasida hosil gilgan yo‘l bo‘yicha
harakatlanadi.
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1. Asosiy gatlam nima va uning ganday xususiyatlari bar?
2. Obyektni belgilangaa yo'nalishda harakatlantirish uchun gaysi

buyruglardan foydalaniladi?
3. Biror obyekt olib uni ixtiyoriy yo‘nalish bo‘ylab harakatlantiring?

6.8. Flashda nigobli animatsiyalar yaratish

Nigob 0;z ichiga oddiy qatlamlarni oladi. Fagat bitta. gatlam niqobli
(bekitadigan) qgatlam bo'lib. u fagat o’zining ostidagi qatlamga tegishli
obyektni bekitadi (nigoblaydi). Qatlamlardan nigob hosil gilish uchun.
quy idagi ketma-ketliklarni bajarish kerak:

1. Nigob go‘ymoqchi boigan. gatlamning nomi ustida sichqonning
o'ng tugmasini bosilib, kontekstli menyudan Insert Layer buyrug‘ini
bering (qo'yilgan vangi gatlam endi nigob o'rnida xizmat qiladi).

2. Nigob gatlamiga rang quying. Agar animatsiyali nigob
yaratmogchi boMsangiz. unda fagat bir marta rang quyilgan bo‘lishi
kerak.

3. Nigob gatlami nomi ustida sichgon o‘ng tugmasini bosing,
kontekstli menyudan Mask (Macica) buyrugMni bering. Shu dagigadan
boshlab yangi qatlam niqobga aylanadi. Shundan keyin gatlamlar
to'plamida quyidagi o'zgarishlar boiadi:

° gatlamli nigob nomidan chapda nigobga tegishli belgi hosil
boiadi;

° nigoblangan gatlamning nomi o’'ngga suriladi va uning yonida
ham shuningdek yangi belgi paydo boiadi;

° ikkala gatlam ham avtomatik ravishda bekitiladi (gatlamning
nomidan o!ngda hosil boigan qulf belgisi shundan dalolat beradi).

NlJigobga biriktirilgan rangning asli koiinmasdan, balki uning
harakati natijasida ortidagi gatlamning ochilishi kuzatiladi. Bosh-
gacha aytganda bekitilgan obyekt nigob orqali harakat bilan ochiladi.
Siz  nigobning holatini. koiinishini har doim o'zgartirishingiz
mum kin. Uni tahrirlash liolatiga keltirish uchun qulf belgisi
ustida sichgonni chap tugmasini bosish kifoya. Bu bilan siz qulfni
avtomatik ravishda olib tashlagan boiasiz. Tahrirlash rejimini ishga



tushirish uchun nigobli gatlam nomini sichqgon o’'ng tugmasi bilan
bosish va kontekstli menyudan Show AIll (Hammasini ko'rsatish)
buyrugini bering.

Nigobni koiish rejimini voqish uchun, sichqon o‘ng tugmasini
nigobli gatlam nomiga yoki nigob ostidagi qatlam nomiga bosish va
kontekstli menyudan Show Masking buyrug'ini berish kerak.

Savol va topshiriglar:

Nigob hosil gilish ketma-ketligini aytib bering?

Animatsiyalashgan nigob hosil qiling?

Qo'shimcha fonli niqob hosil gilish ketma-ketligini aytib bering?
Animatsiyalashgan niqob va qo’shimcha fonli niqoblarning farglari
nimada?
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XULOSA

Xulosa gLlib aytganda, jamiyatning barcha jabhalarida ro'y be-
rayotgan hamxna yangiliklar, kashfiyotlar va rivojlatiishning to'xtovsiz
o'sishi zamirida taiim tiziniida erishilayotgan yutuqlar yotadi. Bunga
ta’'lim tizimida erishilayotgan yutuqglar samaralari deb baho berish
ximmkin. Faqgat taiim tizimidagina jamiyatning barcha jabhalari uchun
zarur yuksak bilimli. iqgtidorli kadrlar tayyorlanadi. Taiim tizimida
samaradorlikka erishish uchun esa professor-crqgituvchilardan o‘z ustida
tinimsiz ishlash, fan-texnika yangiliklaridan o'z vaqtida xabardor
boiish va ularni o'z mehnat faoliyatiga tatbiqg qilish. chet tillarini bilish,
axborot texnologiyalaridan ogilona fovdalana olishlari talab etiladi.

Axborot texnologiyalari va uning eng so'nggi yutuqlaridan xabardor
boiish va ularni o'z sohalariga tatbiq gilib samarali mehnat faoliyatini
tashkil qilish muhim ahamiyat kasb etadi. Yuqorida aytilganidek. taiim
tizimida o'quv materiallarining vizuallashishi bilan taiim samaradorligi
ortib boradi. Bunda esa elektron o'quv resurslaridan (EO'R) keng
foydalaniladi. Turli fanlar bo'yicha EO'Rlanni yaratish va joriy qilish
orgali ta’'lim tizimida o'gitish samaradorligiga erishiladi. EO'Rlarini
yaratish uchun esa avvalo boshlangich kompyuter savodxonligiga ega
boiish, shu bilan birga maxsus dasturiy vositalardan foydalanish va bir
gancha dasturlash tillarini bilish talab gilinadi. Boshlangich kompyuter
savodxonligi informatika va axborot texnologiyalari fanlarini o'qitish
orqali oigatilsa, EO‘Rlarini yaratish esa Web-dizaj'n kabi fanlarni
o‘qgitish orqgali oigatiladi. Shu magsadda ushbu qo'llanmada ham
EO ‘Rlari uchun turli illustratsiyalar tayyorlashga moijallangan grafik
inuharrirlar, web saytlarni yaratishga moijallangan dasturiy vositalar.
animatsiyalar tayyorlashga moijallangan dasturlarni o'rgatishga oid
maiumotlar keltirilgan.
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